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Конфигурация системы

Комплект 
беспроводного 
микрофона 
UWP-D21 
UWP-D22 
UWP-D26

Приемник 
беспроводного 
микрофона 
URX-P03D

Адаптер 
многоцелевого 
разъема 
SMAD-P3D

Адаптер 
многоцелевого 
разъема 
SMAD-P5

Адаптер байонета 
A
LA-EA3 
LA-EA4

Объектив с 
байонетом E

Микрофон 
ECM-VG1 
ECM-MS2 

Блок 
дистанционного 
управления 
RM-30BP

Блок производства 
прямых многокамерных 
трансляций
MCX-500

Пульт управления на рукоятке 
(входит в комплект поставки)

ILME-FX6V/ILME-FX6VK 
ILME-FX6T/ILME-FX6TK

Комплект 
адаптера XLR 
XLR-K2M 
XLR-K3M

Лампа для 
видеосъемки 
HVL-LBPC

Карты памяти  
CFexpress Type A

Карты памяти  
SDXC

Зарядное 
устройство 
BC-CU1  
(из комплекта 
поставки)

Аккумуляторный блок
BP-U35, BP-U60, 
BP-U60T, BP-U70, 
BP-U90, BP-U100

Адаптер переменного 
тока (входит в комплект 
поставки)

Устройство чтения карт 
CFexpress Type A/  
Устройство чтения карт SD

Зарядное устройство 
BC-U1A, BC-U2A

1. Обзор
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Расположение и назначение компонентов

Левая и передняя стороны

11
1

2

4
5
6
7
8

9

12

13

14

3

16

15

10

1. Крючок для измерения расстояния
Крючок для измерения расстояния 
находится на одной плоскости с 
датчиком изображения. Используйте это 
крючок в качестве опорной точки для 
точного измерения расстояния между 
видеокамерой и объектом съемки. При 
измерении расстояния до объекта съемки 
можно прикрепить один конец мерной 
рулетки к крючку.

2. Разъем видоискателя (стр. 20)

3. Вентиляционное отверстие

[Примечание]
Не закрывайте вентиляционное отверстие.

4. Переключатель выбора TC IN/OUT  
(стр. 35, 117)

5. Разъем пульта управления на рукоятке 
(стр. 22)

6.  (метка N) (стр. 62)
ˎˎ Приложите смартфон с функцией 
NFC к устройству, чтобы установить 
беспроводное соединение.  
Некоторые смартфоны, поддерживающие 
системы беспроводных платежей, могут 
не поддерживать NFC. Дополнительную 
информацию см. в инструкции по 
эксплуатации смартфона.
ˎˎ NFC (Near Field Communication, 
коммуникация ближнего поля) — это 
международный протокол связи для 
беспроводной связи между объектами, 
находящимися в непосредственной 
близости.

7. Крепление пульта управления на 
рукоятке (стр. 22)

8. Кнопка отсоединения пульта 
управления на рукоятке (стр. 22)

9. Антенна Wi-Fi

10. Индикатор записи/съемки (передний) 
(стр. 35)

Мигает, когда заканчивается место на 
носителе или заряд аккумулятора.

11. Переключатель FOCUS (стр. 38)

12. Датчик изображения

13. Кнопка PUSH AUTO FOCUS (стр. 42)

14. Контакты сигналов объектива

[Примечание]
Не дотрагивайтесь голыми руками.

15. Кнопка WB SET (задание баланса 
белого) (стр. 47)

16. Кнопка отсоединения объектива 
(стр. 23)
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Правая сторона (перед/верх/низ)
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1. Кнопка Clip Flag (стр. 55, 72)

2. Переключатель HOLD (стр. 101)

3. Кнопка START/STOP (пуск/остановка 
записи) (стр. 35)

Нажмите кнопку START/STOP (пуск/
остановка записи), чтобы начать съемку. 
Во время съемки этот светодиод горит 
красным цветом.

4. Диск ND VARIABLE (стр. 46)

5. Переключатель ND PRESET/VARIABLE 
(стр. 46)

6. Кнопки вверх/вниз ND FILTER POSITION 
(стр. 46)

7. Индикатор ND CLEAR (стр. 46)

8. Кнопка ND VARIABLE AUTO (стр. 46)
Нажмите кнопку ND VARIABLE AUTO, чтобы 
запустить автоматическую корректировку 
плотности фильтра нейтральной плотности. 
При включении светодиод горит зеленым 
цветом.

9. Многофункциональный диск (стр. 51)
Нажмите при просмотре изображения 
в видоискателе для отображения и 
использования прямого меню.
Когда в видоискателе отображается меню, 
поворачивайте диск для перемещения 
курсора вверх и вниз с целью выбора 
элементов меню или настроек. Нажмите, 
чтобы активировать выбранный элемент.
Когда меню не отображается, диск 
также может использоваться как 
программируемый.

10. Кнопка функции IRIS (стр. 44)

11. Кнопка CANCEL/BACK (стр. 71)

12. Кнопка THUMBNAIL (стр. 70)

13. Кнопка MENU (стр. 14, 75)
Нажмите кнопку MENU для отображения 
экрана состояния. Нажмите и удерживайте 
кнопку MENU для отображения экрана 
полного меню. Нажмите кнопку 
при отображении экрана состояния 
или полного меню для возврата на 
предыдущий экран.

14. Кнопка функции ISO/GAIN (стр. 44)

15. Переключатель ISO/GAIN (выбор 
усиления) (стр. 44)

16. Кнопка функции WHT BAL (баланс 
белого) (стр. 47)

17. Переключатель WHT BAL (выбор 
баланса белого из памяти) (стр. 47)

18. Кнопка функции SHUTTER (стр. 45)

19. Гнездо для наушников (стр. 35)

20. Переключатель POWER (стр. 35)

Правая сторона (сзади) 
(стр. 6)
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Правая задняя сторона и гнездо для карт
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1. Антенна Wi-Fi

2. Диск AUDIO LEVEL (CH1) (стр. 49)

3. Переключатель CH1 (AUTO/MAN) 
(стр. 49)

4. Кнопки ASSIGN (программируемые) 1–3 
(стр. 51)

5. Внутренний микрофон (стр. 49)
Микрофон для записи окружающих звуков. 

[Совет]
При установленной ручке этот микрофон 
отключается и включается внутренний микрофон 
ручки (стр. 7).

6. Кнопка DISPLAY (стр. 11)

7. Встроенный динамик (стр. 35)

8. Индикатор POWER (стр. 35)

9. Кнопка SLOT SELECT (выбор гнезда для 
карт памяти (A)/(B)) (стр. 35)

10. Переключатель CH2 (AUTO/MAN) 
(стр. 49)

11. Диск AUDIO LEVEL (CH2) (стр. 49)

12. Индикатор доступа A (стр. 27)

13. Гнездо карты CFexpress Type A/SD-
карты (A) (стр. 27)

14. Гнездо карты CFexpress Type A/SD-
карты (B) (стр. 27)

15. Индикатор доступа B (стр. 27)
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Ручка, задняя сторона и блок разъемов
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1. Переключатель HOLD на ручке 
(стр. 101)

Служит для отключения органов 
управления на ручке.

[Совет]
Также можно настроить использование только 
кнопки START/STOP на рукоятке для записи и 
остановки съемки.

2. Кнопка START/STOP на рукоятке для 
записи и остановки съемки 

3. Внутренний микрофон ручки

4. Многоцелевой разъем

Список принадлежностей, которые можно 
присоединить к многоцелевому разъему, 
можно узнать у местного торгового 
представителя.

5. Программируемый диск на ручке 
(стр. 51)

6. Рычаг масштабирования на рукоятке 
(стр. 102)

7. Кнопки ASSIGN (программируемые) 7–8 
(стр. 51)

8. Многофункциональный селектор 
(джойстик с 8 направлениями и кнопки 
применения)

9. Разъем для крепления 
принадлежностей (стр. 7)

10. Отверстия для винтов крепления 
принадлежностей (1/4 дюйма)

Совместимы с винтами 1/4-20 UNC (длиной 
6 мм или менее).

[Примечание]
Винты длиннее 6 мм могут повредить внешние 
детали.

11. Индикатор записи/съемки (задний) 
(стр. 35)

12. Кнопка BATT RELEASE (стр. 18)

13. Впускное вентиляционное отверстие

[Примечание]
Не закрывайте впускное вентиляционное отверстие.

14. Присоединение аккумуляторного 
блока (стр. 18)

15. Разъем USB-C (стр. 66)

16. Разъем INPUT2 (аудиовход 2) (стр. 49)

17. Разъем INPUT1 (аудиовход 1) (стр. 49)

18. Переключатель INPUT2 (LINE/MIC/
MIC+48V) (стр. 49)

19. Переключатель INPUT1 (LINE/MIC/
MIC+48V) (стр. 49)

20. Отверстия для винтов для внешних 
устройств

Совместимы с винтами M3 (длиной 4 мм 
или менее).

[Примечание]
Винты длиннее 4 мм могут повредить внешние 
поверхности.

21. Разъем HDMI OUT (стр. 116)

22. Разъем SDI OUT (стр. 116)

23. Разъем TC IN/TC OUT (вход/выход 
временного кода) (стр. 117)

24. Разъем REMOTE
Подключение к принадлежности общего 
назначения с разъемом LANC.

25. Разъем USB/многоцелевой разъем 
(стр. 118)

26. Разъем DC-IN (стандартный разъем 
постоянного тока) (стр. 19)

Установка разъема для крепления 
принадлежностей

1 Поднимите передний край пружины 
разъема и потяните за пружину в 
направлении, противоположном 
стрелке на пружине.

Пружина разъема

Разъем для крепления 
принадлежностей

1

2 Поместите разъем для крепления 
принадлежностей на месте установки, 
совместив выступы на разъеме с 
соответствующими точками на месте 
установки, и затяните четыре винта.
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3 Вставьте пружину разъема в 
направлении стрелки таким образом, 
чтобы фрагмент в форме U оказался на 
конце разъема для крепления 
принадлежностей.

Пружина 
разъема

Разъем для крепления 
принадлежностей

2 32 3

Снятие разъема для крепления 
принадлежностей

Снимите пружину разъема, как указано на 
шаге 1 в разделе “Установка разъема для 
крепления принадлежностей”, отверните 
четыре винта и снимите разъем для 
крепления принадлежностей.

Установка ручки

Разместите ручку так, чтобы совместить 
разъем для ручки и отверстия для винтов, 
нажмите на ручку и поверните винты 
крепления ручки по часовой стрелке, чтобы 
закрепить ручку на устройстве.
Можно также затянуть два винта крепления 
ручки, поворачивая их по часовой стрелке 
шестигранным ключом (4 мм).

[Примечание]
Перед использованием ручки убедитесь, что два 
винта крепления ручки надежно затянуты. Если 
винты не будут надежно затянуты, ручка может 
отсоединиться от видеокамеры.

Снятие ручки

Снятие производится в порядке, обратном 
порядку установки.

Установка защитного колпачка 
разъема на рукоятке (входит в 
комплект поставки)

При использовании видеокамеры со снятой 
рукояткой следует защищать разъем при 
помощи входящего в комплект поставки 
защитного колпачка.

[Совет]
При установке рукоятки уберите защитный колпачок 
из комплекта поставки в нижнюю часть ручки.

Защита клемм разъемов

Наденьте крышку на разъемы, которые не 
используются, для защиты клемм разъемов.

Верхняя сторона

1

2 2

2

2

1. Разъем для рукоятки

2. Отверстия для винтов крепления 
принадлежностей (1/4 дюйма)

Совместимы с винтами 1/4-20 UNC (длиной 
6 мм или менее).

[Примечание]
Винты длиннее 6 мм могут повредить внешние 
детали.
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Нижняя сторона

1 2
1. Гнезда головки штатива (1/4 дюйма, 3/8 

дюйма)
Совместимы с винтами 1/4-20 UNC и 
винтами 3/8-16 UNC. Установите на штатив 
(приобретается дополнительно, винты 
длиной 5,5 мм или менее).

2. Выпускное вентиляционное отверстие

[Примечание]
Не закрывайте выпускное вентиляционное 
отверстие.

Видоискатель

Подробное описание процедуры установки 
видоискателя (входит в комплект поставки) 
см. на стр. 20.

1
2
3

4 5

1. Кнопка PEAKING

2. Кнопка ZEBRA

3. Кнопка ASSIGN (программируемая) 9 
(стр. 51)

4. Сенсорная панель
Сенсорные операции можно отключить 
с помощью программируемой кнопки или 
меню (стр. 10).

5. Переключатель MIRROR

Пульт управления на рукоятке

Подробное описание процедуры 
присоединения пульта управления на 
рукоятке (входит в комплект поставки) см. 
на стр. 22.

4

3
2

1

7
8

6
5

1. Рычаг масштабирования

2. Кнопка ASSIGN (программируемая) 4 
(стр. 51)

3. Программируемый диск на рукоятке 
(стр. 51)

4. Кнопка ASSIGN (программируемая) 6 
(стр. 51)

5. Рычаг вращения на рукоятке (стр. 22)

6. Кнопка START/STOP (пуск/остановка 
записи)

7. Многофункциональный селектор 
(джойстик с 8 направлениями и кнопки 
применения)

8. Кнопка ASSIGN (программируемая) 5 
(стр. 51)
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Использование сенсорной панели

Меры предосторожности при 
использовании сенсорной 
панели

Видоискатель устройства представляет 
собой сенсорную панель с прямым 
управлением пальцами.
ˎˎ Сенсорной панели достаточно слегка 
касаться пальцем. Не нажимайте на нее 
с усилием и не пользуйтесь никакими 
предметами с острыми краями или 
наконечниками (ногтями, шариковой 
ручкой, булавкой и т. п.).
ˎˎ В указанных ниже условиях сенсорная 
панель может не реагировать на 
касания. Обратите внимание также на 
то, что такие действия могут привести 
к неисправности.
ˎˎ  Управление кончиками ногтей
ˎˎ  Управление, когда поверхности 
касаются другие предметы
ˎˎ  Управление с установленной 
защитной пленкой или наклейкой
ˎˎ  Управление, когда на дисплее 
находятся капли воды или конденсат
ˎˎ  Управление влажными или потными 
пальцами

Жесты сенсорной панели

Нажатие
Пальцем слегка коснитесь пункта, 
например значка или пункта меню, затем 
сразу же уберите палец.

Перетаскивание
Коснитесь экрана и сдвиньте палец 
в требуемое положение на экране, затем 
уберите палец.

Смахивание
Коснитесь экрана и быстро смахните 
пальцем вверх, вниз, влево или вправо.

[Совет]
Если содержимое экрана продолжается за краями 
экрана, вы можете перетаскивать или смахивать его 
с помощью прокрутки.

Настройка сенсорной панели

Работу сенсорной панели можно включать 
и отключать с помощью пункта Touch 
Operation (стр. 101) в меню Technical.
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Дисплей
Во время съемки (записи/ожидания) и воспроизведения данные о состоянии видеокамеры 
и настройки отображаются в видоискателе поверх изображения.
Для скрытия/отображения этой информации служит кнопка DISPLAY. Даже если эта 
информация скрыта, она отображается при выполнении операций в прямом меню (стр. 51).
Также можно выбрать отображение или скрытие каждого элемента в отдельности (стр. 95).

Информация, отображаемая на экране во время съемки

3 42

6
8

9 1075

11
12

13
14

15
16
17

18 19 20 21 22 23 24 25 26 27 28

29

30
31
32
33
34
35
36

137

1. Индикатор состояния сети (стр. 13)
Отображение состояния сетевого 
подключения в виде значка.

2. Индикатор отправки/индикатор 
оставшихся файлов (стр. 68)

3. Индикатор области фокусировки 
(стр. 39)

Отображает область фокусировки для 
автоматической фокусировки.

4. Режим съемки, гнездо A/B, индикатор 
интервала интервальной съемки 
(стр. 52)

Отображение Значение

Rec Запись

Stby Ожидание съемки

5. Индикатор глубины поля

6. Индикатор режима Imager Scan Mode 
(стр. 25)

Значок  отображается на экране при 
несоответствии размера круга изображения 
объектива и эффективного размера 
изображения, заданного в настройке режиме 
Imager Scan Mode.
Если в параметре Imager Scan Mode задано 
значение FF, в режимах с более узким полем 
зрения (кадрированных) отображается метка “C”.
Кадрирование происходит в следующих режимах.
ˎˎ Если установлен формат записи 
3840×2160, а для частоты кадров 
S&Q Motion задано значение 100 или 
120 кадров/с
ˎˎ Если для параметра Codec задано 
значение RAW или RAW & XAVC-I и задан 
выходной формат RAW 3840×2160

7. Индикатор состояния операции вывода 
RAW (стр. 61)

Отображение состояния вывода сигнала 
RAW.

8. Индикатор состояния серии UWP-D 
(стр. 13)

Отображение в виде значка силы 
радиочастотного сигнала, когда к разъему 
MI, настроенному для передачи цифрового 
звука, подключено устройство серии UWP-D.

9. Индикатор частоты кадров при 
замедленной и ускоренной съемке 
(стр. 52)

10. Индикатор заряда аккумулятора/
напряжения DC IN (стр. 18)

11. Индикатор режима фокусировки 
(стр. 42)

Значение Отображение

Режим Focus Hold Focus Hold

Режим MF MF

Режим AF AF

Режим автофокуса с 
отслеживанием в реальном 
времени

AF с обнаружением лица или глаз (AF/ /
Only/ / )

Значок обнаружения 
лица или глаз

Значок AF 
с обнаружением лица 
или глаз

Only

Значок сохраненного 
отслеживаемого лица

Значок приостановки AF 
в режиме AF 
с обнаружением лица 
или глаз1)

1) Отображается, когда нет сохраненного 
отслеживаемого лица и никакое лицо не 
обнаружено, или когда имеется сохраненное лицо 
и это лицо не обнаружено.

12. Индикатор положения 
масштабирования (стр. 37)

Отображает положение масштабирования 
в диапазоне от 0 (широкоугольный режим) 
до 99 (режим телефото) (если используется 
объектив, который поддерживает 
отображение установки масштабирования).
Индикация может быть изменена на 
шкальный индикатор или индикатор 
расстояния фокусировки (стр. 103).
При включении режима Clear Image 
Zoom на экран добавляются следующие 
элементы.

Отображение Значение

Режим Clear Image Zoom 
включен

Значение 
увеличения

При использовании режима 
Clear Image Zoom

13. Индикатор режима стабилизации 
изображения

14. Индикатор состояния управления 
съемкой выхода SDI/выхода HDMI 
(стр. 116)

Отображение состояния выдачи сигнала 
управления съемкой.

15. Индикатор фокусировки (стр. 38)

16. Индикатор оставшейся емкости 
носителя для записи

Если карта памяти защищена от записи, 
отображается значок  .

17. Индикатор режима баланса белого

Отображение Значение

Режим Auto

 Hold Режим Auto приостановлен

W:P Режим предустановки

W:A Режим из ячейки памяти A

W:B Режим из ячейки памяти B
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18. Индикатор внешней привязки 
временного кода/отображение данных 
времени (стр. 35)

Отображает значение “EXT-LK”, когда 
установлена привязка к временному коду 
внешнего устройства.

19. Индикатор фильтра ND (стр. 46)

Отображение Значение

Режим Auto

Режим управления боке 
(стр. 55)

20. Индикатор файла сцен (стр. 58)

21. Индикатор диафрагмы
Отображает положение диафрагмы 
(значение F), (если используется объектив, 
который поддерживает отображение 
установки диафрагмы).

22. Индикатор предупреждения об уровне 
видеосигнала

23. Индикатор усиления (стр. 44)
В режиме Cine EI показывает значение EI 
(стр. 25).

Отображение Значение

Режим Auto

H Режим предустановки 
H

M Режим предустановки 
M

L Режим предустановки 
L

Режим временной 
регулировки

Режим управления 
боке (стр. 55)

24. Отображение названия клипа 
(стр. 70)

25. Индикатор затвора (стр. 45)

26. Индикатор режима AE/уровня AE 
(стр. 44)

27. Индикатор уровня
Отображается горизонтальный уровень с 
шагом ±1° вплоть до ±15°.

28. Измеритель уровня аудио
Отображение уровня звука каналов с CH1 
по CH4.

29. Монитор видеосигнала (стр. 54)
Отображает форму сигнала, вектороскоп и 
гистограмму.
Оранжевая линия указывает заданное 
значение уровня зебры.
В режиме Cine EI (стр. 25) отображается 
тип LUT контролируемого сигнала.

30. Индикатор базовой чувствительности/
индикатор базового ISO (стр. 44)

В режиме Custom (стр. 25) он показывает 
базовую чувствительность, заданную с 
помощью параметра Base ISO/Sensitivity на 
экране Main Status или ISO/Gain/EI >Base 
Sensitivity в меню Shooting полного меню.
В режиме Cine EI (стр. 25) он показывает 
чувствительность Base ISO, заданную с 
помощью параметра Base ISO/Sensitivity на 
экране Main Status или ISO/Gain/EI >Base 
ISO в меню Shooting полного меню.

31. Помощь в отображении гамма/
индикатор LUT монитора

Отображается состояние функции помощи 
в отображении гамма. Функцию помощи 
в отображении гамма можно включать 
и отключать, назначив функции Gamma 
Display Assist программируемой кнопке 
(стр. 51).
В режиме Cine EI (стр. 25) отображается 
настройка таблицы соответствия LUT 
монитора (стр. 83).

32. Индикатор базового вида (стр. 58)
Показывает настройку базового вида.
В режиме Cine EI (стр. 25) отображается 
видеосигнал на записи на карты памяти 
(стр. 83).

33. Индикатор состояния прокси

34. Индикатор формата записи (кодека) 
(стр. 84)

Отображает имя формата, в котором 
выполняется запись на карты памяти.

35. Индикатор формата записи (частоты 
кадров и метода развертки)

36. Индикатор формата записи (размера 
изображения) (стр. 84)

Отображает размер изображения, которое 
записывается на карты памяти.

37. Кнопка остановки автофокуса с 
отслеживанием в реальном времени 
(стр. 43)
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Информация, отображаемая на экране во время воспроизведения

Следующая информация отображается поверх воспроизводимого изображения.

1

9 10 11 12 13 14

2 3 4 5 6 7 8

1. Индикатор состояния сети

2. Индикатор отправки/индикатор 
оставшихся файлов

3. Номер клипа/общее количество 
клипов

4. Индикатор состояния воспроизведения

5. Индикатор формата воспроизведения 
(частоты кадров и метода развертки)

6. Индикатор формата воспроизведения 
(размера изображения)

7. Индикатор заряда аккумулятора/
напряжения DC IN

8. Индикатор формата воспроизведения 
(кодека)

9. Индикатор носителя
Если карта памяти защищена от записи, 
отображается значок  .

10. Отображение данных времени

11. Отображение названия клипа

12. Индикатор помощь в отображении 
гамма

13. Измеритель уровня аудио
Отображение уровня звука при 
воспроизведении.

14. Индикатор базового Look

Отображаемые значки

Отображаемые значки сетевого подключения

Режим сети Состояние подключения Значок

Режим точки доступа Работа в качестве точки доступа

Ошибка работы точки доступа

Режим станции Подключение Wi-Fi
Значок изменяется в зависимости от 
силы сигнала (4 ступени)

   

Wi-Fi отключен (в том числе во время 
установления соединения)

Ошибка подключения Wi-Fi

Кабель USB Кабель USB подключен

Кабель USB отключен

Ошибка кабеля USB

Отображение значка серии UWP-D

Состояние передатчика Состояние приема Значок

Питание выключено Нет приема

Нормальное состояние передачи Выполняется прием
 –   

(уровень приема (4 уровня))

Состояние отключения звука Прием (звук отключен)

Состояние предупреждения о заряде 
аккумулятора

Выполняется прием
 (значок мигает)

Отключение звука и состояние 
предупреждения о заряде 
аккумулятора

Выполняется прием
 (значок мигает)
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Экран состояния

Настройки и состояние видеокамеры 
можно проверить на экране состояния. 
Настройки пунктов, отмеченных 
звездочкой (*), могут быть изменены.
Экран состояния поддерживает сенсорные 
операции.

Отображение экрана состояния
ˎˎ Нажмите кнопку MENU.

[Совет]
Показать или скрыть каждый экран статуса можно 
с помощью пункта Menu Page On/Off (стр. 102) в 
меню Technical.

Переключение на экран состояния
ˎˎ Поверните многофункциональный диск.
ˎˎ Отклоните многофункциональный 
селектор вверх или вниз
ˎˎ Смахните экран состояния вверх или 
вниз.

Скрытие экрана состояния
ˎˎ Нажмите кнопку MENU.

Изменение настройки
Когда отображается экран состояния, 
нажмите на многофункциональный диск 
или многофункциональный селектор, 
чтобы обеспечить выбор пункта настройки 
на странице. Выберите номер страницы и 
нажмите для переключения страниц.
Можно также выбрать пункты прямо путем 
прикосновения.

[Примечание]
Изменения с экрана состояния можно отключить, 
задав для пункта Menu Settings >User Menu Only 
(стр. 102) в меню Technical в полном меню значение 
On.

Экран Main Status

Отображаются основные функции камеры и 
свободное пространство на носителе.

Отображаемый 
элемент

Описание

S&Q Frame Rate* Настройки съемки с 
замедлением/ускорением 
движения и частоты 
кадров

Frequency/Scan* Настройки частоты 
системы и метода 
развертки

Imager Scan* Режим сканирования 
датчика изображения

Media Remain 
(A)

Оставшееся свободное 
место на носителе в гнезде 
A

ND Filter Настройка фильтра 
нейтральной плотности

ISO/Gain/EI Настройка ISO/усиления/
индекса экспозиции

Base ISO/
Sensitivity*

Настройка базовой 
чувствительности ISO/
базовой чувствительности

Codec* Задание кодека для записи

Media Remain (B) Оставшееся свободное 
место на носителе в гнезде 
B

Scene File* Используемый файл сцен 
и его настройка 
идентификатора файла

Base Look/LUT* Настройка Base Look/LUT

Shutter Настройка выдержки 
затвора или угла затвора

Iris Настройка диафрагмы

Video Format* Размер изображения для 
записи на карты памяти

RAW Output 
Format*

Размер изображения для 
вывода в формате RAW

White Balance Настройка баланса белого

Экран Camera Status

Показывает состояние различных 
предустановленных параметров камеры.

Отображаемый 
элемент

Описание

White Switch<B> Значение настройки 
баланса белого из ячейки 
памяти B

White Switch<A> Значение настройки 
баланса белого из ячейки 
памяти A

White Switch<P> Настройка 
предустановленного 
белого

ND<Preset> Настройки ND Filter 
Preset1–3

ISO / Gain1)<L>* Настройка ISO/Gain1)<L>

ISO / Gain1)<M>* Настройка ISO/Gain1)<M>

ISO / Gain1)<H>* Настройка ISO/Gain1)<H>

Base ISO/
Sensitivity*

Настройка базовой 
чувствительности ISO/
базовой чувствительности

Zebra1* Значение On/Off (вкл./
выкл.) и уровень 
параметра Zebra1

Zebra2* Значение On/Off (вкл./
выкл.) и уровень 
параметра Zebra2

VF Gamma/
Gamma

Категория и кривая гамма

Scene File* Используемый файл сцен 
и его настройка 
идентификатора файла

1) Exposure Index, когда для параметра Shooting 
Mode выбран вариант Cine El.

Экран Audio Status

Отображает настройку входа, измеритель 
уровня аудио и настройку монитора 
громкости для каждого канала.

Отображаемый 
элемент

Описание

CH1 Level 
Control

Состояние включения/
выключения 
автоматической 
регулировки

Level Meter Измеритель уровня аудио

Source* Источник входного сигнала

Ref./Sens.* Эталонный уровень 
входного сигнала

Wind 
Filter*

Настройка фильтра 
подавления шума ветра 
для микрофона

CH2 Level 
Control

Состояние включения/
выключения 
автоматической 
регулировки

Level Meter Измеритель уровня аудио

Source* Источник входного сигнала

Ref./Sens.* Эталонный уровень 
входного сигнала

Wind 
Filter*

Настройка фильтра 
подавления шума ветра 
для микрофона

CH3 Level 
Control*

Состояние включения/
выключения 
автоматической 
регулировки

Level 
Meter*

Измеритель уровня аудио

Source* Источник входного сигнала

Ref./Sens.* Эталонный уровень 
входного сигнала

Wind 
Filter*

Настройка фильтра 
подавления шума ветра 
для микрофона



1. Обзор: Дисплей15

Отображаемый 
элемент

Описание

CH4 Level 
Control*

Состояние включения/
выключения 
автоматической 
регулировки

Level 
Meter*

Измеритель уровня аудио

Source* Источник входного сигнала

Ref./Sens.* Эталонный уровень 
входного сигнала

Wind 
Filter*

Настройка фильтра 
подавления шума ветра 
для микрофона

Audio Input 
Level*

Настройка входного 
уровня звука (основной 
звук)

HDMI Output CH* Настройка выходных 
аудиоканалов HDMI

Volume* Настройка громкости 
наушников/встроенного 
динамика

Monitor CH* Настройка канала 
монитора

Экран состояния Project

Отображаются базовые настройки, 
связанные с проектом съемки.

Отображаемый 
элемент

Описание

Frequency/Scan* Настройки частоты 
системы и метода 
развертки

Codec* Задание кодека для записи

Rec Function* Настройка включения/
выключения особой 
функции записи и 
основные настройки

Отображаемый 
элемент

Описание

Simul Rec* Состояние и настройка 
включения/выключения 
функции одновременной 
записи в 2 гнезда

Title Prefix Часть заголовка в имени 
клипа

Imager Scan* Режим сканирования 
датчика изображения

Video Format* Размер изображения для 
записи на карты памяти

Picture Cache 
Rec*

Включение/выключения 
функции записи кэша 
изображения и настройка 
размера кэша

Number Числовой суффикс имени 
клипа

Shooting Mode* Настройки режима съемки

RAW Output 
Format*

Размер изображения для 
вывода в формате RAW

Proxy Rec* Настройка включения/
выключения функции 
записи прокси

Экран Monitoring Status

Отображает настройки выходов SDI и HDMI.

Отображаемый 
элемент

Описание

SDI Signal* Размер выдаваемого 
изображения

Info. 
Disp.*

Настройка включения/
выключения вывода 
индикации

Color 
Gamut*

Настройка цветового 
пространства/состояние 
таблицы соответствия 
монитора

Отображаемый 
элемент

Описание

HDMI Signal* Размер выдаваемого 
изображения

Info. 
Disp.*

Настройка включения/
выключения вывода 
индикации

Color 
Gamut*

Настройка цветового 
пространства/состояние 
таблицы соответствия 
монитора

Stream Signal Размер выдаваемого 
изображения

Info. 
Disp.

Вывод индикации (Выкл. 
(фиксированное 
значение))

Color 
Gamut*

Настройка цветового 
пространства/состояние 
таблицы соответствия 
монитора

VF Color 
Gamut*

Настройка Gamma Display 
Assist/настройка цветового 
пространства/состояние 
таблицы соответствия LUT 
монитора

Base Look/LUT* Настройка Base Look/LUT

Gamma Display 
Assist*

Включение и отключение 
Gamma Display Assist

Экран Assignable Button Status

Отображает функции, назначенные каждой 
их программируемых кнопок.

Отображаемый 
элемент

Описание

1 Функция, назначенная 
программируемой кнопке 
ASSIGN 1

2 Функция, назначенная 
программируемой кнопке 
ASSIGN 2

Отображаемый 
элемент

Описание

3 Функция, назначенная 
программируемой кнопке 
ASSIGN 3

4 Функция, назначенная 
программируемой кнопке 
ASSIGN 4

5 Функция, назначенная 
программируемой кнопке 
ASSIGN 5

6 Функция, назначенная 
программируемой кнопке 
ASSIGN 6

7 Функция, назначенная 
программируемой кнопке 
ASSIGN 7

8 Функция, назначенная 
программируемой кнопке 
ASSIGN 8

9 Функция, назначенная 
программируемой кнопке 
ASSIGN 9

Focus Hold 
Button

Функция, назначенная 
кнопке Focus Hold 
объектива

Multi Function 
Dial

Функция, назначенная 
многофункциональному 
диску

Grip Dial Функция, назначенная 
программируемому диску 
на рукоятке

Handle Dial Функция, назначенная 
программируемому диску 
на ручке

Экран Battery Status

Отображает информацию об аккумуляторе 
и источнике питания, подключенному к 
разъему DC IN.

Отображаемый 
элемент

Описание

Detected Battery Тип аккумулятора

Remaining Оставшаяся емкость (%)
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Отображаемый 
элемент

Описание

Charge Count Количество подзарядок

Capacity Оставшаяся емкость (Ач)

Voltage Напряжение аккумулятора 
(В)

Manufacture 
Date

Дата производства 
аккумулятора

Video Light 
Remaining

Отображает оставшуюся 
емкость аккумулятора 
лампы для видеосъемки.

Power Source Источник электропитания

Supplied Voltage Напряжение, подаваемое 
источником питания

Экран Media Status

Отображает оставшуюся емкость и время 
записи на носителях.

Отображаемый 
элемент

Описание

Информация о 
носителе A

Отображает значок 
носителя, когда носитель 
для записи вставлен в 
гнездо A.

Счетчик 
оставшейся 
емкости 
носителя A

Отображает оставшуюся 
емкость на носителе для 
записи, вставленном в 
гнездо A, которая 
выражается в процентах 
на гистограмме.

Оставшееся 
время записи на 
носитель A

Отображает, сколько еще 
времени примерно может 
продолжаться запись на 
носитель, вставленный в 
гнездо A, в текущих 
условиях записи (в 
минутах).

Информация о 
носителе B

Отображает значок 
носителя, когда носитель 
для записи вставлен в 
гнездо B.

Отображаемый 
элемент

Описание

Счетчик 
оставшейся 
емкости 
носителя B

Отображает оставшуюся 
емкость на носителе для 
записи, вставленном в 
гнездо B, которая 
выражается в процентах 
на гистограмме.

Оставшееся 
время записи на 
носитель B

Отображает, сколько еще 
времени примерно может 
продолжаться запись на 
носитель, вставленный в 
гнездо B, в текущих 
условиях записи (в 
минутах).

Экран Network Status

Отображение состояния сетевого 
подключения.

Отображаемый 
элемент

Описание

Wireless LAN Состояние подключения и 
настройки беспроводной 
сети

Wired LAN Состояние подключения и 
настройки проводной 
локальной сети

Modem Настройки беспроводной 
сети и состояние 
подключения кабеля USB

Экран File Transfer Status

Отображение сведений о передаче файлов.

Отображаемый 
элемент

Описание

Auto Upload 
(Proxy)

Состояние включения/
выключения функции 
автоматической отправки 
(прокси)

Job Status 
(Remain / Total)

Оставшееся число заданий 
и общее число заданий

Total Transfer 
Progress

Общий ход выполнения 
всех заданий

Default Upload 
Server

Имя сервера назначения 
автоматической отправки 
(прокси)

Current File 
Transfer Progress

Ход выполнения передачи 
текущего файла

Current 
Transferring File 
Name

Имя текущего 
передаваемого файла

Server Address Адрес сервера назначения 
передаваемого файла

Destination 
Directory

Каталог назначения 
сервера назначения 
передаваемого файла
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Использование экранов настройки с сенсорным вводом

Компоновка экрана

Пункт

Метка, показывающая 
текущую настройку

Кнопка Set (применить)

Курсор выбора 
настройки 
(оранжевая рамка)

Название пункта

Варианты выбора

Управление

1 Нажмите пункт настройки.

Нажатие

Отображаются варианты для выбора 
значения.

2 Перетащите или смахните настройку, 
чтобы выбрать значение.

Смахивание

3 Нажмите кнопку Set или курсор выбора 
значения.
Значение применяется, и снова 
отображается предыдущий экран.

[Советы]
ˎˎ Нажмите кнопку CANCEL/BACK, чтобы вернуться 

к предыдущему значению.
ˎˎ Можно использовать также многофункциональный 

диск или многофункциональный селектор.
ˎˎ Кроме того, сенсорные операции можно 

отключить (стр. 101).
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Подготовка источника питания
Можно использовать аккумуляторный 
блок или электропитание от адаптера 
переменного тока.
В целях безопасности используйте только 
аккумуляторные блоки и адаптеры 
переменного тока Sony из списка ниже.

Литий-ионные аккумуляторные блоки
BP-U35 (входит в комплект поставки)
BP-U60
BP-U60T
BP-U70
BP-U90
BP-U100

Зарядные устройства
BC-CU1 (входит в комплект поставки)
BC-U1A
BC-U2A

Адаптер переменного тока (входит в 
комплект поставки)
[ВНИМАНИЕ]
Не храните аккумуляторные блоки в местах, 
подвергающихся воздействию прямого 
солнечного света, огня или высокой 
температуры.

[Примечания]
ˎˎ При работе от источника питания переменного 

тока используйте входящий в комплект поставки 
адаптер переменного тока.
ˎˎ Всегда устанавливайте переключатель POWER 

в положение Off перед отключением или 
подключением аккумулятора или адаптера 
переменного тока. Если он отключается или 
подключается, когда переключатель POWER 
находится в положении On, в некоторых 
случаях видеокамера может не включиться. 
Если видеокамера не включается, установите 
переключатель POWER в положение Off и 
временно отключите аккумулятор или адаптер 
переменного тока, затем подождите 30 секунд, 
прежде чем подключать его обратно. (Если 
адаптер переменного тока отключается или 
подключается, когда видеокамера работает 
от аккумулятора, или наоборот, его можно 
отключить или подключить без проблем, когда 
переключатель POWER находится в положении 
On.)

Использование 
аккумуляторного блока

Для присоединения аккумуляторного 
блока вставьте его в отсек (стр. 7), 
а затем надавите на него вниз, чтобы 
зафиксировать на месте.

Для извлечения аккумуляторного блока 
нажмите и удерживайте кнопку BATT 
RELEASE (стр. 7), затем потяните 
аккумуляторный блок вверх и вытащите его 
из отсека.

Кнопка BATT 
RELEASE

[Примечания]
ˎˎ Перед установкой аккумуляторного блока 

зарядите аккумулятор с помощью специального 
зарядного устройства BC-CU1, BC-U1A или BC-U2A.
ˎˎ При зарядке теплого аккумулятора (например, 

сразу после использования) он может зарядиться 
только частично.

Проверка оставшейся емкости

При съемке/воспроизведении с 
использованием аккумуляторного блока 
оставшаяся емкость аккумулятора 
отображается в видоискателе (стр. 11).

Значок Значение

От 91% до 100%

От 71% до 90%

От 51% до 70%

От 31% до 50%

От 11% до 30%

От 0% до 10%

Видеокамера указывает оставшуюся 
емкость аккумулятора, вычисляя 
оставшееся время работы при условии 
продолжения работы с текущим уровнем 
энергопотребления.

Если заряд аккумулятора иссякает

Если во время работы оставшийся заряд 
аккумулятора падает ниже определенного 
уровня (состояние Low Battery), появляется 
сообщение о низком уровне заряда 
аккумулятора и индикатор записи/съемки 
начинает мигать.
Если заряд аккумулятора падает до 
уровня, при котором работа не может 
продолжаться (состояние Battery 
Empty), выдается сообщение о том, что 
аккумулятор разряжен.
Замените его на заряженный 
аккумуляторный блок.

Изменение уровней, на которых 
выдаются предупреждения

По умолчанию уровень Low Battery 
установлен на 10% от полного заряда 
аккумулятора, а уровень Battery Empty — 
на 3%. Изменить настройки уровней, на 
которых выдаются предупреждения, можно 
с помощью пункта Camera Battery Alarm 
(стр. 103) в меню Technical полного меню.

Зарядка аккумулятора с помощью 
зарядного устройства из комплекта 
поставки (BC-CU1)

1 Подсоедините адаптер переменного 
тока (входит в комплект поставки) к 
зарядному устройству, затем 
подсоедините шнур питания (входит в 
комплект поставки) к источнику 
питания переменного тока.

2 Нажмите на аккумулятор вниз и 
сдвиньте его в показанном стрелкой 
направлении.
Индикатор CHARGE загорается 
оранжевым цветом, и начинается 
зарядка.

Индикатор CHARGE

Адаптер переменного тока

Шнур питания
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Индикатор CHARGE (оранжевый)
Горит:  зарядка
Мигает:  ошибка зарядки или температура 

вне рабочего диапазона и зарядка 
приостановлена

ˎˎ После полной зарядки индикатор CHARGE 
зарядного устройства выключается.
ˎˎ Обязательно используйте фирменные 
аккумуляторы Sony.

Время зарядки
Приблизительное время (в минутах), 
необходимое для зарядки полностью 
разряженного аккумулятора.

Аккумулятор Время полной 
зарядки

BP-U35 120 минут

[Примечание]
Если адаптер переменного тока отсоединен от 
зарядного устройства, а аккумулятор остался 
подключенным к зарядному устройству, аккумулятор 
начинает разряжаться.

Использование электропитания 
переменного тока

Подключив видеокамеру к источнику 
питания переменного тока, вы сможете 
использовать камеру, не беспокоясь 
о необходимости подзаряжать 
аккумуляторный блок.

Разъем DC IN

Адаптер переменного тока

Шнур 
питания

Подсоедините адаптер переменного тока 
к разъему DC IN на видеокамере, после 
чего подсоедините шнур питания (входит 
в комплект поставки) к источнику питания 
переменного тока.

Если выходное напряжение адаптера 
переменного тока становится низким

Если во время работы выходное 
напряжение адаптера переменного тока 
становится ниже определенного уровня 
(состояние DC Low Voltage1), отображается 
сообщение о снижении выходного 
напряжения адаптера переменного тока и 
начинает мигать индикатор записи/съемки.
Если выходное напряжение адаптера 
переменного тока становится ниже 

уровня, при котором дальнейшая работа 
невозможна (состояние DC Low Voltage2), 
отображается сообщение о слишком 
низком выходном напряжении адаптера 
переменного тока.
В этом случае адаптер переменного тока 
может быть неисправен. Проверьте адаптер 
переменного тока.

Изменение значений напряжения, 
при которых выдаются 
предупреждения

По умолчанию уровню DC Low Voltage1 
задано значение 16,5 В, а уровню 
DC Low Voltage2 — 15,5 В. Изменить 
настройки уровней, на которых выдаются 
предупреждения, можно с помощью пункта 
Camera DC IN Alarm (стр. 103) в меню 
Technical.

Адаптер переменного тока

ˎˎ Не располагайте адаптер переменного 
тока в ограниченном пространстве, 
например, между стеной и мебелью.
ˎˎ Подсоединяйте адаптер переменного 
тока к ближайшему источнику питания 
переменного тока. Если во время работы 
возникнет неисправность, сразу же 
отсоедините шнур питания от источника 
питания переменного тока.
ˎˎ Не замыкайте металлические части вилки 
адаптера переменного тока. Это приведет 
к повреждению прибора.
ˎˎ Аккумулятор нельзя заряжать, когда он 
присоединен к видеокамере, даже если 
подключен адаптер переменного тока.
ˎˎ Для отсоединения адаптера переменного 
тока от устройства возьмитесь за вилку и 
потяните ее. Если потянуть за кабель, это 
может привести к неисправности.
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Присоединение устройств

Присоединение микрофона 
(продается отдельно)

1 Установите микрофон в держатель 
микрофона.

2 Подсоедините кабель микрофона к 
разъему INPUT1 или INPUT2.

INPUT

1
LINE MIC

+48VMIC

2
LINE MIC

+48VMIC

1

2

Микрофон

Держатель 
микрофона

INPUT1 INPUT2

3 Поместите кабель микрофона в 
держатель кабеля, как показано на 
рисунке.

Держатель кабеля

[Советы]
ˎˎ Если не удается надежно закрепить микрофон, 

используйте втулку из комплекта поставки 
микрофона.
ˎˎ В зависимости от типа установленного объектива, 

на изображении с видеокамеры может быть 
виден край микрофона. Отрегулируйте положение 
микрофона.

Присоединение видоискателя

[Примечание]
Присоединять и снимать видоискатель следует, когда 
питание видеокамеры отключено.

Присоединение видоискателя к 
передней части ручки

1 Вставьте адаптер монтажного зажима 
видоискателя в крепление 
видоискателя на ручке (), затем 
поворачивайте винт (входит в комплект 
поставки) по часовой стрелке, чтобы 
закрепить адаптер в требуемом 
положении ().
Адаптер монтажного зажима можно 
свободно устанавливать под разными 
углами с шагом 45°, но рекомендуется 
использовать положение, в котором 
точка крепления находится 
непосредственно над винтом.

Винт
Адаптер монтажного 
зажима видоискателя

2 Установите зажим видоискателя на 
адаптер монтажного зажима 
видоискателя (), затем поверните 
ручку фиксатора по часовой стрелке, 
чтобы закрепить его в требуемом 
положении ().

[Примечание]
При использовании видоискателя обязательно 
надежно затягивайте ручку фиксатора. Если ручка 
фиксатора не будет надежно затянута, видоискатель 
может упасть.

3 Совместите метку  на видеокамере с 
меткой  на разъеме видоискателя и 
вставьте кабель.
Перед тем как вставлять разъем, 
убедитесь, что метка  находится с 
наружной стороны.

4 Поместите кабель в держатель кабеля, 
как показано на рисунке.

Держатель кабеля
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Присоединение видоискателя к 
задней части ручки

На задней части ручки () и на задней 
части видеокамеры () предусмотрено 
по две точки крепления для установки 
видоискателя. Установите видоискатель 
таким же образом, как описано в пункте 
“Присоединение видоискателя к передней 
части ручки”.

Регулировка положения 
видоискателя

Наклоняйте видоискатель вверх, вниз, 
вперед и назад, чтобы отрегулировать угол 
его установки.
С помощью переключателя MIRROR 
можно включить зеркальное отражение 
изображения, например для просмотра с 
передней стороны видеокамеры.

[Совет]
Когда устройство не используется или перевозится, 
для защиты видоискателя рекомендуется 
устанавливать его в показанное на рисунке 
положение.

Снятие видоискателя

Ослабьте ручку фиксатора видоискателя 
и выполните процедуру присоединения 
видоискателя в обратном порядке.

Присоединение бленды 
видоискателя

1 Откройте металлические зажимы на 
бленде видоискателя.

2 Закрепите металлический зажим 
вверху бленды видоискателя за крючок 
вверху видоискателя, затем закрепите 
металлический зажим внизу бленды 
видоискателя на крючке внизу 
видоискателя.

Крючки крепления

3 Нажмите на фиксирующую пластину 
внизу бленды видоискателя в 
направлении стрелки для фиксации 
бленды видоискателя.

Фиксирующая 
пластина

Открытие бленды видоискателя

Потяните нижнюю центральную часть 
бленды видоискателя на себя, затем 
потяните бленду вверх, чтобы открыть ее.

[Примечание]
При перемещении видоискателя беритесь за его 
корпус. Не беритесь за бленду видоискателя.

Снятие бленды видоискателя

Разблокируйте защелку бленды 
видоискателя и снимите бленду 
видоискателя с видоискателя.
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Присоединение пульта 
управления на рукоятке

[Примечание]
Присоединять и снимать пульт управления на 
рукоятке следует, когда питание видеокамеры 
отключено.

1 Подключите кабель к разъему пульта 
управления на рукоятке.

2 Совместите расположенное на 
видеокамере крепление пульта 
управления на рукоятке с установочной 
индексной меткой рукоятки (), 
установите рукоятку на видеокамеру и 
медленно поверните рукоятку против 
часовой стрелки ().
При фиксации в правильном 
положении слышен щелчок.

Индексная метка

[Примечание]
Если не удается правильно установить рукоятку, 
выполните установку повторно, не применяя 
излишних усилий к пульту управления на рукоятке 
или к видеокамере.

3 Вставьте подключенный на шаге 2 
кабель под паз на пульте управления 
на рукоятке, как показано на рисунке.

[Примечание]
Если не поместить кабель под паз, при изменении 
угла крепления рукоятки на кабель может 
передаваться излишнее усилие или кабель может 
попасть в поворотный механизм.

Регулировка угла пульта управления 
на рукоятке

Угол наклона пульта управления 
на рукоятке можно регулировать в 
показанном на следующем рисунке 
диапазоне в соответствии с вашим стилем 
съемки.

Стандартное положение

Повернут в направлении объектива (макс. 90°)

Повернут в направлении задней части 
(макс. 83°)

1 Переместите рычаг вращения на 
рукоятке в показанное на рисунке 
положение и поверните рукоятку при 
нажатом рычаге.

2 Уберите палец с рычага вращения на 
рукоятке около требуемого положения.

3 Немного переместите рукоятку, пока не 
услышите щелчок, означающий, что 
рукоятка зафиксирована.
После фиксации рукоятки рычаг 
вращения на рукоятке возвращается в 
исходное положение.

[Примечания]
ˎˎ После изменения положения обязательно 

проверяйте надежность фиксации рукоятки.
ˎˎ Установить угол за пределами диапазона 

регулировки невозможно. Не прикладывайте 
избыточное усилие при повороте рукоятки.
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Хват рукоятки (рекомендуемый 
способ)

Правил по хвату рукоятки не существует, 
но приведенный ниже пример показывает 
способ удобного управления с помощью 
рукоятки.

При использовании кнопки ASSIGN 5 или 
многофункционального селектора

A: Нажимайте программируемый диск на 
рукоятке указательным пальцем.
B: Управляйте многофункциональным 
селектором и кнопкой ASSIGN 5 большим 
пальцем.
C: Крепко держите рукоятку средним 
пальцем, безымянным пальцем и 
мизинцем.

При управлении масштабом

A: Управляйте рычагом масштабирования 
указательным и средним пальцами.
B: Крепко держите рукоятку большим 
пальцем.
C: Крепко держите рукоятку безымянным 
пальцем и мизинцем.

Снятие рукоятки

[Примечание]
При снятии рукоятки обязательно положите 
видеокамеру на ровную поверхность, такую как стол.

1 Отсоедините кабель от разъема пульта 
управления на рукоятке.

2 Нажав и удерживая кнопку 
отсоединения пульта управления на 
рукоятке, поверните рукоятку по 
часовой стрелки до ее отсоединения.

Кнопка отсоединения пульта 
управления на рукоятке

[Совет]
В точке крепления рукоятки на устройстве и в 
соответствующей точке крепления на рукоятке 
можно закрепить розетку.
За сведениями о приобретении розеток 
обращайтесь к дилеру Sony.
 – Со стороны видеокамеры: 4-546-932- 

(приобретается дополнительно)
 – Со стороны рукоятки: 4-547-089- (приобретается 

дополнительно)
 – Винты для монтажа* 

Со стороны видеокамеры: 7-627-556- 
(приобретаются дополнительно) 
Со стороны рукоятки: 7-627-556- (приобретаются 
дополнительно)

* Для каждой розетки требуются четыре винта 
(отверстия для винтов обозначены кружками 
на следующем рисунке). Использование других 
винтов может привести к повреждению внешних 
частей.

Со стороны 
видеокамеры

Со стороны 
рукоятки

Присоединение объектива

[ВНИМАНИЕ]
Не оставляйте объектив на солнечном 
свете. Прямые солнечные лучи могут 
пройти через объектив, сфокусироваться в 
видеокамере и привести к возгоранию.

[Примечания]
ˎˎ Присоединять и снимать объектив следует, когда 

питание видеокамеры отключено.
ˎˎ Объектив является точным прибором. Не кладите 

объектив на поверхность байонетом вниз. 
Устанавливайте входящую в комплект поставки 
крышку байонета объектива.

[Совет]
Подробные сведения о том, какие объективы 
поддерживает видеокамера, можно получить у 
представителя службы технического обслуживания 
компании Sony.

Присоединение объектива с 
байонетом E

1 Снимите крышку объектива и крышку с 
видеокамеры и объектива.
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2 Выровняйте метку на байонете 
объектива (белую) с видеокамерой, 
осторожно вставьте объектив, после чего 
поверните объектив по часовой стрелке.
При фиксации в правильном 
положении слышен щелчок.

Установочные метки (белые)

[Примечание]
При установке объектива не нажимайте кнопку 
отсоединения объектива.

Присоединение объектива с 
байонетом A
Для использования объективов с 
байонетом A сначала установите адаптер 
байонета объектива (не входит в комплект 
поставки) и только затем присоединяйте 
объектив с байонетом A.

[Примечание]
При использовании объективов с байонетом 
A диафрагма устанавливается вручную, а для 
фокусировки устанавливается режим MF.

Снятие объектива
Для снятия объектива выполните 
следующую процедуру.

1 Нажав и удерживая кнопку 
отсоединения объектива, поверните 
объектив против часовой стрелки, 
поддерживая его.

2 Потяните объектив вперед.

[Примечания]
ˎˎ При снятии объектива совместите установочную 

метку на стопорном кольце объектива с 
установочной меткой на видеокамере.

ˎˎ Надежно держите объектив рукой, чтобы он не упал.
ˎˎ Если не планируется сразу же установить другой 

объектив, обязательно установите крышку корпуса.

Регулировка диафрагмы для 
объективов с переключателем Auto Iris

ˎˎ Если переключатель Auto Iris на 
объективе установлен в положение AUTO, 
диафрагма настраивается автоматически 
и может также настраиваться вручную на 
видеокамере.
ˎˎ Если переключатель Auto Iris на 
объективе установлен в положение 
MANUAL, диафрагма может быть 
настроена только при помощи кольца 
объектива. Регулировка диафрагмы, 
производимая на видеокамере, не имеет 
никакого эффекта.

Регулировка фокуса для объективов с 
переключателем фокуса

ˎˎ Если переключатель фокуса на объективе 
установлен в положение AF/MF или AF, 
фокус настраивается автоматически и 
может также настраиваться вручную 
с пульта дистанционного управления.
ˎˎ Если переключатель фокуса на объективе 
установлен в положение MF, фокус 
настраивается с помощью кольца 
объектива, а также может настраиваться 
вручную с пульта дистанционного 
управления.

 [Примечание]
При использовании объектива с байонетом A 
ручная настройка с пульта дистанционного 
управления может быть недоступна.
ˎˎ Если переключатель фокуса на объективе 
установлен в положение Full MF, фокус 
может быть настроен только при помощи 
кольца объектива. Регулировка фокуса, 
производимая на видеокамере, не имеет 
никакого эффекта.

Крепление к штативу

При присоединении к штативу используйте 
гнезда головки штатива на видеокамере. 
Использование крепления для штатива на 
объективе может привести к повреждению.
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Настройка основных операций видеокамеры
Начальный экран настройки открывается 
в видоискателе при первом включении 
видеокамеры либо после того, как 
резервный аккумулятор был полностью 
разряжен.
На этом экране задайте дату и время для 
внутренних часов прибора.

Time Zone
В параметре Time Zone задается разница 
во времени от универсального глобального 
времени. Задайте нужное значение.

Установка даты и времени

Многофункциональным селектором 
(стр. 7) или многофункциональным 
диском (стр. 5) выбирайте элементы 
или настройки, затем нажмите кнопку 
применения на многофункциональном 
селекторе или многофункциональный диск, 
чтобы применить настройки и запустить 
часы.
После закрытия экрана настроек изменить 
дату, время и часовой пояс можно с 
помощью пункта Clock Set (стр. 109) в 
меню Maintenance.

[Примечания]
ˎˎ Если настройка времени сбилась после полного 

разряда резервного аккумулятора, возникшего 
из-за отключения питания на продолжительное 
время (аккумуляторный блок отключен, а внешний 
источник электропитания не подсоединен к 
разъему DC IN), начальный экран настройки 
откроется, когда видеокамера будет включена в 
следующий раз.
ˎˎ Когда в видоискателе отображается начальный 

экран настройки, какие-либо другие операции, 
кроме выключения видеокамеры, можно будет 
выполнять только после задания настроек на этом 
экране.
ˎˎ В видеокамере имеется встроенный элемент 

питания для хранения данных о дате, времени 
и других данных даже в случае выключения 
видеокамеры.

Перед съемкой настройте основные 
операции видеокамеры на экране 
состояния Project в соответствии с 
потребностями.

Режим съемки

Можно выбрать один из следующих 
режимов съемки: “Custom mode” для 
гибкого создания изображений на месте 
и “Cine EI mode” (режим, в котором 
видеокамера работает как кинокамера, 
когда отснятый материал монтируется 
в студии).
Режим съемки устанавливается с помощью 
параметра Shooting Mode (стр. 15) на 
экране состояния Project.

[Совет]
Режим съемки можно также задать с помощью 
параметра Base Setting >Shooting Mode (стр. 84) в 
меню Project полного меню.

Режим Custom

В режиме съемки Custom можно выбрать 
видеостандарт.
Видеостандарт можно задать с помощью 
параметра Base Setting >Target Display 
(стр. 84) в меню Project полного меню.
ˎˎ SDR(BT.709): съемка в соответствии со 
стандартом вещания HD
ˎˎ HDR(HLG): съемка в соответствии со 
стандартном вещания нового поколения 4K

Подробное описание см. на стр. 58.

Режим Cine EI
Когда используется режим съемки Cine EI, 
выберите базовое цветовое пространство 
для сигнала записи и выходного сигнала. 
Выбранное здесь цветовое пространство 
используется для выходного видеосигнала, 
когда параметру MLUT задано значение Off.
Цветовое пространство можно задать с 
помощью параметра Cine EI Setting >Color 
Gamut (стр. 85) в меню Project полного 
меню.
ˎˎ S-Gamut3.Cine/SLog3: простая 
в настройке цветовая гамма для 
цифровой кинематографии (DCI-P3).
ˎˎ S-Gamut3/SLog3: широкая гамма цветов 
Sony, которая охватывает цветовое 
пространство ITU-R BT.2020.

Подробное описание см. на стр. 60.
[Примечания]
ˎˎ Режим Cine EI имеет следующие ограничения.

ˎˎ Функции, которые невозможно настроить 
автоматически (трекинг)
 – Баланс белого
 – Усиление
 – Затвор

ˎˎ Функции, которые невозможно настроить
 – Чувствительность ISO/усиление 

(задана базовая чувствительность ISO 
(фиксированная))

 – Настройки меню Paint/Look (кроме Base 
Look)

 – Scene File (отключен)
ˎˎ Следующие функции доступны только в режиме 

Cine EI (стр. 60).
ˎˎ Exposure Index
ˎˎ Monitor LUT

Частота системы

Частота системы задается параметром 
Frequency/Scan (стр. 15) на экране 
состояния Project. В зависимости от 
выбранного значения, видеокамера может 
автоматически перезагрузиться после 
переключения.

[Совет]
Частоту системы можно также задать с помощью 
параметра Rec Format >Frequency (стр. 84) в меню 
Project полного меню.

[Примечание]
Переключение частоты системы во время записи или 
воспроизведения невозможно.

Режим Imager Scan Mode

Можно задать эффективный размер 
изображения и разрешение датчика 
изображения.
Режим развертки устанавливается 
с помощью параметра Imager Scan 
(стр. 15) на экране состояния Project.
ˎˎ FF: полнокадровый размер.
ˎˎ S35: размер Super 35mm.

[Совет]
Режим развертки можно также задать с помощью 
параметра Rec Format >Imager Scan Mode (стр. 84) 
в меню Project полного меню.

[Примечания]
ˎˎ Переключение режима Imager Scan Mode во время 

записи или воспроизведения невозможно.
ˎˎ Если задано значение S35, видеоформат 

ограничен значением 1920×1080.

Кодек

Кодек устанавливается помощью 
параметра Codec (стр. 15) на экране 
состояния Project.

[Совет]
Кодек можно также задать с помощью параметра 
Rec Format >Codec (стр. 84) в меню Project полного 
меню.

[Примечание]
Переключение кодека во время записи или 
воспроизведения невозможно.
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Видеоформат

Можно задать видеоформат для записи. 
Видеоформат устанавливается помощью 
параметра Video Format (стр. 15) на 
экране состояния Project.

[Совет]
Видеоформат можно также задать с помощью 
параметра Rec Format >Video Format (стр. 84) в 
меню Project полного меню.

[Примечания]
ˎˎ Переключение видеоформата во время записи 

или воспроизведения невозможно.
ˎˎ В зависимости от настройки видеоформата 

могут накладываться ограничения на сигнал, 
выводимый на разъемы SDI OUT и HDMI OUT.
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Видеокамера записывает аудио- и видеосигналы на карты памяти CFexpress Type A 
(не входят в комплект поставки) или SDXC (не входят в комплект поставки), которые 
вставляются в гнезда для карт. Карты памяти также используются для записи прокси, 
хранения/загрузки настроек и при обновлении (обновление программного обеспечения).

Сведения о картах памяти CFexpress Type A

Используйте в видеокамере карты памяти Sony CFexpress Type A*, перечисленные в 
разделе “Рекомендуемый носитель” (стр. 28).
Подробные сведения о работе с носителями других производителей см. в инструкции по 
эксплуатации носителей или в информации от производителя.
*  В этом документе такие карты памяти называются “карты CFexpress”.

Сведения о картах памяти SDXC

Используйте в видеокамере карты памяти SDXC*, перечисленные в разделе 
“Рекомендуемый носитель” (стр. 28).
*  В этом документе такие карты памяти называются “SD-карты”.

Использование карт памяти
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Рекомендуемый носитель

Условия гарантированной работы зависят от формата записи (Rec Format) и настроек записи (Recording).
Да: работа поддерживается
Нет: нормальная работа не гарантируется

Формат записи CFexpress 
Type A

SDXC

VPG400 Class10 U1 U3 VSC
V10

VSC
V30

VSC
V60

VSC
V90

RAW Out &  
XAVC-I

4096×2160
Class300

Нормальный режим 59.94P Да Нет Нет Нет Нет Нет Нет Да

50P Да Нет Нет Нет Нет Нет Нет Да

29.97P Да Нет Нет Нет Нет Нет Да Да

25P Да Нет Нет Нет Нет Нет Да Да

24P Да Нет Нет Нет Нет Нет Да Да

23.98P Да Нет Нет Нет Нет Нет Да Да

3840×2160
Class300

Нормальный режим 59.94P Да Нет Нет Нет Нет Нет Нет Да

50P Да Нет Нет Нет Нет Нет Нет Да

29.97P Да Нет Нет Нет Нет Нет Да Да

25P Да Нет Нет Нет Нет Нет Да Да

23.98P Да Нет Нет Нет Нет Нет Да Да

S&Q (60fps или менее) 59.94P Да Нет Нет Нет Нет Нет Нет Да

50P Да Нет Нет Нет Нет Нет Нет Да

29.97P Да Нет Нет Нет Нет Нет Нет Да

25P Да Нет Нет Нет Нет Нет Нет Да

23.98P Да Нет Нет Нет Нет Нет Нет Да

S&Q (100fps, 120fps) 59.94P Да Нет Нет Нет Нет Нет Нет Нет

50P Да Нет Нет Нет Нет Нет Нет Нет

29.97P Да Нет Нет Нет Нет Нет Нет Нет

25P Да Нет Нет Нет Нет Нет Нет Нет

23.98P Да Нет Нет Нет Нет Нет Нет Нет
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Формат записи CFexpress 
Type A

SDXC

VPG400 Class10 U1 U3 VSC
V10

VSC
V30

VSC
V60

VSC
V90

XAVC-I 4096×2160
Class300 

Нормальный режим 59.94P Да Нет Нет Нет Нет Нет Нет Да

50P Да Нет Нет Нет Нет Нет Нет Да

29.97P Да Нет Нет Нет Нет Нет Да Да

25P Да Нет Нет Нет Нет Нет Да Да

24P Да Нет Нет Нет Нет Нет Да Да

23.98P Да Нет Нет Нет Нет Нет Да Да

S&Q (60fps или менее) 59.94P Да Нет Нет Нет Нет Нет Нет Да

50P Да Нет Нет Нет Нет Нет Нет Да

29.97P Да Нет Нет Нет Нет Нет Нет Да

25P Да Нет Нет Нет Нет Нет Нет Да

24P Да Нет Нет Нет Нет Нет Нет Да

23.98P Да Нет Нет Нет Нет Нет Нет Да

3840×2160
Class300 

Нормальный режим 59.94P Да Нет Нет Нет Нет Нет Нет Да

50P Да Нет Нет Нет Нет Нет Нет Да

29.97P Да Нет Нет Нет Нет Нет Да Да

25P Да Нет Нет Нет Нет Нет Да Да

23.98P Да Нет Нет Нет Нет Нет Да Да

S&Q (60fps или менее) 59.94P Да Нет Нет Нет Нет Нет Нет Да

50P Да Нет Нет Нет Нет Нет Нет Да

29.97P Да Нет Нет Нет Нет Нет Нет Да

25P Да Нет Нет Нет Нет Нет Нет Да

23.98P Да Нет Нет Нет Нет Нет Нет Да

S&Q (100fps, 120fps) 59.94P Да Нет Нет Нет Нет Нет Нет Нет

50P Да Нет Нет Нет Нет Нет Нет Нет

29.97P Да Нет Нет Нет Нет Нет Нет Нет

25P Да Нет Нет Нет Нет Нет Нет Нет

23.98P Да Нет Нет Нет Нет Нет Нет Нет
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Формат записи CFexpress 
Type A

SDXC

VPG400 Class10 U1 U3 VSC
V10

VSC
V30

VSC
V60

VSC
V90

XAVC-I 1920×1080
Class100

Нормальный режим 59.94P Да Нет Нет Нет Нет Нет Да Да

50P Да Нет Нет Нет Нет Нет Да Да

29.97P Да Нет Нет Да Нет Да Да Да

25P Да Нет Нет Да Нет Да Да Да

23.98P Да Нет Нет Да Нет Да Да Да

S&Q (60fps или менее) 59.94P Да Нет Нет Нет Нет Нет Да Да

50P Да Нет Нет Нет Нет Нет Да Да

29.97P Да Нет Нет Нет Нет Нет Да Да

25P Да Нет Нет Нет Нет Нет Да Да

23.98P Да Нет Нет Нет Нет Нет Да Да

S&Q (100fps, 120fps) 59.94P Да Нет Нет Нет Нет Нет Нет Да

50P Да Нет Нет Нет Нет Нет Нет Да

29.97P Да Нет Нет Нет Нет Нет Нет Да

25P Да Нет Нет Нет Нет Нет Нет Да

23.98P Да Нет Нет Нет Нет Нет Нет Да

S&Q (150fps, 180fps) 59.94P Да Нет Нет Нет Нет Нет Нет Нет

50P Да Нет Нет Нет Нет Нет Нет Нет

29.97P Да Нет Нет Нет Нет Нет Нет Нет

25P Да Нет Нет Нет Нет Нет Нет Нет

23.98P Да Нет Нет Нет Нет Нет Нет Нет

S&Q (200fps, 240fps) 59.94P Да Нет Нет Нет Нет Нет Нет Нет

50P Да Нет Нет Нет Нет Нет Нет Нет

29.97P Да Нет Нет Нет Нет Нет Нет Нет

25P Да Нет Нет Нет Нет Нет Нет Нет

23.98P Да Нет Нет Нет Нет Нет Нет Нет
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Формат записи CFexpress 
Type A

SDXC

VPG400 Class10 U1 U3 VSC
V10

VSC
V30

VSC
V60

VSC
V90

XAVC-L 3840×2160
420 

Нормальный режим 59.94P Да Нет Нет Да Нет Да Да Да

50P Да Нет Нет Да Нет Да Да Да

29.97P Да Нет Нет Да Нет Да Да Да

25P Да Нет Нет Да Нет Да Да Да

23.98P Да Нет Нет Да Нет Да Да Да

S&Q (60fps или менее) 59.94P Да Нет Нет Да Нет Да Да Да

50P Да Нет Нет Да Нет Да Да Да

29.97P Да Нет Нет Нет Нет Нет Да Да

25P Да Нет Нет Нет Нет Нет Да Да

23.98P Да Нет Нет Нет Нет Нет Нет Да

S&Q (100fps, 120fps) 59.94P Да Нет Нет Нет Нет Нет Да Да

50P Да Нет Нет Нет Нет Нет Да Да

29.97P Да Нет Нет Нет Нет Нет Нет Да

25P Да Нет Нет Нет Нет Нет Нет Да

23.98P Да Нет Нет Нет Нет Нет Нет Нет

1920×1080
HD50

Нормальный режим 59.94P Да Нет Нет Да Нет Да Да Да

50P Да Нет Нет Да Нет Да Да Да

29.97P Да Нет Нет Да Нет Да Да Да

25P Да Нет Нет Да Нет Да Да Да

23.98P Да Нет Нет Да Нет Да Да Да

S&Q (60fps или менее) 59.94P Да Да Да Да Да Да Да Да

50P Да Да Да Да Да Да Да Да

29.97P Да Нет Нет Да Нет Да Да Да

25P Да Нет Нет Да Нет Да Да Да

23.98P Да Нет Нет Да Нет Да Да Да

S&Q (100fps, 120fps) 59.94P Да Нет Нет Да Нет Да Да Да

50P Да Нет Нет Да Нет Да Да Да

29.97P Да Нет Нет Нет Нет Нет Да Да

25P Да Нет Нет Нет Нет Нет Да Да

23.98P Да Нет Нет Нет Нет Нет Да Да
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Формат записи CFexpress 
Type A

SDXC

VPG400 Class10 U1 U3 VSC
V10

VSC
V30

VSC
V60

VSC
V90

XAVC-L 1920×1080
HD50

S&Q (150fps, 180fps) 59.94P Да Нет Нет Нет Нет Нет Да Да

50P Да Нет Нет Нет Нет Нет Да Да

29.97P Да Нет Нет Нет Нет Нет Нет Да

25P Да Нет Нет Нет Нет Нет Нет Да

23.98P Да Нет Нет Нет Нет Нет Нет Да

S&Q (200fps, 240fps) 59.94P Да Нет Нет Нет Нет Нет Да Да

50P Да Нет Нет Нет Нет Нет Да Да

29.97P Да Нет Нет Нет Нет Нет Нет Да

25P Да Нет Нет Нет Нет Нет Нет Да

23.98P Да Нет Нет Нет Нет Нет Нет Да

1920×1080
HD35

Нормальный режим 59.94P Да Да Да Да Да Да Да Да

50P Да Да Да Да Да Да Да Да

29.97P Да Да Да Да Да Да Да Да

25P Да Да Да Да Да Да Да Да

23.98P Да Да Да Да Да Да Да Да

S&Q (60fps или менее) 59.94P Да Да Да Да Да Да Да Да

50P Да Да Да Да Да Да Да Да

29.97P Да Нет Нет Да Нет Да Да Да

25P Да Нет Нет Да Нет Да Да Да

23.98P Да Нет Нет Да Нет Да Да Да

S&Q (100fps, 120fps) 59.94P Да Нет Нет Да Нет Да Да Да

50P Да Нет Нет Да Нет Да Да Да

29.97P Да Нет Нет Да Нет Да Да Да

25P Да Нет Нет Да Нет Да Да Да

23.98P Да Нет Нет Нет Нет Нет Да Да

S&Q (150fps, 180fps) 59.94P Да Нет Нет Да Нет Да Да Да

50P Да Нет Нет Да Нет Да Да Да

29.97P Да Нет Нет Нет Нет Нет Да Да

25P Да Нет Нет Нет Нет Нет Да Да

23.98P Да Нет Нет Нет Нет Нет Да Да

S&Q (200fps, 240fps) 59.94P Да Нет Нет Да Нет Да Да Да

50P Да Нет Нет Да Нет Да Да Да

29.97P Да Нет Нет Нет Нет Нет Да Да

25P Да Нет Нет Нет Нет Нет Да Да

23.98P Да Нет Нет Нет Нет Нет Нет Да
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Установка карты памяти

1 Откройте крышку отделения с гнездами 
для карт памяти.

2 Установите карту памяти.
ˎˎ Для карт CFexpress этикетка 
обращена влево.

Этикетка

ˎˎ Для SD-карт этикетка обращена 
вправо, а скошенный угол находится 
внизу.

Скошенный угол

Индикатор доступа (стр. 6) 
загорится красным, после чего его цвет 
изменится на зеленый, если карта 
является работоспособной.

[Примечание]
Если индикатор доступа постоянно мигает 
красным и не становится зеленым, выключите 
видеокамеру на время, выньте и вставьте опять 
карту памяти.

3 Закройте крышку носителя.

[Примечания]
ˎˎ Сама карта памяти, гнездо для карт памяти и 

данные, записанные на карту памяти могут быть 
повреждены, если вставлять карту в гнездо с 
усилием, когда она неправильно ориентирована.
ˎˎ При записи в оба гнезда для карт памяти 

CFexpress Type A/SD (A и B) вставляйте носители, 
рекомендуемые для работы с соответствующим 
форматом.

Извлечение карты памяти

Откройте крышку отделения с гнездами 
для карт памяти и слегка нажмите на карту 
памяти, чтобы извлечь ее.

[Примечания]
ˎˎ Если видеокамера выключается, когда карта 

памяти используется, или карта памяти 
извлекается в этот момент, целостность 
находящихся на карте памяти данных не 
гарантируется. Все данные, записанные на карту 
памяти, могут быть потеряны. Перед выключением 
видеокамеры или извлечением карты памяти 
всегда необходимо убедиться, что индикатор 
доступа горит зеленым цветом или не горит.
ˎˎ При извлечении карты памяти сразу после 

завершения съемки она может быть горячей, но 
это не указывает на неисправность.

Форматирование 
(инициализация) карт памяти

Если в видеокамеру вставить 
неформатированную карту памяти 
или карту памяти, которая была 
отформатирована в другой системе, 
в видоискателе откроется сообщение 
“Media Needs to be Formatted” (Носитель 
необходимо отформатировать).

Для форматирования карты выполните 
следующую процедуру.

1 Выберите пункт Format Media 
(стр. 94) в меню TC/Media полного 
меню.

2 Выберите Media(A) (гнездо A) или 
Media(B) (гнездо B), затем выберите 
способ форматирования (Full Format 
(полное) или Quick Format (быстрое)).
Отображается сообщение с запросом 
подтверждения.
ˎˎ Full Format: полная инициализация 
носителя, включая регион данных и 
информацию управления данными.
ˎˎ Quick Format: только инициализация 
информации управления данными 
носителя.

3 Выберите Execute.
Во время выполнения форматирования 
на экране отображается сообщение, а 
индикатор доступа горит красным.
После завершения форматирования 
отображается сообщение о 
завершении. Нажмите 
многофункциональный диск, чтобы 
закрыть сообщение.

[Примечания]
ˎˎ При форматировании карты памяти все 

находящиеся на ней данные, в том числе 
записанные видеоклипы и файлы настройки, 
стираются.
ˎˎ В зависимости от длительности процесса 

форматирования во время его выполнения могут 
отображаться сообщения.

Если выполнить форматирование не 
удалось

Карты памяти, которые не поддерживаются 
видеокамерой, нельзя отформатировать.
На экране появится сообщение с 
предупреждением. Выполните инструкции 

по замене карты на поддерживаемую карту 
памяти.

Использование карты памяти, 
отформатированной в видеокамере, 
в гнезде другого устройства

Прежде всего, создайте резервную копию 
находящихся на карте данных, затем 
отформатируйте карту на том устройстве, 
где она будет использоваться.

Проверка оставшегося времени 
записи

При съемке (записи/в режиме ожидания) 
можно отслеживать оставшееся свободное 
место на картах памяти, установленных 
в гнезда, по индикаторам оставшейся 
емкости носителей A и B, которые 
отображаются в видоискателе (стр. 11).
Оставшееся время записи вычисляется 
по оставшейся емкости носителей, 
установленных в каждом гнезде, и 
текущему формату видео (скорости 
передачи данных при записи). Оно 
отображается в минутах.

Время замены карты памяти

ˎˎ Когда общее оставшееся время записи 
на обеих картах памяти становится менее 
5 минут, на экране появляется сообщение 
“Media Near Full” (Носитель почти 
заполнен), индикатор записи/съемки 
начинает мигать и подается звуковой 
сигнал (через выход на наушники).  
Замените на носитель с достаточным 
свободным местом.
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ˎˎ Если продолжить запись до тех пор, 
пока вся емкость не будет исчерпана, то 
на экране появится сообщение “Media 
Full” (Носитель заполнен) и запись будет 
остановлена.

[Примечание]
На одну карту памяти можно записать 
приблизительно 600 клипов.

Восстановление карт памяти

Если по какой-либо причине на карте 
памяти произойдет ошибка, эту карту 
необходимо восстановить перед 
использованием.
При загрузке карты памяти, которая требует 
восстановления, на экране видоискателя 
отображается сообщение с запросом, 
хотите ли вы восстановить карту.

Восстановление карты

Поворачивая многофункциональный 
диск (стр. 5), выберите Execute, затем 
нажмите многофункциональный диск.
Во время форматирования на экране 
отображается сообщение и ход выполнения 
(%), а индикатор доступа горит красным.
После завершения восстановления 
отображается сообщение.

В случае сбоя восстановления

ˎˎ Карты памяти, на которых возникли 
ошибки памяти, не могут быть 
восстановлены. На экране появится 
сообщение с предупреждением. 
Выполните инструкции по замене карты 
памяти.
ˎˎ При повторном форматировании 
карт памяти, на которых возникли 
ошибки памяти, эти карты могут стать 
пригодными для использования.

ˎˎ В некоторых случаях какие-то клипы 
могут быть восстановлены, а другие 
— нет. Восстановленные клипы 
воспроизводятся нормально.

[Примечания]
ˎˎ Восстановление носителя, записанного в данной 

видеокамере, обязательно выполняйте с помощью 
данной видеокамеры.
ˎˎ С помощью данной видеокамеры невозможно 

восстановить носитель, записанный в другом 
устройстве или в другой видеокамере другой 
версии (даже этой же модели).
ˎˎ Восстановление клипов длительностью менее 2 с 

невозможно.



35 3. Съемка

Основные операции
Далее описана процедура ведения простой 
съемки.

1 Присоедините необходимые устройства 
и удостоверьтесь в том, что подается 
питание.

2 Вставьте карты памяти.

3 Установите переключатель POWER во 
включенное положение.
Загорается индикатор POWER, и в 
видоискателе появляется изображение 
камеры.

4 Нажмите кнопку START/STOP (пуск/
остановка записи) (стр. 5).
Загорается индикатор записи/съемки, и 
начинается запись.

5 Чтобы остановить запись, нажмите 
кнопку START/STOP (пуск/остановка 
записи) еще раз.
Запись будет остановлена, и 
видеокамера перейдет в режим STBY 
(режим ожидания).

[Примечание]
Если кнопка START/STOP (пуск/остановка записи) 
нажата в течение нескольких секунд после 
включения видеокамеры, индикатор записи/съемки 
загорается, указывая на то, что устройство находится 
в состоянии записи, но запись на носитель может не 
осуществляться в течение первых нескольких секунд 
в зависимости от выбранного формата записи.

Переключение между картами 
памяти

Если в видеокамеру вставлены две карты 
памяти, для переключения карт служит 
кнопка SLOT SELECT (стр. 6).
Запись автоматически переключается на 
вторую карту памяти непосредственно 
перед тем, как оставшаяся емкость первой 
карты памяти уменьшится до нуля (запись 
с переключением). Можно продолжать 
непрерывную съемку с переключением 
карт памяти, заменяя заполненную карту 
памяти новой.

[Примечание]
Переключаться между картами памяти в режиме 
воспроизведения нельзя. Кроме того, непрерывное 
воспроизведение клипов с носителей, вставленных в 
гнезда A и B, не поддерживается.

Клипы (записанные данные)
Когда запись останавливается, видео, звук и 
сопутствующие данные от начала до конца 
записи сохраняются в виде единого “клипа” 
на карту памяти.

Названия клипов
Имя каждого клипа, записанного 
видеокамерой, автоматически назначается 
с использованием формата, заданного 
в пункте Clip Name Format (стр. 94) меню 
TC/Media полного меню.

Максимальная продолжительность клипа
До 6 часов на клип.
Максимальная длительность непрерывной 
съемки совпадает с максимальной 
длительностью клипа. Если время съемки 
превышает максимальную длительность 
клипа, автоматически создается новый клип 
и съемка продолжается. На экране эскизов 
новый клип отображается как отдельный 
клип.

Несколько клипов записывается 
последовательно во время записи 
с переключением карт, но запись 
останавливается автоматически 
приблизительно через 24 часа.

[Примечания]
ˎˎ Не извлекайте карту памяти в тот момент, когда на 

нее ведется запись. Во время записи заменяйте 
карты памяти только в гнездах, для которых не 
горит индикатор доступа к гнезду.
ˎˎ Когда на карте памяти, на которую выполняется 

запись, остается места менее чем на одну минуту 
видео, а в другое гнездо вставлена доступная 
для записи карта памяти, на экране открывается 
сообщение “Will Switch Slots Soon” (Гнезда скоро 
будут переключены). Это сообщение исчезнет 
после того, как переключение гнезд будет 
произведено.
ˎˎ Запись с переключением карт памяти может не 

работать, если запись запускается в тот момент, 
когда на карте памяти осталось свободного 
места менее чем на одну минуту видео. Во 
избежание ошибок при выполнении записи с 
переключением карт памяти перед началом 
записи удостоверьтесь, что на карте памяти 
осталось больше свободного места, чем на одну 
минуту видео.
ˎˎ Видео, записанное с помощью функции записи 

с переключением карт памяти, не может 
воспроизводиться на видеокамере без паузы.
ˎˎ Для объединения видео, записанного с помощью 

функции записи с переключением карт памяти, 
используйте программное обеспечение “Catalyst 
Browse”.

Мониторинг звука

Прослушивать записываемый звук можно с 
помощью наушников.
Подключите наушники к гнезду для 
наушников (стр. 5), и вы сможете 
прослушивать записываемый звук. 
Прослушивать воспроизводимый звук 
(стр. 71) также можно с помощью 
встроенного динамика (стр. 6) или 
наушников.
Громкость контролируемого звука можно 
регулировать с помощью параметра 
Volume (стр. 14) на экране Audio Status 
или параметра Audio Output >Volume 
(стр. 99) в меню Audio полного меню.
Канал контролируемого звука можно 
выбрать с помощью параметра Monitor 
CH (стр. 14) на экране Audio Status 
или параметра Audio Output >Monitor CH 
(стр. 99) в меню Audio полного меню.

Указание данных времени

Установка временного кода

Задайте временной код для записи с 
помощью пункта Timecode (стр. 93) меню 
TC/Media полного меню.

Задание пользовательских битов

В записанное изображение можно 
добавить 8-значный шестнадцатеричный 
номер в виде пользовательских битов. 
Можно также задать для пользовательских 
битов текущее время. Для задания 
используйте пункт Users Bit (стр. 93) в 
меню TC/Media.

Отображение данных времени

Временной код для отображения задается 
в пункте TC Display (стр. 93) >Display 
Select меню TC/Media.
Нажатием программируемой кнопки 
(стр. 51), которой назначена функция 
DURATION/TC/U-BIT, отображаемые 
на экране данные последовательно 
переключаются между временным 
кодом, битами пользователя и 
продолжительностью.

Переключение ввода/вывода 
временного кода

Для переключения ввода/вывода 
временного кода служит переключатель TC 
IN/OUT (стр. 4).
Подробное описание см. на стр. 117.
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Перемотка записи назад (Rec 
Review)

Последний записанный клип можно 
просмотреть на экране (просмотр записи).

[Примечание]
Функция Rec Review не будет работать при 
изменении формата видео после записи клипа.

Способ просмотра записи

Заранее назначьте функцию Rec Review 
одной из программируемых кнопок.
Когда запись остановлена, нажмите 
программируемую кнопку (стр. 51), 
которой назначена функция Rec Review. 
Начнется воспроизведение клипа, 
записанного последним.
Клип будет воспроизведен до конца, работа 
функции Rec Review будет завершена, 
а видеокамера вернется в режим STBY 
(режим ожидания).

Остановка работы функции Rec 
Review

Нажмите программируемую кнопку, 
которой назначена функция Rec Review, или 
нажмите кнопку CANCEL/BACK.

Настройки просмотра записи

С помощью настройки Rec Review 
(стр. 101) из меню Technical можно задать 
одну из следующих позиций начала 
воспроизведения.
ˎˎ Последние 3 секунды клипа
ˎˎ Последние 10 секунд клипа
ˎˎ Начало клипа

[Совет]
Если требуется просмотреть конкретный клип 
после съемки нескольких клипов, нажмите кнопку 
THUMBNAIL, чтобы открыть экран эскизов, и выберите 
клип для начала воспроизведения.
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Масштаб можно настраивать в соответствии 
с условиями съемки.

Если установлен объектив с сервоприводом 
масштабирования, масштаб можно 
регулировать рычагом масштабирования 
пульта управления на рукоятке или на 
ручке. Скорость масштабирования зависит 
от силы нажатия на рычаг.
Видеокамера оснащена функцией 
масштабирования с обработкой сигнала 
изображения, называемой Clear Image 
Zoom. Когда функция Clear Image 
Zoom включена, масштабирование 
поддерживается даже для объективов с 
фиксированным фокусным расстоянием. 
Ее также можно использовать для 
расширения диапазона масштабирования 
за пределы оптического диапазона 
на объективах с сервоприводом 
масштабирования.
Максимальный коэффициент 
масштабирования с помощью функции 
Clear Image Zoom зависит от разрешения 
записи.
ˎˎ Для разрешения записи QFHD/4K: 1,5×
ˎˎ Для разрешения записи HD: 2×

Выбор типа масштабирования

Тип масштабирования задается 
параметром Zoom >Zoom Type (стр. 102) в 
меню Technical полного меню.
Тип масштабирования зависит от типа 
установленного объектива.

Установленный 
объектив

Настройка Zoom Type
Optical Zoom 
Only

On(Clear 
Image Zoom)

Объектив с 
фиксированным 
фокусным 
расстоянием/
ручным 
масштабированием

Масштабирование с 
помощью рычага не 
поддерживается.

Поддерживается 
функция Clear 
Image Zoom.

Объектив с 
сервоприводом 
масштабирования

Только оптическое 
масштабирование

Поддерживаются 
оптическое 
масштабирование 
и функция Clear 
Image Zoom.

[Примечания]
ˎˎ Функция Clear Image Zoom недоступна в 

следующих случаях.
 – Если для параметра S&Q Motion >Frame Rate 

(стр. 83) в меню Shooting полного меню 
задано значение выше 60fps

 – Если для параметра Rec Format >Codec 
(стр. 84) в меню Project полного меню задано 
значение RAW или вариант, который включает 
в себя RAW

ˎˎ При использовании переключателя выбора 
SERVO/MANUAL на объективе значение 
увеличения функции Clear Image Zoom 
сбрасывается на 1×. 
ˎˎ При использовании функции автофокуса при 

нажатии (AF-S) во время выполнения операции 
Clear Image Zoom, функция автофокуса отдает 
приоритет области в центре экрана.

Настройка масштабирования на 
ручке

Масштабирование на ручке задается 
параметром Handle Zoom (стр. 102) в 
меню Technical полного меню.

Настройка направления 
регулировки кольцом 
масштабирования

На некоторых объективах с байонетом 
E можно задать обратное направление 
вращения кольца масштабирования.
Направление вращения задается 
параметром Lens >Zoom Ring Direction 
(стр. 103) в меню Technical полного меню.

Регулировка масштаба
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Настройка фокусировки
Фокусировку можно настраивать 
автоматически или вручную в соответствии 
с условиями съемки.

Регулировка фокусировки 
вручную (Manual Focus)

Чтобы выполнять фокусировку вручную, 
установите переключатель FOCUS 
(стр. 4) в положение “MAN”.
Это позволит регулировать фокус вручную в 
зависимости от условий съемки.
Ручная фокусировка подходит для съемки 
объектов следующих видов.
ˎˎ Объекты, которые находятся за окном, 
покрытом каплями воды
ˎˎ Объекты, которые сливаются с фоном
ˎˎ Объекты, находящиеся дальше 
расположенных поблизости объектов

[Совет]
Когда основным методом управления является 
ручная регулировка, в следующих случаях можно 
использовать автоматическую фокусировку.
ˎˎ Когда для чувствительности к смене объекта AF 

задано значение 1(Locked)
ˎˎ Когда переключатель FOCUS установлен в 

положение “AF”
ˎˎ При использовании кольца фокусировки (AF Assist, 

стр. 41)

Фокусировка касанием (Spot Focus)

В режиме ручной фокусировки можно 
указать положение, в котором требуется 
навести фокус, коснувшись экрана.
Для того чтобы использовать точечную 
фокусировку, задайте параметру Focus 
>Touch Function in MF (стр. 83) значение 
Spot Focus в меню Shooting.
Метка точечной фокусировки отображается 
при нажатии того места на экране, где 
требуется навести фокус.

[Советы]
ˎˎ В режиме точечной фокусировки можно 

нажать программируемую кнопку (стр. 51), 
которой назначена функция Push AF/Push MF, 
чтобы приостановить точечную фокусировку и 
использовать автоматическую фокусировку, пока 
эта кнопка удерживается нажатой. После того как 
кнопка будет отпущена, восстанавливается ручная 
фокусировка.
ˎˎ Функция Spot Focus не работает, если в объективе 

задана фокусировка вручную.
ˎˎ Указать положение точечной фокусировки нельзя, 

когда используется увеличение зоны фокуса или 
когда параметру Touch Operation (стр. 101) в 
меню Technical задано значение Off.

Временное использование 
автоматической фокусировки (Push 
Auto Focus (AF))

Если для параметра Focus >Push AF Mode 
(стр. 83) в меню Shooting полного меню 
задано значение AF, нажмите кнопку 
PUSH AUTO FOCUS (стр. 4) в режиме 
ручной фокусировки, чтобы использовать 
автоматическую фокусировку, пока эта 
кнопка удерживается нажатой.
Фокусировка производится в пределах 
области фокусировки, заданной с помощью 
параметра Focus >Focus Area (стр. 82) в 
меню Shooting полного меню.
После того как кнопка будет отпущена, 
восстанавливается ручная фокусировка.
Это удобно, когда требуется медленно 
перемещать фокус с одного объекта на 
другой во время ручной фокусировки.

[Совет]
Эта же операция поддерживается с помощью 
программируемой кнопки (стр. 51), которой 
назначена функция Push AF/Push MF.

[Примечание]
Функция Push Auto Focus не работает, если в 
объективе задана фокусировка вручную.

Использование покадровой 
автоматической фокусировки (Push 
Auto Focus (AF-S))

Задайте для параметра Focus >Push AF 
Mode (стр. 83) в меню Shooting полного 
меню значение Single-shot AF(AF-S), затем 
задайте область фокусировки с помощью 
параметра Focus >Focus Area(AF-S) 
(стр. 82) в меню Shooting полного меню.
Нажмите кнопку PUSH AUTO FOCUS при 
работе в режиме ручной фокусировки, 
чтобы автоматически сфокусироваться 
с высокой скоростью. Фокусировка 
прекратится, как только оператор отпустит 
кнопку.
Состояние фокусировки обозначается 
индикатором фокусировки.
ˎˎ Горит: фокус фиксируется в положении 
фокусировки.
ˎˎ Мигает: не в фокусе. Поскольку 
фокусировка ведется не автоматически, 
измените композицию и настройки 
фокусировки, чтобы установить фокус.

После того как кнопка будет отпущена, 
восстанавливается ручная фокусировка.
Это полезно, когда требуется быстро 
сфокусироваться на объекте перед началом 
съемки.

[Советы]
ˎˎ Эта же операция поддерживается с помощью 

программируемой кнопки (стр. 51), которой 
назначена функция Push AF/Push MF.
ˎˎ Функцию Push AF Mode также можно назначить 

программируемой кнопке (стр. 51).
ˎˎ Функцию Focus Area(AF-S) также можно назначить 

программируемой кнопке (стр. 51).

ˎˎ Рамку области фокусировки можно отобразить 
или скрыть с помощью пункта Display On/Off 
>Focus Area Ind.(AF-S) (стр. 95) в меню Monitoring 
полного меню.
ˎˎ Во время фокусировки с использованием 

увеличенного изображения фокусировка 
регулируется в соответствии с положением, 
в котором производится увеличение области 
фокусировки.

[Примечания]
ˎˎ Функция Push Auto Focus не работает, если в 

объективе задана фокусировка вручную.
ˎˎ При использовании кнопки DISPLAY рамка области 

фокусировки не скрывается.
ˎˎ  Во время выполнения операции Clear Image 

Zoom нельзя задать положение рамки Focus Area 
(AF-S). Во время выполнения операции Push AF-S, 
функция автофокуса также отдает приоритет 
центральной части изображения.

Фокусировка с использованием 
увеличенного изображения (Focus 
Magnifier)

По умолчанию функция Focus Magnifier 
×3/×6 задана кнопке ASSIGN 4, 
расположенной на пульте управления на 
рукоятке, и кнопке ASSIGN 7 на рукоятке 
(стр. 51).
Нажмите кнопку ASSIGN 4 или ASSIGN 7, 
чтобы переключить видоискатель на 
экран увеличения для фокусировки, на 
котором центр кадра увеличивается 
приблизительно в три раза. Нажмите 
эту кнопку еще раз, чтобы увеличить эту 
область приблизительно в шесть раз. Эта 
функция полезна для проверки фокуса.
Нажмите кнопку еще раз, чтобы вернуться к 
нормальному изображению.
Положение, в котором производится 
увеличение области фокусировки, 
можно перемещать с помощью 
многофункционального селектора 
(стр. 7). При нажатии мультиселектора 
производится возврат в центр 
изображения.
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Если во время увеличения области 
фокусировки используется автоматическая 
фокусировка при нажатой кнопке (AF), 
фокусировка производится в пределах 
области фокусировки, заданной с помощью 
пункта Focus >Focus Area (стр. 82) в меню 
Shooting полного меню.
Если автоматическая фокусировка при 
нажатой кнопке (AF-S) используется во 
время увеличения области фокусировки, 
фокусировка регулируется в соответствии 
с положением, в котором производится 
увеличение области фокусировки.

[Примечания]
ˎˎ При увеличении области фокусировки 

записываемое изображение и изображение, 
передающееся на выход SDI/HDMI, не 
увеличиваются.
ˎˎ Во время увеличения области фокусировки кнопка 

MENU и другие операции не работают.
ˎˎ При выключении видеокамеры область 

увеличения возвращается в центр экрана.

Автоматическая регулировка 
фокусировки (Auto Focus)

В видеокамере используется фазовая AF 
для быстрой фокусировки и контрастная AF 
для точной фокусировки.
Сочетание этих двух методов 
автофокусировки обеспечивает быструю и 
точную автоматическую фокусировку.
Чтобы фокусировка выполнялась 
автоматически, установите переключатель 
FOCUS (стр. 4) видеокамеры 
в положение “AUTO”. Если объектив 
оборудован селекторным переключателем 
фокуса, установите его в положение “AF/MF” 
или “AF”. Если переключатель установлен в 
положение “Full MF” или “MF”, видеокамера 
не может управлять фокусировкой 
объектива (стр. 24).

[Совет]
Даже если для параметра Focus >AF Assist (стр. 83) 
в меню Shooting полного меню задано значение On, 
фокусировку все равно можно настраивать во время 
автоматической фокусировки с помощью кольца 
фокусировки на объективе.

[Примечания]
ˎˎ Требуется объектив, поддерживающий 

автоматическую фокусировку.
ˎˎ В некоторых условиях съемки точность может не 

обеспечиваться.
ˎˎ Фокус невозможно настроить автоматически на 

объективе с байонетом A.

Задание области/положения 
автоматической фокусировки (Focus 
Area)

Целевую область для автоматической 
фокусировки можно задать с помощью 
параметра Focus >Focus Area (стр. 82) в 
меню Shooting полного меню.

Flexible Spot:
Производит фокусировку на указанное 
положение изображения.
Если выбран этот вариант, укажите 
положение многофункциональным 
селектором (стр. 7).
Вернуться в центральное положение 
можно, нажав и удерживая 
многофункциональный селектор.

Zone:
Автоматический поиск положения 
фокусировки в указанной зоне.
Если выбран этот вариант, укажите 
положение многофункциональным 
селектором (стр. 7).

Вернуться в центральное положение 
можно, нажав и удерживая 
многофункциональный селектор.

Wide:
При фокусировке производится поиск 
объекта по широкому углу изображения. 
Рамка не отображается.

[Совет]
Эта же операция поддерживается с помощью 
программируемой кнопки (стр. 51), которой 
назначена функция Focus Area.
Рамку области фокусировки можно отобразить или 
скрыть с помощью пункта Display On/Off >Focus Area 
Indicator (стр. 95) в меню Monitoring полного меню.

[Примечание]
При использовании кнопки DISPLAY рамка области 
фокусировки не скрывается.

Быстрое изменение области 
фокусировки (Focus Setting)

Чтобы иметь возможность быстро 
изменять положение и размер области 
автоматической фокусировки во время 
съемки, назначьте функцию Focus Setting 
программируемой кнопке (стр. 51).
Работа функции зависит от настройки 
области фокусировки.

Когда пункту Focus >Focus Area (стр. 82) 
в меню Shooting полного меню задано 
значение Flexible Spot или Zone
Чтобы изменить положение области 
фокусировки, нажмите программируемую 
кнопку, которой назначена функция 
Focus Setting, и выполните регулировку 
с помощью многофункционального 
селектора (стр. 7).
Чтобы вернуть область фокусировки 
в центр во время регулировки 
ее положения, нажмите 
многофункциональный селектор.
Чтобы изменить размер области 
фокусировки, нажмите и удерживайте 
программируемую кнопку, которой 
назначена функция Focus Setting.
После изменения размера, задайте 
положение области фокусировки, нажав 
многофункциональный селектор.
Завершив регулировку, нажмите 
программируемую кнопку, которой 
назначена функция Focus Setting, чтобы 
вернуться на исходный экран.

Когда пункту Focus >Focus Area (стр. 82) 
в меню Shooting полного меню задано 
значение Wide
Изменить можно только размер области 
фокусировки. Для этого нажмите и 
удерживайте программируемую кнопку, 
которой назначена функция Focus Setting. 
Чтобы изменить положение, сначала 
необходимо изменить тип на Flexible Spot 
или Zone.

[Советы]
ˎˎ Когда параметру Focus >Push AF Mode (стр. 83) 

в меню Shooting полного меню задано значение 
Single-shot AF(AF-S) и переключатель FOCUS 
(стр. 4) находится в положении MF, можно 
изменять положение области фокусировки Focus 
Area(AF-S) (стр. 82).
ˎˎ Рамка области фокусировки отображается 

оранжевым цветом, когда положение области 
фокусировки можно изменить.
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Перемещение рамки области 
фокусировки с помощью сенсорных 
операций (область сенсорной 
фокусировки)

Положение области фокусировки можно 
изменить, нажав программируемую 
кнопку (стр. 51), которой назначена 
функция Focus Setting, чтобы изменить 
цвет индикации области фокусировки на 
оранжевый, а затем переместив эту область 
с помощью сенсорных операций.
Нажмите экран для перемещения центра 
области фокусировки в место нажатия. 
Перетаскивайте экран, чтобы область 
фокусировки перемещалась вслед за 
пальцем (стр. 10).

[Совет]
Сенсорные операции фокусировки на экране 
съемки можно включать и выключать с помощью 
программируемой кнопки, которой назначена 
функция Focus Setting.

Нажмите в любом месте

Центр области фокусировки 
перемещается в нажатое место.

Перетащите для перемещения области 
фокусировки вслед за пальцем

[Примечания]
ˎˎ Если нажать в некотором положении или 

перетащить область фокусировки в положение 
вне диапазона настройки, область фокусировки 
устанавливается на верхнем, нижнем, левом или 
правом краю диапазона настройки.
ˎˎ В указанных ниже условиях эта функция 

недоступна.
 – Если для пункта Touch Operation (стр. 101) 

в меню Technical полного меню задано значение 
Off

 – Если область фокусировки отображается серым 
цветом или вообще не отображается

Настройка работы автофокусировки 
(скорость изменения AF, 
чувствительность к смене объекта AF)

Скорость изменения AF
Скорость изменения фокусировки при 
изменении объекта можно задать с 
помощью пункта Focus >AF Transition Speed 
(стр. 82) в меню Shooting полного меню.
Если задана низкая скорость, при 
изменении объекта фокусировки фокус 
перемещается медленно, что позволяет 
снимать впечатляющие кадры.
Если задана высокая скорость, фокус 
быстро переключается между объектами. 
Камера моментально фокусируется на 
объекте съемки, попадающем в кадр, что 
делает эту настройку идеальным вариантом 
для документальной съемки, требующей 
быстрой фокусировки.

Во время изменения:
1(Slow): фокус изменяется 
медленно
.
.
.
7(Fast): фокус изменяется 
быстро

Фокусировка на дальний объект

Фокусировка на ближний объект
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Чувствительность к смене объекта AF
Чувствительность к смене объектов можно 
задать с помощью пункта Focus >AF Subj. 
Shift Sens. (стр. 82) в меню Shooting 
полного меню.
Когда задана низкая чувствительность, 
фокус не будет сразу же изменяться, если 
перед объектом, на который наведен фокус, 
появляется другой объект. Когда задана 
высокая чувствительность, фокусировка 
изменяется, отдавая приоритет объекту, 
появившемуся впереди.

[Совет]
Если функция AF Speed/Sens. назначена 
программируемой кнопке, при каждом нажатии 
этой кнопки отображаются полосы уровня для 
регулировки значений, позволяя изменять скорость 
изменения AF и чувствительность к смене объекта AF.
Скорость изменения AF  Чувствительность к смене 
объекта AF  Нет индикации …

AF Subj. Shift Sens.: 1(Locked On) AF Subj. Shift Sens.: 5(Responsive)

Медленное изменение фокусировки на 
другой объект

Быстрое изменение фокусировки на 
другой объект

Изменение целевой области 
фокусировки вручную (AF Assist)

Даже если для параметра Focus >AF Assist 
(стр. 83) в меню Shooting полного меню 
задано значение On, фокусировку на объект 
все равно можно настраивать во время 
автоматической фокусировки с помощью 
кольца фокусировки на объективе.
После прекращения использования кольца 
фокусировки продолжается автоматическая 
фокусировка на объект, сфокусированный 
с помощью кольца фокусировки (состояние 
AF Assist).
После использования кольца фокусировки 
перемещение фокусировки на другой 
объект несколько затруднено, независимо 
от настройки параметра Focus >AF Subj. Shift 
Sens. (стр. 82) в меню Shooting полного 
меню.
Состояние AF Assist отменяется в 
следующих случаях.
ˎˎ Когда объект, фокусировка на который 
произведена с помощью кольца 
фокусировки, пропадает из вида
ˎˎ При переключении на ручную 
фокусировку
ˎˎ Когда запущена функция автоматической 
фокусировки с отслеживанием в 
реальном времени

[Советы]
ˎˎ Состояние AF Assist можно быстро отменить с 

помощью программируемой кнопки (стр. 51), 
которой назначена функция Push AF/Push MF.
ˎˎ Работе функции Realtime Tracking AF 

прекращается, если повернуть кольцо 
фокусировки.
ˎˎ В режиме Face/Eye Only AF автоматическая 

фокусировка производится на лицо, ближайшее 
к положению фокусировки, заданному кольцом 
фокусировки.
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Временное использование ручной 
фокусировки (Push Manual Focus)

Нажмите кнопку PUSH AUTO FOCUS 
(стр. 4) при работе в режиме 
автоматической фокусировки, чтобы 
фокусироваться вручную, пока нажата эта 
кнопка.
После того как кнопка будет отпущена, 
восстанавливается автоматическая 
фокусировка.
Это позволяет временно останавливать 
автоматическую фокусировку и 
фокусироваться вручную, когда что-либо, 
не являющееся объектом съемки, проходит 
перед ним.

[Совет]
Эта же операция поддерживается с помощью 
программируемой кнопки (стр. 51), которой 
назначена функция Push AF/Push MF.

Отслеживание 
с использованием обнаружения 
лиц и глаз (Face/Eye Detection 
AF)

Видеокамера может обнаруживать 
лица и глаза людей в качестве цели для 
отслеживания и настраивать фокус на лица 
и глаза в пределах области фокусировки.
Эта функция доступна только при 
использовании режима фокусировки 
AF или во время автофокусировки при 
нажатой кнопке.
Если обнаружены лица, отображаются 
серые рамки обнаружения лица или 
глаз. Если возможна автоматическая 
фокусировка, цвет рамки изменяется 
на белый и начинается отслеживание. 
Если обнаружены глаза и настраивается 
фокусировка, рамка обнаружения лица/
глаз отображается на глазах. Если 
обнаружено несколько человек, главный 
объект определяется автоматически.

[Советы]
ˎˎ Если задана область фокусировки Zone или 

Flexible Spot и лица или глаза перекрываются 
в указанной области фокусировки, цвет рамок 
обнаружения лиц/глаз изменяется на белый, и 
видеокамера фокусируется на эти лица или глаза.
ˎˎ Если используется функция автоматической 

фокусировки при нажатой кнопке (AF-S), цвет 
рамок обнаружения лиц/глаз, находящихся 
в фокусе, изменяется на зеленый.

Работа AF с обнаружением лиц/глаз 
задается с помощью пункта Focus >Face/Eye 
Detection AF (стр. 83) в меню Shooting.

Face/Eye Only AF:
Камера обнаруживает лица или глаза 
объектов (людей), а также фокусируется 
и ведет отслеживание только их лиц или 
глаз. Если лицо или глаза не обнаружены, 
AF временно останавливается и 
отображается значок  (приостановленной 
автоматической фокусировки в режиме 
Face/Eye Only AF) (стр. 11). Этот режим 
эффективен, если требуется автоматическая 
фокусировка и отслеживание только лиц 
или глаз.

Face/Eye Priority AF:
Камера обнаруживает лица или глаза 
объектов (людей) и устанавливает 
приоритет фокусировки/отслеживания 
лиц или глаз. Если лицо или глаза не 
обнаружены, фокусировка производится 
в режиме AF (настройка по умолчанию).

Off:
Функция автоматической фокусировки 
с обнаружением лиц или глаз отключена.

[Примечания]
ˎˎ Во время использовании автоматической 

фокусировки при нажатой кнопке включается 
режим Face/Eye Priority AF, даже если выбран 
режим Face/Eye Only AF.
ˎˎ Если переключатель FOCUS установлен 

в положение MAN, AF с обнаружением лиц/глаз 
отключена (кроме автоматической фокусировки 
при нажатой кнопке).
ˎˎ Если выключить видеокамеру, когда выбран 

режим Face/Eye Only AF, при следующем 
включении видеокамеры автоматически 
устанавливается режим Face/Eye Priority AF.

Скрытие рамок обнаружения лиц или 
глаз

Рамки обнаружения лиц или глаз можно 
отображать или скрывать с помощью 
пункта Display On/Off >Face/Eye Detection 
Frame (стр. 95) в меню Monitoring 
полного меню.

[Примечание]
Зеленые рамки обнаружения лиц или глаз 
отображаются для лиц и глаз, находящихся в фокусе 
при использовании автофокусировки при нажатой 
кнопке (AF-S), и они не скрываются с помощью 
кнопки DISPLAY или когда для пункта Face/Eye 
Detection Frame задано значение Off.

Переключение режима AF 
с обнаружением лиц и глаз 
с помощью программируемой кнопки

Назначьте функцию Face/Eye Detection 
AF программируемой кнопке (стр. 51). 
Затем режим функции AF с обнаружением 
лиц и глаз будет переключаться при 
каждом нажатии этой кнопки в следующем 
порядке: Face/Eye Priority AF, Face/Eye Only 
AF и Off.

Настройка с помощью прямого меню

Режим работы функции AF с обнаружением 
лиц и глаз можно задавать также 
с помощью прямого меню (стр. 51).
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Отслеживание указанного 
объекта (Realtime Tracking AF)

Можно удерживать объект в фокусе, 
указав его касанием или выбрав рамку 
отслеживания лица.
После выбора объекта отображается 
белая рамка отслеживания, после чего 
начинается само отслеживание.

[Советы]
ˎˎ Отслеживание ведется во всей области 

изображения независимо от заданной настройки 
области фокусировки.
ˎˎ Когда параметру Focus >Touch Function in MF 

(стр. 83) в меню Shooting задано значение 
Tracking AF, автофокус с отслеживанием в 
реальном времени поддерживается даже, когда 
выбран режим фокуса MF.

В зависимости от выбранного варианта 
AF с обнаружением лиц или глаз, с целью 
отслеживания выполняются следующие 
действия.

Face/Eye Only AF, Face/Eye Priority AF:
Используйте для фокусировки на 
указанном объекте и отслеживания этого 
объекта.
Если отслеживается человек и обнаружено 
лицо/глаза, камера фокусируется на лице/
глазах.
При обнаружении лица/глаз 
отслеживаемого объекта его лицо 
сохраняется. При этом отображается значок 

 (сохраненное лицо для отслеживания) 
(стр. 11).

[Примечание]
Если AF с отслеживанием запускается в режиме 
ручной фокусировки, лицо целевого объекта 
отслеживания не сохраняется.

Off:
Фокусировка на указанном объекте и 
отслеживание этого объекта.
Обнаружение лица/глаз не производится, 
даже если объектом отслеживания 
является человек.

[Примечание]
Функция Realtime Tracking AF не работает, если в 
объективе задана фокусировка вручную.

Запуск автоматической фокусировки с 
отслеживанием в реальном времени

Когда в качестве цели отслеживания 
указывается определенный объект, 
начинается отслеживание этой цели.

Указание касанием
Коснитесь целевого объекта, чтобы 
отслеживать его в следующих состояниях:
ˎˎ В режиме фокусировки MF или при 
фокусировке вручную нажатием кнопки, 
а также когда параметру Focus >Touch 
Function in MF (стр. 83) в меню Shooting 
задано значение Tracking AF
ˎˎ Когда используется режим фокусировки 
AF или во время автофокусировки при 
нажатой кнопке (AF)

[Примечание]
Указывать цель касанием нельзя, когда параметру 
Touch Operation (стр. 101) в меню Technical задано 
значение Off.

Указание путем выбора рамки 
обнаружения лица
С помощью многофункционального 
селектора (стр. 7) переместите 
указатель выбора лица (оранжевое 
подчеркивание) на целевой объект, и 
нажмите многофункциональный селектор.

Другие рамки  
обнаружения лиц 
(серые) Рамка отслеживания

Курсор выбора лица (оранжевый)

[Советы]
ˎˎ Целевой объект, который требуется отслеживать в 

режиме AF с отслеживанием в реальном времени, 
можно изменять.
ˎˎ Если в режиме AF с отслеживанием в реальном 

времени нажать программируемую кнопку 
(стр. 51), которой назначена функция Focus 
Magnifier, отслеживание продолжится, а область 
фокусировки будет увеличена. Однако нельзя 
указать цель для отслеживания в режиме 
увеличения области фокусировки.

[Примечание]
В режиме ручной фокусировки нельзя запустить 
отслеживание выбором рамки обнаружения лица.

Остановка автоматической 
фокусировки с отслеживанием в 
реальном времени

Остановка касанием
Коснитесь кнопки  (остановка 
автофокуса с отслеживанием в реальном 
времени), отображаемой на сенсорной 
панели вверху слева.

[Советы]
ˎˎ Автоматическая фокусировка с отслеживанием в 

реальном времени останавливается в следующих 
случаях:
 – При изменении положения переключателя 

FOCUS или AUTO/MAN на объективе
 – При изменении режима фокусировки
 – При выполнении автоматической фокусировки
 – При изменении настройки области фокусировки 

или работы автоматической фокусировки с 
обнаружением лица/глаз

 – При нажатии программируемой кнопки, 
которой назначена функция Push AF/Push MF

 – Когда целевой объект отслеживания не 
находится в пределах съемочного экрана или 
когда объект уходит из фокуса на несколько 
секунд

ˎˎ Когда отслеживаемое лицо сохраняется (при 
этом отображается значок “ ” сохраненного 
отслеживаемого лица), автоматическая 
фокусировка с отслеживанием в реальном 
времени возобновляется, когда такое лицо 
окажется в области изображения. Чтобы удалить 
отслеживаемое лицо, остановите автоматическую 
фокусировку с отслеживанием в реальном 
времени, выполнив приведенную выше 
процедуру.
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Регулировка яркости

B

C
D
E

F
H

I

A

Яркость можно регулировать путем 
настройки диафрагмы, усиления, 
выдержки, а также уровня освещенности с 
помощью фильтров ND. Регулировку также 
можно выполнять автоматически.
Целевой уровень для автоматической 
регулировки яркости задается с помощью 
параметра Auto Exposure (стр. 80) 
>Level в меню Shooting полного меню. 
Функцию Auto Exposure Level также можно 
назначить программируемой кнопке или 
программируемому диску (стр. 51).

[Примечание]
Усиления нельзя регулировать использовать 
в режиме Cine EI. Базовая чувствительность 
является фиксированной. Яркость также нельзя 
регулировать автоматически с помощью 
выдержки. Автоматическая регулировка яркости с 
использованием диафрагмы и фильтра нейтральной 
плотности поддерживается.

Выбор базовой 
чувствительности

В видеокамере можно выбрать один из 
двух типов базовой чувствительности.
В режиме Custom можно задать для 
базовой чувствительности значение High 
или Low с помощью параметра Base ISO/
Sensitivity на экране Main Status (стр. 14) 
или Camera Status (стр. 14) либо с 
помощью параметра ISO/Gain/EI >Base 
Sensitivity (стр. 79) в меню Shooting 
полного меню. 
В режиме Cine EI можно задать базовую 
чувствительность ISO 12800 или ISO 800 с 
помощью параметра Base ISO/Sensitivity на 
экране Main Status (стр. 14) или Camera 
Status (стр. 14)либо параметра ISO/Gain/
EI >Base ISO (стр. 79) в меню Shooting 
полного меню.
Рекомендуется вбор параметра Low или 
ISO 800 в нормальных условиях освещения 
и выбор параметра High или ISO 12800 в 
условиях низкого освещения.

* Можно настроить также на экране состояния.

[Совет]
Функцию Base ISO/Sensitivity также можно назначить 
программируемой кнопке (стр. 51).

Регулировка диафрагмы

Можно настраивать диафрагму для 
регулировки яркости.

Автоматическая регулировка диафрагмы

Эта функция регулирует яркость в 
соответствии с объектом съемки. 
Требуется объектив, поддерживающий 
автоматическую диафрагму.

1 Если присоединен объектив с 
переключателем Auto Iris, переведите 
переключатель в положение AUTO.

2 Нажмите и удерживайте кнопку IRIS (E) 
для отображения прямого меню 
(стр. 51), затем выберите Auto.

 [Совет]
Функцию Auto Iris также можно назначить 
программируемой кнопке (стр. 51).

 [Примечание]
Диафрагму невозможно настроить 
автоматически на объективе с байонетом A.

Регулировка диафрагмы вручную

1 Нажмите и удерживайте кнопку 
функции IRIS (E) для отображения 
прямого меню (стр. 51), затем 
выберите Manual.

2 Нажмите кнопку функции IRIS (E), чтобы 
величина диафрагмы отображалась на 
белом фоне.

3 Настройте значение, поворачивая 
многофункциональный диск.

 [Советы]
ˎˎ Многофункциональный диск можно 

также использовать как диск IRIS 
(стр. 51), назначив функцию IRIS 
многофункциональному диску.
ˎˎ Функцию IRIS также можно назначить 

программируемому диску (стр. 51).

Временная регулировка 
в автоматическом режиме

Нажмите программируемую кнопку 
(стр. 51), которой назначена функция 
Push Auto Iris, чтобы при нажатой кнопке 
диафрагма временно настраивалась 
автоматически.
После того как кнопка будет отпущена, 
диафрагма вернется к ранее заданной 
установке.

[Примечания]
ˎˎ Если переключатель Auto Iris на объективе 

установлен в положение MANUAL, функции Auto 
Iris и Push Auto Iris на видеокамере не работают. 
Регулировка диафрагмы вручную на видеокамере 
также не приведет к каким-либо изменениям.

ˎˎ Невозможно выполнить функцию Push Auto Iris, 
когда параметру Iris > Bokeh Control (стр. 80) в 
меню Shooting задано значение On.

Регулировка усиления

В режиме Custom можно регулировать 
усиление для настройки яркости.

Автоматическая регулировка 
усиления

Нажмите и удерживайте кнопку функции 
ISO/GAIN (H) для отображения прямого 
меню (стр. 51), затем выберите Auto.

[Советы]
ˎˎ Это же действие можно выполнить, задав для 

пункта Auto Exposure (стр. 80) >AGC в меню 
Shooting значение On.
ˎˎ Функцию AGC также можно назначить 

программируемой кнопке (стр. 51).

Регулировка усиления вручную

Управлять усилением можно, когда 
требуется отрегулировать экспозицию 
при использовании фиксированного 
значения диафрагмы, либо если вы хотите 
воспрепятствовать увеличению усиления 
из-за AGC.

1 Нажмите и удерживайте кнопку 
функции ISO/GAIN (H) для отображения 
прямого меню (стр. 51), затем 
выберите Manual.
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2 Установите переключатель ISO/GAIN (I) 
в положение H, M или L.

[Советы]
ˎˎ Предварительно заданное значение для каждого 

положения переключателя можно изменить 
с помощью параметра ISO/Gain<L>/<M>/<H> 
(стр. 14) на экране Camera Status или параметра 
ISO/Gain/EI >ISO/Gain<H>/<M>/<L> (стр. 79) в 
меню Shooting полного меню.
ˎˎ Можно также назначить функцию Push AGC 

программируемой кнопке и временно включать 
AGC, нажимая эту кнопку и удерживая ее нажатой.

[Примечание]
Невозможно выполнить функцию Push AGC, когда 
параметру Iris > Bokeh Control (стр. 80) в меню 
Shooting полного меню задано значение On.

Управление усилением (точная 
регулировка)

1 Нажмите кнопку функции ISO/GAIN (H), 
чтобы величина усиления 
отображалась на белом фоне.

2 Настройте значение, поворачивая 
многофункциональный диск.

[Совет]
Измените предустановленное значение усиления 
в соответствии с настройкой переключателя ISO/
GAIN (I).

Временное управление усилением 
(точная регулировка)

Поворачивайте программируемый диск 
(стр. 51), которому назначена функция 
ISO/Gain/EI, чтобы отрегулировать значение 
усиления, заданное переключателем ISO/
GAIN (I).
Это полезно, когда требуется 
отрегулировать экспозицию по одному 
шагу, не меняя глубину поля.
Регулировка значения усиления отменяется 
изменением положения переключателя 
ISO/GAIN (I), изменением базовой 
чувствительности, включением функции 
AGC или выключением питания.

[Советы]
ˎˎ Можно также назначить эту функцию 

многофункциональному диску (стр. 51).
ˎˎ Можно также назначить функцию Push AGC 

программируемой кнопке и временно включать 
AGC, нажимая эту кнопку и удерживая ее нажатой.

[Примечание]
Невозможно выполнить функцию Push AGC, когда 
параметру Iris > Bokeh Control (стр. 80) в меню 
Shooting полного меню задано значение On.

Регулировка индекса 
экспозиции

В режиме Cine EI предполагается, что 
видеовыход, параметру MLUT которого 
задано значение Off, записывается 
как основной сигнал. Изменив яркость 
изображения когда параметру MLUT задано 
значение On, в соответствии со значением 
EI, можно во время съемки проверить 
результат регулировки чувствительности 
экспозиции при работе с отснятым 
материалом в студии.
Для изменения значения EI необходимо 
установить переключатель ISO/GAIN (I) 
в положение H, M или L.

[Совет]
Изменить значение EI, заданное каждому положению 
переключателя, можно с помощью пункта ISO/Gain/
EI (стр. 14) на экране Camera Status или пунктов 
ISO/Gain/EI >Exposure Index<H>/<M>/<L> (стр. 79) 
в меню Shooting полного меню.

Точная регулировка индекса 
экспозиции

1 Нажмите кнопку функции ISO/GAIN (H), 
чтобы величина EI отображалась на 
белом фоне.

2 Настройте значение, поворачивая 
многофункциональный диск.

[Совет]
Измените предустановленное значение EI 
в соответствии с настройкой переключателя ISO/
GAIN (I).

Регулировка выдержки

Можно регулировать выдержку для 
настройки яркости.

Автоматическая регулировка 
выдержки

Нажмите и удерживайте кнопку функции 
SHUTTER (F) для отображения прямого 
меню (стр. 51), затем выберите Auto для 
автоматической регулировки выдержки 
или угла затвора в соответствии с яркостью 
изображения.

[Совет]
Это же действие можно выполнить, задав для пункта 
Auto Exposure > Auto Shutter (стр. 81) в меню 
Shooting полного меню значение On.

Регулировка выдержки вручную

1 Нажмите и удерживайте кнопку 
функции SHUTTER (F) для отображения 
прямого меню (стр. 51), затем 
выберите Speed или Angle.

2 Нажмите кнопку функции SHUTTER (F), 
чтобы значение выдержки 
отобразилось на белом фоне.

3 Настройте выдержку, поворачивая 
многофункциональный диск.

[Советы]
ˎˎ Для настройки времени экспозиции в соответствии 

с интервалом между кадрами выберите значение 
Off на шаге 1.
ˎˎ Также можно задать угол и отрегулировать частоту 

(стр. 79).
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Регулировка уровня 
освещенности (фильтр ND)

Когда освещенность слишком яркая, ее 
уровень можно понизить с помощью 
фильтра ND.
В видеокамере предусмотрено два 
режима фильтра нейтральной плотности. 
Между этими двумя режимами можно 
переключаться с помощью переключателя 
ND PRESET/VARIABLE.

Настройка в предустановленном 
режиме

Установите переключатель ND PRESET/
VARIABLE (A) в положение PRESET и 
установите кнопки вверх/вниз ND FILTER 
POSITION (B) на одну из следующих 
настроек.
Clear: фильтр ND не используется
1: Коэффициент пропускания задается 
настройкой ND Filter >Preset1 (стр. 79) в 
меню Shooting полного меню.
2: Коэффициент пропускания задается 
настройкой ND Filter >Preset2 (стр. 79) в 
меню Shooting полного меню.
3: Коэффициент пропускания задается 
настройкой ND Filter >Preset3 (стр. 79) в 
меню Shooting полного меню.

Настройка в переменном режиме

Установите переключатель ND PRESET/
VARIABLE (A) в положение VARIABLE. 
Переключайте кнопки вверх/вниз ND FILTER 
POSITION (B) между положениями CLEAR и On.

Автоматическая регулировка уровня 
освещенности
Можно задать для параметра Auto ND 
Filter значение On, чтобы включить 
автоматическую регулировку экспозиции с 
помощью фильтра нейтральной плотности.

1 Нажмите кнопку [+] кнопки вверх/вниз 
ND FILTER POSITION (B), чтобы включить 
фильтр ND.

2 Нажмите и удерживайте кнопку ND 
VARIABLE AUTO (C), пока не будет 
выбран вариант Auto.

Регулировка уровня освещенности 
вручную

1 Нажмите кнопку [+] кнопки вверх/вниз 
ND FILTER POSITION (B), чтобы включить 
фильтр ND.

2 Нажмите и удерживайте кнопку ND 
VARIABLE AUTO (C), пока не будет 
выбран вариант Manual.

3 Поворачивайте диск ND VARIABLE (D) 
для настройки коэффициента 
пропускания фильтра.

[Совет]
Функцию ND Filter также можно назначить 
программируемому диску (стр. 51).

Временная регулировка в автоматическом 
режиме
Можно назначить функцию Push Auto 
ND программируемой кнопке (стр. 51) 
и временно задавать для параметра 
Auto ND Filter значение On, нажимая и 
удерживая эту кнопку. При отпускании 
кнопки для параметра Auto ND Filter снова 
устанавливается значение Off.
Нажмите кнопку [+] кнопки вверх/вниз ND 
FILTER POSITION (B), чтобы включить фильтр 
ND.

[Примечания]
ˎˎ При переключении фильтра ND на значение 

CLEAR или из этого значения во время съемки на 
изображении отображается рамка фильтра ND 
и звук срабатывания записывается на звуковую 
дорожку.
ˎˎ Невозможно выполнить функцию Push Auto ND, 

когда параметру Iris > Bokeh Control (стр. 80) в 
меню Shooting задано значение On.

[Советы]
ˎˎ Чтобы задать значение CLEAR, когда фильтру 

задано значение ND1/4, необходимо повернуть 
диск ND VARIABLE (D) вниз. Поворот диска вверх, 
когда фильтру задано значение CLEAR, задает ему 
значение ND1/4. Это действие можно отменить 
с помощью пункта ND Dial >CLEAR with Dial 
(стр. 101) в меню Technical полного меню.
ˎˎ Можно также назначить функцию ND Filter Position 

программируемой кнопке (стр. 51), и нажимать 
эту кнопку для изменения настройки вместо 
использования кнопок вверх/вниз ND FILTER 
POSITION.  
Предустановленный режим: Clear  Preset1 
 Preset2  Preset3  Clear… 
Переменный режим: Clear  On  Clear…
ˎˎ Можно также назначить функцию Auto ND Filter 

программируемой кнопке (стр. 51), и нажимать 
эту кнопку для выключения функции Auto ND Filter.
ˎˎ Если при съемке ярко освещенного объекта 

слишком сильно закрыть диафрагму, может 
возникнуть дифракционное размытие, в 
результате чего изображение начнет выходить 
из фокуса (типичное явление в видеокамерах). С 
помощью диска фильтр ND можно подавить это 
явление для улучшения результатов съемки.
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Режим регулировки можно выбрать, исходя 
из условий съемки.

ATW (автоматическое 
отслеживание баланса белого)

Эта функция автоматически подбирается 
подходящий уровень баланса белого.
Баланс белого автоматически регулируется 
при изменении цветовой температуры 
источника света.
Нажмите и удерживайте кнопку функции 
WHT BAL (G) для отображения прямого 
меню (стр. 51), затем выберите ATW.
Скорость регулировки можно изменять 
(есть пять значений) с помощью пункта 
White Setting >ATW Speed (стр. 82) из 
меню Shooting полного меню.

[Совет]
Можно зафиксировать текущее значение баланса 
белого, назначив функцию ATW Hold одной из 
программируемых кнопок (стр. 51) и нажав 
соответствующую кнопку, чтобы приостановить 
работу режима ATW.

[Примечания]
ˎˎ ATW невозможно использовать в режиме Cine EI.
ˎˎ Обеспечить запись правильных цветов с помощью 

функции ATW не всегда возможно. Это зависит от 
условий освещенности и объекта съемки.  
Примеры приведены ниже.
 – Когда в объекте съемки, например небе, море, 

земле или цветах, имеется один доминирующий 
цвет.

 – Когда цветовая температура чрезвычайно 
высокая или низкая.

 Если нужного эффекта не удается добиться из-за 
того, что скорость автоматического отслеживания 
функции ATW слишком медленная или по 
другим причинам, используйте автоматическую 
регулировку баланса белого.

Регулировка баланса белого 
вручную

1 Когда для баланса белого задан режим 
ATW, нажмите и удерживайте кнопку 
функции WHT BAL (G) для отображения 
прямого меню (стр. 51), затем 
выберите W:P, W:A или W:B.

2 С помощью переключателя WHT BAL (J) 
выберите значение B, A или PRESET.
B: режим из ячейки памяти B
A: режим из ячейки памяти A
PRESET: режим предустановки

[Совет]
Режим ATW можно включить для ячейки памяти 
B, задав в пункте White Setting >White Switch<B> 
(стр. 82) в меню Shooting полного меню значение 
ATW.

Режим из ячейки памяти A/B
Этот режим задает балансу белого 
настройку, сохраненную в ячейке памяти A 
или B соответственно.

Режим предустановки
В этом режиме цветовой температуре 
устанавливается заранее заданное 
значение (по умолчанию это 3200K).

Изменение предустановленного 
значения по умолчанию

В режиме предустановки действующее 
предустановленное значение можно 
изменять напрямую.
Нажмите и удерживайте кнопку функции 
WHT BAL (G) и выберите в прямом меню 
один из следующих функций.
Режим Custom: ˎ3200K, ˎ4300K, 

ˎ5600K, ˎ6300K
Режим Cine EI: ˎ3200K, ˎ4300K, 

ˎ5500K

[Совет]
Можно также назначить функцию Preset White Select 
программируемой кнопке (стр. 51) и нажимать эту 
кнопку для изменения настройки.
Режим Custom: 3200K  4300K  5600K  6300K 
 3200K…

Режим Cine EI: 3200K  4300K  5500K  3200K…

Изменение цветовой температуры

1 Нажмите кнопку функции WHT BAL (G), 
чтобы значение цветовой температуры 
отображалось на белом фоне.

2 Настройте значение, поворачивая 
многофункциональный диск.

[Советы]
ˎˎ В режиме предустановки можно задавать 

значение в единицах 100K.
ˎˎ В режиме памяти можно задавать значение 

с шагом 20K в диапазоне от 2000K до 5600K. 
Значения более 5600K можно задавать с 
интервалом, равным величине изменения цвета 
(в Майредах) от 5580K до 5600K. Можно также 
настроить значение оттенка с помощью пункта 
White (стр. 81) >Tint в меню Shooting полного 
меню.

Выполнение автоматической 
регулировки баланса белого

Баланс белого, сохраняемый в ячейки 
памяти A/B, настраивается автоматически.

1 Выберите режим из ячейки памяти A 
или режим из ячейки памяти B.

2 Поместите лист белой бумаги (или 
другой предмет) в место, в котором 
имеются такой же источник и такие же 
условия освещения, как у объекта 
съемки, затем увеличьте масштаб и 
заполните белым весь экран.

3 Отрегулируйте яркость.
Отрегулируйте диафрагму, выполнив 
процедуру, которая описана в разделе 
“Регулировка диафрагмы вручную” 
(стр. 44).

4 Нажмите кнопку WB SET (стр. 4).
ˎˎ Если автоматический баланс белого 
выполняется в режиме ячейки 
памяти, то заданное в результате 
автоматической регулировки 
значение будет сохранено в ячейке 
памяти (A или B), выбранной в шаге 1.
ˎˎ Если автоматический баланс 
белого выполняется в режиме ATW, 
результат наследуется, а работа 
ATW возобновляется по окончании 
автоматической регулировки. Это 
полезно, когда отрегулировать 
баланс белого нужно очень быстро 
независимо от значения настройки 
ATW Speed.

Обеспечение естественных цветов (баланс белого)
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[Примечание]
Если регулировка завершится неудачно, на экране 
будет примерно в течение трех секунд отображаться 
сообщение об ошибке. Если после повторных 
попыток настроить баланс белого сообщение 
об ошибке появляется снова, обратитесь к 
представителю службы технического обслуживания 
компании Sony.



3. Съемка49

Записываемый звук настраивается 
с помощью входных разъемов, 
переключателей и дисков видеокамеры.

Входные разъемы для внешнего 
аудиосигнала и селекторные 
переключатели

Разъем INPUT1 (стр. 7)
Разъем INPUT2 (стр. 7)
Многоцелевой разъем (стр. 7)
Переключатель INPUT1 (LINE/MIC/MIC+48V) 
(стр. 7)
Переключатель INPUT2 (LINE/MIC/MIC+48V) 
(стр. 7)

Переключатели для задания уровня 
звука

Переключатель CH1 (AUTO/MAN) (стр. 6)
Переключатель CH2 (AUTO/MAN) (стр. 6)
Диск AUDIO LEVEL (CH1) (стр. 6)
Диск AUDIO LEVEL (CH2) (стр. 6)

Экран Audio Status

Выбор устройства, подающего 
входной аудиосигнал

1 Задайте аудиовход с помощью пунктов 
CH1/CH2/CH3/CH4 >Source (стр. 14) на 
экране Audio Status или пунктов Audio 
Input >CH1 Input Select – CH4 Input Select 
(стр. 98) в меню Audio полного меню.
При использовании микрофона или 
адаптера XLR, подключенного к 
многоцелевому разъему, укажите Shoe 
CH1 или Shoe CH2. Подробную 
информацию об адаптере XLR см. в 
разделе “Добавление входных 
аудиоразъемов” (стр. 50).

 [Примечания]
ˎˎ В режиме Interval Rec или Slow & Quick Motion 

звук не записывается.
ˎˎ Видеокамера оснащена встроенным 

микрофоном для записи окружающих звуков. 
Он может использоваться для синхронизации 
времени с другим оборудованием. В этом 
случае задайте Internal MIC.
ˎˎ Когда установлена ручка, активным для 

записи звука становится только внутренний 
микрофон ручки (стр. 7). Когда ручка не 
установлена, можно использовать микрофон 
(стр. 6) для записи окружающих звуков.
ˎˎ Если для параметров CH1 Input Select и CH2 

Input Select задано значение Internal MIC, 
уровень записи звуков обоих каналов CH1 и 
CH2 регулируется диском AUDIO LEVEL(CH1) 
(стр. 6). Если для параметров CH3 Input 
Select и CH4 Input Select задано значение 
Internal MIC, уровень записи звуков обоих CH3 
и CH4 регулируется параметром CH3 Input 
Level (стр. 98).

2 Выберите источник входного 
аудиосигнала.
Переключатели INPUT1/INPUT2 (LINE/
MIC/MIC+48V) относятся к устройствам, 
подключенным к разъемам INPUT1/
INPUT2 соответственно.

Подключенное 
устройство

Положение 
переключателя

Внешний источник 
аудиосигнала (например, 
микшер)

LINE

Динамический микрофон, 
беспроводной микрофон

MIC

Микрофон с фантомным 
питанием +48 В

MIC+48V

ˎˎ Если выбрать MIC+48V и подключить 
микрофон, который несовместим с 
источником +48 В, это может привести 
к повреждению подключенного 
устройства. Проверьте настройку 
перед подключением устройства.
ˎˎ Если беспокоит шум на разъемах, к 
которым не подключены устройства, 
установите соответствующие 
переключатели INPUT1/INPUT2 (LINE/
MIC/MIC+48V) в положение LINE.

Автоматическая регулировка 
уровня записи звука

Переключатели CH1/CH2 (AUTO/MAN) 
для каналов, регулировка которых будет 
производиться автоматически, необходимо 
установить в положение AUTO.
Для CH3/CH4 установите для управления 
уровнем звука на экране Audio Status 
(стр. 14) или для параметров Audio Input 
>CH3 Level Control и CH4 Level Control в 
меню Audio полного меню значение Auto 
(стр. 98).

Регулировка уровня записи 
звука вручную

Для регулировки уровня записи звука 
каналов CH1/CH2 используется следующая 
процедура.

1 Переключатели CH1/CH2 (AUTO/MAN) 
для каналов, регулировка которых 
будет производиться вручную, 
установите в положение MAN.

2 Во время съемки или в режиме 
ожидания регулировка уровня звука 
производится дисками AUDIO LEVEL 
(CH1)/(CH2) соответствующих каналов.
ˎˎ Для CH3/CH4 с помощью параметров 
CH3/CH4 (стр. 14) на экране Audio 
Status или параметра Audio Input >CH3 
Level Control или CH4 Level Control в 
меню Audio полного меню задайте 
для управления уровнем звука 
значение Manual, затем отрегулируйте 
уровень записи звука с помощью 
параметра CH3 Input Level или CH4 
Input Level.
ˎˎ Можно настроить уровень для 
каналов с CH1 по CH4 в качестве 
группы. Регулировать уровень записи 
можно с помощью программируемого 
диска (стр. 51) которому назначена 
функция Audio Input Level, экрана 
Audio Status или параметра Audio 
Input >Audio Input Level в меню Audio 
полного меню.

[Совет]
На экране Audio Status удобно проверять входной 
уровень звука (стр. 14).

[Примечания]
ˎˎ Параметры Audio Input Level могут быть отключены 

в зависимости от настроек, заданных в меню 
Audio. Подробные сведения см. на диаграмме, 
приведенной на стр. 135.
ˎˎ Видеокамера поддерживает сочетания различных 

настроек. Подробные сведения см. на диаграмме, 
приведенной на стр. 135.

Настройка записываемого звука
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Добавление входных 
аудиоразъемов

К видеокамере можно подключить до 
четырех каналов аудиоустройств XLR 
одновременно с помощью адаптера XLR-
K2M XLR (не входит в комплект поставки) 
или адаптера XLR-K3M XLR (не входит 
в комплект поставки).
Установите адаптер XLR на многоцелевой 
разъем и установите для параметра CH3 
>Source значение Shoe CH1, а для параметра 
CH4 >Source значение Shoe CH2 на экране 
Audio Status (стр. 14). Либо установите 
для параметра Audio Input >CH3 Input Select 
значение Shoe CH1, а для параметра CH4 
Input Select значение Shoe CH2 в меню 
Audio полного меню.
Для каналов, в которых в качестве входа 
выбран адаптер XLR, накладывающиеся 
функции видеокамеры будут отключены. 
Для регулировки используйте 
переключатели и диски на адаптере XLR.

[Примечания]
ˎˎ Видеокамера поддерживает двухканальный 

цифровой аудиоинтерфейс XLR-K3M.
ˎˎ Если для параметров Audio Input >CH3 Level и 

CH4 Level установлено значение Audio Input 
Level в меню Audio, значение Audio Input 
Level видеокамеры умножается на уровень, 
настроенный на адаптере XLR.  
Функция Audio Input Level также включается, 
когда переключатель XLR-адаптера установлен в 
положение AUTO.  
Когда указано значение “Through”, звук будет 
записываться с уровнем, настроенным на 
адаптере XLR (стр. 136).
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Полезные функции

Использование прямого меню

Можно проверять состояние и настройки 
видеокамеры, отображаемые на экране 
видоискателя, и напрямую выбирать и 
изменять настройки.
Можно настроить указанные ниже пункты.
ˎˎ Face/Eye Detection AF
ˎˎ SteadyShot
ˎˎ White Mode
ˎˎ Color Temp
ˎˎ Scene File
ˎˎ ND Filter Position / Auto ND Filter
ˎˎ ND Filter Value
ˎˎ Auto Iris
ˎˎ Iris Value
ˎˎ AGC
ˎˎ Gain Value
ˎˎ ISO Value
ˎˎ Exposure Index Value
ˎˎ Auto Shutter / ECS
ˎˎ Shutter Value
ˎˎ Auto Exposure Mode
ˎˎ Auto Exposure Level
ˎˎ S&Q Motion Frame Rate

1 Нажмите многофункциональный диск 
или программируемую кнопку, которой 
назначена функция Direct Menu.
Только элементы, которые допускают 
настройку с помощью прямого меню, 
можно выбрать на экране с помощью 
оранжевого курсора.

2 Многофункциональным диском 
переместите курсор на нужный пункт 
меню, затем нажмите диск 
многофункциональный диск.
Открывается меню, или пункт 
отображается на белом фоне.

3 Поворачивая многофункциональный 
диск, выберите настройку, затем 
нажмите многофункциональный диск.
Меню или белый фон исчезает, и на 
экране появляется новая настройка 
с оранжевым курсором.
Чтобы закрыть Direct Menu, снова 
нажмите программируемую кнопку, 
которой назначен вызов Direct Menu, 
или подождите 3 секунды, не выполняя 
никаких действий.

 [Советы]
ˎˎ Прямые настройки можно также задавать, 

нажимая и удерживая каждую из кнопок 
функций (стр. 5).
ˎˎ Когда пункты отображаются на белом 

фоне, многофункциональный диск может 
использоваться как программируемый диск.
ˎˎ Многофункциональный селектор (стр. 9) 

также можно использовать для операций 
выбора.

Программируемые кнопки/диски

На видеокамере есть девять 
программируемых кнопок (стр. 6, 7, 
9), которым можно назначать функции.
Можно также назначить функции 
многофункциональному диску 
на видеокамере (стр. 5), 
программируемому диску на ручке 
(стр. 7) и программируемому диску на 
пульте управления на рукоятке (стр. 9).

Изменение функции кнопки

Используйте пункт Assignable Button 
(стр. 87) в меню Project полного меню.
Просмотреть функции, назначенные 
программируемым дискам, можно на 
экране Assignable Button Status (стр. 15).

По умолчанию программируемым кнопкам 
назначены функции
Кнопка 1 S&Q Motion
Кнопка 2 AF Speed/Sens.
Кнопка 3 Focus Setting
Кнопка 4 Focus Magnifier x3/x6
Кнопка 5 Direct Menu
Кнопка 6 Off
Кнопка 7 Focus Magnifier x3/x6
Кнопка 8 Direct Menu
Кнопка 9 Video Signal Monitor
Кнопка Focus Hold Focus Hold

Функции, которые можно назначить
ˎˎ Off
ˎˎ Base ISO/Sensitivity
ˎˎ AGC
ˎˎ Push AGC
ˎˎ ND Filter Position
ˎˎ Auto ND Filter
ˎˎ Push Auto ND
ˎˎ Auto Iris
ˎˎ Push Auto Iris
ˎˎ Bokeh Control
ˎˎ Auto Shutter
ˎˎ Auto Exposure Level
ˎˎ Backlight
ˎˎ Spotlight
ˎˎ Preset White Select
ˎˎ ATW
ˎˎ ATW Hold
ˎˎ AF Speed/Sens.
ˎˎ Focus Setting
ˎˎ Focus Area
ˎˎ Focus Area(AF-S)
ˎˎ Face/Eye Detection AF
ˎˎ Push AF Mode
ˎˎ Push AF/Push MF
ˎˎ Focus Hold
ˎˎ Focus Magnifier x3/x6
ˎˎ Focus Magnifier x3
ˎˎ Focus Magnifier x6
ˎˎ S&Q Motion
ˎˎ SteadyShot

ˎˎ Rec
ˎˎ Picture Cache Rec
ˎˎ Rec Review
ˎˎ Clip Flag OK
ˎˎ Clip Flag NG
ˎˎ Clip Flag Keep
ˎˎ Color Bars
ˎˎ Tally [Front]
ˎˎ DURATION/TC/U-BIT
ˎˎ Display
ˎˎ Lens Info
ˎˎ Video Signal Monitor
ˎˎ Marker
ˎˎ VF Adjust
ˎˎ VF Mode
ˎˎ Gamma Display Assist
ˎˎ Peaking
ˎˎ Zebra
ˎˎ Volume
ˎˎ Thumbnail
ˎˎ Touch Operation
ˎˎ Handle Zoom
ˎˎ NFC
ˎˎ Auto Upload (Proxy)
ˎˎ Direct Menu
ˎˎ User Menu
ˎˎ Menu

Изменение функции диска

Можно изменить функцию 
многофункционального диска на 
видеокамере, программируемого диска 
на рукоятке и программируемого диска на 
ручке.

Для многофункционального диска 
используйте пункт Multi Function Dial 
(стр. 90) > Default Function в меню Project.
По умолчанию назначено значение Off.
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Функции, которые можно назначить 
многофункциональному диску
ˎˎ Off
ˎˎ ISO/Gain/EI
ˎˎ IRIS
ˎˎ Auto Exposure Level
ˎˎ Audio Input Level

[Примечание]
Настройка отображается, пока меню находится на 
экране.

Для программируемого диска используйте 
пункт Assignable Dial (стр. 89) в меню 
Project полного меню.
По умолчанию всем назначена функция IRIS.

[Совет]
Настройка программируемого диска на RM-30BP (не 
входит в комплект поставки) соответствует настройке 
Grip/Remote Dial.

Функции, которые можно назначить 
программируемому диску на ручке/
рукоятке
ˎˎ Off
ˎˎ ISO/Gain/EI
ˎˎ ND Filter
ˎˎ IRIS
ˎˎ Auto Exposure Level
ˎˎ Audio Input Level
ˎˎ Multi Function Dial

Просмотреть функции, назначенные 
программируемым дискам, можно на 
экране Assignable Button Status (стр. 15).

Съемка с замедлением/ускорением движения

Если для формата записи (стр. 84) задано одно из следующих значений, можно 
установить разную частоту кадров записи и частоту кадров воспроизведения.

Формат записи Частота кадров

Частота системы Режим Imager 
Scan Mode

Codec Формат видео

59.94/50/29.97/ 
25/23.98

FF RAW 3840×2160P 1–60, 100, 120

RAW & XAVC-I 3840×2160P 1–60, 100, 120

XAVC-I 4096×2160P 1–60

3840×2160P 1–60, 100, 120

1920×1080P 1–60, 100, 120, 150, 
180, 200, 240

XAVC-L 3840×2160P 1–60, 100, 120

1920×1080P 1–60, 100, 120, 150, 
180, 200, 240

S35 XAVC-I 1920×1080P 1–60, 100, 120

XAVC-L 1920×1080P 1–60, 100, 120

24 FF XAVC-I 4096×2160P 1–60

Режим Slow & Quick Motion можно включать 
и выключать, нажимая программируемую 
кнопку (стр. 51), которой назначена 
функция S&Q Motion.
Частоту кадров для съемки можно задать, 
нажав и удерживая эту кнопку.

[Совет]
Режим также можно выбрать с помощью пункта S&Q 
Frame Rate на экране Main Status, пункта Rec Function 
на экране состояния Project и пункта S&Q Motion в 
меню Shooting полного меню.

[Примечания]
ˎˎ Режим с замедлением/ускорением движения 

нельзя задать во время записи, воспроизведения, 
либо когда отображается экран эскизов.
ˎˎ В режиме с замедлением/ускорением движения 

запись звука не поддерживается.
ˎˎ Функция автоматической фокусировки, 

функция автоматической регулировки 
диафрагмы и функция автоматического 
управления затвором отключаются в режиме 
с замедлением/ускорением движения. Однако 
функцию автоматической фокусировки можно 
использовать, когда установлены следующие 
значения частоты кадров.

Частота системы Частота кадров

59,94/29,97/23,98 30, 60, 120, 240

50/25 25, 50, 100, 200

ˎˎ Подробную информацию об использовании 
выхода RAW см. на стр. 61.

Запись видео с промежутками 
(Interval Rec)

С помощью функции Interval Rec 
видеокамеры можно записывать видео с 
заданной длительностью во внутреннюю 
память видеокамеры. Эта функция 
обеспечивает эффективный способ съемки 
медленно движущихся объектов.
При начале записи видеокамера 
автоматически записывает заданное 
количество кадров (Number of Frames) 
через указанный временной интервал 
(Interval Time).

Интервал съемки (Interval Time)

Количество кадров в одном дубле
(Number of Frames)

Когда функция Interval Rec включена, 
лампа для видеосъемки HVL-LBPC 
(приобретается дополнительно) включается 
автоматически перед началом съемки, что 
дает возможность снимать при стабильном 
освещении и цветовой температуре 
(функция предварительного освещения).

[Примечания]
ˎˎ Одновременно можно использовать только одну 

функцию записи в особом режиме, например 
Interval Rec.
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ˎˎ При включении другого особого режима записи в 
то время, когда используется функция Interval Rec, 
она будет автоматически отключена.
ˎˎ Работа в режиме Interval Rec автоматически 

завершается после изменения таких системных 
настроек, как формат видео.
ˎˎ Настройки функции Interval Rec нельзя изменить 

во время съемки или воспроизведения, либо, 
когда отображается экран эскизов.

Настройка функции Interval Rec

Выберите Rec Function >Interval Rec 
на экране состояния Project и задайте 
значения параметрам Number of Frames и 
Interval Time.
При использовании лампы для 
видеосъемки HVL-LBPC (приобретается 
дополнительно) с помощью параметра 
Interval Rec >Pre-Lighting в меню Project 
задайте необходимый временной интервал 
включения лампы для видеосъемки перед 
началом съемки.

[Совет]
Задать режим также можно с помощью параметра 
Interval Rec (стр. 86) в меню Project полного меню.

[Примечания]
ˎˎ Если требуется, чтобы лампа для видеосъемки 

включилась перед началом съемки, переведите 
переключатель лампы для видеосъемки в 
положение AUTO. Лампа для видеосъемки 
включается и выключается автоматически в 
соответствии со значением параметра Video Light 
Set (стр. 103), заданным в меню Technical.
ˎˎ Если перевести переключатель лампы для 

видеосъемки в положение ON, лампа будет гореть 
всегда (она не будет включаться и выключаться 
автоматически).
ˎˎ Если лампа для видеосъемки настроена таким 

образом, что она выключается на 5 секунд или 
менее, она не будет выключаться.

Видеокамера выходит из режима Interval 
Rec при отключении питания, но при этом 
значения параметров Number of Frames, 
Interval Time и Pre-lighting сохраняются. 
Их не нужно будет снова задавать в 
следующий раз при использовании режима 
Interval Rec.

Съемка в режиме Interval Rec

Нажмите кнопку START/STOP (пуск/
остановка записи), чтобы начать 
съемку. В видоискателе попеременно 
отображаются надписи “Int Rec” и “Int 
Stby”.
При использовании функции 
предварительного освещения лампа для 
видеосъемки включится перед началом 
съемки.

Остановка съемки

Остановите съемку.
Когда съемка завершается, видеоданные, 
которые были сохранены в памяти вплоть 
до этого момента, записываются на 
носитель.

Выход из режима Interval Rec

Выполните одно из следующих действий.
ˎˎ Переведите переключатель POWER в 
положение Off.
ˎˎ В режиме ожидание съемки на экране 
состояния Project задайте параметру Rec 
Function любое значение, кроме Interval 
Rec.

Кроме того, работа в режиме Interval 
Rec автоматически завершается при 
перезапуске видеокамеры.

Ограничения во время записи

ˎˎ Звук не записывается.
ˎˎ Просмотр записи (Rec Review) 
невозможен.

Если видеокамера выключается во 
время записи

ˎˎ Если переключатель POWER 
видеокамеры переводится в положение 
Off, видеокамеры обращается к носителю 
на несколько секунд, чтобы записать на 
него изображения, сохраненные в памяти 
вплоть до этого момента, после чего 
питание автоматически выключается.
ˎˎ Если подача питания прекращается из-за 
извлечения аккумулятора, отсоединения 
шнура питания постоянного тока либо 
отключения подачи питания от адаптера 
переменного тока, видео- и аудиоданные, 
снятые до этого момента, могут быть 
потеряны (максимум 10 секунд). При 
замене аккумулятора следует соблюдать 
осторожность.

Запись кэшированных 
изображений (Picture Cache Rec)

Функция Picture Cache Rec позволяет 
записывать видео задним числом при 
начале съемки поддерживая внутреннюю 
кэш-память заданной продолжительности 
при съемке.
Задайте параметру Picture Cache Rec 
значение On на экране состояния Project и 
выберите размер кэша.

Настройка Cache 
Size

Время кэша 
(приблизительно)

Short 5 секунд

Medium 10 секунд

Long 20 секунд

Max Максимальное значение 
для каждого формата 
записи

[Советы]
ˎˎ Время кэша может быть короче, что зависит от 

частоты кадров при съемке и от формата записи. 
Проверьте значение, отображаемое внизу справа 
на экране настройки размера кэша.
ˎˎ Задать режим также можно с помощью параметра 

Picture Cache Rec (стр. 86) в меню Project 
полного меню.
ˎˎ Переключать значение параметра Picture Cache 

Rec между On и Off также можно с помощью 
программируемой кнопки (стр. 51).

[Примечания]
ˎˎ Функцию Picture Cache Rec нельзя использовать в 

сочетании с функцией Interval Rec, одновременной 
записью в 2 гнезда и записью прокси. Когда 
функция Picture Cache Rec включена (On), 
остальные перечисленные функции записи 
принудительно отключаются (Off).
ˎˎ Режим Picture Cache Rec нельзя выбрать во время 

записи, либо когда выполняется функция Rec 
Review.
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ˎˎ Когда одновременно включены функции Slow & 
Quick Motion и Picture Cache Rec (On), временной 
код записывается в режиме Free Run независимо 
от значения, заданного в меню TC/Media 
(стр. 93).
ˎˎ Иногда задать значение параметра Output Format 

в режиме Picture Cache Rec бывает невозможно. В 
этом случае временно задайте параметру Picture 
Cache Rec значение Off, после чего измените эту 
настройку.

Запуск функции Picture Cache Rec

Когда функции Picture Cache Rec задается 
значение On, в видоискателе отображается 
“Cache” ( — зеленый).
При нажатии кнопки START/STOP (пуск/
остановка записи) запись запускается, 
и видео записывается на карты памяти, 
начиная с видео, которое хранится в кэш-
памяти.

Отмена функции Picture Cache Rec

Установите функции Picture Cache Rec 
значение Off на экране состояния Project 
или нажмите программируемую кнопку, 
которой назначена функция Picture Cache 
Rec.

[Примечания]
ˎˎ При изменении формата записи видео или Basic 

Look, хранящиеся в кэш-памяти видео удаляется, и 
кэширование начинается заново. Соответственно, 
запись картинки в кэш изображения перед 
изменением формата невозможна, даже если 
начать запись сразу же после смены формата.
ˎˎ Если для функции Picture Cache Rec задается 

значение On или Off сразу же после установки 
карты памяти, данные из кэша нельзя будет 
записывать на карту.
ˎˎ Видео сохраняется в кэш-памяти, когда 

функция Picture Cache Rec включена (On). Видео, 
записываемое до включения этой функции, не 
кэшируется.
ˎˎ Во время доступа к карте памяти, например при 

воспроизведении, работе функции Rec Review 
или при отображении экрана эскизов, видео в 
кэш-память не сохраняется. Запись видео в кэш 
изображения в это время невозможна.

Одновременная запись на 
карты памяти A и B (2-slot Simul 
Rec)

Можно одновременно записывать на карты 
памяти A и B, задав для параметра Simul 
Rec (стр. 15) на экране состояния Project 
или для параметра Simul Rec >Setting 
(стр. 86) в меню Project полного меню 
значение On.

Раздельная запись на карту памяти A 
и на карту памяти B

Запускать и останавливать запись можно 
будет для каждой карты памяти отдельно 
с помощью кнопок записи START/STOP, 
расположенных на видеокамере и 
рукоятке.
По умолчанию обе кнопки настроены 
запускать и останавливать одновременную 
запись на обе карты памяти (A и B).
ˎˎ “Rec Button:[SlotA SlotB] Handle Rec 
Button:[SlotA SlotB]”

Когда кнопки настраиваются для 
управления записью на различные карты 
памяти, параметр SDI/HDMI Rec Control 
(стр. 87) следует за состоянием записи 
гнезда A.

Изменение настройки

Выберите пункт Simul Rec >Rec Button Set 
(стр. 86) в меню Project.

Rec Button Set Кнопки и карты 
памяти

“Rec Button:[SlotA 
SlotB] Handle Rec 
Button:[SlotA SlotB]”

Запуск/остановка 
одновременной 
записи на карты 
памяти A и B с 
помощью любой из 
двух кнопок.

“Rec Button:[SlotA] 
Handle Rec Button: 
[SlotB]”

Кнопка START/STOP 
записи запускает/
останавливает запись 
на карту памяти A, а 
кнопка START/STOP 
записи на рукоятке 
запускает/
останавливает запись 
на карту памяти B.

“Rec Button:[SlotB] 
Handle Rec 
Button:[SlotA]”

Кнопка START/STOP 
записи запускает/
останавливает запись 
на карту памяти B, а 
кнопка START/STOP 
записи на рукоятке 
запускает/
останавливает запись 
на карту памяти A.

[Совет]
Кнопки записи на пульте управления на рукоятке 
и на пульте управления LANC работают так же, как 
кнопка START/STOP на видеокамере.

Предотвращение случайного нажатия 
кнопки START/STOP (пуск/остановка 
записи) на рукоятке

Установите переключатель HOLD на 
рукоятке в положение HOLD.

[Примечание]
Переключатель HOLD на рукоятке не работает, когда 
параметру HOLD Switch Setting (стр. 101) >with Rec 
Button задано значение Off в меню Technical полного 
меню. Когда этому параметру задано значение On, 
задайте параметру Handle HOLD Switch значение Rec 
Button Only.

Чтобы включить рычаг масштабирования 
и остальные кнопки на рукоятке (кроме 
кнопки START/STOP), задайте параметру 
HOLD Switch Setting >Handle HOLD Switch 
значение Rec Button Only.

Монитор видеосигнала

С помощью параметра Display On/Off 
>Video Signal Monitor (стр. 96) в меню 
Monitoring можно задать тип отображения 
видеосигнала на экране видоискателя: 
форму сигнала, вектороскоп или 
гистограмму.
Оранжевая линия указывает заданное 
значение уровня зебры.
Функцию Video Signal Monitor также можно 
назначить программируемой кнопке 
(стр. 51).

Отображение цели мониторинга

В режиме Cine EI в правом верхнем углу 
монитора видеосигнала для индикации 
цели мониторинга отображается 
информация о настройке цветового 
пространства (стр. 25) или о таблице 
соответствия монитора LUT (стр. 83).
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Функция Gamma Display Assist

Когда в режиме Custom для параметра 
Target Display задано значение HDR(HLG) 
(стр. 25), задайте для параметра 
Gamma Display Assist* на экране 
Monitoring Status значение On для 
просмотра вспомогательной индикации 
в видоискателе, упрощающей съемку 
в режиме HDR.
* Настроить эту функцию также можно с помощью 

параметра Gamma Display Assist >Setting 
(стр. 97) в меню Monitoring полного меню.

Выбор дисплея видоискателя при 
включенной функции Gamma Display 
Assist

Для отображения изображений HDR в 
видоискателе при включенной функции 
Gamma Display Assist поддерживается два 
метода отображения.

Отображение HDR с поддержанием 
контраста между областями низкой и 
высокой освещенности
В этом методе возможности HDR 
используются для того, чтобы отображать 
изображение в видоискателе с четкими 
черными и светлыми областями, даже при 
съемке на темном или ярком фоне. Однако 
контрастность будет немного снижена.
Чтобы использовать этот метод 
отображения, задайте параметру HDR 
Setting >VF SDR Preview (стр. 86) в меню 
Project полного меню значение Off.

Отображение SDR путем простого 
преобразования из HDR в SDR
Этот метод позволяет управлять камерой 
как обычным устройством SDR.
Можно регулировать яркость изображения 
HDR, настраивая разницу в усилении между 
HDR и SDR с помощью параметра SDR Gain.
Чтобы использовать этот метод 
отображения, выполните настройку, следуя 
приведенной далее процедуре.

1 Задайте параметру HDR Setting >VF SDR 
Preview (стр. 86) в меню Project 
полного меню значение On.

2 Регулируйте значение усиления SDR в 
режиме HDR с помощью параметра 
HDR Setting >SDR Gain (стр. 86) в 
меню Project полного меню.

[Совет]
При преобразовании из HDR в SDR с помощью SR 
Live Metadata после съемки, применяется значение 
параметра SDR Gain с тем, чтобы при отображении 
изображения SDR экспозиция была такой же, как при 
просмотре в видоискателе во время съемки.

Флаги клипов

Чтобы добавить в клип флаг клипа OK, 
нажмите кнопку Clip Flag (стр. 5) и 
выберите Add OK.
Чтобы удалить флаг клипа OK, дважды 
нажмите эту кнопку и выберите Delete Clip 
Flag.

[Советы]
ˎˎ Для добавления флагов клипов можно также 

использовать программируемую кнопку, которой 
назначена функция флага клипа (стр. 51).
ˎˎ Флаг клипа можно также добавить с помощью 

пункта Set Clip Flag (стр. 100) в меню Thumbnail 
полного меню (стр. 72).

Компенсация дыхания

Задать, следует ли компенсировать 
дыхание для объектива можно с помощью 
параметра Lens >Breathing Compensation 
(стр. 103) в меню Technical полного меню.
Эта функция корректирует явление, при 
котором угол обзора изменяется при 
перемещении положения фокуса.
При выполнении компенсации дыхания 
часть изображения электронным образом 
обрезается для поддержания неизменного 
угла обзора, чтобы избежать появления 
явления дыхания фокуса.

[Примечания]
ˎˎ Когда функция компенсации дыхания включена, 

угол обзора и качество изображения могут слегка 
измениться.
ˎˎ В некоторых случаях (которые зависят от 

объектива) скорректировать изменение угла 
обзора, когда включена функция компенсации 
дыхания, невозможно.
ˎˎ Компенсация дыхания невозможна, когда 

установлен объектив, который не поддерживает 
эту функцию.
ˎˎ В следующих случаях этой функции задается 

значение Off (без возможности изменения).
 – Если для параметра Lens >Distortion Comp. в 

меню Technical задано значение Off
 – Когда параметр S&Q Motion >Setting в меню 

Shooting имеет значение On
 – Если для параметра Rec Format >Codec в меню 

Project задано значение RAW или вариант, 
который включает в себя RAW

Регулировка боке (функция 
Bokeh Control)

Можно с легкостью отрегулировать степень 
эффекта боке, связав фильтр ND и усиление 
и операцией задания значения диафрагмы.

Включение и выключение функции 
управления боке

Включить эту функцию можно только при 
регулировке экспозиции вручную. Задайте 
ручной режим регулировки диафрагмы, 
усиления, выдержки и фильтра ND, после 
чего переведите фильтр ND в переменный 
режим.
Для включения и выключения функции 
управления боке используется пункт Iris 
>Bokeh Control (стр. 80) в меню Shooting 
полного меню.
Когда функция управления боке включена 
(On), на индикаторах фильтра ND и 
усиления отображается значок  . 

[Совет]
Функцию Bokeh Control также можно назначить 
программируемой кнопке (стр. 51), после чего 
включать и выключать данную функцию можно будет 
с помощью этой кнопки.

Регулировка степени эффекта боке

1 Включите функцию управления боке.

2 Определите экспозицию, 
отрегулировав фильтр ND и усиление.

3 Отрегулируйте диафрагму.
Степень эффекта боке изменится.
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[Советы]
ˎˎ Когда функция управления боке включена (On), 

значение фильтра ND и усиления совместно 
компенсируют изменение экспозиции, вызванное 
регулировкой диафрагмы, что позволяет менять 
степень эффекта боке.
ˎˎ Сначала управление боке связывается с фильтром 

ND в ответ на изменение диафрагмы. Когда 
менять значение фильтра ND будет невозможно, 
задействуется значение усиления.
ˎˎ В режиме MF рекомендуется сначала задать 

диафрагму, а затем отрегулировать фокус.
ˎˎ Если вместо функции управления боке 

используется автоматический фильтр ND, фильтр 
ND будет зависеть от изменения яркости объекта 
съемки.

Отображение, когда задействовано 
значение усиления

Когда функция управления боке включена, 
усиление может меняться по мере 
регулировки диафрагмы.
Когда связь с усилением активна и 
усиление меняется, в верхней части экрана 
отображается сообщение, а значок  на 
индикаторе усиления начинает мигать. 

[Примечания]
ˎˎ Эта функция может работать только при 

использовании объективов с байонетом E, которые 
могут обмениваться данными с устройством.
ˎˎ Максимального эффекта от этой функции можно 

добиться с помощью кольца регулировки 
диафрагмы на объективе Sony с байонетом E.
ˎˎ Внешний вид зависит от скорости работы, 

объектива, настроек и объекта съемки. Также 
может меняться яркость. Настоятельно 
рекомендуется выполнить тестирование с 
использованием камеры перед съемкой.
ˎˎ Яркость может меняться при изменении 

направления регулировки диафрагмы, например, 
при открытии диафрагмы после ее закрытия или 
при закрытии диафрагмы после ее открытия. 
В этом случае сначала поверните кольцо 
регулировки сильнее, чем требуется, а затем 
верните его немного назад, проверьте яркость и 
начните съемку.  
Например, если вы хотите открыть диафрагму 
до значения F8, чтобы замылить фон, сначала 
закройте диафрагму сильнее, чем F8, а затем 

верните кольцо на значение F8, проверьте яркость 
и начните съемку.
ˎˎ Выполнять управление боке следует медленно. 

Если работу требуется ускорить, постараетесь 
производить регулировку постепенно, постоянно 
проверяя, как меняется изображение.
ˎˎ Качество изображения при управлении боке не 

гарантируется в любых условиях съемки.
ˎˎ При выполнении любых из перечисленных далее 

операций функция управления боке отключается.
 – Когда видеокамера выключается
 – Когда регулировка диафрагмы, усиления, 

выдержки или фильтра ND переводится в 
автоматический режим

 – При переключатель режима съемки
 – Когда фильтр ND переводится в режим Clear или 

Preset
 – При снятии объектива
 – При перезапуске видеокамеры, например после 

переключения частоты
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Запись прокси
Эта функция позволяет записывать прокси-
данные низкого разрешения одновременно 
с записью исходных видеоданных высокого 
разрешения.

Сведения о поддерживаемых картах памяти, 
форматировании карт памяти и проверке оставшейся 
емкости см. в разделе “Использование карт памяти” 
(стр. 27).

Настройка перед съемкой

1 Задайте для параметра Proxy Rec 
(стр. 15) на экране состояния Project 
или параметра Proxy Rec >Setting 
(стр. 86) в меню Project полного меню 
значение On.

2 Установите карту памяти в гнездо для 
карт CFexpress Type A/SD-карт 
(стр. 6).
ˎˎ Для карт CFexpress этикетка 
обращена влево.
ˎˎ Для SD-карт этикетка обращена 
вправо, а скошенный угол находится 
внизу.

[Примечание]
Для параметра Proxy Rec невозможно задать 
значение On одновременно с параметрами S&Q 
Motion или Interval Rec. При задании для параметра 
Proxy Rec значения On для остальных режимов 
записи принудительно устанавливается значение Off.

Запись прокси

После задания необходимых настроек для 
съемки нажмите кнопку START/STOP (пуск/
остановка записи), чтобы начать съемку.

[Примечания]
ˎˎ Если видеокамера выключается, когда карта 

памяти используется, или карта памяти 
извлекается в этот момент, целостность 
находящихся на карте памяти данных не 
гарантируется. Все данные, записанные на карту 
памяти, могут быть потеряны. Перед выключением 
видеокамеры или извлечением карты памяти 
необходимо обязательно убедиться, что 
индикатор доступа к карте памяти не горит.
ˎˎ При установке или извлечении карты памяти 

следите, чтобы она не выскочила из гнезда.

Для выхода остановите съемку.

Задание аудоиканала для 
записи прокси

Выберите пункт Proxy Rec >Audio Channel 
(стр. 86) в меню Project полного меню 
и задайте аудиоканал для записи данных 
прокси.

О записанном файле

Файл имеет расширение “.mp4”.
Одновременно записывается временной 
код.

Место сохранения записанного 
файла

Записанный файл сохраняется в 
следующем каталоге.

Носитель для 
записи

Путь к папке

SDXC /PRIVATE/XDROOT/Sub

CFexpress Type A /XDROOT/Sub

Об имени файла

Имя файла состоит из названия клипа, 
записанного на карту памяти, и суффикса 
“S03”.
Подробные сведения о названиях клипов 
см. в пункте Clip Name Format (стр. 94) в 
меню TC/Media полного меню.
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Съемка с требуемым видом
Когда в видеокамере установлен режим 
Custom, можно добавить регулировки 
черного, матрицы и других параметров для 
создания “вида” на основе базового вида.

：

Вид

Матрица

Черный

Базовый вид

Можно также быстро выбрать другой вид, 
если сохраните другие сочетания настроек 
в файлах сцен.
Видеокамера поставляется с шестью 
предварительно настроенными видами.

Выбор вида

1 При открытом экране съемки нажмите 
многофункциональный диск.

2 Выберите значок  (файл сцены).

3 Нажмите многофункциональный диск.

4 Выберите требуемый вид в меню и 
нажмите многофункциональный диск.

[Советы]
ˎˎ Следующие предварительно заданные настройки 

сконфигурированы по умолчанию.

Shooting Mode Custom

Target Display SDR(BT.709) HDR(HLG)

Файл сцены 1 S-Cinetone HLG Live

Файл сцены 2 Standard HLG Natural

Файл сцены 3 Фото (Не зарегистрирован)

Файл сцены 4 ITU709 (Не зарегистрирован)

Файл сцены  
5–16

(Не зарегистрирован) (Не зарегистрирован)

ˎˎ Вид можно также выбрать с помощью пункта 
Scene File (стр. 14) на экране Main Status или 
пункта Scene File >Recall (стр. 91) в меню Paint/
Look полного меню. Предварительно заданный 
вид можно также вызвать с помощью пункта Scene 
File >Preset Recall.

Импорт требуемого базового 
вида

Можно импортировать созданный на 
компьютере или другом устройстве файл 
3D LUT в качестве базового вида. Можно 
импортировать не более 16 файлов.
ˎˎ Формат файла: файл CUBE (*.cube) для 
17-точечной или 33-точечной таблицы 
соответствия 3D LUT, созданный 
с помощью программы Catalyst Browse, 
RAW Viewer или DaVinci Resolve* (от 
компании Blackmagic Design Pty. Ltd.).
* Проверено с программой Resolve V9.0, V10.0 и 

V11.0.

ˎˎ Входное цветовое пространство/гамма: 
S-Gamut3.Cine/S-Log3 или S-Gamut3/S-Log3

1 На компьютере или другом устройстве 
сохраните файл 3D LUT в указанной 
папке или на носителе для записи.

Носитель для 
записи

Путь к папке

SDXC /PRIVATE/SONY/PRO/LUT/

CFexpress Type 
A

/SONY/PRO/LUT/

2 Вставьте носитель для записи, на 
котором сохранены файлы 3D LUT, в 
гнездо для карт CFexpress Type A/
SD-карт (B).

3 Выберите Base Look >Import (стр. 91) 
в меню Paint/Look полного меню.

4 Выберите место назначения для импорта.

5 Выберите импортируемый файл 3D LUT.
Следуйте инструкциям на экране. 
Видеокамера обрабатывает файл 3D LUT 
как базовый вид.

6 Выберите импортированный файл 3D 
LUT с помощью пункта Base Look >Select 
(стр. 91) в меню Paint/Look полного 
меню.

7 Настройте параметры Base Look >Input 
и Output (стр. 91) в меню Paint/Look 
полного меню в соответствии с 
атрибутами импортированного файла 
3D LUT.

Регулировка в случае недостаточной 
экспозиции

Если при автоматической экспозиции с 
выбранным импортированным базовым 
видом наблюдается тенденция к 
недостаточной экспозиции, настройте 
параметр Base Look >AE Level Offset 
(стр. 91) в меню Paint/Look.

[Примечания]
ˎˎ Если просто импортировать файл 3D LUT, 

это не повлияет на изображение. Загрузите 
импортированный файл 3D LUT с помощью пункта 
Base Look >Select (стр. 91) в меню Paint/Look 
полного меню.
ˎˎ Если параметр Input задан неправильно, 

требуемый вид не будет получен.
ˎˎ Настройки пунктов меню Input, Output и AE Level 

Offset применяются к базовому виду, выбранному 
с помощью пункта Select. Если импортировано 
несколько файлов 3D LUT, выберите пункт Select 
для каждого файла 3D LUT и настройте параметры 
Input, Output, и AE Level Offset отдельно для 
каждого файла.
ˎˎ Заданные настройки Input, Output и AE Level Offset 

сохраняются для каждого файла 3D LUT.
ˎˎ Варианты выбора базового вида/LUT для 

импортированных файлов 3D LUT являются 
общими для режимов SDR(BT.709)/HDR(HLG)/
Cine EI, но преобразование цветового 
пространства и гамма-кривой в соответствии с 
этими режимами не выполняется.
ˎˎ Файлы 3D LUT не удаляются при выполнении 

пункта All Reset >Reset в меню Maintenance 

полного меню.
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Настройка вида

Вид можно настроить на основе базового 
вида с помощью пункта Matrix и других 
пунктов настройки в меню Paint/Look 
полного меню. Подробнее о каждом пункте 
настройки см. в разделе стр. 91.
Подключите видеокамеру к телевизору 
или монитору и настройте качество 
изображения, контролируя его на экране 
телевизора или монитора.

[Примечание]
При импорте файла 3D LUT и применении его к 
изображению требуемый вид, определенный в 
файле 3D LUT, не будет получен, если в меню Paint/
Look были изменены настройка Matrix и другие 
настройки, отличные от настроек базового вида. Все 
измененные настройки можно сбросить с помощью 
пункта Reset Paint Settings >Reset without Base Look 
(стр. 91) в меню Paint/Look полного меню.

Сохранение вида

С помощью пункта Scene File >Store 
(стр. 91) в меню Paint/Look полного меню 
можно сохранить текущий вид как файл 
сцены во внутренней памяти.
Возможно быстрое сохранение с помощью 
вызова прямого меню с экрана съемки.

[Примечания]
ˎˎ Если выбрать другой вид без сохранения текущего 

вида, текущий вид будет удален.
ˎˎ Файлы сцен не удаляются при выполнении пункта 

All Reset >Reset (стр. 109) в меню Maintenance 
полного меню.

[Совет]
Предварительно заданные файлы сцен можно 
перезаписать.
Чтобы восстановить предварительно заданный файл 
сцены, загрузите восстанавливаемый вид с помощью 
пункта Scene File >Preset Recall (стр. 91) в меню 
Paint/Look полного меню, затем сохраните файл 
сцены с помощью пункта Scene File >Store.

Удаление сохраненного вида

С помощью пункта Scene File >Delete 
(стр. 91) в меню Paint/Look полного меню 
можно удалить файл сцены из внутренней 
памяти.

[Совет]
Удаленный файл больше не будет отображаться в 
прямом меню.

Удаление базового вида

Импортированный файл 3D LUT можно 
удалить с помощью пункта Base Look 
>Delete (стр. 91) в меню Paint/Look 
полного меню.
Можно удалить все импортированные 
файлы 3D LUT с помощью пункта Base Look 
>Delete All (стр. 91) в меню Paint/Look 
полного меню.

[Примечания]
ˎˎ Перед удалением убедитесь, что базовый вид 

не используется ни в одном из файлов сцен. 
Если будет удален используемый базовый вид, 
вид из соответствующих файлов сцен будет 
неправильным.
ˎˎ Импортированные файлы 3D LUT не удаляются при 

выборе пункта All Reset >Reset (стр. 109) в меню 
Maintenance полного меню.
ˎˎ Удаленный базовый вид больше не может 

использоваться как таблица LUT в режиме Cine EI 
(стр. 60).
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Съемка с последующей регулировкой вида в студии
Используя видеокамеру в режиме Cine EI 
и равномерно записывая градации от 
темных до ярких областей, впоследствии в 
студии можно выполнять тонкую настройку, 
например локально восстанавливая 
градации в темных и ярких областях.
Однако при просмотре снятых изображений 
на обычном мониторе общая контрастность 
будет выглядеть низкой, что затрудняет 
регулировку фокусировки и экспозиции.
Можно применить таблицу соответствия 
LUT к целевому монитору на видеокамере, 
чтобы упростить различные регулировки 
во время съемки. Можно также 
применить таблицу соответствия LUT к 
воспроизводимому видео для проверки 
конечного результата.
Таблицы соответствия LUT применяются 
следующими системами. Однако 
можно применить только одну таблицу 
соответствия LUT.
ˎˎ Выход SDI и выход HDMI
ˎˎ Видоискатель и изображения прокси, 
потоковая трансляция
ˎˎ Видео, записанное на носитель для записи

Применение таблицы LUT к 
изображению на видоискателе

1 Нажмите кнопку MENU для 
отображения экрана Monitoring Status.

2 Выберите столбец Gamut/Gamma в 
строке VF.

3 Выберите On или Off.

[Примечания]
ˎˎ Настройка LUT On/Off в строке VF также 

применяется к файлу прокси и потоковому видео.
ˎˎ При использовании увеличения для фокусировки 

доступна функция Gamma Display Assist.

[Советы]
ˎˎ Можно также задать значение с помощью 

параметра LUT On/Off >VF/Proxy/Stream (стр. 83) 
в меню Shooting полного меню.
ˎˎ SDI/HDMI можно задать аналогично строке VF.
ˎˎ Для видеозаписей на носителе для записи можно 

задать значение с помощью параметра LUT On/Off 
>Internal Rec (стр. 83) в меню Shooting полного 
меню.

Изменение таблицы 
соответствия LUT

1 Нажмите кнопку MENU для 
отображения экрана Monitoring Status.

2 Выберите поле Base Look/LUT.

3 Выберите применяемую таблицу LUT из 
списка базовых видов.

[Советы]
ˎˎ Можно также импортировать и применить файл 

3D LUT. Для базового вида можно выбрать s709, 
709(800%) или S-Log3. Подробнее см. в разделах 
“Импорт требуемого базового вида” (стр. 58) и 
“Удаление базового вида” (стр. 59).
ˎˎ Базовый вид можно также задать с помощью 

пункта Base Look >Select (стр. 91) в меню Paint/
Look полного меню.

Изменение распределения 
темных и ярких областей в 
записанном видео

Можно изменить распределение темных и 
ярких областей, например, если требуется 
задать приоритет тона темных областей 
над тоном ярких областей, изменив 
значение параметра Exposure Index в 
базовой чувствительности.

1 Примените таблицу LUT к изображению 
на видоискателе (стр. 60).

2 Нажмите кнопку MENU для 
отображения экрана Camera Status.

3 Задайте поля L/M/H пункта Exposure 
Index.
Отдельные настройки назначаются 
положениям L/M/H переключателя 
ISO/GAIN (стр. 5).

4 Выберите значение Exposure Index, 
которое требуется применить с 
помощью переключателя ISO/GAIN.

5 Настройте требуемую экспозицию 
изображения в видоискателе.

[Примечание]
При использовании увеличения для фокусировки 
доступна функция Gamma Display Assist. Настройка 
Exposure Index не применяется в режиме Gamma 
Display Assist.

[Советы]
ˎˎ Экспозицию можно также настроить с помощью 

пункта ISO/Gain/EI >Exposure Index (стр. 79) в 
меню Shooting полного меню.
ˎˎ Второе числовое значение настройки указывает, 

сколько ступеней информации о яркости 
назначено ярким областям (с яркостью более 18% 
серого). Более яркие области будут передержаны.  

Пример: в “400EI/5.0E,” 5,0 ступеней назначены 
яркой стороне.
ˎˎ Это можно также использовать как руководство 

для проверки темных и ярких областей 
перед съемкой. Например, если положение 
M соответствует базовой чувствительности, 
положение L соответствует минус 2 ступеням, а 
положение H — плюс 2 ступеням, для проверки 
можно изменять положение переключателя ISO/
GAIN. После проверки экспозиции не забудьте 
вернуть переключатель в положение M.
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Выходной видеосигнал RAW с разъема SDI 
OUT или разъема HDMI OUT видеокамеры 
можно записывать на внешнее устройство 
записи.

Запись сигнала с разъема SDI 
OUT

1 Подключите внешнее устройство 
записи RAW к разъему SDI OUT 
видеокамеры.

2 С помощью экрана состояния Project 
(стр. 15) или параметра Base Setting 
>Shooting Mode (стр. 84) в меню 
Project полного меню задайте режим 
съемки Cine EI.

3 Задайте режим развертки (только FF) с 
помощью параметра Imager Scan на 
экране состояния Project или параметра 
Rec Format >Imager Scan Mode 
(стр. 84) в меню Project полного 
меню.

4 С помощью экрана состояния Project 
или параметра Rec Format >Codec 
(стр. 84) в меню Project полного меню 
задайте кодек, который включает в себя 
формат RAW.
При выборе значения RAW & XAVC-I 
одновременно записываются на 
внешнее устройство записи RAW и 
видеосигнал на карты памяти 
в видеокамере.

5 Задайте разрешение с помощью 
экрана состояния Project или параметра 
Rec Format >RAW Output Format 
(стр. 84) в меню Project полного 
меню.

6 Убедитесь, что внешнее устройство 
записи включено, затем нажмите 
кнопку START/STOP (пуск/остановка 
записи) на видеокамере.

 [Примечание]
Если запустить запись на внешнем устройстве 
записи без использования кнопки записи 
START/STOP на видеокамере, клипы могут не 
записываться должным образом.

Ниже приведены поддерживаемые 
форматы выходных сигналов RAW.

Частота 
системы

Codec RAW Output 
Format

59.94/
50/
29.97/
25/
23.98

RAW 4096×2160

3840×2160

RAW & XAVC-I 4096×2160

3840×2160

24 RAW 4096×2160

RAW & XAVC-I 4096×2160

Запись сигнала с разъема HDMI 
OUT

1 Подключите внешнее устройство 
записи RAW к разъему HDMI OUT 
видеокамеры.

2 С помощью экрана состояния Project 
(стр. 15) или параметра Base Setting 
>Shooting Mode (стр. 84) в меню 
Project полного меню задайте режим 
съемки Cine EI.

3 Задайте режим развертки (только FF) с 
помощью параметра Imager Scan на 
экране состояния Project или параметра 
Rec Format >Imager Scan Mode 
(стр. 84) в меню Project полного 
меню.

4 С помощью экрана состояния Project 
или параметра Rec Format >Codec 
(стр. 84) в меню Project полного меню 
задайте кодек RAW(HDMI).
При выборе значения RAW(HDMI) & 
XAVC-I одновременно записываются на 
внешнее устройство записи RAW и 
видеосигнал на карты памяти 
в видеокамере.

5 Убедитесь, что внешнее устройство 
записи включено, затем нажмите 
кнопку START/STOP (пуск/остановка 
записи) на видеокамере.

[Примечание]
Если запустить запись на внешнем устройстве 
записи без использования кнопки записи START/
STOP на видеокамере, клипы могут не записываться 
должным образом.

Ниже приведены поддерживаемые 
форматы выходных сигналов RAW.

Частота 
системы

Codec RAW Output 
Format

59.94/
50/
29.97/
25/
23.98

RAW(HDMI) 4240×2392

RAW(HDMI) & 
XAVC-I

4240×2392

Индикатор состояния записи

Если для параметра Display On/Off 
(стр. 95) >RAW Output Control Status 
в меню Monitoring полного меню 
задано значение On, состояние записи 
RAW обозначается значком на экране 
видоискателя.

[Примечание]
Сигнал управления записью выводится на разъем 
SDI OUT видеокамеры, но получить состояние 
внешнего устройства записи невозможно. 
Соответственно, видеокамера может показывать, что 
выполняется видеозапись RAW, когда фактически 
внешнее устройство записи ничего не записывает. 
Для получения правильного состояния работы 
проверяйте индикатор на внешнем устройстве 
записи.

[Совет]
Отображается также значение параметра RAW 
Output Format.

Съемка с замедлением/
ускорением движения

Если для параметра S&Q Motion >Setting 
в меню Shooting задано значение On, 
видеосигнал RAW записывается в режиме 
съемки с замедлением/ускорением 
движения.
Подробные сведения о поддерживаемых 
значениях частоты кадров при съемке см. 
на стр. 52.

[Примечание]
Запись с замедлением/ускорением движения через 
разъем HDMI OUT не поддерживается.

Запись видео в формате RAW
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Подключение к другим устройствам по локальной сети
Видеокамера может подключаться 
к смартфонам, планшетам и другим 
устройствам по локальной сети.
Установление подключения по локальной 
сети между устройством и видеокамерой 
позволяет выполнять следующие действия 
с помощью приложения “Content Browser 
Mobile”.
ˎˎ Дистанционное управление 
Видеокамерой можно управлять со 
смартфона или планшета, подключенного 
к видеокамере по локальной сети.
ˎˎ Передача файлов 
Можно передавать на сервер по 
локальной сети файл прокси (низкого 
разрешения) или оригинальный файл 
(высокого разрешения), записанный на 
карту памяти в видеокамере.
ˎˎ Контроль видео 
Можно контролировать изображение 
на камере или воспроизводить видео из 
видеокамеры с помощью приложения 
“Content Browser Mobile” на другом 
устройстве.

 [Примечание]
 При следующих параметрах просмотр видео не 

поддерживается.
 – Режим Slow & Quick Motion
 – Частота системы 24
 – Режим Interval Rec

Приложение “Content Browser Mobile”

С помощью приложения “Content Browser 
Mobile” можно дистанционно управлять 
видеокамерой с экрана другого устройства, 
просматривая видеоизображение 
с видеокамеры, а также задавать настройки 
видеокамеры.

Подробные сведения о приложении “Content Browser 
Mobile” можно получить у представителя службы 
технического обслуживания компании Sony.

Задание имени пользователя и 
пароля

Имя пользователя и пароль видеокамеры 
необходимо задать, чтобы можно было 
использовать сетевые функции.

1 Задайте значение параметра Access 
Authentication >User Name (стр. 104) 
в меню Network полного меню.

2 Задайте значение параметра Access 
Authentication > Input Password 
(стр. 104) в меню Network полного 
меню.

 [Советы]
ˎˎ Пароль также можно сформировать 

автоматически. Для этого выберите команду 
Generate Password, а не команду Input 
Password.
ˎˎ Имя пользователя, пароль, текст и QR-код 

можно отобразить с помощью команды Show 
Settings.

 [Примечание]
Следите за тем, чтобы QR-код и пароль не 
увидели посторонние.

Подключение с использованием 
режима точки доступа 
беспроводной локальной сети

Видеокамера выполняет функции точки 
доступа и подключается к устройству по 
беспроводной локальной сети.

Смартфон/планшет

Подключение к устройству с 
поддержкой NFC одним касанием

Устройства, поддерживающие NFC, можно 
подключить (одним касанием) с помощью 
NFC.

1 Откройте меню [Settings] на устройстве, 
выберите [More] и установите флажок 
NFC.

2 Включите видеокамеру.

3 Включите функцию NFC.
Нажмите и удерживайте (в течение 3 с) 
программируемую кнопку, которой 
назначена функция NFC, или выберите 
пункт Wireless LAN >NFC в меню 
Network, чтобы включить режим 
подключения по NFC.
Функция NFC доступна только тогда, 
когда на экране отображается значок .

4 Прикоснитесь к видеокамере 
устройством.
Устройство подключается к 
видеокамере, и запускается 
приложение “Content Browser Mobile”.

 [Примечания]
ˎˎ Заранее отключите спящий режим и 

блокировку экрана.
ˎˎ Коснитесь устройством видеокамеры 

и удерживайте его, пока не запустится 
приложение “Content Browser Mobile” (1–2 
секунды).
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Подключение к устройству, 
поддерживающему WPS

Устройства, поддерживающие WPS, можно 
подключать с использованием WPS.

1 Выберите пункт Wireless LAN >Setting 
>Access Point Mode в меню Network 
полного меню.

2 Выберите пункт Wireless LAN >WPS 
>Execute в меню Network полного меню.

3 Откройте настройки сети или 
настройки Wi-Fi на устройстве и 
включите Wi-Fi.

4 Выберите SSID видеокамеры в списке 
SSID сети Wi-Fi на устройстве, затем 
выберите WPS Push Button в пункте 
Option на устройстве для подключения.

 [Примечания]
ˎˎ Способ выполнения операций зависит от 

конкретного устройства.
ˎˎ SSID и пароль видеокамеры можно 

проверить в пункте AP Mode Settings >Camera 
SSID & Password (стр. 104) в меню Network 
полного меню.

5 Подключитесь с помощью приложения 
Content Browser Mobile.

 [Совет]
Информацию, требуемую для подключения 
устройства, можно проверить с помощью пункта 
Access Authentication >Show Settings (стр. 104) 
в меню Network полного меню.

Подключение с вводом SSID и пароля 
на устройстве

Видеокамеру можно подключить 
к устройству, введя SSID и пароль 
видеокамеры на устройстве.

1 Выберите пункт Wireless LAN >Setting 
>Access Point Mode в меню Network 
полного меню.

2 Откройте настройки сети или 
настройки Wi-Fi на устройстве и 
включите Wi-Fi.

3 Подключите устройство к видеокамере, 
выбрав SSID видеокамеры в списке SSID 
сети Wi-Fi и введя пароль.
SSID и пароль видеокамеры можно 
проверить в пункте AP Mode Settings 
>Camera SSID & Password (стр. 104) в 
меню Network.

 [Примечание]
Способ выполнения операций зависит от 
конкретного устройства.

4 Подключитесь с помощью приложения 
Content Browser Mobile.

 [Совет]
Информацию, требуемую для подключения 
устройства, можно проверить с помощью пункта 
Access Authentication >Show Settings (стр. 104) 
в меню Network полного меню.

Подключение с использованием 
режима станции беспроводной 
локальной сети

Видеокамера подключается к 
существующей точке доступа 
беспроводной сети в качестве клиента. 
Видеокамера и устройство подключаются 
через точку доступа.
В журнале отображаются 10 последних 
использовавшихся точек доступа.
Журнал подключения сохраняется в файле 
ALL, но пароли доступа не сохраняются. При 
следующем подключении после загрузки 
файла ALL требуется ввести пароль.

Смартфон/
планшет

Точка доступа

Компьютер

Подключение к точке доступа с 
помощью функции WPS

Если точка доступа поддерживает функцию 
WPS, к точке доступа можно подключиться 
с помощью простой настройки.

1 Включите точку доступа.

2 Включите видеокамеру.

3 Выберите пункт Wireless LAN >Setting > 
Station Mode в меню Network полного 
меню.

4 Выберите пункт ST Mode Settings 
>Camera Remote Control (стр. 105) 
>Enable в меню Network полного меню.

5 Выберите пункт Wireless LAN >WPS 
>Execute в меню Network полного меню.

6 Нажмите кнопку WPS на точке доступа.
Сведения об использовании кнопки 
WPS см. в инструкции по эксплуатации 
точки доступа.
После успешного подключения значок 
индикатора состояния сети на экране 
видоискателя показывает силу сигнала 
1 или выше.

 [Примечание]
В случае сбоя подключения повторите 
операцию, начиная с шага 1.

7 Подключите устройство к точке доступа.
Сведения о подключении см. в 
инструкции по эксплуатации 
устройства.

8 Запустите приложение “Content Browser 
Mobile” на устройстве и выберите 
видеокамеру.
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 [Совет]
Информацию, требуемую для подключения 
устройства, можно проверить с помощью пункта 
Access Authentication >Show Settings (стр. 104) 
в меню Network полного меню.

Подключение с помощью функции 
автоматического обнаружения точки 
доступа

1 Выполните шаги с 1 по 3 из раздела 
“Подключение к точке доступа с 
помощью функции WPS” (стр. 63).

2 Выберите пункт ST Mode Settings >Scan 
Networks (стр. 105) >Execute в меню 
Network полного меню.
Видеокамера начинает обнаружение 
точек для подключения.
Обнаруженные возможные варианты 
подключения отображаются в виде 
списка.

3 Выберите из списка точку для 
подключения.
Открывается экран сведений о сети 
(точке доступа). Выбранное 
подключение отображается в поле SSID.

4 Выберите Password и введите пароль 
для точки доступа, к которой 
производится подключение, на экране 
ввода пароля.
При выборе идентификатора SSID в 
журнале подключений настройки 
задаются автоматически, включая 
пароль.
Задайте пароль, чтобы вернуться на 
экран сведений о сети (точке доступа).

5 Задайте следующие параметры 
подключения.
ˎˎ DHCP 
Задайте настройки DHCP.  
Если задано значение On, IP-
адрес назначается видеокамере 
автоматически.  
Чтобы задать IP-адрес видеокамеры 
вручную, задайте значение Off.
ˎˎ IP Address 
Введите IP-адрес устройства.  
Эта настройка доступна только в том 
случае, если для параметра DHCP 
задано значение Off.
ˎˎ Subnet Mask 
Введите маску подсети устройства.  
Эта настройка доступна только в том 
случае, если для параметра DHCP 
задано значение Off.
ˎˎ Gateway 
Введите шлюз для точки доступа.  
Эта настройка доступна только в том 
случае, если для параметра DHCP 
задано значение Off.
ˎˎ DNS Auto 
Задает, требуется ли получать DNS 
автоматически.  
Если задано значение On, 
адрес сервера DNS получается 
автоматически. Эта настройка 
доступна только в том случае, если 
для параметра DHCP задано значение 
On.
ˎˎ Primary DNS Server 
Введите основной сервер DNS для 
точки доступа.  
Эта настройка доступна только в том 
случае, если для параметра DNS Auto 
задано значение Off.
ˎˎ Secondary DNS Server 
Введите дополнительный сервер DNS 
для точки доступа.  
Эта настройка доступна только в том 
случае, если для параметра DNS Auto 
задано значение Off.

6 После завершения выберите Connect 
для подключения к точке доступа.

7 Подключите устройство к точке доступа.
Сведения о подключении см. в 
инструкции по эксплуатации 
устройства.

8 Запустите приложение “Content Browser 
Mobile” на устройстве и выберите 
видеокамеру.

 [Совет]
Информацию, требуемую для подключения 
устройства, можно проверить с помощью пункта 
Access Authentication >Show Settings (стр. 104) 
в меню Network полного меню.

Подключение вручную путем ввода 
информации о точке доступа

1 Выполните шаги с 1 по 3 из раздела 
“Подключение к точке доступа с 
помощью функции WPS” (стр. 63).

2 Выберите пункт ST Mode Settings 
>Manual Register (стр. 106) >Execute в 
меню Network полного меню.
Сразу открывается экран сведений о 
сети (точке доступа).

3 Задайте следующие параметры 
подключения.
ˎˎ SSID 
Введите идентификатор SSID 
подключаемой точки доступа.
ˎˎ Security 
Введите способ шифрования.
ˎˎ Password 
Введите пароль для подключаемой 
точки доступа.
ˎˎ DHCP 
Задайте настройки DHCP.  
Если задано значение On, IP-
адрес назначается видеокамере 
автоматически.  

Чтобы задать IP-адрес видеокамеры 
вручную, задайте значение Off.
ˎˎ IP Address 
Введите IP-адрес устройства.  
Эта настройка доступна только в том 
случае, если для параметра DHCP 
задано значение Off.
ˎˎ Subnet Mask 
Введите маску подсети устройства.  
Эта настройка доступна только в том 
случае, если для параметра DHCP 
задано значение Off.
ˎˎ Gateway 
Введите адрес шлюза.  
Эта настройка доступна только в том 
случае, если для параметра DHCP 
задано значение Off.
ˎˎ DNS Auto 
Задает, требуется ли получать DNS 
автоматически.  
Если задано значение On, 
адрес сервера DNS получается 
автоматически. Эта настройка 
доступна только в том случае, если 
для параметра DHCP задано значение 
On.
ˎˎ Primary DNS Server 
Введите адрес основного сервера 
DNS.  
Эта настройка доступна только в том 
случае, если для параметра DNS Auto 
задано значение Off.
ˎˎ Secondary DNS Server 
Введите адрес дополнительного 
сервера DNS.  
Эта настройка доступна только в том 
случае, если для параметра DNS Auto 
задано значение Off.

4 После завершения выберите Connect 
для подключения к точке доступа.
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5 Подключите устройство к точке доступа.
Сведения о подключении см. в 
инструкции по эксплуатации 
устройства.

6 Запустите приложение “Content Browser 
Mobile” на устройстве и выберите 
видеокамеру.

 [Совет]
Информацию, требуемую для подключения 
устройства, можно проверить с помощью пункта 
Access Authentication >Show Settings (стр. 104) 
в меню Network полного меню.
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Видеокамеру можно подключать к 
Интернету с помощью кабеля USB, 
проводной ЛВС или беспроводной ЛВС.
Заранее задайте имя пользователя и 
пароль для видеокамеры (стр. 62).

Подключение с помощью 
кабеля USB

Устройство можно подключить к смартфону 
кабелем USB, затем подключить к 
Интернету с помощью смартфона.

Настройка связи со смартфоном

Включите связь по кабелю на смартфоне.
Дополнительную информацию см. в 
инструкции по эксплуатации смартфона.

Подключение смартфона 
к видеокамере

Подключите кабель USB к разъему USB-C 
(стр. 7) видеокамеры, затем подключите 
его к смартфону.

[Примечания]
ˎˎ Подключать и отключать смартфон следует при 

отключенном питании видеокамеры.
ˎˎ Подключение по кабелю USB не может 

использоваться, если смартфон подключен через 
концентратор USB.
ˎˎ Подключение по кабелю USB не может 

использоваться, если к разъему USB/
многоцелевому разъему (стр. 7) подключен 
компьютер.

Подключение к сети

1 Включите видеокамеру.

2 Задайте для параметра Modem >Setting 
(стр. 107) в меню Network полного 
меню значение On.

Включение работы со смартфона

Видеокамерой можно управлять 
дистанционно с помощью приложения 
Content Browser Mobile на смартфоне, 
подключенном с помощью кабеля USB.

1 Задайте для параметра Modem 
>Camera Remote Control (стр. 107) 
в меню Network полного меню 
значение Enable.

2 Запустите приложение “Content Browser 
Mobile” на смартфоне и выберите 
видеокамеру.

 [Совет]
Информацию, требуемую для подключения 
к видеокамере из приложения Content Browser 
Mobile, можно проверить с помощью пункта 
Access Authentication >Show Settings (стр. 104) 
в меню Network полного меню.

Подключение с использованием 
режима станции беспроводной 
локальной сети (Wi-Fi Station 
Mode)

Видеокамеру можно подключить 
к Интернету в режиме станции 
Wi-Fi с помощью дополнительно 
приобретаемого маршрутизатора Wi-Fi или 
с помощью кабеля Wi-Fi на смартфоне.
Подключитесь к маршрутизатору Wi-Fi 
или устройству, как описано в разделе 
“Подключение с использованием режима 

станции беспроводной локальной сети” 
(стр. 63).

Смартфон/
планшет

Маршрутизатор Wi-Fi

Компьютер

Интернет

Смартфон/
планшет

Интернет

Подключение с помощью 
кабеля ЛВС

Подключиться к Интернету можно, 
подключив разъем проводной ЛВС 
адаптера проводной ЛВС (не входит в 
комплект поставки), подключенного к 
разъему USB-C (стр. 7) видеокамеры, 
к маршрутизатору Wi-Fi (не входит в 
комплект поставки) с помощью кабеля ЛВС.

Смартфон/
планшет

Компьютер

Маршрутизатор Wi-Fi

Адаптер 
проводной ЛВС

Интернет

Подключение к Интернету
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Подключения кабеля ЛВС и настройки 
проводной ЛВС

1 Подсоедините адаптер проводной ЛВС 
к разъему USB-C видеокамеры.

2 Подключите разъем проводной ЛВС 
адаптера проводной ЛВС к 
маршрутизатору Wi-Fi с помощью 
кабеля ЛВС.

3 Включите видеокамеру.

4 Задайте для параметра Wired LAN 
>Setting (стр. 106) в меню Network 
полного меню значение On.

5 Настройте параметры подключения с 
помощью пункта Wired LAN >Detail 
Settings (стр. 106) в меню Network.
ˎˎ DHCP 
Задайте настройки DHCP.  
Если задано значение On, IP-
адрес назначается видеокамере 
автоматически.  
Чтобы задать IP-адрес видеокамеры 
вручную, задайте значение Off.
ˎˎ IP Address 
Введите IP-адрес устройства.  
Эта настройка доступна только в том 
случае, если для параметра DHCP 
задано значение Off.
ˎˎ Subnet Mask 
Введите маску подсети устройства.  
Эта настройка доступна только в том 
случае, если для параметра DHCP 
задано значение Off.
ˎˎ Gateway 
Введите адрес шлюза.  
Эта настройка доступна только в том 
случае, если для параметра DHCP 
задано значение Off.

ˎˎ DNS Auto 
Задает, требуется ли получать DNS 
автоматически.  
Если задано значение On, 
адрес сервера DNS получается 
автоматически. Эта настройка 
доступна только в том случае, если 
для параметра DHCP задано значение 
On.
ˎˎ Primary DNS Server 
Введите адрес основного сервера 
DNS.  
Эта настройка доступна только в том 
случае, если для параметра DNS Auto 
задано значение Off.
ˎˎ Secondary DNS Server 
Введите адрес дополнительного 
сервера DNS.  
Эта настройка доступна только в том 
случае, если для параметра DNS Auto 
задано значение Off.

6 После завершения выберите Set, чтобы 
применить настройки.

[Примечания]
ˎˎ Обязательно выбирайте Set после изменения 

настроек подключения. Если не выбрать Set, 
настройки не применяются.
ˎˎ Используйте адаптер проводной ЛВС с разъемом 

USB Type C. Рекомендуется использовать адаптер, 
поддерживающий гигабитный Ethernet. Однако 
работа на всех устройствах не гарантируется.
ˎˎ Адаптер проводной ЛВС с разъемом USB 

(не входит в комплект поставки) не может 
использоваться, если к разъему USB/
многоцелевому разъему (стр. 7) подключен 
компьютер.
ˎˎ В зависимости от модели адаптера проводной 

ЛВС (не входит в комплект поставки) возможно 
нарушение работы встроенной функции связи по 
Wi-Fi.

Включение работы со смартфона 
через проводную ЛВС

Для дистанционного управления 
видеокамерой с помощью приложения 
Content Browser Mobile на смартфоне через 
Wi-Fi, используя маршрутизатор Wi-Fi, 
подключенный к проводной сети, задайте 
для параметра Wired LAN >Camera Remote 
Control (стр. 106) в меню Network полного 
меню значение Enable.



4. Сетевые функции68

Отправка файлов
Записанный видеокамерой файл прокси 
или оригинальный файл можно отправить 
на сервер в Интернете или на сервер в 
локальной сети через смартфоны или через 
точку доступа.

Подготовка

Подключение к сети

Подключите видеокамеру к Интернету или 
локальной сети, как описано в разделе 
“Подключение к Интернету” (стр. 66) или 
“Подключение к другим устройствам по 
локальной сети” (стр. 62).

Регистрация места назначения 
передачи файлов

Заранее зарегистрируйте сервер для 
отправки.

1 Выберите File Transfer >Server Settings1 
(или Server Settings2, Server Settings3) в 
меню Network полного меню.
Открывается экран настройки пункта 
назначения передачи.

2 Задайте каждый параметр на экране 
настройки пункта назначения 
передачи.
Display Name
Введите имя сервера для отображения 
в списке пунктов назначения передачи.
Service
Отображается тип сервера.
“FTP”: FTP-сервер
Host Name
Введите адрес сервера.

Port
Введите номер порта для подключения 
к серверу.
User Name
Введите имя пользователя.
Password
Введите пароль.
Passive Mode
Включение и выключение пассивного 
режима.
Destination Directory
Введите имя каталога на целевом 
сервере.

 [Примечания]
ˎˎ При редактировании “” обозначает 

символы, изменить которые невозможно. 
При редактировании имени каталога, 
содержащего эти символы, правильная работа 
не гарантируется.  
Если требуется редактирование, удалите все 
символы и введите значение заново.
ˎˎ Если в параметр Destination Directory введены 

символы, недопустимые на целевом сервере, 
файлы будут переданы в главный каталог 
пользователя. Недопустимые символы зависят 
от сервера.

Using Secure Protocol
Задает, требуется ли выполнять 
безопасную отправку по FTP.
Root Certificate
Загрузка или очистка сертификата.
ˎˎ Load 
Выберите Set на шаге 3, чтобы 
импортировать сертификат CA.

* Загружаемый сертификат должен иметь 
формат PEM с именем файла “certification.
pem”, и его необходимо записать в корневой 
каталог карты памяти, установленной в гнездо 
карты CFexpress Type A/SD-карты (B).

ˎˎ Clear 
Выберите Set на шаге 3, чтобы удалить 
сертификат CA.
ˎˎ None 
Не загружать и не удалять сертификат.

 [Примечания]
ˎˎ Перед импортом сертификата CA установите 

правильное время на часах видеокамеры.

ˎˎ При записи в формате XAVC-I 4096×2160P/ 
3840×2160P 59.94/50P пункт Load недоступен.
ˎˎ В состоянии с низким напряжением пункты 

Load/Clear для сертификата CA недоступны.

Root Certificate Status
Отображение состояния загрузки 
сертификата.
Reset
Сброс настроек в пункте Server Settings 
на значения по умолчанию.

3 После завершения выберите Set, чтобы 
применить настройки.
Обязательно выбирайте Set после 
изменения настроек. Если не выбрать 
Set, настройки не применяются.

Выбор файла и его отправка

Можно выбрать файлы прокси или 
оригинальные файлы, записанные на карты 
памяти, для передачи на сервер.

Отправка файла прокси на карте 
памяти с экрана эскизов

1 Подключите устройство к видеокамере 
по ЛВС (стр. 62).

2 Выберите Transfer Clip (Proxy) >Select 
Clip в меню Thumbnail полного меню.
Экран переключается с полного меню 
на экран эскизов.
Клипы можно передавать с экрана 
эскизов или с экрана отфильтрованных 
эскизов клипов.

3 Выберите клип, который необходимо 
перенести, и нажмите кнопку MENU.
Открывается экран подтверждения 
передачи.

4 Выберите Execute.
Файл прокси, соответствующий 
выбранному файлу, регистрируется как 
задание по передаче, после чего 
начинается отправка файла.
После успешной регистрации задания 
по передаче открывается экран 
результатов передачи.

5 Выберите OK.

Отправка всех файлов
Выберите All Clips вместо Select Clip на 
шаге 2, чтобы передать файлы прокси, 
соответствующие всем файлам.

[Примечание]
Можно передать не более 200 файлов.



4. Сетевые функции: Отправка файлов69

Отправка оригинального файла на 
карте памяти с экрана эскизов

1 Подключите устройство к видеокамере 
по ЛВС (стр. 62).

2 Выберите Transfer Clip >Select Clip в 
меню Thumbnail полного меню.
Экран переключается с полного меню 
на экран эскизов.
Клипы можно передавать с экрана 
эскизов или с экрана отфильтрованных 
эскизов клипов.

3 Выберите клип, который необходимо 
перенести, и нажмите кнопку MENU.
Открывается экран подтверждения 
передачи.

4 Выберите Execute.
Выбранный файл регистрируется как 
задание по передаче, после чего 
начинается отправка файла.
После успешной регистрации задания 
по передаче открывается экран 
результатов передачи.

5 Выберите OK.

Отправка всех файлов
Выберите All Clips вместо Select Clip на 
шаге 2, чтобы передать все файлы.

[Примечание]
Можно передать не более 200 файлов.

Проверка передачи файла

Состояние передачи файла можно 
проверить, выбрав File Transfer >View Job 
List (стр. 107) в меню Network полного 
меню.
Состояние передачи файла можно также 
проверить на экране приложения Content 
Browser Mobile.

[Совет]
Если для параметра File Transfer >Auto Upload (Proxy) 
(стр. 107) в меню Network полного меню задано 
значение On и имеется сетевое подключение, по 
завершении записи файлы прокси автоматически 
отправляются на сервер, указанный в пункте Default 
Upload Server (стр. 107).

[Примечания]
ˎˎ Можно зарегистрировать до 200 заданий 

передачи.
ˎˎ Список заданий сохраняется при выключении 

видеокамеры, но до 10 минут последней 
информации о ходе выполнения могут быть 
утрачены, если снять аккумулятор или выключить 
видеокамеру, предварительно не установив 
переключатель POWER в положение STANDBY.
ˎˎ Задания, добавленные после перехода в 

состояние низкого напряжения аккумулятора, не 
сохраняются в списке заданий.
ˎˎ Если во время передачи файла произошла 

ошибка, передача клипа с тем же именем, что и 
переданный клип, может не возобновиться — это 
зависит от настроек и состояния целевого сервера 
передачи. В таким случае проверьте настройки и 
состояние целевого сервера передачи.

Отправка с использованием 
протокола Secure FTP

Файлы можно отправлять в 
зашифрованном виде с использованием 
для подключения к целевому файловому 
серверу протокола FTPS в явном режиме 
(FTPES).

Настройка безопасной передачи по 
FTP

Для безопасной передачи по FTP задайте 
на целевом файловом сервере для 
параметра Using Secure Protocol значение 
ON и импортируйте сертификат.
Подробное описание конфигурации см. в 
разделе “Регистрация места назначения 
передачи файлов” (стр. 68).
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Экран эскизов
При нажатии кнопки THUMBNAIL (стр. 5) клипы, записанные на карту памяти, отображаются на экране в виде эскизов.
На экране эскизов можно выбрать клип и запустить его воспроизведение. Изображение может воспроизводиться в видоискателе или на внешнем мониторе.
При повторном нажатии кнопки THUMBNAIL экран эскизов будет закрыт и в видоискателе снова появится передаваемое камерой изображение.

[Примечание]
На экране эскизов отображаются только клипы, записанные в выбранном в данный момент формате. Если нужного клипа нет на экране, проверьте формат записи. На это следует обращать особое внимание перед 
форматированием (инициализацией) носителя.

Компоновка экрана

В нижней части экрана отображается информация о клипе, на который наведен курсор.

4 5

6

3

1

2

Индикатор текущей выбранной карты памяти
(Если карта памяти защищена, отображается значок замка.)

Курсор (желтый)

Номер клипа/общее количество клипов

1. Эскиз (индексное изображение)
Отображает индексное изображение 
клипа. После записи клипа его первый 
кадр автоматически задается в качестве 
индексного изображения.
Информация о клипе/кадре отображается 
под эскизом. Отображаемую информацию 
можно изменить с помощью пункта 
Customize View (стр. 100) >Thumbnail 
Caption меню Thumbnail полного меню.

2. Название клипа
Отображает имя выбранного клипа.

3. Формат записи видео
Отображает формат файла выбранного 
клипа.

4. Информация об особой записи
Отображает режим записи, но только в том 
случае, если клип был записан в особом 
режиме.
В отношении клипов, записанных в режиме 
с замедлением/ускорением движения, 
справа отображается частота кадров.

5. Длительность клипа

6. Дата создания



5. Экран эскизов71

Воспроизведение клипов

Воспроизведение записанных 
клипов

Воспроизводить записанные клипы можно, 
когда видеокамера находится в режиме 
ожидания записи (Stby).

1 Вставьте карту памяти для 
воспроизведения.

2 Нажмите кнопку THUMBNAIL.

3 С помощью многофункционального 
селектора (стр. 7) или 
многофункционального диска 
(стр. 5) переместите курсор на эскиз 
клипа, который требуется 
воспроизвести.

4 Нажмите кнопку применения на 
многофункциональном селекторе или 
многофункциональный диск.
Воспроизведение начнется с начала 
выбранного клипа.

Управлять воспроизведением можно с 
помощью следующих кнопок.
Нажмите кнопку применения на 

многофункциональном селекторе или 
многофункциональный диск: 
Приостановка воспроизведения.  
Нажмите его еще раз, чтобы 
возобновить воспроизведение.

Нажмите кнопку влево или вправо 
многофункционального селектора: 
Переход в начало клипа/начало 
следующего клипа.

Нажмите и удерживайте кнопку влево 
или вправо многофункционального 
селектора: 
Перемотка назад/вперед.  

Воспроизведение возобновится, когда 
кнопка будет отпущена.

Кнопка CANCEL/BACK: 
Остановка воспроизведения и возврат 
в режим ожидания записи.

[Примечания]
ˎˎ На границе между клипами изображение 

может прерываться или замирать. Управлять 
видеокамерой в течение такого периода нельзя.
ˎˎ После выбора клипа на экране эскизов и 

начала воспроизведения может наблюдаться 
кратковременный разрыв изображения в 
начале клипа. Чтобы начать воспроизведения 
клипа без разрыва, переключите видеокамеру 
в режим воспроизведения, приостановите 
воспроизведение, кнопкой влево 
многофункционального селектора вернитесь в 
начало клипа и снова запустите воспроизведение.
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На экране эскизов для управления клипами 
и проверки их свойств служит меню 
Thumbnail полного меню.
Меню Thumbnail (стр. 100) открывается, 
если, нажав и удерживая кнопку MENU, 
выбрать Thumbnail.

Операции меню Thumbnail

Многофункциональным селектором 
(стр. 7) или многофункциональным 
диском (стр. 5) выберите функцию, 
затем нажмите кнопку применения на 
многофункциональном селекторе или 
многофункциональный диск.
Нажмите кнопку CANCEL/BACK (стр. 5), 
чтобы вернуться на предыдущий экран.

[Примечание]
В зависимости от состояния видеокамеры в момент 
отображения меню некоторые его пункты будут 
недоступны для выбора.

Пункты меню для операций с 
клипами

ˎˎ Display Clip Properties
ˎˎ Set Clip Flag
ˎˎ Lock/Unlock Clip
ˎˎ Delete Clip
ˎˎ Transfer Clip
ˎˎ Transfer Clip (Proxy)
ˎˎ Filter Clips
ˎˎ Customize View

Подробные сведения о пунктах меню 
операций с клипами см. в разделе меню 
Thumbnail (стр. 100).

Отображение свойств клипа

Чтобы открыть экран свойств, выберите 
пункт Display Clip Properties (стр. 100) в 
меню Thumbnail.

Добавление флагов клипа

В клипы можно добавлять флаги клипов 
(метки OK, NG или KP), чтобы фильтровать 
отображение клипов на основе их флагов.
Выберите эскиз клипа, в который требуется 
добавить флаг клипа, затем выберите 
флаг клипа с помощью пункта Set Clip Flag 
(стр. 100) в меню Thumbnail полного меню.

Настройка Добавленный флаг клипа

Add OK OK

Add NG NG

Add KEEP KP

[Советы]
ˎˎ Для добавления флагов клипов можно также 

использовать программируемую кнопку, которой 
назначена функция флага клипа (стр. 51).
ˎˎ Флаг клипа OK (стр. 55) можно добавить 

к эскизу выбранного клипа, нажав кнопку Clip Flag 
(стр. 5).

Отображение экрана эскизов 
отфильтрованных клипов

Выберите пункт Filter Clips (стр. 100) в 
меню Thumbnail полного меню, после чего 
выберите тип флага клипа, чтобы вывести 
на экран только те клипы, у которых есть 
указанный флаг.
Для отображения всех клипов выберите All.

[Совет]
Можно также последовательно переключать 
фильтры с помощью кнопки DISPLAY.

Удаление клипов

Клипы можно удалять с карт памяти.
Выберите Delete Clip >Select Clip или All Clips 
в меню Thumbnail полного меню.
Select Clip: 

Удаление выбранных клипов. Можно 
выбрать несколько клипов.

All Clips: 
Удаление всех отображаемых на экране 
клипов.

Изменение информации, 
отображаемой на экране эскизов

Информацию о клипе/кадре, 
отображаемую под эскизом, можно 
изменить.
Выберите пункт Customize View >Thumbnail 
Caption в меню Thumbnail полного меню, 
затем выберите информацию, которая 
будет отображаться.
Date Time: 

Отображение даты и времени создания 
клипа и его последнего изменения.

Time Code: 
Отображение временного кода.

Duration: 
Отображение длительности клипа.

Sequential Number: 
Отображение порядкового номера 
каждого эскиза.

Операции с клипами



73 6. Отображение меню и настройки

Конфигурация и иерархия полного меню
Нажмите и удерживайте кнопку MENU, 
чтобы открыть полное меню в видоискателе 
для задания различных параметров 
съемки, записи и воспроизведения (это 
меню также можно вывести на внешний 
монитор). Полное меню состоит из 
следующих меню.

Конфигурация меню

Меню User
Содержит пункты меню, которые 
пользователь настраивает с помощью 
Edit User Menu.

Меню Edit User
Содержит пункты меню, 
предназначенные для изменения меню 
User.

Меню Shooting
Содержит настройки, относящиеся к 
съемке.

Меню Project
Содержит базовые настройки проекта.

Меню Paint/Look
Содержит настройки, относящиеся к 
качеству изображения.

Меню TC/Media
Содержит настройки, относящиеся к 
временным кодам и носителю для 
записи.

Меню Monitoring
Содержит настройки, относящиеся к 
выводу видео и индикации в 
видоискателе.

Меню Audio
Содержит настройки, относящиеся к 
звуку.

Меню Thumbnail
Содержит настройки, относящиеся к 
экрану эскизов.

Меню Technical
Содержит настройки для технических 
параметров.

Меню Network
Содержит настройки, относящиеся к 
сети.

Меню Maintenance
Содержит настройки устройств, такие 
как часты и язык.

Иерархия полного меню

User 
(Заводские 
настройки)

Base Setting

Focus

S&Q Motion

LUT On/Off

Simul Rec

Proxy Rec

Interval Rec

Assignable Button

Assignable Dial

Multi Function Dial

All File

Clip Name Format

Format Media

VF Setting

Zebra

Zoom

Menu Settings

Edit User Menu Add Item

Customize Reset

Shooting ISO/Gain/EI

ND Filter

Shutter

Iris

Auto Exposure

White

White Setting

Offset White

Focus

S&Q Motion

LUT On/Off

Noise Suppression

Flicker Reduce

SteadyShot

Project Base Setting

Rec Format

Cine EI Setting

HDR Setting

Simul Rec

Proxy Rec

Interval Rec

Picture Cache Rec

SDI/HDMI Rec Control

Assignable Button

Assignable Dial

Multi Function Dial

User File

All File

Paint/Look Scene File

Base Look

Reset Paint Settings

Black

Knee

Detail

Matrix

Multi Matrix

TC/Media Timecode

TC Display

Users Bit

HDMI TC Out

Clip Name Format

Update Media

Format Media

Monitoring Output On/Off

Output Format

Output Display

Display On/Off

Marker

VF Setting

Gamma Display Assist

Peaking

Zebra

Audio Audio Input

Audio Output

Thumbnail Display Clip Properties

Set Clip Flag

Lock/Unlock Clip

Delete Clip

Transfer Clip

Transfer Clip (Proxy)

Filter Clips

Customize View
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Technical Color Bars

ND Dial

Tally

HOLD Switch Setting

Touch Operation

Rec Review

Zoom

Handle Zoom

Menu Settings

Menu Page On/Off

Fan Control

Lens

Video Light Set

APR

Camera Battery Alarm

Camera DC IN Alarm

Network Access Authentication

Wireless LAN

AP Mode Settings

ST Mode Settings

Wired LAN

Modem

File Transfer

Network Reset

Maintenance Language

Clock Set

All Reset

Hours Meter

Version
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Операции полного меню
Нажмите и удерживайте кнопку MENU, 
чтобы открыть полное меню в видоискателе 
для задания детальных настроек (это 
меню также можно вывести на внешний 
монитор).

Элементы управления меню

Кнопка MENU (стр. 5)
Нажмите и удерживайте для 
отображения полного меню. Нажмите 
еще раз при открытом полном меню, 
чтобы скрыть его.

Многофункциональный селектор (джойстик 
с 8 направлениями и кнопки применения) 
(стр. 7)

Кнопками 8-стороннего джойстика 
перемещайте курсор вверх, вниз, влево 
и вправо для выбора пунктов меню или 
настроек.
Чтобы применить выбранный элемент, 
нажмите кнопку применения 
многофункционального селектора.

Многофункциональный диск (стр. 5)
Многофункциональный диск служит 
для перемещения курсора вверх и вниз 
с целью выбора элементов меню или 
настроек.
Чтобы применить выбранный элемент, 
нажмите многофункциональный диск.

Кнопка CANCEL/BACK (стр. 5)
Нажмите для возврата к предыдущему 
меню. Незавершенное изменение 
отменяется.

[Примечания]
ˎˎ Полное меню недоступно в режиме увеличения 

области фокусировки (стр. 38).
ˎˎ В зависимости от состояния видеокамеры в 

момент отображения меню некоторые его пункты 
будут недоступны для выбора.

Пункты меню настройки

Нажимая кнопки 8-стороннего джойстика 
или поворачивая многофункциональный 
диск, переместите курсор на нужный пункт 
меню, затем нажмите кнопку применения 
или многофункциональный диск, чтобы 
выбрать этот пункт.
ˎˎ В области выбора пунктов меню 
отображается до восьми строк. Если все 
доступные для пункта меню параметры 
не умещаются на экране, прокрутите 
список, перемещая курсор вверх/вниз.
ˎˎ Для вложенных пунктов с широким 
диапазоном возможных значений 
(например, от –99 до +99), область 
параметров не отображается. Текущее 
значение выделяется, что указывает на 
возможность изменения значения.
ˎˎ Если выбрать [Execute] для функции, эта 
функция будет выполнена.
ˎˎ Если выбрать пункт, перед выполнением 
которого требуется подтверждение, 
то меню будет временно скрыто и 
откроется сообщение о подтверждении. 
Ознакомьтесь с сообщением, после чего 
выберите выполнение функции или 
отмену.

Ввод строки символов

При выборе элемента, например, имени 
файла, для которого требуется ввести 
символы, открывается экран ввода 
символов.

1

2 3

1 Нажимая кнопки 8-стороннего 
джойстика или поворачивая 
многофункциональный диск, выберите 
тип символов, затем примените 
настройку.
ABC: буквенные символы в верхнем 
регистре
abc: буквенные символы в нижнем 
регистре
123: цифровые символы
!#$: особые символы

2 Выберите символ заданного типа, 
затем примените настройку.
Курсор переместится в следующее 
поле.

Space: ввод символа пробела в 
положении курсора.

/: перемещение положения 
курсора.

BS: удаление символа, расположенного 
слева от курсора (backspace).

3 После завершения выберите [Done] и 
примените настройку.
Строка символов будет подтверждена, 
а экран ввода символов закроется.

Блокировка и отмена 
блокировки меню

Полное меню можно заблокировать, чтобы 
отображалось только меню User.
В этом состоянии невозможно изменять 
настройки с помощью экранов состояния.

Блокировка меню

1 Нажав и удерживая 
многофункциональный диск, нажмите и 
удерживайте кнопку MENU.

2 Выберите Menu Settings >User Menu 
with Lock в меню Technical.

 [Примечание]
Если нажать и удерживать кнопку MENU для 
отображения обычного полного меню, в пункте 
Menu Settings меню Technical отображается 
пункт User Menu Only. Нажав и удерживая 
многофункциональный диск, нажмите и 
удерживайте кнопку MENU для отображения 
пункта User Menu with Lock.

3 Задайте значение On и нажмите кнопку 
применения или 
многофункциональный диск.
Экран видоискателя переключается на 
экран ввода цифрового пароля.
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4 Введите произвольное число.
Введите 4-значное число в диапазоне 
от 0000 до 9999. Значение по 
умолчанию — 0000.
Введите цифру и нажмите кнопку 
применения или 
многофункциональный диск для 
перемещения курсора на следующую 
цифру.
После ввода всех цифр переместите 
курсор на SET.

5 Нажмите кнопку применения или 
многофункциональный диск.
Ввод применен.
Отображается сообщение 
подтверждения, и экран переключается 
на экран меню User.

Отмена блокировки меню

1 Нажав и удерживая 
многофункциональный диск, нажмите и 
удерживайте кнопку MENU.

2 Выберите Menu Settings >User Menu 
with Lock в меню User.

 [Примечание]
Если нажать и удерживать кнопку MENU для 
отображения обычного полного меню, в пункте 
Menu Settings меню Technical отображается 
пункт User Menu Only. Нажав и удерживая 
многофункциональный диск, нажмите и 
удерживайте кнопку MENU для отображения 
пункта User Menu with Lock.

3 Задайте значение Off и нажмите кнопку 
применения или 
многофункциональный диск.
Экран видоискателя переключается на 
экран ввода цифрового пароля.

4 Введите цифровой пароль, который 
использовался для блокировки меню.
Введите цифру и нажмите кнопку 
применения или 
многофункциональный диск для 
перемещения курсора на следующую 
цифру.
После ввода всех цифр переместите 
курсор на Set.

5 Нажмите кнопку применения или 
многофункциональный диск.
Ввод применен.
Если введенный цифровой пароль 
соответствует цифровому паролю, 
использованному для блокировки 
меню, блокировка меню отменяется и 
отображается меню.

[Примечания]
ˎˎ Если введенный цифровой пароль 

не соответствует цифровому паролю, 
использованному для блокировки меню, 
блокировка меню не отменяется.

ˎˎ Рекомендуется записать цифровой пароль и держать 
его под рукой на случай, если вы забудете цифровой 
пароль. Если вы все-таки забудете цифровой пароль, 
обратитесь к представителю службы технического 
обслуживания компании Sony.

ˎˎ Если меню настройки заблокировано, а пункты 
полного меню из приведенной ниже таблицы 
не зарегистрированы в меню User, эти функции 
не могут быть назначены программируемым 
кнопкам.
ˎˎ Если эти функции уже назначены 

программируемым кнопкам, при блокировке 
меню программируемая настройка принудительно 
отключается.

Пункт полного меню Выбор 
программируемых 
кнопок

Shooting >ISO/Gain/EI 
>Base Sensitivity,  
Shooting >ISO/Gain/EI 
>Base ISO

Base ISO/Sensitivity

Shooting >Auto 
Exposure >AGC

AGC

— Auto ND Filter

Shooting >Iris >Bokeh 
Control

Bokeh Control

Shooting >Auto 
Exposure >Auto Shutter

Auto Shutter

Shooting >Auto 
Exposure >Level

Auto Exposure Level

Shooting >Auto 
Exposure >Mode

Backlight

Shooting >Auto 
Exposure >Mode

Spotlight

Shooting >White > 
Preset White

Preset White Select

Shooting >Focus > 
AF Transition Speed,  
Shooting >Focus > 
AF Subj. Shift Sens.

AF Speed/Sens.

Shooting >Focus > 
Focus Area

Focus Area

Shooting >Focus > 
Focus Area(AF-S)

Focus Area(AF-S)

Shooting >Focus > 
Face/Eye Detection AF

Face/Eye Detection 
AF

Shooting >Focus > 
Push AF Mode

Push AF Mode

Shooting >S&Q Motion 
>Setting

S&Q Motion

Shooting >SteadyShot 
>Setting

SteadyShot

Пункт полного меню Выбор 
программируемых 
кнопок

Project >Picture Cache 
Rec >Setting

Picture Cache Rec

Technical >Rec Review 
>Setting

Rec Review

Thumbnail >Set Clip 
Flag >Add OK

Clip Flag OK

Thumbnail >Set Clip 
Flag >Add NG

Clip Flag NG

Thumbnail >Set Clip 
Flag >Add KEEP

Clip Flag Keep

Technical >Color Bars 
>Setting

Color Bars

Monitoring >Display 
On/Off >Lens Info

Lens Info

Monitoring >Display 
On/Off >Video Signal 
Monitor

Video Signal 
Monitor

Monitoring >Marker 
>Setting

Marker

Monitoring >VF Setting 
>Color Mode

VF Mode

Monitoring >Gamma 
Display Assist >Setting

Gamma Display 
Assist

Monitoring >Peaking 
>Setting

Peaking

Monitoring >Zebra 
>Setting

Zebra

Audio >Audio Output 
>Volume

Volume

Technical >Touch 
Operation >Setting

Touch Operation

Technical >Handle 
Zoom >Setting

Handle Zoom

Network >Wireless LAN 
>NFC

NFC

Network >File Transfer 
>Auto Upload (Proxy)

Auto Upload (Proxy)

User User Menu
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Меню User
В этом разделе приводится описание предназначения и настроек каждого пункта меню.

User

Пункт Описание

Base Setting Пункт Project >Base Setting

Focus Пункт Shooting >Focus

S&Q Motion Пункт Shooting >S&Q Motion

LUT On/Off Пункт Shooting >LUT On/Off

Simul Rec Пункт Project >Simul Rec

Proxy Rec Пункт Project >Proxy Rec

Interval Rec Пункт Project >Interval Rec

Assignable Button Пункт Project >Assignable Button

Assignable Dial Пункт Project >Assignable Dial

Multi Function Dial Пункт Project >Multi Function Dial

All File Пункт Project >All File

Clip Name Format Пункт TC/Media >Clip Name Format

Format Media Пункт TC/Media >Format Media

VF Setting Пункт Monitoring >VF Setting

Zebra Пункт Monitoring >Zebra

Zoom Пункт Technical >Zoom

Menu Settings Пункт Technical >Menu Settings

Edit User Menu Отображение экрана меню Edit User.

[Примечание]
С помощью меню Edit User можно добавлять пункты меню в меню User и удалять их из того меню. Можно 
настроить не более 20 пунктов.
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Меню Edit User
Меню Edit User отображается на верхнем уровне, когда в меню User выбирается пункт Edit 
User Menu.

Edit User

Пункт Настройка подпункта Описание

Add Item
Добавление пункта в 
меню User

Добавление пункта в меню User.

Customize Reset
Сброс пунктов в меню 
User

Восстановление пунктов, которые 
содержатся в меню User по 
умолчанию.

Пункт меню, 
выбранный во время 
редактирования

Delete Удаление зарегистрированного 
пункта из меню User.

Move Изменение расположения 
зарегистрированных пунктов в 
меню User.

Edit Sub Item Изменение (регистрация/
удаление) зарегистрированных 
подпунктов в меню User.
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Меню Shooting
В этом разделе приводится описание предназначения и настроек каждого пункта меню.
Настройки, заданные по умолчанию, выделены полужирным шрифтом (например, 18dB).

Shooting >ISO/Gain/EI
Задание настроек усиления.

Пункт Настройка подпункта Описание
Mode ISO/dB Выбор режима настройки усиления.

ISO/Gain<H> Подробное описание настроек см. в 
разделе “Настройки и значения по 
умолчанию для ISO/Gain” (стр. 110).

Задание предварительно 
установленного значения усиления 
<H>.

ISO/Gain<M> Подробное описание настроек см. в 
разделе “Настройки и значения по 
умолчанию для ISO/Gain” (стр. 110).

Задание предварительно 
установленного значения усиления 
<M>.

ISO/Gain<L> Подробное описание настроек см. в 
разделе “Настройки и значения по 
умолчанию для ISO/Gain” (стр. 110).

Задание предварительно 
установленного значения усиления 
<L>.

Exposure 
Index<H>

Когда для параметра Base ISO задано 
значение ISO 800:

200EI / 4.0E
250EI / 4.3E
320EI / 4.7E
400EI / 5.0E
500EI / 5.3E
640EI / 5.7E
800EI / 6.0E
1000EI / 6.3E
1250EI / 6.7E
1600EI / 7.0E
2000EI / 7.3E
2500EI / 7.7E
3200EI / 8.0E

Когда для параметра Base ISO задано 
значение ISO 12800:

3200EI / 4.0E
4000EI / 4.3E
5000EI / 4.7E
6400EI / 5.0E
8000EI / 5.3E
10000EI / 5.7E
12800EI / 6.0E
16000EI / 6.3E
20000EI / 6.7E
25600EI / 7.0E
32000EI / 7.3E
40000EI / 7.7E
51200EI / 8.0E

Установка значения индекса 
экспозиции <H>.
Доступно только в режиме Cine EI.

Shooting >ISO/Gain/EI
Задание настроек усиления.

Пункт Настройка подпункта Описание
Exposure 
Index<M>

(Такие же значения, как для Exposure 
Index<H>)
Когда для параметра Base ISO задано 
значение ISO 800:

1000EI / 6.3E
Когда для параметра Base ISO задано 
значение ISO 12800:

16000EI / 6.3E

Установка значения индекса 
экспозиции <M>.

Exposure 
Index<L>

(Такие же значения, как для Exposure 
Index<H>)
Когда для параметра Base ISO задано 
значение ISO 800:

800EI / 6.0E
Когда для параметра Base ISO задано 
значение ISO 12800:

12800EI / 6.0E

Установка значения индекса 
экспозиции <L>.

Shockless 
Gain

On / Off Включение или выключение функции 
плавного усиления.

Base 
Sensitivity

High / Low Задает базовую чувствительность для 
режима SDR/HDR.

Base ISO ISO 12800 / ISO 800 Задает базовую чувствительность ISO 
для режима Cine EI.

Shooting >ND Filter
Задание предварительно установленных значений для фильтра нейтральной плотности.

Пункт Настройка подпункта Описание

Preset1 1/4 / 1/8 / 1/16 / 1/32 / 1/64 / 1/128 Задание предварительно 
установленного значения 1 для 
фильтра нейтральной плотности.

Preset2 1/4 / 1/8 / 1/16 / 1/32 / 1/64 / 1/128 Задание предварительно 
установленного значения 2 для 
фильтра нейтральной плотности.

Preset3 1/4 / 1/8 / 1/16 / 1/32 / 1/64 / 1/128 Задание предварительно 
установленного значения 3 для 
фильтра нейтральной плотности.

Shooting >Shutter
Задание настроек условий работы электронного затвора.

Пункт Настройка подпункта Описание

Mode Speed / Angle Выбор режима работы электронного 
затвора.
Служит для четкой съемки быстро 
движущихся объектов. Выбор режима 
для задания скорости затвора в 
секундах (Speed) или в виде угла 
раскрытия затвора (Angle).
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Shooting >Shutter
Задание настроек условий работы электронного затвора.

Пункт Настройка подпункта Описание

Shutter Speed  
On/Off

On / Off Задает, будет ли время экспозиции при 
выбранном режиме Speed следовать 
значению Shutter Speed или будет 
устанавливаться полная экспозиция.

Shutter Speed 64F – 1/8000
Возможные значения зависят от частоты 
кадров выбранного формата видео.
59.94P: 

64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F / 
3F / 2F / 1/50 / 1/60 / 1/100 / 1/120 / 
1/125 / 1/250 / 1/500 / 1/1000 / 
1/2000 / 1/4000 / 1/8000

50P: 
64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F / 
3F / 2F / 1/50 / 1/60 / 1/100 / 1/120 / 
1/125 / 1/250 / 1/500 / 1/1000 / 
1/2000 / 1/4000 / 1/8000

29.97P: 
64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F / 
3F / 2F / 1/30 / 1/40 / 1/50 / 1/60 / 
1/100 / 1/120 / 1/125 / 1/250 / 1/500 / 
1/1000 / 1/2000 / 1/4000 / 1/8000

25P: 
64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F / 
3F / 2F / 1/25 / 1/33 / 1/50 / 1/60 / 
1/100 / 1/120 / 1/125 / 1/250 / 1/500 / 
1/1000 / 1/2000 / 1/4000 / 1/8000

24P/23.98P: 
64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F / 
3F / 2F / 1/24 / 1/32 / 1/48 / 1/50 / 
1/60 / 1/96 / 1/100 / 1/120 / 1/125 / 
1/250 / 1/500 / 1/1000 / 1/2000 / 
1/4000 / 1/8000

Установка выдержки, когда параметру 
Mode задано значение Speed.

Shutter Angle 64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F / 3F / 
2F / 360.0° / 300.0° /  
270.0° / 240.0° / 216.0° / 210.0° /  
180.0° / 172.8° / 150.0° / 144.0° /  
120.0° / 90.0° / 86.4° / 72.0° / 45.0° / 
30.0° / 22.5° / 11.25° / 5.6°

Установка угла раскрытия затвора, 
когда параметру Mode задано 
значение Angle.

ECS On/Off On / Off Включение и выключение функции 
Extended Clear Scan.

Shooting >Shutter
Задание настроек условий работы электронного затвора.

Пункт Настройка подпункта Описание

ECS 
Frequency

От 23.99 до 8000
Возможные значения зависят от частоты 
кадров выбранного формата видео.
Значения по умолчанию указаны ниже.
59.94P: 60.00
50P: 50.00
29.97P: 30.00
23.98P: 23.99
25P: 25.02
24P: 24.02

Установка частоты ECS, когда 
параметру Mode задано значение ECS.

Shooting >Iris
Задание настроек функции управления боке.

Пункт Настройка подпункта Описание

Bokeh 
Control

On / Off Включение или выключение функции 
управления боке.

Shooting >Auto Exposure
Задание настроек автоматической регулировки экспозиции.

Пункт Настройка подпункта Описание

Level +3.0 / +2.75 / +2.5 / +2.25 / +2.0 / +1.75 / 
+1.5 / +1.25 / +1.0 / +0.75 / +0.5 / +0.25 / 
±0 / –0.25 / –0.5 / –0.75 / –1.0 / –1.25 / 
–1.5 / –1.75 / –2.0 / –2.25 / –2.5 / –2.75 / 
–3.0

Установка уровня яркости для 
автоматически определяемой 
экспозиции.

Mode Backlight / Standard / Spotlight Задает режим работы автоматической 
настройки экспозиции.
Backlight: 

Режим фоновой подсветки (режим 
для сокращения затемнения 
объекта съемки, когда он освещен 
сзади)

Standard: 
Стандартный режим

Spotlight: 
Режим точечной подсветки (режим 
для сокращения областей 
усеченного белого, когда объект 
съемки освещен точечным 
источником)

Speed От –99 до +99 (±0) Задает скорость регулировки для 
автоматической настройки экспозиции.

AGC On / Off Включение и выключение функции AGC 
(Auto Gain Control — Автоматическая 
регулировка усиления).
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Shooting >Auto Exposure
Задание настроек автоматической регулировки экспозиции.

Пункт Настройка подпункта Описание

AGC Limit Подробное описание настроек см. в 
разделе “Настройки и значения по 
умолчанию для AGC Limit” (стр. 112).

Установка максимального усиления 
функции AGC.

AGC Point F2.8 / F4 / F5.6 Задает диафрагменное число, на 
котором начинается работа функции 
AGC, когда функция AGC включена.

Auto Shutter On / Off Включение или выключение функции 
автоматического управления затвором.

A.SHT Limit 1/100 / 1/150 / 1/200 / 1/250 / 1/2000 Установка самой быстрой скорости 
затвора функции автоматического 
управления затвором.

A.SHT Point F5.6 / F8 / F11 / F16 Задает диафрагменное число, на 
котором начинает работать функция 
автоматического управления затвором.

Clip High light On / Off Включение или выключение функции, 
которая игнорирует самые яркие 
области для обеспечения плавного 
отклика на высокую яркость.

Detect 
Window

1 / 2 / 3 / 4 / 5 / 6 / Custom Установка диапазона экспозиметра для 
автоматической регулировки 
экспозиции в соответствии с яркостью 
объекта съемки. (Недоступно при 
регулировке экспозиции вручную)

Detect 
Window 
Indication

On / Off Включение и выключение индикации 
диапазона экспозамера.

Custom Width От 40 до 999 (500) Задание ширины диапазона 
экспозамера.

Custom 
Height

От 70 до 999 (500) Задание высоты диапазона 
экспозамера.

Custom H 
Position

От –479 до +479 (±0) Задание положения диапазона 
экспозамера по горизонтали.

Custom V 
Position

От –464 до +464 (±0) Задание положения диапазона 
экспозамера по вертикали.

Shooting >White
Задание настроек баланса белого.

Пункт Настройка подпункта Описание

Preset White От 2000K до 15000K (3200K) Установка предварительно заданного 
значения баланса белого.

Color Temp 
<A>

От 2000K до 15000K (3200K) Задание цветовой температуры 
баланса белого, сохраняемой 
в памяти A.

[Примечание]
Поскольку значение параметра Color Temp 
ограничивается величинами 2000K и 
15000K во время работы функции R/B Gain, 
правильное отображение значения Color 
Temp для значения R/B Gain может быть 
невозможно.

Tint<A> От –99 до +99 (±0) Задание значения баланса белого, 
сохраненного в памяти баланса белого A.

[Примечание]
Поскольку во время работы функции R/B Gain 
значение параметра Tint ограничивается 
величинами ±99, правильное отображение значения 
Tint для значения R/B Gain может быть невозможно.

R Gain <A> От –99.0 до +99.0 (±0.0) Задание усиления R баланса белого, 
сохраненное в памяти A.

B Gain <A> От –99.0 до +99.0 (±0.0) Задание усиления B баланса белого, 
сохраненное в памяти A.

Color Temp 
<B>

От 2000K до 15000K (3200K) Задание цветовой температуры баланса 
белого, сохраняемой в памяти B.

[Примечание]
Поскольку значение параметра Color Temp 
ограничивается величинами 2000K и 15000K во 
время работы функции R/B Gain, правильное 
отображение значения Color Temp для 
значения R/B Gain может быть невозможно.

Tint<B> От –99 до +99 (±0) Задание значения баланса белого, 
сохраненного в памяти баланса белого B.

[Примечание]
Поскольку во время работы функции 
R/B Gain значение параметра Tint 
ограничивается величинами ±99, 
правильное отображение значения Tint для 
значения R/B Gain может быть невозможно.

R Gain <B> От –99.0 до +99.0 (±0.0) Задание усиления R баланса белого, 
сохраненное в памяти B.

B Gain <B> От –99.0 до +99.0 (±0.0) Задание усиления B баланса белого, 
сохраненное в памяти B.
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Shooting >White Setting
Регулировка настройки баланса белого.

Пункт Настройка подпункта Описание

Shockless 
White

Off / 1 / 2 / 3 Установка скорости отклика баланса белого 
при переключении режима баланса белого.
Off: мгновенное переключение.
1–3: чем больше число, тем медленнее 

выполняется переключение.
ATW Speed 1 / 2 / 3 / 4 / 5 Установка скорости реакции в режиме ATW.

1: самая быстрая скорость реакции
White 
Switch<B>

Memory / ATW Выбор режима регулировки баланса белого, 
который устанавливается при переводе 
переключателя WHT BAL в положение B.

Filter White 
Memory

On / Off Включение функции, которая задает область 
памяти баланса белого для каждого 
включения/выключения фильтра ND.
On: установка памяти баланса белого 

для каждого фильтра ND.

 [Совет]
В предустановленном режиме 
предусмотрено четыре настройки 
(CLEAR/1/2/3). В переменном режиме 
предусмотрено две настройки (CLEAR/
On).

Off: установка одного значения 
баланса белого из памяти для всех 
фильтров ND.

Shooting >Offset White
Задание настроек смещения баланса белого.

Пункт Настройка подпункта Описание

Offset White 
<A>

On / Off Указание необходимости добавлять 
(On) или не добавлять (Off) значение 
смещения к значению баланса белого 
из ячейки памяти A.

Offset Color 
Temp<A>

От –99 до +99 (±0) Задание смещения цветовой температуры, 
добавляемого к балансу белого из ячейки 
памяти A, когда параметру Offset White <A> 
задано значение On.

Offset Tint<A> От –99 до +99 (±0) Задание смещения значения Tint, 
добавляемого к балансу белого из 
ячейки памяти A, когда параметру 
Offset White <A> задано значение On.

Offset White 
<B>

On / Off Указание необходимости добавлять 
(On) или не добавлять (Off) значение 
смещения к значению баланса белого 
из ячейки памяти B.

Offset Color 
Temp<B>

От –99 до +99 (±0) Задание смещения цветовой температуры, 
добавляемого к балансу белого из ячейки 
памяти B, когда параметру Offset White <B> 
задано значение On.

Shooting >Offset White
Задание настроек смещения баланса белого.

Пункт Настройка подпункта Описание

Offset Tint<B> От –99 до +99 (±0) Задание смещения значения Tint, 
добавляемого к балансу белого из 
ячейки памяти B, когда параметру 
Offset White <B> задано значение On.

Offset White 
<ATW>

On / Off Указание необходимости добавлять (On) 
или не добавлять (Off) значение смещения 
к значению баланса белого ATW.

Offset Color 
Temp<ATW>

От –99 до +99 (±0) Задание смещения цветовой 
температуры, добавляемого к балансу 
белого ATW, когда параметру Offset 
White <ATW> задано значение On.

Offset 
Tint<ATW>

От –99 до +99 (±0) Задание смещения значения Tint, 
добавляемого к балансу белого ATW, 
когда параметру Offset White <ATW> 
задано значение On.

Shooting >Focus
Задание настроек фокусировки.

Пункт Настройка подпункта Описание

AF Transition 
Speed

1(Slow) / 2 / 3 / 4 / 5 / 6 / 7(Fast) Задание скорости изменения 
фокусировки в случае изменения 
объекта во время автоматической 
фокусировки.

AF Subj. Shift 
Sens.

1(Locked On) / 2 / 3 / 4 / 5(Responsive) Задание чувствительности изменения 
фокусировки на объект во время 
автоматической фокусировки.

Focus Area Wide / Zone / Flexible Spot Установка целевой области для 
автоматической фокусировки и 
автоматической фокусировки при 
нажатой кнопке (AF) (стр. 39).
Wide: 

При фокусировке производит 
поиск объекта по широкому углу 
изображения.

Zone: 
Автоматический поиск точки 
фокусировки в указанной зоне.

Flexible Spot: 
Производит фокусировку на 
указанное положение 
изображения.

Focus Area 
(AF-S)

Flexible Spot Установка целевой области для 
автоматической фокусировки одним 
движением (AF-S).
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Shooting >Focus
Задание настроек фокусировки.

Пункт Настройка подпункта Описание

Face/Eye 
Detection AF

Face/Eye Only AF / Face/Eye Priority AF / 
Off

Включение/отключение функции AF 
с обнаружением лиц.

Push AF 
Mode

AF / Single-shot AF(AF-S) Задание режима автофокусировки при 
нажатой кнопке во время ручной 
фокусировки.

Touch 
Function in 
MF

Tracking AF / Spot Focus Задание действия, которое 
выполняется при нажатии сенсорной 
панели в режиме ручной фокусировки.

AF Assist On / Off Если этому параметру задано 
значение “On”, пользователь может 
временно переопределять автофокус 
и задавать фокус вручную.

Shooting >S&Q Motion
Задание настроек режима замедления/ускорения движения (стр. 52).

Пункт Настройка подпункта Описание

Setting On / Off Включение и выключение режима 
записи с замедлением/ускорением 
движения.
Когда установлено значение On, 
следующие функции отключены.

 ˎ Автоматическая установка 
диафрагмы

 ˎ Автоматическая фокусировка
Frame Rate 1fps–60fps / 100fps / 120fps / 150fps / 

180fps / 200fps / 240fps
Установка частоты кадров для съемки с 
замедлением/ускорением движения.

[Примечание]
Возможные значения зависят от выбранной 
частоты системы, кодека и формата видео.

Shooting >LUT On/Off
Задание настроек таблицы соответствия.

Пункт Настройка подпункта Описание

SDI/HDMI MLUT On / MLUT Off Позволяет выбрать, будет ли 
применяться таблица соответствия LUT 
монитора к видеоизображению, 
выводимому на разъемы SDI и HDMI.

VF/Proxy/
Stream

MLUT On / MLUT Off Позволяет выбрать, будет ли 
применяться таблица соответствия LUT 
монитора к выводимому видео в 
видоискателе, записи прокси и 
потоковому видео.

Shooting >LUT On/Off
Задание настроек таблицы соответствия.

Пункт Настройка подпункта Описание

Internal Rec MLUT On / MLUT Off Позволяет выбрать, будет ли 
применяться таблица соответствия LUT 
монитора к внутреннему 
записываемому видео.

Shooting >Noise Suppression
Задание настроек шумоподавления.

[Совет]
Настройки Setting(Custom) и Level(Custom) отражаются в настройке Target Display (стр. 114).

Пункт Настройка подпункта Описание

Setting 
(Custom)

On / Off Включение или выключение функции 
подавления шума в режиме Custom.

Level 
(Custom)

Low / Mid / High Задание уровня подавления шума в 
режиме Custom.

Setting 
(Cine EI)

On / Off Включение или выключение функции 
подавления шума в режиме Cine EI.

Level 
(Cine EI)

Low / Mid / High Задание уровня подавления шума в 
режиме Cine EI.

Shooting >Flicker Reduce
Задание настроек коррекции мерцания.

Пункт Настройка подпункта Описание

Mode Auto / On / Off Установка режима коррекции 
мерцания.

Frequency 50Hz / 60Hz Установка частоты источника питания, 
от которого работает освещение, 
вызывающее мерцание.

Shooting >SteadyShot
Задание настроек стабилизации изображения.

Пункт Настройка подпункта Описание

Setting Active / Standard / Off Задание функции стабилизации 
изображения.

[Примечание]
Возможно при установке совместимого 
объектива.
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В этом разделе приводится описание предназначения и настроек каждого пункта меню.
Настройки, заданные по умолчанию, выделены полужирным шрифтом (например, 18dB).

Project >Base Setting
Задание базовых настроек.

Пункт Настройка подпункта Описание

Shooting 
Mode

Custom / Cine EI Установка режима съемки (стр. 25).

Target 
Display

SDR(BT.709) / HDR(HLG) Задание цветового пространства 
записи/вывода в режиме Custom.

Project >Rec Format
Задание настроек формата записи.

Пункт Настройка подпункта Описание

Frequency 59.94 / 50 / 29.97 / 25 / 24 / 23.98 Выбор частоты системы.

Imager Scan 
Mode

FF / S35 Задание сочетания способа 
считывания датчика изображения (все 
пикселы/группирование пикселов) и 
настройки размера датчика 
изображения.

Codec RAW / RAW & XAVC-I / RAW(HDMI) /  
RAW(HDMI) & XAVC-I / XAVC-I / XAVC-L

Установка режима записи/
воспроизведения.

RAW Output 
Format

Доступные настройки зависят от 
параметров Frequency и Codec.

Задание разрешения выходного 
сигнала RAW.

[Примечание]
Когда Codec установлен на RAW & XAVC-I, 
параметр Video Format переключается в 
соответствии с параметром RAW Output 
Format.

Frequency Codec Варианты 
выбора

59.94/
50/
29.97/
25/
23.98

RAW 4096×2160

3840×2160

RAW & 
XAVC-I

4096×2160

3840×2160

RAW(HDMI) 4240×2392

RAW(HDMI) 
& XAVC-I

4240×2392

24 RAW 4096×2160

RAW & 
XAVC-I

4096×2160

Project >Rec Format
Задание настроек формата записи.

Пункт Настройка подпункта Описание

Video Format Доступные настройки зависят от 
параметров Frequency и Codec.

Установка формата записи.

Frequency Codec Варианты 
выбора

59.94 RAW/
RAW(HDMI)

–

RAW & 
XAVC-I

4096×2160P

3840×2160P

RAW(HDMI) 
& XAVC-I

3840×2160P

XAVC-I 4096×2160P

3840×2160P

1920×1080P

XAVC-L 3840×2160P

1920×1080P 50

1920×1080P 35

50 RAW/
RAW(HDMI)

–

RAW & 
XAVC-I

4096×2160P

3840×2160P

RAW(HDMI) 
& XAVC-I

3840×2160P

XAVC-I 4096×2160P

3840×2160P

1920×1080P

XAVC-L 3840×2160P

1920×1080P 50

1920×1080P 35

Меню Project
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Project >Rec Format
Задание настроек формата записи.

Пункт Настройка подпункта Описание

Video Format 29.97 RAW/
RAW(HDMI)

–

RAW & 
XAVC-I

4096×2160P

3840×2160P

RAW(HDMI) 
& XAVC-I

3840×2160P

XAVC-I 4096×2160P

3840×2160P

1920×1080P

XAVC-L 3840×2160P

1920×1080P 50

1920×1080P 35

25 RAW/
RAW(HDMI)

–

RAW & 
XAVC-I

4096×2160P

3840×2160P

RAW(HDMI) 
& XAVC-I

3840×2160P

XAVC-I 4096×2160P

3840×2160P

1920×1080P

XAVC-L 3840×2160P

1920×1080P 50

1920×1080P 35

Project >Rec Format
Задание настроек формата записи.

Пункт Настройка подпункта Описание

Video Format 23.98 RAW/
RAW(HDMI)

–

RAW & 
XAVC-I

4096×2160P

3840×2160P

RAW(HDMI) 
& XAVC-I

3840×2160P

XAVC-I 4096×2160P

3840×2160P

1920×1080P

XAVC-L 3840×2160P

1920×1080P 50

1920×1080P 35

24 RAW/
RAW(HDMI)

–

RAW & 
XAVC-I

4096×2160P

RAW(HDMI) 
& XAVC-I

3840×2160P

XAVC-I 4096×2160P

Project >Cine EI Setting
Задание настроек режима Cine EI.

Пункт Настройка подпункта Описание

Color Gamut S-Gamut3/SLog3 / S-Gamut3.Cine/SLog3 Задание цветового пространства в 
режиме Cine EI.
S-Gamut3/SLog3: 

Задание для цветового 
пространства в режиме Cine EI 
значения S-Gamut3.

S-Gamut3.Cine/SLog3: 
Задание для цветового 
пространства в режиме Cine EI 
значения S-Gamut3.Cine.
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Project > HDR Setting
Задание настроек режима HDR.

Пункт Настройка подпункта Описание

VF SDR 
Preview

On / Off В режиме HDR этот параметр служит 
для включения и выключения 
функции, которая преобразует 
изображение в видоискателе из HDR в 
SDR, когда работает функция Gamma 
Display Assist.

[Совет]
Когда задано значение On, значение 
параметра SDR Gain применяется к 
изображению в видоискателе.

SDR Gain От 0dB до –15dB (–6dB) В режиме HDR служит для задания 
значения параметра SDR Gain, которое 
применяется к изображению в 
видоискателе, когда параметру VF SDR 
Preview задано значение On.

Project >Simul Rec
Задание настроек режима одновременной записи (стр. 54).

Пункт Настройка подпункта Описание

Setting On / Off Включение или выключение функции 
одновременной записи и установка 
целевого носителя для записи.

Rec Button 
Set

Rec Button:[SlotA SlotB] Handle Rec 
Button:[SlotA SlotB] / Rec Button:[SlotA] 
Handle Rec Button:[SlotB] / Rec 
Button:[SlotB] Handle Rec Button:[SlotA]

Назначение кнопок записи, 
используемых для выбора носителей 
записи.

Project >Proxy Rec
Задание настроек режима записи прокси.

Пункт Настройка подпункта Описание

Setting On / Off Включение или выключение режима 
записи прокси.

Audio 
Channel

CH1/CH2 / CH3/CH4 Выбор аудиоканала для записи данных 
прокси.

Project >Interval Rec
Задание настроек режима съемки с интервалом (стр. 52).

Пункт Настройка подпункта Описание

Setting On / Off Включение или выключение режима 
съемки с интервалом. (При задании 
этому режиму значения On всем 
остальным особым режимам задается 
значение Off.)

Interval Time 1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 / 15 / 
20 / 30 / 40 / 50 (s)
1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 / 15 / 20 / 
30 / 40 / 50 (min)
1 / 2 / 3 / 4 / 6 / 12 / 24 (h)

Задание интервала между съемкой в 
режиме Interval Rec (когда параметру 
Interval Rec задано значение On).

Number of 
Frames

1frame / 2frames / 3frames / 6frames / 
9frames / 12frames
Возможные значения зависят от частоты 
кадров выбранного формата видео.
59.94P/50P: 

2frames / 6frames / 12frames
29.97P/25P/24P/23.98P: 

1frame / 3frames / 6frames / 9frames

Задание количества кадров, которое 
будет записано за один дубль в 
режиме Interval Rec (когда параметру 
Interval Rec задано значение On).

Pre-Lighting Off / 2 s / 5 s / 10 s Задание времени (в секундах), за 
которое лампа для видеосъемки будет 
включаться перед началом съемки в 
режиме Interval Rec.

[Совет]
Этот параметр доступен только при 
использовании компонента HVL-LBPC 
(приобретается дополнительно).

Project >Picture Cache Rec
Задание настроек режима записи в кэш изображения (стр. 53).

Пункт Настройка подпункта Описание

Setting On / Off Включение или выключение режима 
записи в кэш изображения.

Cache Size Short / Medium / Long / Max Задание времени накопления 
изображений в кэш-памяти 
изображения (время записи кэша 
изображения).

Cache Rec 
Time

Отображение времени накопления 
изображений в кэш-памяти 
изображения (время записи кэша 
изображения).
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Project >SDI/HDMI Rec Control
Задание настроек управления записью через выходы SDI/HDMI.

Пункт Настройка подпункта Описание

Setting Off / SDI/HDMI Remote I/F / Parallel Rec Задание управления запуском и 
остановкой записи на внешнем 
устройстве с помощью выходного 
сигнала SDI/HDMI.
Off: 

Дистанционное управление не 
используется.

SDI/HDMI Remote I/F: 
Запуск/остановка записи на 
внешнее подключенное 
устройство, когда в видеокамеру 
не вставлен носитель для записи. 
Без синхронизации по точности 
кадров с носителем из 
видеокамеры.

Parallel Rec: 
Запуск/остановка записи на 
внешнее подключенное 
устройство, когда в видеокамеру 
вставлен носитель для записи. 
С синхронизацией по точности 
кадров с носителем из 
видеокамеры.

[Примечание]
Для управления с использованием 
выходного сигнала HDMI задайте для 
параметра HDMI TC Out >Setting (стр. 93) в 
меню TC/Media полного меню значение On.

Project >Assignable Button
Назначение функций программируемым кнопкам.

Пункт Настройка подпункта Описание

<1> – <9>, 
Focus Hold 
Button

Off / Base ISO/Sensitivity / AGC / Push 
AGC / ND Filter Position / Auto ND Filter / 
Push Auto ND / Auto Iris / Push Auto Iris / 
Bokeh Control / Auto Shutter / Auto 
Exposure Level / Backlight / Spotlight / 
Preset White Select / ATW / ATW Hold / AF 
Speed/Sens. / Focus Setting / Focus Area / 
Focus Area(AF-S) / Face/Eye Detection AF / 
Push AF Mode / Push AF/Push MF / Focus 
Hold / Focus Magnifier x3/x6 / Focus 
Magnifier x3 / Focus Magnifier x6 / S&Q 
Motion / SteadyShot / Rec / Picture Cache 
Rec / Rec Review / Clip Flag OK / Clip Flag 
NG / Clip Flag Keep / Color Bars / Tally 
[Front] / DURATION/TC/U-BIT / Display / 
Lens Info / Video Signal Monitor / Marker / 
VF Adjust / VF Mode / Gamma Display 
Assist / Peaking / Zebra / Volume / 
Thumbnail / Touch Operation / Handle 
Zoom / NFC / Auto Upload (Proxy) / Direct 
Menu / User Menu / Menu

Назначение функций 
программируемым кнопкам.
Base ISO/Sensitivity: 

Переключение базовой 
чувствительности датчика 
изображения.

AGC: 
Включение или выключение 
функции AGC.

Push AGC: 
Включение функции AGC на время, 
пока нажата кнопка.

ND Filter Position: 
Переключение фильтров 
нейтральной плотности.

Auto ND Filter: 
Включение или выключение функции 
автоматического фильтра ND.

Push Auto ND: 
Включение функции 
автоматического фильтра ND на 
время, пока нажата кнопка.

Auto Iris: 
Включение или выключение 
функции диафрагмы.

Push Auto Iris: 
Включение автоматической 
регулировки диафрагмы на время, 
пока нажата кнопка.

Bokeh Control: 
Включение и выключение режима 
управления боке.

Auto Shutter: 
Включение или выключение 
функции автоматического затвора.

Auto Exposure Level: 
Отображение или закрытие 
прямого меню Auto Exposure Level.

Backlight: 
Переключение между режимами 
Backlight и Standard.

Spotlight: 
Переключение между режимами 
Spotlight и Standard.

Preset White Select: 
Переключение значения стандартного 
режима баланса белого.

ATW: 
Включение или выключение 
функции ATW.
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Project >Assignable Button
Назначение функций программируемым кнопкам.

Пункт Настройка подпункта Описание

<1> – <9>, 
Focus Hold 
Button

ATW Hold: 
Приостановка работы функции 
ATW.

AF Speed/Sens.: 
Переключение настройки скорости 
изменения AF и настройки 
чувствительность к смене объекта 
AF.

Focus Setting: 
Задает область фокусировки.

Focus Area: 
Задает область фокусировки для 
AF и AF при нажатии кнопки.

Focus Area(AF-S): 
Задание области фокусировки для 
AF при нажатии кнопки (AF-S).

Face/Eye Detection AF: 
Переключение настроек AF 
с обнаружением лиц и глаз.

Push AF Mode: 
Переключение настройки режима 
Push AF.

Push AF/Push MF: 
В режиме фокусировки MF режим 
AF включается при нажатой кнопке. 
В режиме фокусировки AF режим 
MF включается при нажатой 
кнопке.

Focus Hold: 
В режиме фокусировки AF фокус 
фиксируется при нажатой кнопке.

Focus Magnifier x3/x6:
Focus Magnifier x3:
Focus Magnifier x6: 

Включение или выключение 
функции увеличения области 
фокусировки.

S&Q Motion: 
Включение и выключение режима 
записи с замедлением/ускорением 
движения. 
При нажатии и удерживании 
производится установка частоты 
кадров при съемке.

SteadyShot: 
Переключение между режимами 
Active, Standard и Off.

Rec: 
Запуск или остановка записи.

Project >Assignable Button
Назначение функций программируемым кнопкам.

Пункт Настройка подпункта Описание

<1> – <9>, 
Focus Hold 
Button

Picture Cache Rec: 
Включение или выключение 
режима записи в кэш 
изображения.

Rec Review: 
Включение или выключение 
функции Rec Review.

Clip Flag OK: 
Запуск функции Add OK. 
Нажмите дважды, чтобы выполнить 
функцию Delete Clip Flag.

Clip Flag NG: 
Выполнение функции Add NG. 
Нажмите дважды, чтобы выполнить 
функцию Delete Clip Flag.

Clip Flag Keep: 
Выполнение функции Add Keep. 
Нажмите дважды, чтобы выполнить 
функцию Delete Clip Flag.

Color Bars: 
Включение или выключение 
цветовых полос.

Tally [Front]: 
Включение или выключение 
функции включения или мигания 
индикатора записи/съемки.

DURATION/TC/U-BIT: 
Переключение между Time Code, 
Users Bit и Duration.

Display: 
Включение или выключение 
экранной индикации.

Lens Info: 
Переключение индикатора 
глубины поля резкости.

Video Signal Monitor: 
Переключение монитора 
видеосигнала (например, 
монитора формы сигнала).

Marker: 
Включение или выключение 
функции маркера.

VF Adjust: 
Отображение полос уровня для 
регулировки яркости экрана 
видоискателя.

VF Mode: 
Переключение изображения 
в видоискателе между цветным и 
черно-белым.
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Project >Assignable Button
Назначение функций программируемым кнопкам.

Пункт Настройка подпункта Описание

<1> – <9>, 
Focus Hold 
Button

Gamma Display Assist: 
Переключение функции помощи 
в отображении гамма-кривой.

Peaking: 
Включение или выключение 
функции контурной коррекции.

Zebra: 
Включение или выключение 
функции Zebra.

Volume: 
Регулировка громкости контрольного 
звука, выводимого на гнездо для 
наушников или на встроенный динамик.

Thumbnail: 
Отображение или закрытие экрана 
эскизов.

Touch Operation: 
Включение и выключение 
сенсорного управления.

Handle Zoom: 
Переключение работы органов 
управления масштабированием на 
рукоятке.

NFC: 
Выполнение функции NFC.

Auto Upload (Proxy): 
Включение или выключение 
автоматической передачи файлов прокси.

Direct Menu: 
Отображение или закрытие прямого меню.

User Menu: 
Отображение или закрытие меню User.

Menu: 
Отображение или закрытие 
полного меню.

Project >Assignable Dial
Назначение функций для программируемого диска и задание направления вращения.

Пункт Настройка подпункта Описание

Grip/Remote 
Dial

Off / ISO/Gain/EI / ND Filter / IRIS /  
Auto Exposure Level / Audio Input Level / 
Multi Function Dial

Назначение функций 
программируемому диску на ручке.
ISO/Gain/EI: 

Регулировка усиления или EI.
ND Filter: 

Регулировка фильтра ND.
IRIS: 

Регулировка диафрагмы.
Auto Exposure Level: 

Регулировка уровня 
автоматической экспозиции.

Audio Input Level: 
Регулировка уровня записи звука.

Multi Function Dial: 
Работает как 
многофункциональный диск.

Grip Dial 
Direction

Normal / Opposite Задание направления вращения 
программируемого диска на рукоятке.
Normal: вращение в обычном 

направлении.
Opposite: вращение в обратном 

направлении.
Handle Dial Off / ISO/Gain/EI / ND Filter / IRIS / Auto 

Exposure Level / Audio Input Level / Multi 
Function Dial

Назначение функций 
программируемому диску на ручке.
ISO/Gain/EI: 

Регулировка усиления или EI.
ND Filter: 

Регулировка фильтра ND.
IRIS: 

Регулировка диафрагмы.
Auto Exposure Level: 

Регулировка уровня 
автоматической экспозиции.

Audio Input Level: 
Регулировка уровня записи звука.

Multi Function Dial: 
Работает как 
многофункциональный диск.

Handle Dial 
Direction

Normal / Opposite Задание направления вращения 
программируемого диска на ручке.
Normal: вращение в обычном 

направлении.
Opposite: вращение в обратном 

направлении.
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Project >Multi Function Dial
Назначение функций многофункциональному диску.

Пункт Настройка подпункта Описание

Default 
Function

Off / IRIS / ISO/Gain/EI / Auto Exposure 
Level / Audio Input Level

Назначение функции по умолчанию 
многофункциональному диску.
IRIS: 

Регулировка диафрагмы.
ISO/Gain/EI: 

Регулировка усиления или EI.
Auto Exposure Level: 

Регулировка уровня 
автоматической экспозиции.

Audio Input Level: 
Регулировка уровня записи звука.

Project >User File
Задание настроек, относящихся к операциям с файлами пользовательских настроек.

Пункт Настройка подпункта Описание

Load 
Media(B)

Execute / Cancel Загрузка настроек пользовательского 
файла с карты памяти, установленной 
в гнездо карты CFexpress Type A/
SD-карты (B).
Execute: выполнение функции.

Save 
Media(B)

Execute / Cancel Сохранение настроек 
пользовательского файла на карте 
памяти, установленной в гнездо карты 
CFexpress Type A/SD-карты (B).
Execute: выполнение функции.

File ID Отображение экрана для отображения 
или изменения идентификатора файла 
для пользовательских файлов.

Load 
Customize 
Data

On / Off Задание того, следует ли загружать 
сведения о настроенном меню User 
при выполнении команды Load 
Media(B).

Load White 
Data

On / Off Задание того, следует ли загружать 
сведения о балансе белого при 
выполнении команды Load Media(B).

Project >All File
Задание настроек, относящихся к файлам ALL.

Пункт Настройка подпункта Описание

Load 
Media(B)

Execute / Cancel Загрузка файла ALL
Execute: выполнение функции.

Save 
Media(B)

Execute / Cancel Сохранение файла ALL.
Execute: выполнение функции.

File ID Назначение имени файлу.

Load Network 
Data

On / Off Задание того, следует ли загружать 
сведения о настройках меню Network 
при выполнении команды Load 
Media(B).
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Меню Paint/Look
В этом разделе приводится описание предназначения и настроек каждого пункта меню.
Настройки, заданные по умолчанию, выделены полужирным шрифтом (например, 18dB).

Paint/Look >Scene File
Задание настроек, относящихся к файлам сцен.

Пункт Настройка подпункта Описание

Recall Загрузка файла сцены, хранящегося во 
внутренней памяти, и применение его 
настроек в качестве текущих настроек 
качества изображения.

Store Сохранение текущего состояния 
качества изображения в виде файла 
сцены во внутренней памяти.

Delete Удаления файла сцены из внутренней 
памяти.

Preset Recall Если для параметра Shooting Mode задано 
значение Custom, а для параметра Target 
Display — значение SDR(BT.709):

S-Cinetone / Standard / Still / ITU709
Если для параметра Shooting Mode задано 
значение Custom, а для параметра Target 
Display — значение HDR(HLG):

HLG Live / HLG Natural

Применение стандартных настроек 
качества изображения (которые не 
допускают перезаписи) в качестве 
текущих настроек качества 
изображения.

Paint/Look >Base Look
Задание настроек, относящихся к базовому виду.

Пункт Настройка подпункта Описание

Select Если для параметра Shooting Mode задано 
значение Custom, а для параметра Target 
Display — значение SDR(BT.709):

S-Cinetone / Standard / Still / ITU709 / 
User1 – User16

Если для параметра Shooting Mode задано 
значение Custom, а для параметра Target 
Display — значение HDR(HLG):

HLG Live / HLG Natural / User1 – 
User16

Если для параметра Shooting Mode 
задано значение Cine EI:

s709 / 709(800) / S-Log3 / User1 – 
User16

Выбор базового вида.

Delete Удаление выбранного базового вида.

Delete All Удаление всех базовых видов.

Import Загрузка файла базового вида с 
носителя для записи.

Input S-Gamut3/SLog3 / S-Gamut3.Cine/SLog3 Задание входной гаммы для 
выбранного базового вида.

Output BT.709 / HLG Задание выходной цветовой гаммы 
для выбранного базового вида.

Paint/Look >Base Look
Задание настроек, относящихся к базовому виду.

Пункт Настройка подпункта Описание

AE Level 
Offset

0EV / 1/3EV / 2/3EV / 1EV / 4/3EV /  
5/3EV / 2EV

Задание опорного значения экспозиции 
для выбранного базового вида.

Paint/Look >Reset Paint Settings
Сброс настроек меню Paint/Look, кроме базового вида.

Пункт Настройка подпункта Описание

Reset without 
Base Look

Execute / Cancel Сброс настроек меню Paint/Look, 
кроме базового вида.
Execute: выполнение функции.

Paint/Look >Black
Задание настроек черного.

Пункт Настройка подпункта Описание

Master Black От –99.0 до +99.0 (±0.0) Установка контрольного уровня 
черного цвета.

R Black От –99.0 до +99.0 (±0.0) Установка уровня R черного цвета.

B Black От –99.0 до +99.0 (±0.0) Установка уровня B черного цвета.

Paint/Look >Knee
Задание настроек коррекции точки излома.

Пункт Настройка подпункта Описание

Setting Если для параметра Target Display 
задано значение SDR(BT.709):

On / Off / ---
Если для параметра Target Display 
задано значение HDR(HLG):

On / Off / ---

Включение или выключение функции 
коррекции колена.

[Совет]
Действует только, когда параметру Base 
Look >Select задано значение Standard или 
ITU709.

Auto Knee Если для параметра Target Display 
задано значение SDR(BT.709):

On / Off / ---
Если для параметра Target Display 
задано значение HDR(HLG):

On / Off / ---

Включение или выключение функции 
автоматического излома.

Point От 75% до 109% (90%) Установка точки колена.

Slope От –99 до +99 (±0) Установка наклона колена.
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Paint/Look >Detail
Задание настроек регулирования деталей.

Пункт Настройка подпункта Описание

Setting On / Off Включение или выключение функции 
деталей.

Level От –7 до +7 (±0) Установка уровня деталей.

Manual 
Setting

On / Off / --- Включение или выключение функции 
ручного регулирования деталей.

V/H Balance От –2 до +2 (±0) Задание баланса между вертикальной 
(V) и горизонтальной (H) детализацией 
для ручной регулировки деталей.

B/W Balance Type1 / Type2 / Type3 / Type4 / Type5 Задание баланса между деталями 
черного (B) для темных областей и 
деталями белого (W) для светлых 
областей при ручной регулировке 
деталей.

Limit От 0 до 7 Задание уровня ограничения деталей 
для ручной регулировки деталей.

Crispening От 0 до 7 Задание уровня повышения резкости 
для ручной регулировки деталей.

High Light 
Detail

От 0 до 4 Задание уровня деталей для светлых 
областей при ручной регулировке 
деталей.

Paint/Look >Matrix
Задание настроек матричной коррекции.

Пункт Настройка подпункта Описание

User Matrix On / Off Включение или выключение функции 
пользовательской матричной 
коррекции.

User Matrix 
Level

От –99 до +99 (±0) Регулировка насыщенности цвета 
всего изображения.

User Matrix 
Phase

От –99 до +99 (±0) Регулировка оттенка цвета (фазы) 
всего изображения.

User Matrix 
R-G

От –99 до +99 (±0) Задание определенной пользователем 
матрицы R-G.

User Matrix 
R-B

От –99 до +99 (±0) Задание определенной пользователем 
матрицы R-B.

User Matrix 
G-R

От –99 до +99 (±0) Задание определенной пользователем 
матрицы G-R.

User Matrix 
G-B

От –99 до +99 (±0) Задание определенной пользователем 
матрицы G-B.

Paint/Look >Matrix
Задание настроек матричной коррекции.

Пункт Настройка подпункта Описание

User Matrix 
B-R

От –99 до +99 (±0) Задание определенной пользователем 
матрицы B-R.

User Matrix 
B-G

От –99 до +99 (±0) Задание определенной пользователем 
матрицы B-G.

Paint/Look >Multi Matrix
Задание настроек мультиматричной коррекции.

Пункт Настройка подпункта Описание

Setting On / Off Включение или выключение функции 
мультиматричной коррекции.

Reset Execute / Cancel Сброс оттенка и насыщенности для 
каждого цвета оси на значения по 
умолчанию.

Axis B / B+ / MG– / MG / MG+ / R / R+ / YL– / 
YL / YL+ / G– / G / G+ / CY / CY+ / B–

Выбор оси.

Hue От –99 до +99 (±0) Выбор оттенка цвета, используемого 
для мультиматричной коррекции.

Saturation От –99 до +99 (±0) Выбор насыщенности цвета, 
используемого для мультиматричной 
коррекции.
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Меню TC/Media
В этом разделе приводится описание предназначения и настроек каждого пункта меню.
Настройки, заданные по умолчанию, выделены полужирным шрифтом (например, 18dB).

TC/Media >Timecode
Задание настроек временного кода.

Пункт Настройка подпункта Описание

Mode Preset / Regen / Clock Установка режима отсчета временного 
кода.
Preset: 

Начало отсчета от предварительно 
заданного значения.

Regen: 
Начало отсчета от временного кода 
конца предыдущего клипа.

Clock: 
Использование внутренних часов 
в качестве временного кода.

Run Rec Run / Free Run Rec Run: отсчет ведется только при 
записи.

Free Run: отсчет ведется всегда, 
независимо от режима работы 
видеокамеры.

Setting Установка произвольного значения 
временного кода.
SET: установка значения.

Reset Execute / Cancel Сброс временного кода до значения 
00:00:00:00.
Execute: выполнение функции.

TC Format DF / NDF Установка формата временного кода.
DF: Drop Frame
NDF: Non-Drop Frame

TC/Media >TC Display
Задание настроек отображения данных времени.

Пункт Настройка подпункта Описание

Display Select Timecode / Users Bit / Duration Переключение отображения данных 
времени.

TC/Media >Users Bit
Задание настроек, относящихся к битам пользователя.

Пункт Настройка подпункта Описание

Mode Fix / Time Установка режима битов пользователя.
Fix: использование в битах 

пользователя произвольного 
фиксированного значения.

Time: Использует текущее время в 
битах пользователя.

Setting Установка произвольного значения 
для битов пользователя.

TC/Media >HDMI TC Out
Задание настроек, относящихся к выводу временного кода при использовании разъема 
HDMI.

Пункт Настройка подпункта Описание

Setting On / Off Установка возможности передачи 
временного кода на устройства для 
других целей через выход HDMI.
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TC/Media >Clip Name Format
Задание настроек, связанных с именами клипов и их удалением.

Пункт Настройка подпункта Описание

Title Prefix nnn_ (nnn последние 3 цифры 
порядкового номера)
(Отображается не более 7 цифр)

Задание части названия (от 4 до 46 
символов) в имени клипа.
Открывает экран ввода строки символов.

Структура экрана ввода строки 
символов
Область выбора символов (3 строки): 

Выбор символов для вставки 
в положении курсора в области 
Title Prefix.  
!#$%()+.-.;=@[ ]^_~0123456789 
abcdefghijklmnopqrstuvwxyz 
ABCDEFGHIJKLMNOPQRSTUVWXYZ

Область операций с курсором 
(1 строка): 
Space: вставка пробела 
в положении курсора.  
: перемещение курсора влево.  
: перемещение курсора вправо.  
BS: удаление символа, 
расположенного слева от 
положения курсора.

Область Title Prefix (1 строка): 
Область ввода названия.

Задание названия
1. С помощью 

многофункционального селектора 
(стр. 7) выберите символ для 
вставки в положение курсора в 
области Title Prefix из области 
выбора символов, затем нажмите 
кнопку применения на 
многофункциональном селекторе. 
(Вставляется выбранный символ, и 
курсор перемещается вправо.)

2. Повторяйте шаг 1 для задания 
названия. (При необходимости 
используйте BS.)

3. После задания названия выберите 
пункт Done, чтобы закрыть экран 
ввода символов.

Number Set От 0001 до 9999 Задание 4-значного цифрового 
суффикса имени клипа.

TC/Media >Update Media
Обновление файла управления на картах памяти.

Пункт Настройка подпункта Описание

Media(A) Execute / Cancel Обновление файла управления на 
карте памяти, вставленной в гнездо A.
Execute: выполнение функции.

Media(B) Execute / Cancel Обновление файла управления на 
карте памяти, вставленной в гнездо B.
Execute: выполнение функции.

TC/Media >Format Media
Инициализация карт памяти.

Пункт Настройка подпункта Описание

Media(A) Full Format / Quick Format / Cancel Форматирование карты памяти, 
вставленной в гнездо A.

Media(B) Full Format / Quick Format / Cancel Форматирование карты памяти, 
вставленной в гнездо B.
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В этом разделе приводится описание предназначения и настроек каждого пункта меню.
Настройки, заданные по умолчанию, выделены полужирным шрифтом (например, 18dB).

Monitoring >Output On/Off
Задание настроек видеовыхода.

Пункт Настройка подпункта Описание

SDI On / Off Включение или выключение выхода 
SDI.

HDMI On / Off Включение или выключение выхода 
HDMI.

Monitoring >Output Format
Задание настроек выходного формата.

Пункт Настройка подпункта Описание

SDI Подробное описание настроек см. в 
разделе “Форматы и ограничения для 
выходов” (стр. 121).

Установка разрешения выходов SDI и 
HDMI.HDMI

Monitoring >Output Display
Задание настроек вывода отображения на экране.

Пункт Настройка подпункта Описание

SDI On / Off Задает, внедряются ли меню, 
состояние и отображение на экране в 
выходной сигнал SDI.

HDMI On / Off Задает, внедряются ли меню, 
состояние и отображение на экране 
в выходной сигнал HDMI.

Monitoring >Display On/Off
Задание настроек отображаемых элементов.

Пункт Настройка подпункта Описание

Network 
Status

On / Off Выбор элементов для отображения на 
экране видоискателя.

File Transfer 
Status

On / Off

Rec/Play 
Status

On / Off

RAW Output 
Control 
Status

On / Off

Tally On / Off

Battery 
Remain

On / Off

Focus Mode On / Off

Focus 
Position

On / Off

Focus Area 
Indicator

On / Off

Focus Area 
Ind.(AF-S)

On / Off

Face/Eye 
Detection 
Frame

On / Off

Lens Info On / Off

Imager Scan 
Mode

On / Off

Rec Format On / Off

Frame Rate On / Off

Zoom 
Position

On / Off

UWP RF Level On / Off

SteadyShot On / Off

Меню Monitoring
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Monitoring >Display On/Off
Задание настроек отображаемых элементов.

Пункт Настройка подпункта Описание

Base Look/
LUT

On / Off

SDI/HDMI 
Rec Control

On / Off

Gamma 
Display Assist

On / Off

Proxy Status On / Off

Base ISO/
Sensitivity

On / Off

Media Status On / Off

Video Signal 
Monitor

Off / Waveform / Vector / Histogram

Clip Name On / Off

White 
Balance

On / Off

Scene File On / Off

Focus 
Indicator

On / Off

Auto 
Exposure 
Mode

On / Off

Auto 
Exposure 
Level

On / Off

Timecode On / Off

ND Filter On / Off

Iris On / Off

ISO/Gain/EI On / Off

Shutter On / Off

Level Gauge On / Off

Audio Level 
Meter

On / Off

Video Level 
Warning

On / Off

Clip Number On / Off

Notice 
Message

On / Off

Monitoring >Marker
Задание настроек отображения маркеров.

Пункт Настройка подпункта Описание

Setting On / Off Включение или выключение 
отображения всех маркеров.

Color White / Yellow / Cyan / Green / Magenta / 
Red / Blue

Выбор цвета сигнала маркера.

Center 
Marker

1 / 2 / 3 / 4 / Off Выбор центрального маркера.

Safety Zone On / Off Включение или выключение маркера 
зоны гарантированного отображения.

Safety Area 80% / 90% / 92.5% / 95% Выбор размера маркера зоны 
гарантированного отображения (в 
процентах от общего размера экрана).

Aspect 
Marker

Line / Mask / Off Выбор типа маркера формата 
изображения.

Aspect Mask От 0 до 15 (12) Задает уровень видеосигнала за 
пределами маркера.

Aspect Safety 
Zone

On / Off Включение или выключение маркера 
зоны гарантированного отображения 
формата изображения.

Aspect Safety 
Area

80% / 90% / 92.5% / 95% Выбор размера маркера зоны 
гарантированного отображения 
формата изображения (в процентах от 
общего размера экрана).

Aspect Select 1:1 / 4:3 / 13:9 / 14:9 / 15:9 / 16:9 / 17:9 / 
1.66:1 / 1.85:1 / 2.35:1 / 2.39:1 / Custom

Установка режима при отображении 
маркера формата изображения.

Custom 
Aspect Ratio

Введите произвольное значение 
(01.00:01.00)

Установка произвольного значения 
соотношения сторон изображения.
[Примечание]
Эта настройка включена, если для параметра 
Aspect Select задано значение Custom.

Guide Frame On / Off Включение или выключение 
отображения опорной рамки.

100% Marker On / Off Включение или выключение 100% маркера.

User Box On / Off Включение или выключение отображения 
маркера поля пользователя.

User Box 
Width

От 3 до 479 (240) Установка ширины маркера поля 
пользователя (расстояние от центра до 
левого и правого краев).

User Box 
Height

От 3 до 269 (135) Установка высоты маркера поля 
пользователя (расстояние от центра до 
верхнего и нижнего краев).

User Box H 
Position

От –476 до +476 (0) Задание положения центра маркера 
поля пользователя по горизонтали.

User Box V 
Position

От –266 до +266 (0) Задание положения центра маркера 
поля пользователя по вертикали.
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Monitoring >VF Setting
Задание настроек видоискателя.

Пункт Настройка подпункта Описание

Brightness От 1 до 15 (8) Регулировка яркости изображения в 
видоискателе.

Color Mode Color / B&W Выбор режима отображения 
видоискателя в режиме E-E/записи.

Monitoring >Gamma Display Assist
Задание настроек помощи в отображении гамма.

Пункт Настройка подпункта Описание

Setting On / Off Включение или выключение функции 
Gamma Display Assist в режиме Custom, 
когда для параметра Target Display 
задано значение HDR(HLG).

Monitoring >Peaking
Задание настроек контурной коррекции.

Пункт Настройка подпункта Описание

Setting On / Off Включение или выключение функции 
контурной коррекции.

Peaking Level High / Mid / Low Установка уровня сигнала цветной 
контурной коррекции.

Color B&W / Red / Yellow / Blue Выбор цвета сигнала цветной 
контурной коррекции.

Monitoring >Zebra
Задание настроек узора зебры.

Пункт Настройка подпункта Описание

Setting Off / Zebra1 / Zebra2 Выбор типа узора зебры (Off, Zebra 1, 
Zebra 2).

Zebra1 Level От 0% до 109% (70%) Установка уровня отображения Zebra 1.

Zebra1 
Aperture 
Level

От 2% до 20% (10%) Установка уровня диафрагмы Zebra 1.

Zebra2 Level От 0% до 109% (100%) Установка уровня отображения Zebra 
2.
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Меню Audio
В этом разделе приводится описание предназначения и настроек каждого пункта меню.
Настройки, заданные по умолчанию, выделены полужирным шрифтом (например, 18dB).
См. раздел “Блок-схемы” (стр. 135).

Audio >Audio Input
Задание настроек аудиовхода.

Пункт Настройка подпункта Описание

CH1 Input 
Select

INPUT1 / Internal MIC / Shoe CH1 Переключение источника входного 
сигнала для записи в канал 1.

CH2 Input 
Select

INPUT1 / INPUT2 / Internal MIC / Shoe CH2 Переключение источника входного 
сигнала для записи в канал 2.

CH3 Input 
Select

Off / INPUT1 / Internal MIC / Shoe CH1 Переключение источника входного 
сигнала для записи в канал 3.

CH4 Input 
Select

Off / INPUT1 / INPUT2 / Internal MIC / 
Shoe CH2

Переключение источника входного 
сигнала для записи в канал 4.

INPUT1 MIC 
Reference

–80dB / –70dB / –60dB / –50dB / –40dB / 
–30dB

Установка эталонного уровня записи 
для входного сигнала микрофона XLR 
из канала INPUT1.

INPUT2 MIC 
Reference

–80dB / –70dB / –60dB / –50dB / –40dB / 
–30dB

Установка эталонного уровня записи 
для входного сигнала микрофона XLR 
из канала INPUT2.

Line Input 
Reference

+4dB / 0dB / –3dB / EBUL Выбор опорного входного уровня, 
когда переключатель INPUT1/INPUT2 
установлен в положение LINE.

Reference 
Level

–20dB / –18dB / –16dB / –12dB / EBUL Выбор уровня записи опорного 
звукового сигнала 1 кГц.

CH1 Wind 
Filter

On / Off Включение/выключение фильтра 
подавления шума ветра для записи в 
канале 1.

CH2 Wind 
Filter

On / Off Включение/выключение фильтра 
подавления шума ветра для записи в 
канале 2.

CH3 Wind 
Filter

On / Off Включение/выключение фильтра 
подавления шума ветра для записи в 
канале 3.

CH4 Wind 
Filter

On / Off Включение/выключение фильтра 
подавления шума ветра для записи в 
канале 4.

CH3 Level 
Control

Auto / Manual Выбор автоматической регулировки 
входного уровня звука или ручной 
регулировки для записи канала 3.

[Примечание]
Если для параметров CH3 Input Select и 
CH4 Input Select установлено значение 
Internal MIC, канал CH4 переключается в 
автоматический/ручной режим совместно с 
этой настройкой.

Audio >Audio Input
Задание настроек аудиовхода.

Пункт Настройка подпункта Описание

CH4 Level 
Control

Auto / Manual Выбор автоматической регулировки 
входного уровня звука или ручной 
регулировки для записи канала 4.

[Примечание]
Если для параметров CH3 Input Select и 
CH4 Input Select установлено значение 
Internal MIC, канал CH4 переключается в 
автоматический/ручной режим совместно с 
настройкой CH3 Level Control.

CH3 Input 
Level

От 0 до 99 (49) Задание уровня входного сигнала для 
записи канала 3.

CH4 Input 
Level

От 0 до 99 (49) Задание уровня входного сигнала для 
записи канала 4.

Audio Input 
Level

От 0 до 99 Установка уровня входного 
аудиосигнала.
Можно использовать в качестве 
основного уровня громкости, в 
соответствии с настройками CH1 Level 
– CH4 Level.

Limiter Mode Off / –6dB / –9dB / –12dB / –15dB / –17dB Выбор характеристик ограничителя 
для больших входных сигналов при 
регулировке уровня аудиосигнала 
вручную.

CH1&2 AGC 
Mode

Mono / Stereo Установка автоматического режима 
регулировки уровня для записи канала 
1 и канала 2. Если задано значение 
Stereo, функция AGC синхронизирована 
между каналами.

CH3&4 AGC 
Mode

Mono / Stereo Установка автоматического режима 
регулировки уровня для записи канала 
3 и канала 4. Если задано значение 
Stereo, функция AGC синхронизирована 
между каналами.

AGC Spec –6dB / –9dB / –12dB / –15dB / –17dB Выбор характеристик AGC.

1kHz Tone on 
Color Bars

On / Off Включение или выключение опорного 
тонального сигнала частотой 1 кГц при 
отображении цветовых полос.

[Примечание]
Когда для этого параметра установлено 
значение On, тональный сигнал частотой 
1 кГц включается для записи в канал 3 и 4 
даже в том случае, если для параметров CH3 
Input Select и CH4 Input Select установлено 
значение Off.
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Audio >Audio Input
Задание настроек аудиовхода.

Пункт Настройка подпункта Описание

CH1 Level Вход без адаптера XLR
Audio Input Level / Side / Level+Side

Вход с адаптером XLR (стр. 50)
Audio Input Level / Through

Установка сочетания регулировок 
уровня входного аудиосигнала, 
включенных для записи канала 1.

[Примечание]
“Side” означает диск AUDIO LEVEL (CH1), 
расположенный на боковой стороне 
видеокамеры. При выборе Level+Side 
уровень записи звука определяется 
сочетанием значения параметра Audio Input 
Level и положения диска (стр. 135).

CH2 Level Вход без адаптера XLR
Audio Input Level / Side / Level+Side

Вход с адаптером XLR (стр. 50)
Audio Input Level / Through

Установка сочетания регулировок 
уровня входного аудиосигнала, 
включенных для записи канала 2.

[Примечание]
“Side” означает диск AUDIO LEVEL (CH2), 
расположенный на боковой стороне 
видеокамеры. При выборе Level+Side 
уровень записи звука определяется 
сочетанием значения параметра Audio Input 
Level и положения диска (стр. 135).

CH3 Level Вход без адаптера XLR
Audio Input Level / CH3 Input Level / 
Level+CH3 Input Level

Вход с адаптером XLR (стр. 50)
Audio Input Level / Through

Установка сочетания регулировок 
уровня входного аудиосигнала, 
включенных для записи канала 3.

CH4 Level Вход без адаптера XLR
Audio Input Level / CH4 Input Level / 
Level+CH4 Input Level

Вход с адаптером XLR (стр. 50)
Audio Input Level / Through

Установка сочетания регулировок 
уровня входного аудиосигнала, 
включенных для записи канала 4.

Audio >Audio Output
Задание настроек аудиовыхода.

Пункт Настройка подпункта Описание

Monitor CH CH1/CH2 / CH3/CH4 / MIX ALL / CH1 / 
CH2 / CH3 / CH4

Выбор вывода аудиоканала на гнездо 
для наушников или на встроенный 
динамик.

[Примечание]
Если звук нескольких каналов настроен 
для одновременного вывода, выходной 
уровень каждого канала уменьшается для 
предотвращения ограничения.

Volume От 0 до 50 Регулировка громкости контрольного 
звука, выводимого на гнездо для 
наушников или на встроенный 
динамик.

Headphone 
Out

Mono / Stereo Выбор типа выходного аудиосигнала, 
подаваемого на гнездо для 
наушников: монофонический 
(значение Mono) или 
стереофонический (значение Stereo).

Alarm Level От 0 до 7 (4) Регулировка громкости аварийных 
сигналов.

HDMI Output 
CH

CH1/CH2 / CH3/CH4 Установка сочетания аудиоканалов на 
выходе HDMI.
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В этом разделе приводится описание предназначения и настроек каждого пункта меню.
Настройки, заданные по умолчанию, выделены полужирным шрифтом (например, 18dB).

Thumbnail

Пункт Настройка подпункта Описание

Display Clip 
Properties

Отображение экрана свойств клипа.

Thumbnail >Set Clip Flag
Задание настроек флагов клипов.

Пункт Настройка подпункта Описание

Add OK Добавление флага OK.

Add NG Добавление флага NG.

Add KEEP Добавление флага Keep.

Delete Clip 
Flag

Удаление всех флагов.

Thumbnail >Lock/Unlock Clip
Задание настроек защиты клипов.

Пункт Настройка подпункта Описание

Select Clip Выбор клипа и установка/снятие его 
блокировки.

Lock All Clips Блокировка всех клипов.

Unlock All 
Clips

Снятие блокировки всех клипов.

Thumbnail >Delete Clip
Удаление клипов.

Пункт Настройка подпункта Описание

Select Clip Удаление выбранных клипов.

All Clips Удаление всех клипов.

Thumbnail >Transfer Clip
Передача клипов.

[Примечание]
Функцию Transfer Clip нельзя настроить, когда не задан пароль с помощью пункта Access Authentication 
меню Network.

Пункт Настройка подпункта Описание

Select Clip Передача выбранных клипов.

All Clips Передача всех клипов.

[Примечание]
Можно передать не более 200 клипов.

Thumbnail >Transfer Clip (Proxy)
Передача клипов прокси.

[Примечание]
Функцию Transfer Clip (Proxy) нельзя настроить, когда не задан пароль с помощью пункта Access 
Authentication меню Network.

Пункт Настройка подпункта Описание

Select Clip Передача клипов прокси, 
соответствующих выбранным клипам.

All Clips Передача клипов прокси, 
соответствующих всем клипам.

[Примечание]
Можно передать не более 200 клипов.

Thumbnail >Filter Clips
Задание настроек клипов для отображения.

Пункт Настройка подпункта Описание

OK Отображение только клипов, имеющих 
флаг OK.

NG Отображение только клипов, имеющих 
флаг NG.

KEEP Отображение только клипов, имеющих 
флаг Keep.

None Отображение только клипов, которым 
не заданы никакие флаги.

All Отображение всех клипов, независимо 
от наличия каких-либо флагов.

Thumbnail >Customize View
Переключение вида экрана эскизов.

Пункт Настройка подпункта Описание

Thumbnail 
Caption

Date Time / Time Code / Duration / 
Sequential Number

Переключение информации, 
отображаемой под эскизами.

Меню Thumbnail
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Меню Technical
В этом разделе приводится описание предназначения и настроек каждого пункта меню.
Настройки, заданные по умолчанию, выделены полужирным шрифтом (например, 18dB).

Technical >Color Bars
Задание настроек цветных полос.

Пункт Настройка подпункта Описание

Setting On / Off Включение или выключение цветовых 
полос.

Type ARIB / 100% / 75% / SMPTE Выбор типа цветовой полосы.

Technical >ND Dial
Задание настроек, относящихся к операциям с диска ND VARIABLE.

Пункт Настройка подпункта Описание

CLEAR with 
Dial

On / Off Задание того, требуется ли включить 
переключение состояния ND (CLEAR 
 On) с помощью диска ND VARIABLE.

Technical >Tally
Задание настроек индикатора записи/съемки.

Пункт Настройка подпункта Описание

Front On / Off Включение и выключение индикатора 
записи/съемки (переднего).

Rear On / Off Включение и выключение индикатора 
записи/съемки (заднего).

Technical >HOLD Switch Setting
Задание настроек переключателя Hold.

Пункт Настройка подпункта Описание

with Rec 
Button

On / Off Задает блокировку работы кнопки 
START/STOP (пуск/остановка записи).

with Hand 
Grip Remote

On / Off Задает блокировку работы пульта 
управления на рукоятке.

Technical >HOLD Switch Setting
Задание настроек переключателя Hold.

Пункт Настройка подпункта Описание

Handle HOLD 
Switch

Normal / Rec Button Only Указание того, является ли целевым 
элементов переключателя HOLD на 
рукоятке только расположенная на ней 
же кнопка START/STOP (пуск/остановка 
записи).
Normal: 

Целевыми элементами являются 
все органы управления, 
расположенные на рукоятке.  
При этом за кнопку START/STOP 
(пуск/остановка записи) на 
рукоятке отвечает настройка “with 
Rec Button”.

Rec Button Only: 
Только кнопка START/STOP (пуск/
остановка записи) на рукоятке 
является целевым элементом 
операции удержания.

Technical >Touch Operation
Задание настроек, относящихся к сенсорному управлению.

Пункт Настройка подпункта Описание

Setting On / Off Включение и выключение сенсорного 
управления.

Technical >Rec Review
Задание настроек просмотра записи.

Пункт Настройка подпункта Описание

Setting 3 s / 10 s / Clip Выбор времени воспроизведения 
только что записанного клипа для 
функции просмотра записи.
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Technical >Zoom
Задание настроек масштабирования.

Пункт Настройка подпункта Описание

Zoom Type Optical Zoom Only / On(Clear Image 
Zoom)

Задание типа масштабирования.
Optical Zoom Only: 

Оптическое масштабирование 
регулируется с помощью 
объектива.

On(Clear Image Zoom): 
Электронное масштабирования с 
небольшим ухудшением качества 
изображения или без его 
ухудшения.

Technical >Handle Zoom
Задание настроек масштабирования с помощью органа управления, расположенного на 
рукоятке.

Пункт Настройка подпункта Описание

Setting Off / Low / High / Variable Установка скорости рычага 
масштабирования, расположенного на 
рукоятке.

High От 1 до 8 (8) Задание скорости масштабирования 
для рычага масштабирования на 
рукоятке, когда выбрана скорость 
масштабирования на рукоятке High.

Low От 1 до 8 (3) Задание скорости масштабирования 
для рычага масштабирования на 
рукоятке, когда выбрана скорость 
масштабирования на рукоятке Low.

[Примечание]
Если для скорости масштабирования задано 
низкое значение, возможно неравномерное 
масштабирование.

Technical >Menu Settings
Задание настроек, относящихся к меню.

Пункт Настройка подпункта Описание

User Menu 
Only

On / Off Задание отображения только меню 
User (On) или списка меню (Off), когда 
на видеокамере отображается меню.

User Menu 
with Lock

On / Off Задание блокировки отображения меню, 
чтобы отображалось только меню User.

[Примечание]
При обычной операции отображения меню 
этот пункт не отображается. Подробную 
информацию об операции отображения 
меню см. на стр. 75.

Technical >Menu Page On/Off
Задание настроек в отношении отображения экрана состояния.

Пункт Настройка подпункта Описание

Main On / Off Включение или выключение 
отображения экрана Main Status.

Camera On / Off Включение или выключение 
отображения экрана Camera Status.

Audio On / Off Включение или выключение 
отображения экрана Audio Status.

Project On / Off Включение или выключение 
отображения экрана состояния Project.

Monitoring On / Off Включение или выключение 
отображения экрана Monitoring Status.

Assignable 
Button

On / Off Включение или выключение 
отображения экрана Assignable Button 
Status.

Battery On / Off Включение или выключение 
отображения экрана Battery Status.

Media On / Off Включение или выключение 
отображения экрана Media Status.

Network On / Off Включение или выключение 
отображения экрана Network Status.

File Transfer On / Off Включение или выключение 
отображения экрана File Transfer Status.

Technical >Fan Control
Задание настроек режима управления вентилятором.

Пункт Настройка подпункта Описание

Setting Auto / Minimum / Off in Rec Установка режима управления 
вентилятором видеокамеры.

[Примечание]
Даже при выборе Off in Rec вентилятор 
работает, если температура внутри 
видеокамеры поднимается выше 
определенного уровня.
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Technical >Lens
Задание настроек, относящихся к объективам.

Пункт Настройка подпункта Описание

Zoom Ring 
Direction

Left(W)/Right(T) / Right(W)/Left(T) Установка направления вращения 
кольца масштабирования.

[Примечание]
Доступно только при использовании 
объектива с байонетом E, который 
поддерживает переключение направления 
вращения кольца масштабирования.

Shading 
Compensation

Auto / Off Задание автоматической компенсации 
затенения.

Chroma 
Aberration 
Comp.

Auto / Off Задание автоматической компенсации 
хроматических аберраций.

Distortion 
Comp.

Auto / Off Задание автоматической компенсации 
искажения.

Breathing 
Compensation

Auto / Off Задание компенсации дыхания 
объектива.

Distance 
Display

Meter / Feet Задание единиц отображения для 
информации об объективе и 
положения фокусировки.

Zoom 
Position 
Display

Focal Length / Number / Bar Задание формата отображения 
положения масштабирования.

Technical >Video Light Set
Задает способ освещения лампой для видеосъемки. Этот параметр доступен только при 
использовании компонента HVL-LBPC (приобретается дополнительно).

Пункт Настройка подпункта Описание

Video Light 
Set

Power Link / Rec Link / Rec Link + Stby Установка способа управления 
освещением, которое обеспечивается 
лампой для видеосъемки, 
присоединенной к многоцелевому 
разъему.
Power Link: 

Включение или выключение лампы 
для видеосъемки при включении 
или выключении видеокамеры.

Rec Link: 
Включение или выключение лампы 
для видеосъемки при запуске/
остановке записи.

Rec Link + Stby: 
Включение лампы для 
видеосъемки или перевод ее 
в состояние ожидания при запуске/
остановке записи.

Technical >APR
Выполнение APR.

Пункт Настройка подпункта Описание

APR Execute / Cancel Запуск APR (Automatic Pixel Restoration 
— Автоматическое восстановление 
пикселей) для автоматической 
регулировки датчика изображения.
Execute: выполнение функции.
[Примечание]
Перед выполнением функции APR всегда 
закрывайте объектив крышкой.

Technical >Camera Battery Alarm
Задание настроек аварийных сигналов о низком напряжении аккумулятора.

Пункт Настройка подпункта Описание

Low Battery 5% / 10% / 15% / … / 45% / 50% Установка уровня оставшегося заряда 
аккумулятора (с дискретностью 5%), по 
достижении которого выдается 
аварийный сигнал о низком напряжении.

Battery Empty От 3% до 7% Установка уровня оставшегося заряда 
аккумулятора, при котором выдается 
аварийный сигнал о том, что 
аккумулятор разряжен.

Technical >Camera DC IN Alarm
Задание настроек аварийных сигналов о входном напряжении.

Пункт Настройка подпункта Описание

DC Low 
Voltage1

От 16.0V до 19.0V (16.5V) Установка значения напряжения, при 
котором подается аварийный сигнал о 
низком напряжении на разъеме.

DC Low 
Voltage2

От 15.5V до 18.5V Установка значения напряжения, при 
котором подается аварийный сигнал о 
недостаточном напряжении на разъеме.



6. Отображение меню и настройки104

Меню Network
В этом разделе приводится описание предназначения и настроек каждого пункта меню.
Настройки, заданные по умолчанию, выделены полужирным шрифтом (например, 18dB).

Network >Access Authentication
Задание настроек, относящихся к аутентификации доступа.

Пункт Настройка подпункта Описание

User Name Задание имени пользователя для 
аутентификации доступа.

Input 
Password

Задание пароля для аутентификации 
доступа.

[Примечание]
С точки зрения безопасности рекомендуется 
задавать в качестве пароля достаточно 
длинную строку символов, чтобы его было 
трудно угадать другим людям; кроме 
того, рекомендуется хранить пароль в 
безопасном месте.

Generate 
Password

Execute / Cancel Автоматическое формирование 
пароля для аутентификации доступа.
Execute: выполнение функции.

Show 
Settings

Отображение имени пользователя, 
пароля, отпечатка пальца, серийного 
номера, наименования изделия и 
серийного номера для 
аутентификации доступа в виде текста 
или QR-кода.

[Примечание]
Следите за тем, чтобы никто не видел 
пароль и не мог скопировать изображение 
QR-кода.

Network >Wireless LAN
Задание настроек, относящихся к соединениям по беспроводной ЛВС.

Пункт Настройка подпункта Описание

Setting Access Point Mode / Station Mode / Off Выбор режима работы для 
подключения по беспроводной ЛВС.

WPS Execute / Cancel Установление подключения с 
помощью функции WPS (Wi-Fi Protected 
Setup).
Execute: выполнение функции.

NFC Execute / Cancel Установление подключения с 
помощью функции NFC (Near Field 
Communication).
Execute: выполнение функции.

Network >Wireless LAN
Задание настроек, относящихся к соединениям по беспроводной ЛВС.

Пункт Настройка подпункта Описание

MAC Address Отображение MAC-адреса интерфейса 
беспроводной ЛВС видеокамеры.

Network >AP Mode Settings
Задание настроек, относящихся к подключениям в режиме точки доступа.

Пункт Настройка подпункта Описание

Channel Auto(5GHz) / Auto / CH1 / CH2 /  
CH3 / CH4 / CH5 / CH6 / CH7 / CH8 / CH9 / 
CH10 / CH11

Задание канала беспроводной 
локальной сети.
Вариант Auto(5GHz) доступен только на 
модели ILME-FX6V/VK.

Camera SSID 
& Password

Отображение SSID сети и пароля 
видеокамеры.

Regenerate 
Password

Execute / Cancel Создание нового пароля.
Execute: выполнение функции.

IP Address Отображение IP-адреса видеокамеры 
в режиме точки доступа.

Subnet Mask Отображение маска подсети 
видеокамеры в режиме точки доступа.
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Network >ST Mode Settings
Задание настроек, относящихся к подключениям в режиме станции.

Пункт Настройка подпункта Описание

Camera 
Remote 
Control

Enable / Disable Задает, требуется ли включить 
дистанционное управление с 
устройства, подключенного к 
видеокамере по беспроводной ЛВС в 
режиме станции.

Connected 
Network

Отображение подключенной 
беспроводной ЛВС (точки доступа).

SSID Отображение SSID для точки доступа, к 
которой производится подключение.

Security Отображение типа безопасности для 
точки доступа, к которой производится 
подключение.

Password Отображение пароля для точки 
доступа, к которой производится 
подключение.
Если для параметра Security задано 

значение WEP или WPA: *******
Если для параметра Security задано 

значение None: (пусто)

DHCP Показывает, включена или выключена 
функция DHCP.

IP Address Отображение IP-адреса видеокамеры, 
если для параметра DHCP задано 
значение Off.

Subnet Mask Отображение маски подсети 
видеокамеры, если для параметра 
DHCP задано значение Off.

Gateway Отображение шлюза по умолчанию 
видеокамеры, если для параметра 
DHCP задано значение Off.

DNS Auto Показывает, включено или выключено 
получение DNS.

Primary DNS Server Отображение основного сервера DNS 
видеокамеры, если для параметра DNS 
Auto задано значение Off.

Secondary DNS Server Отображение дополнительного 
сервера DNS видеокамеры, если для 
параметра DNS Auto задано значение 
Off.

Network >ST Mode Settings
Задание настроек, относящихся к подключениям в режиме станции.

Пункт Настройка подпункта Описание

Scan 
Networks

Обнаружение беспроводных ЛВС 
(точек доступа) и отображение списка.
Выберите из списка точку для 
подключения.

SSID Отображение SSID для точки доступа, к 
которой производится подключение.

Security Отображение типа безопасности для 
точки доступа, к которой производится 
подключение.

Password Введите пароль для точки доступа, к 
которой производится подключение.

DHCP 
On / Off

Включение или выключение DHCP.

IP Address Введите IP-адрес видеокамеры, если 
для параметра DHCP задано значение 
Off.

Subnet Mask Введите маску подсети видеокамеры, 
если для параметра DHCP задано 
значение Off.

Gateway Введите шлюз по умолчанию 
видеокамеры, если для параметра 
DHCP задано значение Off.

DNS Auto 
On / Off

Включение или выключение 
получения DNS.

Primary DNS Server Введите основной сервер DNS 
видеокамеры, если для параметра DNS 
Auto задано значение Off.

Secondary DNS Server Введите дополнительный сервер DNS 
видеокамеры, если для параметра DNS 
Auto задано значение Off.
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Network >ST Mode Settings
Задание настроек, относящихся к подключениям в режиме станции.

Пункт Настройка подпункта Описание

Manual 
Register

Регистрация настроек для 
подключения к точке доступа вручную.

SSID Введите SSID для точки доступа, к 
которой производится подключение.

Security 
None / WEP / WPA

Задайте тип безопасности для точки 
доступа, к которой производится 
подключение. Выберите WPA, если 
целевая точка доступа имеет тип 
безопасности WPA или WPA2.

Password Введите пароль для точки доступа, к 
которой производится подключение.

DHCP 
On / Off

Включение или выключение DHCP.

IP Address Введите IP-адрес видеокамеры, если 
для параметра DHCP задано значение 
Off.

Subnet Mask Введите маску подсети видеокамеры, 
если для параметра DHCP задано 
значение Off.

Gateway Введите шлюз по умолчанию 
видеокамеры, если для параметра 
DHCP задано значение Off.

DNS Auto 
On / Off

Включение или выключение 
получения DNS.

Primary DNS Server Введите основной сервер DNS, если 
для параметра DNS Auto задано 
значение Off.

Secondary DNS Server Введите дополнительный сервер DNS, 
если для параметра DNS Auto задано 
значение Off.

Network >Wired LAN
Задание настроек, относящихся к соединениям по проводной ЛВС.

Пункт Настройка подпункта Описание

Setting On / Off Включение или выключение функции 
проводной ЛВС.

Camera 
Remote 
Control

Enable / Disable Задает, требуется ли включить 
дистанционное управление с 
устройства, подключенного к 
видеокамере по проводной ЛВС.

Detail 
Settings

Настройка свойств соединения по 
проводной ЛВС.

DHCP 
On / Off

Включение или выключение DHCP.

IP Address Введите IP-адрес видеокамеры, если 
для параметра DHCP задано значение 
Off.

Subnet Mask Введите маску подсети видеокамеры, 
если для параметра DHCP задано 
значение Off.

Gateway Введите шлюз по умолчанию 
видеокамеры, если для параметра 
DHCP задано значение Off.

DNS Auto 
On / Off

Включение или выключение 
получения DNS.

Primary DNS Server Введите основной сервер DNS, если 
для параметра DNS Auto задано 
значение Off.

Secondary DNS Server Введите дополнительный сервер DNS, 
если для параметра DNS Auto задано 
значение Off.
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Network >Modem
Задание настроек, относящихся к подключению по кабелю USB.

Пункт Настройка подпункта Описание

Setting On / Off Включение или выключение 
подключения смартфона.

Camera 
Remote 
Control

Enable / Disable Задание разрешения на 
дистанционное управление по кабелю 
USB с помощью приложения на 
смартфона, например CBM (Content 
Browser Mobile) или C3 Portal App.

Device Name Отображение имени устройства для 
смартфона.

IP Address Отображение IP-адреса смартфона.

Subnet Mask Отображение маски подсети для 
смартфона.

Network >File Transfer
Задание настроек, относящихся к передаче файлов.

Пункт Настройка подпункта Описание

Auto Upload 
(Proxy)

On / Off Включение или выключение 
автоматической передачи файлов 
прокси.

Default 
Upload 
Server

Выбор сервера для отправки файлов. 
Выбранный здесь сервер становится 
пунктом назначения автоматической 
отправки для файлов прокси, а также 
пунктом назначения отправки для 
файлов с экрана эскизов.
Отображение отображаемого имени, 
настроенного в пункте Server Settings 
1–3.

Clear 
Completed 
Jobs

Execute / Cancel Удаление завершенных заданий 
передачи из списка.
Execute: выполнение функции.

Clear All Jobs Execute / Cancel Удаление всех заданий передачи из 
списка.
Execute: выполнение функции.

View Job List Отображение списка заданий 
передачи.

Network >File Transfer
Задание настроек, относящихся к передаче файлов.

Пункт Настройка подпункта Описание

Server 
Settings1

Display Name Задание имени, отображаемого в 
меню настройки пункта назначения 
передачи.

Service 
FTP

Отображение типа сервера.

Host Name Задание имени узла сервера 
назначения передачи.

Port (1–65535 (21)) Задание номера порта сервера 
назначения передачи.

User Name Задание имени пользователя для 
аутентификации подключения сервера 
назначения передачи.

Password Задание пароля аутентификации для 
подключения сервера назначения 
передачи.

Passive Mode 
On / Off

Включение или выключение режима 
PASV.

Destination Directory Введите имя целевого каталога 
передачи.

Using Secure Protocol 
On / Off

Задает, требуется ли использовать (On) 
или не использовать (Off) безопасную 
передачу по FTP (FTPS в явном 
режиме: FTPES).

Root Certificate 
Load / Clear / None

Загрузка корневого сертификата для 
безопасной передачи по FTP и очистка 
настроек.

Root Certificate Status 
Loaded / No Certificate

Отображение состояния загрузки 
корневого сертификата для 
безопасной передачи по FTP.

Reset 
Execute / Cancel

Сброс настроек в пункте Server Settings 
на значения по умолчанию.
Execute: выполнение функции.

Server 
Settings2

То же, что и Server Settings1.

Server 
Settings3

То же, что и Server Settings1.
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Network >Network Reset
Сброс сетевых настроек.

Пункт Настройка подпункта Описание

Reset Execute / Cancel Сброс сетевых настроек.
Execute: выполнение функции.
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В этом разделе приводится описание предназначения и настроек каждого пункта меню.
Настройки, заданные по умолчанию, выделены полужирным шрифтом (например, 18dB).

Maintenance >Language
Установка языка интерфейса.

Пункт Настройка подпункта Описание

Select Установка языка интерфейса.
SET: установка языка.

Maintenance >Clock Set
Задание настроек внутренних часов.

Пункт Настройка подпункта Описание

Time Zone От UTC – 12:00 до UTC + 14:00 Установка разницы относительно 
времени UTC с дискретностью 30 
минут.

Date Mode YYMMDD / MMDDYY / DDMMYY Выбор формата отображения дат.
YYMMDD: год, месяц, день
MMDDYY: месяц, день, год
DDMMYY: день, месяц, год

12h/24h 12h / 24h Выбор формата отображения часов.
12h: 12-часовой режим
24h: 24-часовой режим

Date Установка текущей даты.
SET: установка значения.

Time Установка текущего времени.
SET: установка значения.

Maintenance >All Reset
Сброс настроек на заводские значения по умолчанию.

Пункт Настройка подпункта Описание

Reset Execute / Cancel Сброс всех настроек к значениям по 
умолчанию.
Execute: выполнение функции.

[Примечание]
Удаляется файл 3D LUT, импортированный 
с помощью пункта Base Look >Import 
(стр. 91) в меню Paint/Look. Чтобы удалить 
все импортированные файлы 3D LUT, 
выберите Base Look >Delete All в меню Paint/
Look (стр. 91).

Reset without 
Network

Execute / Cancel Сброс настроек меню на заводские 
значения по умолчанию, кроме 
настроек меню Network.

Maintenance >Hours Meter
Отображение общего времени работы.

Пункт Настройка подпункта Описание

Hours 
(System)

Отображение общего количества 
часов использования (невозможно 
сбросить).

Hours(Reset) Отображение общего количества 
часов использования (можно 
сбросить).

Reset Execute / Cancel Сброс параметра Hours(Reset) на 0.
Execute: выполнение функции.

Maintenance >Version
Отображение сведений о версии.

Пункт Настройка подпункта Описание

Version 
Number

Vx.xx Отображение версии программного 
обеспечения видеокамеры.

Version Up Execute / Cancel Обновление видеокамеры.*

Execute: выполнение функции.
* Эта функция обновляет программное 

обеспечение видеокамеры.

Lens Version 
Number

Vxx Отображение номера версии 
программного обеспечения объектива 
с байонетом E.

Меню Maintenance
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Настройки и значения по умолчанию меню Shooting

Настройки и значения по умолчанию для ISO/Gain

Диапазон и значения по умолчанию настроек ISO/Gain (стр. 79) зависят от настроек Mode, Target Display, Base Look >Select, и Base Sensitivity. Доступные варианты выделены серым 
цветом.

Когда для параметра Mode установлено значение ISO

Target Display SDR(BT.709) HDR(HLG) Общие для SDR(BT.709) и HDR(HLG)

Base Look >Select S-Cinetone / Standard / ITU709 / Still HLG Live / HLG Natural От User1 до User16

Base Sensitivity Low High Low High Low High

ISO 320 ISO/Gain<L> по умолчанию

ISO 400

ISO 500

ISO 640 ISO/Gain<M> по умолчанию

ISO 800 ISO/Gain<L> по умолчанию ISO/Gain<L> по умолчанию

ISO 1000

ISO 1250 ISO/Gain<H> по умолчанию

ISO 1600 ISO/Gain<M> по умолчанию ISO/Gain<M> по умолчанию

ISO 2000

ISO 2500

ISO 3200 ISO/Gain<H> по умолчанию ISO/Gain<H> по умолчанию

ISO 4000

ISO 5000 ISO/Gain<L> по умолчанию

ISO 6400

ISO 8000

ISO 10000 ISO/Gain<M> по умолчанию

ISO 12800 ISO/Gain<L> по умолчанию ISO/Gain<L> по умолчанию

ISO 16000

ISO 20000 ISO/Gain<H> по умолчанию

ISO 25600 ISO/Gain<M> по умолчанию ISO/Gain<M> по умолчанию

ISO 32000

ISO 40000

ISO 51200 ISO/Gain<H> по умолчанию ISO/Gain<H> по умолчанию

ISO 64000

ISO 80000

ISO 102400

ISO 128000

ISO 160000

ISO 204800

ISO 256000

ISO 320000

ISO 409600
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Когда для параметра Mode установлено значение dB

Диапазон настроек

–3dB

–2dB

–1dB

0dB ISO/Gain<L> по умолчанию

1dB

2dB

3dB

4dB

5dB

6dB ISO/Gain<M> по умолчанию

7dB

8dB

9dB

10dB

11dB

12dB ISO/Gain<H> по умолчанию

13dB

14dB

15dB

16dB

17dB

18dB

19dB

20dB

21dB

22dB

23dB

24dB

25dB

26dB

27dB

28dB

29dB

30dB
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Настройки и значения по умолчанию для AGC Limit

Диапазон и значения по умолчанию настроек AGC Limit (стр. 81) зависят от настроек Mode, Target Display, Base Look >Select, и Base Sensitivity. Доступные варианты выделены серым 
цветом.

Когда для параметра Mode установлено значение ISO

Target Display SDR(BT.709) HDR(HLG) HDR(HLG) Общие для SDR(BT.709) и HDR(HLG)

Base Look >Select S-Cinetone / Standard / ITU709 / Still HLG Live HLG Natural От User1 до User16

Base Sensitivity Low High Low High Low High Low High

ISO 400

ISO 500

ISO 640

ISO 800

ISO 1000

ISO 1250

ISO 1600

ISO 2000 По умолчанию

ISO 2500

ISO 3200

ISO 4000

ISO 5000 По умолчанию По умолчанию По умолчанию

ISO 6400

ISO 8000

ISO 10000

ISO 12800

ISO 16000

ISO 20000

ISO 25600

ISO 32000 По умолчанию

ISO 40000

ISO 51200

ISO 64000

ISO 80000 По умолчанию По умолчанию По умолчанию

ISO 102400

ISO 128000

ISO 160000

ISO 204800

ISO 256000

ISO 320000

ISO 409600
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Когда для параметра Mode установлено значение dB

Диапазон настроек

3dB

6dB

9dB

12dB

15dB По умолчанию

18dB

21dB

24dB

27dB

30dB
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Настройки качества изображения, сохраненные для каждого режима съемки
Текущее состояние элементов конфигурации, связанных с качеством изображения, сохраняется для каждого из следующих режимов съемки (стр. 25). При изменении режима съемки 
соответствующие сохраненные настройки применяются для целевого режима съемки.
ˎˎ Режим Custom SDR(BT.709)
ˎˎ Режим Custom HDR(HLG)
ˎˎ Режим Cine EI

Ниже указаны связанные с качеством изображения элементы конфигурации, которые сохраняются для каждого режима съемки.
Да: элемент сохранен.
Нет: элемент не сохранен.

Элемент конфигурации Режим съемки

Режим Custom Режим Cine EI

SDR(BT.709) HDR(HLG)

Меню Shooting ISO/Gain/EI ISO/Gain Да1) Нет

Exposure Index Нет Да

Base Sensitivity Да Нет

Base ISO Нет Да

White Preset White Да Да

Отличные от указанных выше Да

White Setting Да

Offset White Да Нет

LUT On/Off Нет Да

Noise Suppression Setting(Custom) Да Да Нет

Level(Custom) Да Да Нет

Setting(Cine EI) Нет Да

Level(Cine EI) Нет Да

Меню Paint/Look Base Look Select Да Да Да

Input2) Да

Output2) Да

AE Level Offset2) Да

Black Да Да Нет

Knee Auto Knee Да Нет Нет

Отличные от указанных выше Да Да Нет

Detail Да Да Нет

Matrix Да Да Нет

Multi Matrix Да Да Нет

1) Отдельные настройки чувствительности ISO сохраняются для обоих режимов Custom SDR(BT.709) и HDR(HLG).
2) Настройки сохраняются для каждого вида Base Look и не зависят от режима съемки.
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Данные конфигурации

Настройки полного меню можно сохранить 
на карте памяти, установленной в гнездо 
карты CFexpress Type A/SD-карты (B). Это 
позволяет быстро восстановить набор 
настроек меню, соответствующий текущей 
ситуации.
Данные конфигурации сохраняются в 
следующих категориях.

Файлы User
В файлах User сохраняются пункты 
настройки и данные персональной 
настройки меню User.
На карте памяти можно сохранить до 64 
файлов.
Загрузив этот файл в памяти видеокамеры, 
можно задать персональную настройку 
меню User.

Файлы ALL (все настройки)
Файлы ALL сохраняют данные 
конфигурации всех меню. На карте памяти 
можно сохранить до 64 файлов.

[Примечание]
Данные, относящиеся к конкретному устройству 
(затенение, выходные уровни и другие данные, 
которые требуют регулировки для конкретного 
устройства) на сохраняются.

Сохранение файла User/файла 
ALL

1 Установите карту памяти в гнездо для 
карт CFexpress Type A/SD-карт (B) 
(стр. 6).
ˎˎ Для карт CFexpress этикетка 
обращена влево.
ˎˎ Для SD-карт этикетка обращена 
вправо, а скошенный угол находится 
внизу.

2 Для пользовательского файла 
выберите User File >Save Media(B) 
(стр. 90) >Execute в меню Project 
полного меню.
Для файла ALL выберите All File >Save 
Media(B) (стр. 90) >Execute в меню 
Project полного меню.
Открывается экран пункта назначения 
для сохранения файла.

3 Выберите строку “No File” на экране 
выбора целевого каталога для 
сохранения файла.
При выборе строки с записью File ID 
выбранный файл будет перезаписан.
File ID создается автоматически, но его 
можно изменить.

4 На экране подтверждения выберите 
Execute.

Загрузка файла User/файла ALL

1 Установите карту памяти, на которой 
сохранен файл, в гнездо для карт 
CFexpress Type A/SD-карт (B) (стр. 6).
ˎˎ Для карт CFexpress этикетка 
обращена влево.
ˎˎ Для SD-карт этикетка обращена 
вправо, а скошенный угол находится 
внизу.

2 Для пользовательского файла 
выберите User File >Load Media(B) 
(стр. 90) >Execute в меню Project 
полного меню.
Для файла ALL выберите All File >Load 
Media(B) (стр. 90) >Execute в меню 
Project полного меню.
Отображается экран списка файлов.

3 Выберите файл для загрузки.
Открывается экран подтверждения.

4 Выберите Execute.

[Примечания]
ˎˎ После загрузки данных конфигурации устройство 

автоматически перезагружается.
ˎˎ Когда для параметра All File >Load Network Data в 

меню Project полного меню задано значение Off, 
загружаются все настройки из файла ALL, кроме 
настроек меню Network.

Изменение идентификатора 
файла

1 Для пользовательского файла 
выберите User File >File ID (стр. 90) в 
меню Project полного меню.
Для файла ALL выберите All File >File ID 
(стр. 90) в меню Project полного 
меню.
Открывается экран редактирования 
идентификатора файла.

2 Выберите символ 
многофункциональным селектором 
(стр. 7) или многофункциональным 
диском (стр. 5), затем нажмите 
кнопку применения на 
многофункциональном селекторе или 
многофункциональный диск.

3 Повторяйте шаг 2 по мере 
необходимости.

4 Завершив ввод символов, выберите 
Done.

Сохранение и загрузка данных конфигурации
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Подключение внешних мониторов и устройств записи
Для показа на внешнем мониторе 
записанного изображения, которое 
воспроизводит видеокамера, выберите 
выходной сигнал видеокамеры и 
подключите ее к монитору с помощью 
соответствующего кабеля.
К видеокамере также можно подключать 
записывающие устройства, например 
видеомагнитофон, для записи ее 
выходного сигнала.
На внешний монитор можно вывести ту 
же информацию, которая отображается в 
видоискателе, например информацию о 
состоянии и меню. Задайте для параметра 
Info. Disp. (стр. 15) на экране Monitoring 
Status или для параметра Output Display 
(стр. 95) в меню Monitoring полного меню 
значение On в соответствии с сигналом, 
который требуется выводить на монитор.

Разъем SDI OUT (тип BNC)

Включение и выключение выхода, а также 
задание выходного формата производится 
в меню Monitoring (стр. 95).
Для подключения используйте имеющийся 
в продаже коаксиальный кабель на 75 Ом.

[Примечание]
Перед включением видеокамеры удостоверьтесь в 
том, что подключение между прибором и внешним 
устройством заземлено.

(Рекомендуется включать видеокамеру и 
внешнее устройство после подсоединения 
коаксиального кабеля на 75 Ом.)
Если внешнее устройство необходимо 
подключить к видеокамере, когда она 
включена, подсоедините коаксиальный 
кабель на 75 Ом сначала к внешнему 
устройству, и только затем подсоедините 
его к видеокамере.

Запуск записи одновременно на 
видеокамере и внешнем устройстве

Включив выход SDI, задайте параметру 
SDI/HDMI Rec Control (стр. 87) >Setting 
в меню Project полного меню значение 
SDI/HDMI Remote I/F или Parallel Rec, 
чтобы обеспечить выдачу сигнала запуска 
записи REC на внешнее устройство, 
подсоединенное к разъему SDI OUT. Это 
обеспечит синхронную запись изображения 
с видеокамеры на внешнем устройстве.

[Примечания]
ˎˎ Если подключенное устройство не поддерживает 

сигналы запуска записи REC, использовать его в 
этом режиме невозможно.
ˎˎ Когда в настоящий момент носитель не 

установлен, выводится только сигнал запуска 
записи REC.

Разъем HDMI OUT (разъем типа 
A)

Включение и выключение выхода, а также 
задание выходного формата производится 
в меню Monitoring (стр. 95) полного 
меню.

Запуск записи одновременно на 
видеокамере и внешнем устройстве

Включив выход HDMI, задайте параметру 
HDMI TC Out >Setting (стр. 93) в меню 
TC/Media полного меню значение On, а 
параметру SDI/HDMI Rec Control >Setting 
(стр. 87) в меню Project значение SDI/
HDMI Remote I/F или Parallel Rec, чтобы 
обеспечить выдачу сигнала запуска 
записи REC на внешнее устройство, 
подсоединенное к разъему HDMI OUT. 
Это обеспечит синхронную запись 

изображения с видеокамеры на внешнем 
устройстве.
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Синхронизация временных кодов
Временной код данного устройства можно 
синхронизировать с другими устройствами.

Привязка временного кода к 
другим устройствам

Переведите устройство, подающее 
временной код, в режим, в котором 
поддерживается выдача временного кода 
(например Free Run или Clock).

1 Настройте пункт Timecode (стр. 93) в 
меню TC/Media полного меню 
следующим образом.
Mode: Preset
Run: Free Run

2 Нажмите программируемую кнопку 
(стр. 51), которой назначена функция 
DURATION/TC/U-BIT, чтобы отобразить 
временной код на экране.

3 Убедитесь, что переключатель выбора 
TC IN/OUT (стр. 4) установлен в 
положение IN, затем подайте опорный 
временной код для синхронизации 
частоты системы видеокамеры на 
разъем TC IN/TC OUT.

Генератор временного кода видеокамеры 
привязывается к опорному временному 
коду, и на экране появляются символы “EXT-
LK”.
После того, как пройдет примерно десять 
секунд после привязки временного кода, 
состояние, сформированное привязкой к 
внешнему сигналу, будет поддерживаться 
даже в случае отключения внешнего 
источника опорного сигнала временного 
кода.

[Примечания]
ˎˎ При работе в режиме привязки к внешнему 

сигналу временной код мгновенно привязывается 
к внешнему источнику, и значение внешнего 
временного кода появляется в области 
отображения данных. Однако не начинайте запись 
сразу же. Перед записью следует подождать 
несколько секунд, пока генератор временного 
кода не стабилизируется.
ˎˎ Если частота кадров опорного временного кода 

и частота кадров, заданная в видеокамере, не 
совпадают, установить привязку не удастся, а 
видеокамера не будет работать надлежащим 
образом. В этом случае привязка временного кода 
видеокамеры ко внешнему временному коду не 
будет установлена.
ˎˎ Временной код может смещаться на один кадр в 

час относительно опорного временного кода.

Отключение внешней привязки

Измените значение параметра Timecode 
в меню TC/Media полного меню.
Внешняя синхронизация также отключается 
при изменении частоты системы или при 
начале съемки в специальном режиме 
(Slow & Quick Motion или Interval Rec).

Синхронизация временного 
кода другого устройства с 
временным кодом 
видеокамеры

Переведите устройство, подающее 
временной код, в режим, в котором 
поддерживается выдача временного кода 
(например Free Run или Clock).

1 Задайте временной код видеокамеры с 
помощью пункта Timecode (стр. 93) 
меню TC/Media полного меню.

2 Убедитесь, что переключатель выбора 
TC IN/OUT (стр. 4) установлен 
в положение OUT, и подключите разъем 
TC IN/TC OUT к входному разъему 
временного кода на устройстве, 
которое требуется синхронизировать.
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Монтаж клипов и управление ими на компьютере

Подключение с помощью 
кабеля USB

Использование устройства чтения 
карт (не входит в комплект поставки)

Подсоедините устройство чтения карт 
CFexpress или SD-карт к компьютеру 
с помощью кабеля USB и установите 
карту памяти в гнездо устройства чтения 
карт. Карта памяти будет распознана 
компьютером как внешний носитель. На 
поддерживаемых компьютерах можно 
импортировать клипы на высокой скорости 
с использованием режима накопителя 
видеокамеры.

Использование режима накопителя

[Примечание]
Режим накопителя не может использоваться, когда 
для параметра Modem >Setting в меню Network 
полного меню задано значение On или для 
параметра Wired LAN >Setting в меню Network задано 
значение On. Задайте для обоих этих параметров 
значение Off.

Подключите видеокамеру с помощью 
кабеля USB и установите карту памяти 
в гнездо A или B для карт. Карта памяти 
распознается компьютером как внешний 
носитель.

1 Подключите разъем USB-C (стр. 7) 
или разъем USB/многоцелевой разъем 
(стр. 7) к компьютеру с помощью 
кабеля USB.

2 Установите переключатель POWER 
видеокамеры в положение ON.

На экране видоискателя появится 
сообщение с вопросом о том, включить 
ли подключение USB.

 [Примечание]
Сообщение о подтверждении подключения 
USB не отображается, когда на экране имеется 
другое сообщение о подтверждении или ходе 
выполнения. Например, когда производится 
форматирование или восстановление карты 
памяти.
Сообщение о подтверждении появится 
по завершении форматирования или 
восстановления. Сообщение о подтверждении 
подключения USB также не появляется, когда 
отображается экран свойств клипа. Сообщение 
будет отображено по завершении обработки 
или после возврата на экран эскизов.

3 Поворачивая многофункциональный 
диск, выберите Execute.

4 При использовании ОС Windows 
откройте окно “Мой компьютер”. Карта 
памяти в нем должна быть обозначена 
как съемный диск.
При использовании Mac удостоверьтесь 
в том, что на рабочем столе появилась 
папка (редактируемая) “NO NAME” или 
“Untitled”.

[Примечания]
ˎˎ Если индикатор доступа горит красным, не 

выполняйте следующие операции.
 – Отключение питания или отсоединения кабеля 

питания
 – Извлечение карты памяти
 – Отсоединение кабеля USB

ˎˎ Выполнение этой операции на всех компьютерах 
не гарантируется.

Использование систем 
нелинейного монтажа

В системе нелинейного монтажа требуется 
наличие ПО для монтажа (не входит в 
комплект поставки), которое поддерживает 
форматы, записываемые видеокамерой.
Перед редактированием видео сохраните 
нужные вам клипы на жесткий диск 
компьютера с помощью специального 
программного приложения.
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Предупреждения
При образовании конденсата

Если устройство принесли с холода 
в теплое помещение или если резко 
повысилась температура окружающей 
среды, на внешней поверхности 
устройства и/или внутри устройства 
может образоваться влага. Эта явление 
называется конденсацией. В случае 
возникновения конденсации выключите 
устройство и дождитесь исчезновения 
влаги перед использованием устройства. 
Использование влажного устройства может 
привести к его повреждению.

ЖК-экраны

ЖК-панель, установленная на данном 
устройстве, произведена по высокоточной 
технологии, что позволяет достичь не 
менее 99,99 % рабочих пикселей. Несмотря 
на это крайне малая часть пикселей может 
быть “битыми”: постоянно выключенные 
(черные), включенные (красный, зеленый 
или синий) или мигающие. Кроме того, эти 
“битые” пиксели могут внезапно появиться 
после длительного использования. Это 
связано с физическими характеристиками 
жидкокристаллических экранов. Это 
не является неисправностью. Обратите 
внимание: эти проблемы не влияют на 
записанные данные.

Влияние на датчик изображения 
КМОП камеры

[Примечание]
Следующие возможные явления в изображениях 
специфичны для датчиков изображений. Они не 
означают неисправность.

Белые точки
Несмотря на то, что датчики изображения 
производятся с использованием 
высокопрецизионных технологий, в редких 

случаях на экране могут возникать белые 
точки, вызванные космическими лучами и 
т. п.
Это объясняется принципом создания 
датчиков изображения и не является 
неисправностью.
Белые точки большей частью возникают в 
следующих случаях:
ˎˎ при высокой температуре окружающей 
среды;
ˎˎ при повышении чувствительности.

Дрожание
При съемке при освещении 
флуоресцентным светом, натриевыми 
лампами, ртутными лампами или 
светодиодами может дрожать изображение 
на экране или могут изменяться цвета.

Расходные материалы

ˎˎ Вентилятор и батарея являются 
расходными деталями, которые 
необходимо периодически заменять.  
При работе при комнатной температуре 
замену необходимо проводить через 
каждые 5 лет. Однако данный цикл 
является только рекомендуемым и 
не подразумевает гарантированную 
работу этих деталей в течение этого 
времени. Для получения дополнительной 
информации о замене деталей 
обратитесь в сервисный центр Sony или к 
поставщику.
ˎˎ Средний срок службы адаптера 
переменного тока и электролитического 
конденсатора составляет около 
5 лет при нормальной температуре 
работы и нормальном использовании 
(8 часов в день, 25 дней в месяц). 
Если использование превышает 
указанную выше нормальную частоту 
использования, продолжительность 
работы может соответственно 
уменьшиться.

ˎˎ Клемма батареи данного устройства 
(разъем для аккумуляторных блоков и 
адаптеров переменного тока) является 
расходуемой деталью.  
Питание может не подаваться на 
устройство надлежащим образом, если 
штырьки клеммы батареи изогнуты или 
деформированы вследствие удара или 
вибраций, либо если они ржавеют из-за 
длительного использования на открытом 
воздухе.  
Рекомендуется проводить периодические 
осмотры для обеспечения должной 
работы устройства и увеличения 
срока его службы. Для получения 
дополнительных сведений об осмотрах 
обратитесь к представителю службы 
технического обслуживания или отдела 
продаж компании Sony.

О встроенном элементе питания

В видеокамере имеется встроенный 
элемент питания для хранения данных 
о дате, времени и других данных даже 
в случае выключения видеокамеры. 
Встроенный аккумулятор зарядится через 
24 часа, если устройство подключено 
к электрической розетке с помощью 
адаптера переменного тока или если 
установлен полностью заряженный 
основной аккумулятор, независимо от того, 
включена ли видеокамера. Аккумулятор 
полностью разрядится примерно за 2 
месяца, если не подключен адаптер 
переменного тока или видеокамера 
используется без аккумулятора. 
Используйте видеокамеру после зарядки 
элемента питания. Однако даже если этот 
заряжаемый элемент питания не заряжен, 
на работу видеокамеры это не повлияет, 
если при работе не требуется записывать 
дату и время.

Места использования и хранения

Хранить на ровной поверхности в хорошо 
проветриваемом месте.
Не следует использовать или хранить 
устройство в следующих местах.
ˎˎ При чрезмерно высокой или низкой 
температуре (диапазон рабочей 
температуры: от 0 °C до 40 °С) 
Помните, что летом в теплом климате 
температура в автомобиле с закрытыми 
окнами может превышать 50 °C.
ˎˎ В местах с высокой влажностью или 
большим количеством пыли. В местах, где 
устройство может оказаться под дождем
ˎˎ В местах, где присутствует сильная 
вибрация
ˎˎ Вблизи сильных магнитных полей
ˎˎ Около радио или телевизионных 
передатчиков, формирующих сильные 
электромагнитные поля.
ˎˎ Под прямым солнечным светом или 
вблизи нагревательных приборов 
в течение длительного времени

Примечание в отношении лазерных 
лучей

Лазерные лучи могут повредить 
светочувствительные матрицы КМОП. При 
съемке эпизода, в котором присутствуют 
лазерные лучи, не допускайте направления 
лазерного луча на объектив устройства. 
В частности, мощные лазерные лучи, 
испускаемые устройствами медицинского 
или иного назначения, могут вызвать 
повреждения вследствие отражения или 
рассеивания света.
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Во избежание электромагнитных 
помех от портативных 
коммуникационных устройств

Использование портативных телефонов 
и других коммуникационных устройств 
рядом с этой камерой может привести 
к неполадкам и помехам аудио- и 
видеосигналов. Рекомендуется отключать 
питание портативных коммуникационных 
устройств рядом с этой камерой.

Предупреждения по мерам 
безопасности

ˎˎ КОМПАНИЯ SONY НЕ НЕСЕТ 
ОТВЕТСТВЕННОСТИ ЗА КАКОЙ БЫ 
ТО НИ БЫЛО УЩЕРБ, ВОЗНИКШИЙ 
ВСЛЕДСТВИЕ НЕСОБЛЮДЕНИЯ 
МЕР ПРЕДОСТОРОЖНОСТИ ПРИ 
ИСПОЛЬЗОВАНИИ УСТРОЙСТВ 
ПЕРЕДАЧИ ДАННЫХ, НЕИЗБЕЖНЫХ 
УТЕЧЕК ИНФОРМАЦИИ, СВЯЗАННЫХ СО 
СПЕЦИФИКАЦИЯМИ ПЕРЕДАЧИ ДАННЫХ, 
ИЛИ ПРОБЛЕМ БЕЗОПАСНОСТИ ЛЮБОГО 
РОДА.
ˎˎ В зависимости от операционной среды 
возможен несанкционированный доступ 
посторонних лиц к устройству. При 
подключении устройства к сети убедитесь 
в том, что сеть надежно защищена.
ˎˎ Передаваемое содержимое может быть 
непреднамеренно перехвачено третьими 
лицами, находящимися в зоне действия 
сигнала. Используя беспроводную 
локальную сеть, принимайте 
необходимые меры для обеспечения 
безопасности передачи содержимого.
ˎˎ При подключении этого изделия к 
сети выполняйте подключение через 
систему, которая обеспечивает функцию 
защиты, такую как маршрутизатор или 
брандмауэр. При подключении без такой 

защиты могут возникнуть проблемы с 
безопасностью.
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Настройки, заданные по умолчанию, выделены полужирным шрифтом (например, 
1920×1080P (Level A)).

[Примечания]
ˎˎ Разрешение формата вывода ограничено настройками Rec Format >Frequency, Codec и Video Format в меню 

Project полного меню (стр. 84).
ˎˎ Разрешение формата вывода ограничено в сочетании с частотой кадров S&Q. В дополнение к приведенной 

далее таблице выходных форматов разъемов SDI OUT и HDMI OUT выход HDMI переключается на 
разрешение Full HD или ниже при соблюдении всех следующих условий.
 – Параметр S&Q Motion >Setting в меню Shooting имеет значение On
 – Параметр S&Q Motion >Frame Rate в меню Shooting имеет значение, большее 60fps
 – Для параметра Rec Format >Codec в меню Project установлено значение RAW или RAW & XAVC-I, или для 

параметра Output On/Off >SDI в меню Monitoring установлено значение On
ˎˎ Когда это происходит, варианты выбора выходного сигнала HDMI 4096×2160P и 3840×2160P для параметра 

Output Format >SDI/HDMI (стр. 95) в меню Monitoring отображаются серым цветом и недоступны для 
выбора.
ˎˎ Изображение выводится только при задании более высокого разрешения, чем разрешение 

воспроизводимого изображения.

Форматы выходного сигнала на разъеме SDI OUT/HDMI OUT

Задание частоты 
системы
(Rec Format 
>Frequency 
в меню Project)

Задание кодека
(Rec Format 
>Codec в меню 
Project)

Задание RAW/
настроек формата 
записи
(Rec Format >RAW 
Output Format/Video 
Format в меню 
Project)

Выходной формат (Output Format в 
меню Monitoring)

SDI HDMI

50/59.94Hz RAW
RAW & XAVC-I

4096×2160(RAW) (4096×2160 RAW) 4096×2160P

3840×2160P

1920×1080P

1920×1080i

3840×2160(RAW) (3840×2160 RAW) 3840×2160P

1920×1080P

1920×1080i

RAW(HDMI)
RAW(HDMI) & 
XAVC-I

4240×2392(RAW) 1920×1080P 
(Level A)

(4240×2392 HDMI 
RAW)

1920×1080P 
(Level B)

1920×1080i

Задание частоты 
системы
(Rec Format 
>Frequency 
в меню Project)

Задание кодека
(Rec Format 
>Codec в меню 
Project)

Задание RAW/
настроек формата 
записи
(Rec Format >RAW 
Output Format/Video 
Format в меню 
Project)

Выходной формат (Output Format в 
меню Monitoring)

SDI HDMI

50/59.94Hz XAVC-I
XAVC-L

4096×2160(Video) 4096×2160P1) 4096×2160P

4096×2160P 1920×1080P

4096×2160P 1920×1080i

3840×2160P 3840×2160P

3840×2160P 1920×1080P

3840×2160P 1920×1080i

1920×1080P 
(Level A)

1920×1080P

1920×1080P 
(Level A)

1920×1080i

1920×1080P 
(Level B)

1920×1080P

1920×1080P 
(Level B)

1920×1080i

1920×1080i 1920×1080i

3840×2160(Video) 3840×2160P 3840×2160P

3840×2160P 1920×1080P

3840×2160P 1920×1080i

1920×1080P 
(Level A)

1920×1080P

1920×1080P 
(Level A)

1920×1080i

1920×1080P 
(Level B)

1920×1080P

1920×1080P 
(Level B)

1920×1080i

1920×1080i 1920×1080i

Форматы и ограничения для выходов
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Задание частоты 
системы
(Rec Format 
>Frequency 
в меню Project)

Задание кодека
(Rec Format 
>Codec в меню 
Project)

Задание RAW/
настроек формата 
записи
(Rec Format >RAW 
Output Format/Video 
Format в меню 
Project)

Выходной формат (Output Format в 
меню Monitoring)

SDI HDMI

50/59.94Hz XAVC-I
XAVC-L

1920×1080(Video) 1920×1080P 
(Level A)

1920×1080P

1920×1080P 
(Level A)

1920×1080i

1920×1080P 
(Level B)

1920×1080P

1920×1080P 
(Level B)

1920×1080i

1920×1080i 1920×1080i

(Вывод 
остановлен)

720×480P1) 2)

720×576P1) 3)

25/29.97Hz RAW
RAW & XAVC-I

4096×2160(RAW) (4096×2160 RAW) 4096×2160P

3840×2160P

1920×1080P

1920×1080i

3840×2160(RAW) (3840×2160 RAW) 3840×2160P

1920×1080P

1920×1080i

RAW(HDMI)
RAW(HDMI) & 
XAVC-I

4240×2392(RAW) 1920×1080P (4240×2392 HDMI 
RAW)1920×1080PsF

XAVC-I
XAVC-L

4096×2160(Video) 4096×2160P1) 4096×2160P

4096×2160P 1920×1080P

3840×2160P 3840×2160P

3840×2160P 1920×1080P

1920×1080P 1920×1080P

1920×1080PsF 1920×1080i

3840×2160(Video) 3840×2160P 3840×2160P

3840×2160P 1920×1080P

1920×1080P 1920×1080P

1920×1080PsF 1920×1080i

1920×1080(Video) 1920×1080P 1920×1080P

1920×1080PsF 1920×1080i

Задание частоты 
системы
(Rec Format 
>Frequency 
в меню Project)

Задание кодека
(Rec Format 
>Codec в меню 
Project)

Задание RAW/
настроек формата 
записи
(Rec Format >RAW 
Output Format/Video 
Format в меню 
Project)

Выходной формат (Output Format в 
меню Monitoring)

SDI HDMI

23.98Hz RAW
RAW & XAVC-I

4096×2160(RAW) (4096×2160 RAW) 4096×2160P

3840×2160P

1920×1080P

3840×2160(RAW) (3840×2160 RAW) 3840×2160P

1920×1080P

RAW(HDMI)
RAW(HDMI) & 
XAVC-I

4240×2392(RAW) 1920×1080P (4240×2392 HDMI 
RAW)

XAVC-I
XAVC-L

4096×2160(Video) 4096×2160P1) 4096×2160P

4096×2160P 1920×1080P

3840×2160P 3840×2160P

3840×2160P 1920×1080P

1920×1080P 1920×1080P

3840×2160(Video) 3840×2160P 3840×2160P

3840×2160P 1920×1080P

1920×1080P 1920×1080P

1920×1080(Video) 1920×1080P 1920×1080P

24Hz RAW
RAW & XAVC-I

4096×2160(RAW) (4096×2160 RAW) 4096×2160P

1920×1080P

XAVC-I 4096×2160(Video) 4096×2160P1) 4096×2160P

1920×1080P 1920×1080P

1) Невозможно внедрить отображение на экране.
2) При значении частоты системы 59.94
3) При значении частоты системы 50
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Подготовка источника питания

Признак неисправности Причина Действия по устранению

Видеокамера не 
включается.

Не установлен аккумулятор 
или не подается питание 
на разъем DC IN.

Установите аккумулятор (стр. 18) 
или подключите питание от сети 
переменного тока с помощью 
адаптера переменного тока 
(стр. 19).

Аккумулятор полностью 
разряжен.

Замените аккумулятор полностью 
заряженным (стр. 18).

Во время работы питание 
отключается.

Аккумулятор полностью 
разрядился.

Замените аккумулятор полностью 
заряженным (стр. 18).

Аккумулятор очень быстро 
разряжается.

Очень низкая температура 
окружающей среды.

Это связано с характеристиками 
аккумулятора и не является 
дефектом.

Аккумулятор недостаточно 
заряжен.

Зарядите аккумулятор (стр. 18).
Если аккумулятор быстро 
разряжается даже после полной 
зарядки, вероятно, закончился срок 
его службы. Замените аккумулятор 
новым.

Запись/воспроизведение

Признак неисправности Причина Действия по устранению

При нажатии кнопки 
START/STOP (пуск/
остановка записи) запись 
не начинается.

Карта памяти полностью 
заполнена.

Замените карту памяти картой с 
достаточным свободным 
пространством.

Карта памяти требует 
восстановления.

Выполните восстановление карты 
памяти (стр. 34).

Запись звука невозможна. Диски AUDIO LEVEL (CH1/
CH2) установлены на 
минимальный уровень.

Настройте уровни записи звука 
дисками AUDIO LEVEL (CH1/CH2) 
(стр. 49).

Звук записывается с 
искажениями.

Слишком высокий уровень 
записи звука.

Настройте уровни записи звука 
дисками AUDIO LEVEL (CH1/CH2) 
(стр. 49).

В записанном звуке 
слишком много шумов.

Слишком низкий уровень 
записи звука.

Настройте уровни записи звука 
дисками AUDIO LEVEL (CH1/CH2) 
(стр. 49).
Если выбран внешний микрофон, 
также настройте параметр INPUT MIC 
Reference в пункте Audio Input меню 
Audio (стр. 98).

Признак неисправности Причина Действия по устранению

Клипы не воспроизводятся. Клип редактируется. Воспроизведение клипов 
невозможно, если изменены имена 
файлов или папок или если клип 
используется на компьютере. Это не 
является признаком неисправности.

Клип записывается на 
другом устройстве.

Клипы, записанные на других 
устройствах, могут не 
воспроизводиться или отображаться 
с неправильным размером. Это не 
является признаком неисправности.

Внешние устройства

Признак неисправности Действия по устранению

Компьютер не распознает 
видеокамеру.

Отсоедините кабель USB от компьютера, затем снова надежно 
подсоедините его.

Отсоедините кабель USB от компьютера, перезагрузите 
компьютер и снова выполните все шаги в правильном 
порядке.

Соедините компьютер с видеокамерой, подключив кабель USB 
к разъему USB-C или разъему USB/многоцелевому разъему.

Не удается загрузить клипы в 
компьютер.

Отсоедините кабель USB от компьютера, перезагрузите 
видеокамеру, затем снова подсоедините ее.

Для загрузки клипов в компьютер на него должно быть 
установлено прикладное программное обеспечение 
(стр. 118).

Устранение неисправностей
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Подключение по беспроводной ЛВС

[Примечание]
Препятствия и электромагнитные помехи между видеокамерой и точкой доступа беспроводной ЛВС или 
оконечного устройства, а также окружающая обстановка (например, материал стен) могут сократить диапазон 
связи или полностью исключить подключения. При возникновении таких проблем проверьте состояние 
подключения/связи после перемещения видеокамеры в другое место или уменьшения расстояния между 
видеокамерой и точкой доступа/оконечным устройством.

Признак неисправности Действия по устранению

Оконечное устройство не 
может получить доступ к 
видеокамере.

 ˎ Проверьте подключение по беспроводной ЛВС (IP-адрес  
и т. п.).

 ˎ Настройки связи между точкой доступа и клиентом могут 
быть недействительными. Подробные сведения см. в 
инструкции по эксплуатации точки доступа.

Невозможно выполнить вход в 
видеокамеру.

Проверьте заданные имя пользователя и пароль.

Подключение к Интернету

Признак неисправности Действия по устранению

Не удается выполнить 
отправку файлов.

Неправильные имя пользователя и пароль сервера.
Введите правильные имя пользователя и пароль.

Отправка файлов недоступна. Плохие условия приема сигнала.
Переместитесь в другое место и повторите попытку.

При использовании фильтра ND

Признак неисправности Действия по устранению

Фильтр ND не перемещается. Фильтр ND можно вручную переместить в положение Clear с 
помощью приведенной ниже процедуры.

1 Установите переключатель POWER видеокамеры в выключенное положение.

2 Снимите круглую крышку на нижней стороне.

3 Вставьте в отверстие отвертку и поворачивайте ее против часовой стрелки.
ˎˎ Фильтр нейтральной плотности перемещается в положение Clear при повороте 
против часовой стрелки. Продолжайте поворачивать, пока не достигните положения 
Clear.
ˎˎ Используйте отвертку диаметром 2,4 мм или менее. Отвертка вставляется на глубину 
приблизительно 3,0 см.

Отверстие для отвертки
(при снятой крышке)

4 Установите переключатель ND PRESET/VARIABLE (стр. 5) в положение PRESET и 
установите кнопки вверх/вниз ND FILTER POSITION (стр. 5) в положение CLEAR.

[Примечания]
ˎˎ Не используйте приведенную выше процедуру во время обычной работы. Используйте эту процедуру 

только в том случае, если фильтр нейтральной плотности не двигается. Если использовать эту процедуру во 
время обычной работы, можно повредить фильтр нейтральной плотности.
ˎˎ После использования приведенной выше процедуры обратитесь в сервисный центр Sony для ремонта 

видеокамеры.
ˎˎ Если после выполнения приведенной выше процедуры по-прежнему отображается сообщение об ошибке, 

все равно можно снимать.
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Если в видеокамере возникает ситуация, приводящая к появлению уведомления, 
предупреждения или состояния, которое требует подтверждения, в видоискателе отображается 
сообщение, индикатор записи/съемки начинает мигать и подается звуковой сигнал.
Звуковой сигнал подается через наушники, подключенные к разъему для наушников.

Сообщения об ошибках

Видеокамера перестанет работать, когда на экране отображаются следующие сообщения.

Сообщение в 
видоискателе

Предупреждающий 
звуковой сигнал

Индикатор 
записи/
съемки

Причина и решение

E + код ошибки Непрерывный Быстрое 
мигание

Указывает на нештатное состояние в 
видеокамере. Запись останавливается, если в 
видоискателе отображается REC.
Выключите видеокамеру и проверьте все 
подключенные устройства, кабели и носители. 
Если после включения видеокамеры 
сообщение об ошибке снова появится, 
обратитесь к представителю службы 
технического обслуживания компании Sony.
(Если видеокамера не выключается, когда 
переключатель POWER переведен в 
положение OFF, извлеките аккумулятор или 
отсоедините шнур питания от разъема DC IN.)
Ошибка может не отображаться или звуковой 
сигнал может не подаваться в зависимости от 
состояния видеокамеры.

Предупредительные сообщения

Если на экране отображаются следующие сообщения, выполните приведенные 
инструкции.

Сообщение в 
видоискателе

Предупреждающий 
звуковой сигнал

Индикатор 
записи/
съемки

Причина и решение

Battery Near End Прерывистый Мигает Заряд аккумулятора заканчивается.
Подзарядите его как можно скорее.

Battery End Непрерывный Быстрое 
мигание

Аккумуляторный блок разряжен. Запись 
отключена.
Выключите видеокамеру и замените 
аккумуляторный блок.

Сообщение в 
видоискателе

Предупреждающий 
звуковой сигнал

Индикатор 
записи/
съемки

Причина и решение

Temperature High Прерывистый Мигает Высокая внутренняя температура.
Выключите видеокамеру и дайте ей остыть 
перед тем, как продолжить работу.

Media 
Temperature High

Прерывистый Мигает Высокая температура карты CFexpress.
Замените карту или дайте ей остыть, прежде 
чем снова использовать.

Voltage Low Прерывистый Мигает Напряжение на входе DC IN слишком низкое 
(уровень 1). Проверьте источник питания.

Insufficient 
Voltage

Непрерывный Быстрое 
мигание

Напряжение на входе DC IN слишком низкое 
(уровень 2). Запись отключена.
Подключите другой источник питания.

Media Near Full Прерывистый Мигает На карте памяти остается мало свободного 
места.
Замените ее как можно скорее.

Media Full Непрерывный Быстрое 
мигание

Клипы нельзя записывать или копировать, 
поскольку на карте памяти не осталось 
свободного места.
Замените ее немедленно.

Clips Near Full Прерывистый Мигает Количество дополнительных клипов, которые 
можно записать на карту памяти, мало.
Замените ее как можно скорее.

Clips Full Непрерывный Быстрое 
мигание

Достигнуто максимальное количество клипов, 
которые можно записать на карту памяти.
Запись или копирование дополнительных 
клипов невозможно. Замените ее немедленно.

Last Clip 
Recording

Прерывистый Мигает Текущий записываемый клип является 
последним клипом, который может быть 
записан, так как достигнуто максимальное 
количество клипов.
Подготовьте новую карту памяти.

Media(A)1) Life 
Near End

Прерывистый Мигает Срок службы карты памяти заканчивается. 
Замените ее как можно скорее.

Media(A)1) Life End Непрерывный Быстрое 
мигание

Срок службы карты памяти закончился. 
Замените ее немедленно.

Media(A)1) Near 
Full

Прерывистый Мигает При использовании функции Simul Rec

Media(A)1) Full Непрерывный Быстрое 
мигание

При использовании функции Simul Rec

Media(A)1) Clips 
Near Full

Прерывистый Мигает При использовании функции Simul Rec

Media(A)1) Clips 
Full

Непрерывный Быстрое 
мигание

При использовании функции Simul Rec

Media(A)1) Last 
Clip Rec

Прерывистый Мигает При использовании функции Simul Rec

1) “(B)” отображается для карты в гнезде B.

Предупреждения относительно эксплуатации
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Уведомления и сообщения о работе прибора

В центре экрана могут отображаться следующие уведомления и сообщения о работе 
прибора. Для устранения причины уведомления выполните приведенные инструкции.

Сообщение на дисплее Причина и решение

Battery Error
Please Change Battery

Обнаружена неполадка аккумуляторного блока.
Замените его на работоспособный аккумуляторный блок.

Backup Battery End
Please Change

Оставшегося заряда резервной батареи недостаточно.
Зарядите резервную батарею.

Unknown Media (A) 1)

Please Change
Вставлена разбитая на разделы карта памяти или карта 
памяти, содержащая больше клипов, чем может 
обработать видеокамера.
Такую карту нельзя использовать в видеокамере. Ее 
необходимо заменить.

Cannot Use Media (A) 1)

Unsupported File System
Вставлена карта памяти с другой файловой системой или 
неформатированная карта памяти.
Такую карту нельзя использовать в видеокамере. Ее 
необходимо заменить или отформатировать с помощью 
видеокамеры.

Media Error
Media (A) 1) Needs to be Restored

На карте памяти возникла ошибка. Необходимо 
выполнить восстановление карты.
Восстановите карту памяти.

Media Error
Cannot Record to Media (A) 1)

Возможно, карта памяти повреждена и ее больше нельзя 
использовать для записи.
Воспроизведение возможно, поэтому рекомендуется 
сделать копию данных и заменить карту памяти.

Media Error
Cannot Use Media (A) 1)

Возможно, карта памяти повреждена и ее больше нельзя 
использовать для записи или воспроизведения.
Такую карту нельзя использовать в видеокамере. Ее 
необходимо заменить.

Media (A) 1) Error
Recording Halted
Playback Halted

Запись и воспроизведение были остановлены, потому что 
при использовании карты памяти возникла ошибка.
Если проблема сохранится, замените карту памяти.

Media Reached Rewriting Limit
Change Media (A) 1)

Срок службы карты памяти закончился.
Сделайте резервную копию и замените карту памяти 
немедленно. Если продолжить использование карты, то 
запись и воспроизведение будут возможны.
Для получения более подробных сведений см. 
инструкцию по эксплуатации карты памяти.

The specified address is invalid. Указан недопустимый адрес.
Проверьте правильность настройки.

Cannot Use Specified Port Number Указан недопустимый номер порта.
Проверьте правильность настройки.

Сообщение на дисплее Причина и решение

Fan Stopped Встроенный вентилятор остановился.
Не используйте перегретую видеокамеру, отключите 
питание и свяжитесь с представителем службы 
технического обслуживания компании Sony.

Lens I/F Error(xx:xx) При установленном объективе с байонетом E обнаружена 
ошибка связи в интерфейсе объектива.
Проверьте состояние соединения с объективом с 
байонетом E.
Если неполадка сохраняется, обратитесь к представителю 
службы технического обслуживания компании Sony и 
сообщите ему код ошибки (пять символов в скобках).

This Multi Term. acc is not supported 
by the device and cannot be used.
Please verify the compatibility.

Обнаружен несовместимый аксессуар.
Единственный аксессуар для многофункционального 
разъема, который поддерживается данным устройством, 
— это входящий в комплект поставки пульт управления на 
рукоятке.

Failed Эта ошибка может отображаться, если не удается 
получить адрес, когда для параметра DHCP задано 
значение On.
Проверьте настройки сервера DHCP.

Cannot add auto upload job of Proxy 
file because maximum number of 
upload jobs was reached.

Достигнуто максимальное количество заданий передачи.
Удалите ненужные задания. Кроме того, может быть 
неправильной настройка пункта назначения 
автоматической отправки для файлов прокси. Проверьте 
правильность настройки.

<SSID>Not found. Не удается найти сеть (точку доступа) с указанным 
идентификатором <SSID>.
Проверьте правильность настройки.

<SSID>Authentication Failed Не удалось выполнить аутентификацию подключения к 
сети (точке доступа) с указанным идентификатором 
<SSID>.
Проверьте правильность пароля и других настроек.

An IP address conflict has occurred. 
Please check the network settings.

Имеется конфликт в сетевых адресах беспроводной ЛВС, 
проводной ЛВС или кабеля USB.
Измените адрес вручную или измените настройки для 
сетевого маршрутизатора.

The IP address of the Wireless LAN 
Access Point Mode has been 
changed due to an IP address 
conflict.

IP-адрес режима точки доступа беспроводной ЛВС был 
изменен из-за конфликта в сетевых адресах режима точки 
доступа беспроводной ЛВС, проводной ЛВС или кабеля 
USB.
Проверьте настройку IP-адреса.

1) “(B)” отображается для карты в гнезде B.
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Пункты, задаваемые в полном меню

Да: элемент сохранен.
Нет: элемент не сохранен.
–: Не сохраняется (временная настройка)

LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Shooting ISO/Gain/EI Mode Да Нет

ISO/Gain<H> Да Нет

ISO/Gain<M> Да Нет

ISO/Gain<L> Да Нет

Exposure Index<H> Да Нет

Exposure Index<M> Да Нет

Exposure Index<L> Да Нет

Shockless Gain Да Нет

Base Sensitivity Да Нет

Base ISO Да Нет

ND Filter Preset1 Да Нет

Preset2 Да Нет

Preset3 Да Нет

Shutter Mode Да Нет

Shutter Speed On/Off Да Нет

Shutter Speed Да Нет

Shutter Angle Да Нет

ECS On/Off Да Нет

ECS Frequency Да Нет

Iris Bokeh Control Нет Нет

LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Shooting Auto Exposure Level Да Нет

Mode Да Нет

Speed Да Нет

AGC Да Нет

AGC Limit Да Нет

AGC Point Да Нет

Auto Shutter Да Нет

A.SHT Limit Да Нет

A.SHT Point Да Нет

Clip High light Да Нет

Detect Window Да Нет

Detect Window Indication Да Нет

Custom Width Да Нет

Custom Height Да Нет

Custom H Position Да Нет

Custom V Position Да Нет

White Preset White Да Нет

Color Temp <A> Да Нет

Tint<A> Да Нет

R Gain <A> Да Нет

B Gain <A> Да Нет

Color Temp <B> Да Нет

Tint<B> Да Нет

R Gain <B> Да Нет

B Gain <B> Да Нет

White Setting Shockless White Да Нет

ATW Speed Да Нет

White Switch<B> Да Нет

Filter White Memory Да Нет

Элементы, сохраненные в файлы
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LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Shooting Offset White Offset White <A> Да Нет

Offset Color Temp<A> Да Нет

Offset Tint<A> Да Нет

Offset White <B> Да Нет

Offset Color Temp<B> Да Нет

Offset Tint<B> Да Нет

Offset White<ATW> Да Нет

Offset Color Temp<ATW> Да Нет

Offset Tint<ATW> Да Нет

Focus AF Transition Speed Да Нет

AF Subj. Shift Sens. Да Нет

Focus Area Да Нет

Focus Area (AF-S) Да Нет

Face/Eye Detection AF Да Нет

Push AF Mode Да Нет

Touch Function in MF Да Нет

AF Assist Да Нет

S&Q Motion Setting Да Нет

Frame Rate Да Нет

LUT On/Off SDI/HDMI Да Нет

VF/Proxy/Stream Да Нет

Internal Rec Да Нет

Noise Suppression Setting(Custom) Да Нет

Level(Custom) Да Нет

Setting(Cine EI) Да –

Level(Cine EI) Да –

Flicker Reduce Mode Да Нет

Frequency Да Нет

SteadyShot Setting Да Нет

LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Project Base Setting Shooting Mode Да –

Target Display Да –

Rec Format Frequency Да Нет

Imager Scan Mode Да Нет

Codec Да Нет

RAW Output Format Да Нет

Video Format Да Нет

Cine EI Setting Color Gamut Да –

HDR Setting VF SDR Preview Да Нет

SDR Gain Да Нет

Simul Rec Setting Да Нет

Rec Button Set Да Нет

Proxy Rec Setting Да Нет

Audio Channel Да Нет

Interval Rec Setting Нет Нет

Interval Time Да Нет

Number of Frames Да Нет

Pre-Lighting Да Нет

Picture Cache Rec Setting Да Нет

Cache Size Да Нет

Cache Rec Time – –

SDI/HDMI Rec Control Setting Да Нет

Assignable Button <1> Да Нет

<2> Да Нет

<3> Да Нет

<4> Да Нет

<5> Да Нет

<6> Да Нет

<7> Да Нет

<8> Да Нет

<9> Да Нет

Focus Hold Button Да Нет

Assignable Dial Grip/Remote Dial Да Нет

Grip Dial Direction Да Нет

Handle Dial Да Нет

Handle Dial Direction Да Нет

Multi Function Dial Default Function Да Нет
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LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Project User File Load Media(B) – –

Save Media(B) – –

File ID Нет Нет

Load Customize Data Да Нет

Load White Data Да Нет

All File Load Media(B) – –

Save Media(B) – –

File ID Да Нет

Load Network Data Нет Нет

Paint/Look Scene File Recall – –

Store – –

Delete – –

Preset Recall – –

Base Look Select Да Да

Delete – –

Delete All – –

Import – –

Input Да Да

Output Да Да

AE Level Offset Да Да

Reset Paint Settings Reset without Base Look – –

Black Master Black Да Да

R Black Да Да

B Black Да Да

Knee Setting Да Да

Auto Knee Да Да

Point Да Да

Slope Да Да

Detail Setting Да Да

Level Да Да

Manual Setting Да Да

V/H Balance Да Да

B/W Balance Да Да

Limit Да Да

Crispening Да Да

High Light Detail Да Да

LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Paint/Look Matrix User Matrix Да Да

User Matrix Level Да Да

User Matrix Phase Да Да

User Matrix R-G Да Да

User Matrix R-B Да Да

User Matrix G-R Да Да

User Matrix G-B Да Да

User Matrix B-R Да Да

User Matrix B-G Да Да

Multi Matrix Setting Да Да

Reset – –

Axis Нет Да

Hue Да Да

Saturation Да Да

TC/Media Timecode Mode Да Нет

Run Да Нет

Setting Нет Нет

Reset – –

TC Format Да Нет

TC Display Display Select Да Нет

Users Bit Mode Да Нет

Setting Нет Нет

HDMI TC Out Setting Да Нет

Clip Name Format Title Prefix Да Нет

Number Set Нет Нет

Update Media Media(A) – –

Media(B) – –

Format Media Media(A) – –

Media(B) – –

Monitoring Output On/Off SDI Да Нет

HDMI Да Нет

Output Format SDI Да Нет

HDMI Да Нет

Output Display SDI Да Нет

HDMI Да Нет
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LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Monitoring Display On/Off Network Status Да Нет

File Transfer Status Да Нет

Rec/Play Status Да Нет

RAW Output Control Status Да Нет

Tally Да Нет

Battery Remain Да Нет

Focus Mode Да Нет

Focus Position Да Нет

Focus Area Indicator Да Нет

Focus Area Ind.(AF-S) Да Нет

Face/Eye Detection Frame Да Нет

Lens Info Да Нет

Imager Scan Mode Да Нет

Rec Format Да Нет

Frame Rate Да Нет

Zoom Position Да Нет

UWP RF Level Да Нет

SteadyShot Да Нет

Base Look/LUT Да Нет

SDI/HDMI Rec Control Да Нет

Gamma Display Assist Да Нет

Proxy Status Да Нет

Base ISO/Sensitivity Да Нет

Media Status Да Нет

Video Signal Monitor Да Нет

Clip Name Да Нет

White Balance Да Нет

Scene File Да Нет

Focus Indicator Да Нет

Auto Exposure Mode Да Нет

Auto Exposure Level Да Нет

Timecode Да Нет

ND Filter Да Нет

LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Monitoring Display On/Off Iris Да Нет

ISO/Gain/EI Да Нет

Shutter Да Нет

Level Gauge Да Нет

Audio Level Meter Да Нет

Video Level Warning Да Нет

Clip Number Да Нет

Notice Message Да Нет

Marker Setting Да Нет

Color Да Нет

Center Marker Да Нет

Safety Zone Да Нет

Safety Area Да Нет

Aspect Marker Да Нет

Aspect Mask Да Нет

Aspect Safety Zone Да Нет

Aspect Safety Area Да Нет

Aspect Select Да Нет

Custom Aspect Ratio Да Нет

Guide Frame Да Нет

100% Marker Да Нет

User Box Да Нет

User Box Width Да Нет

User Box Height Да Нет

User Box H Position Да Нет

User Box V Position Да Нет

VF Setting Brightness Да Нет

Color Mode Да Нет

Gamma Display Assist Setting Да Нет

Peaking Setting Да Нет

Peaking Level Да Нет

Color Да Нет

Zebra Setting Да Нет

Zebra1 Level Да Нет

Zebra1 Aperture Level Да Нет

Zebra2 Level Да Нет
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LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Audio Audio Input CH1 Input Select Да Нет

CH2 Input Select Да Нет

CH3 Input Select Да Нет

CH4 Input Select Да Нет

INPUT1 MIC Reference Да Нет

INPUT2 MIC Reference Да Нет

Line Input Reference Да Нет

Reference Level Да Нет

CH1 Wind Filter Да Нет

CH2 Wind Filter Да Нет

CH3 Wind Filter Да Нет

CH4 Wind Filter Да Нет

CH3 Level Control Да Нет

CH4 Level Control Да Нет

CH3 Input Level Да Нет

CH4 Input Level Да Нет

Audio Input Level Да Нет

Limiter Mode Да Нет

CH1&2 AGC Mode Да Нет

CH3&4 AGC Mode Да Нет

AGC Spec Да Нет

1kHz Tone on Color Bars Да Нет

CH1 Level Да Нет

CH2 Level Да Нет

CH3 Level Да Нет

CH4 Level Да Нет

Audio Output Monitor CH Да Нет

Volume Нет Нет

Headphone Out Да Нет

Alarm Level Да Нет

HDMI Output CH Да Нет

LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Thumbnail Display Clip Properties – –

Set Clip Flag Add OK – –

Add NG – –

Add KEEP – –

Delete Clip Flag – –

Lock/Unlock Clip Select Clip – –

Lock All Clips – –

Unlock All Clips – –

Delete Clip Select Clip – –

All Clips – –

Transfer Clip Select Clip – –

All Clips – –

Transfer Clip (Proxy) Select Clip – –

All Clips – –

Filter Clips OK – –

NG – –

KEEP – –

None – –

All – –

Customize View Thumbnail Caption Да –

Technical Color Bars Setting Нет Нет

Type Да Нет

ND Dial CLEAR with Dial Да Нет

Tally Front Да Нет

Rear Да Нет

HOLD Switch Setting with Rec Button Да Нет

with Hand Grip Remote Да Нет

Handle HOLD Switch Да Нет

Touch Operation Setting Да Нет

Rec Review Setting Да Нет

Zoom Zoom Type Да Нет

Handle Zoom Setting Да Нет

High Да Нет

Low Да Нет

Menu Settings User Menu Only Да Нет

User Menu with Lock Нет Нет
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LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Technical Menu Page On/Off Main Да Нет

Camera Да Нет

Audio Да Нет

Project Да Нет

Monitoring Да Нет

Assignable Button Да Нет

Battery Да Нет

Media Да Нет

Network Да Нет

File Transfer Да Нет

Fan Control Setting Да Нет

Lens Zoom Ring Direction Да Нет

Shading Compensation Да Нет

Chroma Aberration Comp. Да Нет

Distortion Comp. Да Нет

Breathing Compensation Да Нет

Distance Display Да Нет

Zoom Position Display Да Нет

Video Light Set Video Light Set Да Нет

APR APR – –

Camera Battery Alarm Low Battery Да Нет

Battery Empty Да Нет

Camera DC IN Alarm DC Low Voltage1 Да Нет

DC Low Voltage2 Да Нет

Network Access Authentication User Name Нет Нет

Input Password Нет Нет

Generate Password – –

Show Settings – –

Wireless LAN Setting Да Нет

WPS – –

NFC – –

MAC Address – –

AP Mode Settings Channel Да Нет

Camera SSID & Password – –

Regenerate Password – –

IP Address – –

Subnet Mask – –

LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Network ST Mode Settings Camera Remote Control Да Нет

Connected Network

SSID – –

Security – –

Password – –

DHCP – –

IP Address – –

Subnet Mask – –

Gateway – –

DNS Auto – –

Primary DNS Server – –

Secondary DNS Server – –

Scan Networks

SSID – –

Security – –

Password Нет Нет

DHCP Да Нет

IP Address Да Нет

Subnet Mask Да Нет

Gateway Да Нет

DNS Auto Да Нет

Primary DNS Server Да Нет

Secondary DNS Server Да Нет

Manual Register

SSID Да Нет

Security Да Нет

Password Нет Нет

DHCP Да Нет

IP Address Да Нет

Subnet Mask Да Нет

Gateway Да Нет

DNS Auto Да Нет

Primary DNS Server Да Нет

Secondary DNS Server Да Нет
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LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Network Wired LAN Setting Да Нет

Camera Remote Control Да Нет

Detail Settings

DHCP Да Нет

IP Address Да Нет

Subnet Mask Да Нет

Gateway Да Нет

DNS Auto Да Нет

Primary DNS Server Да Нет

Secondary DNS Server Да Нет

Modem Setting Да Нет

Camera Remote Control Да Нет

Device Name – –

IP Address – –

Subnet Mask – –

File Transfer Auto Upload (Proxy) Да Нет

Default Upload Server Да Нет

Clear Completed Jobs – –

Clear All Jobs – –

View Job List – –

Server Settings1/Server Settings2/Server Settings3

Display Name Да Нет

Service Да Нет

Host Name Да Нет

Port Да Нет

User Name Нет Нет

Password Нет Нет

Passive Mode Да Нет

Destination Directory Да Нет

Using Secure Protocol Да Нет

Root Certificate – –

Root Certificate Status – –

Reset – –

Network Reset Reset – –

LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Maintenance Language Select Да Нет

Clock Set Time Zone Да Нет

Date Mode Да Нет

12h/24h Да Нет

Date Нет Нет

Time Нет Нет

All Reset Reset – –

Reset without Network – –

Hours Meter Hours(System) – –

Hours(Reset) – –

Reset – –

Version Version Number – –

Version Up – –

Lens Version Number – –
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Пункты, настраиваемые программируемыми кнопками

Да: элемент сохранен.
Нет: элемент не сохранен.
–: Не сохраняется (временная настройка)

Выбор программируемых кнопок All File Scene File

ND Filter Position Да Нет

Auto Iris Да Нет

ATW Да Нет

Focus Setting Да Нет

Display Да –

VF Adjust Да –

Пункты, настраиваемые программируемым диском

Да: элемент сохранен.
Нет: элемент не сохранен.
–: Не сохраняется (временная настройка)

Выбор для программируемого 
диска

All File Scene File

IRIS Да Нет

ND Filter Да Нет

Audio Input Level Да Нет



8. Приложение135

См. соответствующие пункты в разделах “Настройка записываемого звука” (стр. 49) и “Меню User” (стр. 77).

Audio Input (CH1&CH2)

Ниже показана блок-схема с установленной ручкой.

INPUT1

L

R

INPUT2

Shoe CH1

Shoe CH2

Internal MIC

CH1

[CH1 Input Select]
INPUT1
Internal MIC
Shoe CH1

[CH2 Input Select]
INPUT1
INPUT2
Internal MIC
Shoe CH2

Fo
r 

X
LR

 a
d

ap
to

r
Fo

r 
X

LR
 a

d
ap

to
r

<CH1 LEVEL
   CONTROL>*
AUTO
MAN

<CH1 INPUT LEVEL>
0 ~ 10

[CH1 Wind Filter]
On
O�

[CH2 Wind Filter]
On
O�

CH2

<CH2 LEVEL
   CONTROL>*
AUTO
MAN

<CH2 INPUT LEVEL>
0 ~ 10

[CH1&2 AGC Mode]
Mono
Stereo [Color Bars]

[1kHz Tone on Color
Bars]
On
O�

[Audio Input Level]
0 ~ 99

[Limiter Mode]
O�, -6dB,

-9dB, -12dB,
-15dB, -17dB SG

[CH1 Level]
Audio Input Level
Side
Level + Side
Through

[CH2 Level]
Audio Input Level
Side
Level + Side
Through

* Задается значение Manual, когда звук подается от адаптера XLR.

Блок-схемы
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Audio Input (CH3&CH4)

Ниже показана блок-схема с установленной ручкой.

L

R

CH3

[CH3 Level
 Control]*
Auto
Manual

[CH4 Level
 Control]*
Auto
Manual

[CH3 Input Level]
0 ~ 99

CH4

[CH4 Input Level]
0 ~ 99

[CH3&4 AGC Mode]
Mono
Stereo

[Audio Input Level]
0 ~ 99

[Limiter Mode]
O�, -6dB,
-9dB, -12dB,
-15dB, -17dB SG

OFF

[CH3 Input Select]
O�
INPUT1
Internal MIC
Shoe CH1

Fo
r 

X
LR

 a
d

ap
to

r
Fo

r 
X

LR
 a

d
ap

to
r

[CH3 Wind Filter]
On
O�

[CH4 Wind Filter]
On
O�

[CH4 Input Select]
O�
INPUT1
INPUT2
Internal MIC
Shoe CH2

INPUT1

INPUT2

Shoe CH1

Shoe CH2

Internal MIC

[CH3 Level]
Audio Input Level
CH3 Input Level
Level+CH3 Input Level
Through

[CH4 Level]
Audio Input Level
CH4 Input Level
Level+CH4 Input Level
Through

[Color Bars]
[1kHz Tone on Color
Bars]
On
O�

 
* Задается значение Manual, когда звук подается от адаптера XLR.
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Audio Output

L

R

Alarm
Beep

[HDMI Output CH]
CH1/CH2, CH3/CH4

[Monitor CH]
CH1, CH2, CH3, CH4,
CH1/CH2, CH3/CH4,
MIX ALL

[Headphone Out]
Mono, Stereo

[VOLUME]
0 ～ 50

[Alarm Level]
0 ～ 7

Ch
MIX

CH1

SDI OUT

Headphone

Internal Speaker

HDMI OUT

CH2

CH3

CH4
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С помощью видеокамеры можно обновлять 
программное обеспечение объективов с 
байонетом E.
Список объективов, для которых возможно 
обновление, и соответствующего 
программного обеспечения см. на веб-
сайте для объективов.

Проверка версии

1 Установите объектив с байонетом E на 
видеокамеру (стр. 23).

2 Выберите пункт Version в меню 
Maintenance полного меню для 
отображения номера версии объектива 
Lens Version Number (стр. 109).
Номер версии программного 
обеспечения объектива с байонетом E 
отображается сбоку.

Обновление программного 
обеспечения

Перевод видеокамеры в режим накопителя 
(стр. 118).
Обновите программное обеспечение в 
соответствии с процедурой, прилагаемой к 
программному обеспечению объектива.

Обновление программного обеспечения объектива с байонетом E
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Лицензия на портфель патентов 
для AVC MPEG-4

ДАННОЕ ИЗДЕЛИЕ ЛИЦЕНЗИРОВАНО В 
СООТВЕТСТВИИ С ЛИЦЕНЗИЕЙ НА ПОРТФЕЛЬ 
ПАТЕНТОВ AVC ДЛЯ ПЕРСОНАЛЬНОГО 
ИСПОЛЬЗОВАНИЯ ПОТРЕБИТЕЛЕМ И 
ДРУГИХ ПРИМЕНЕНИЙ, В КОТОРЫХ НЕ 
ПРЕДУСМОТРЕНО ВОЗНАГРАЖДЕНИЕ, ДЛЯ
(i) КОДИРОВАНИЯ ВИДЕО В СООТВЕТСТВИИ 

СО СТАНДАРТОМ AVC (“ВИДЕО AVC”) И/
ИЛИ

(ii) ДЕКОДИРОВАНИЯ ВИДЕО AVC, КОТОРОЕ 
БЫЛО ЗАКОДИРОВАНО ПОТРЕБИТЕЛЕМ 
ДЛЯ СВОИХ ЛИЧНЫХ НУЖД И/ИЛИ БЫЛО 
ПОЛУЧЕНО ОТ ВИДЕОПРОВАЙДЕРА, 
ИМЕЮЩЕГО ЛИЦЕНЗИЮ НА 
ПРЕДОСТАВЛЕНИЕ ВИДЕО AVC.

НИ ДЛЯ КАКИХ ДРУГИХ СПОСОБОВ 
ПРИМЕНЕНИЯ ЛИЦЕНЗИЯ НЕ 
ПРЕДОСТАВЛЯЕТСЯ И ЕЕ ДЕЙСТВИЕ НЕ 
ПОДРАЗУМЕВАЕТСЯ. ЗА ДОПОЛНИТЕЛЬНОЙ 
ИНФОРМАЦИЕЙ ОБРАЩАЙТЕСЬ В 
КОМПАНИЮ MPEG LA, L.L.C. СМ.  
HTTP://WWW.MPEGLA.COM

Получение программного 
обеспечения в соответствии с 
лицензией GPL/LGPL

В этом изделии используется программное 
обеспечение, на которое распространяется 
действие лицензии GPL/LGPL. Настоящим 
уведомляем вас о том, что в соответствии 
с условиями лицензии GPL/LGPL у вас 
есть право на доступ, изменение и 
распространение исходного кода этих 
программ.
Исходный код опубликован в Интернете. 
Перейдите по следующему URL-адресу и 
выполните инструкции по загрузке.

https://oss.sony.net/Products/Linux/

Мы просим вас не обращаться к нам по 
поводу содержимого исходного кода.

Лицензии (на английском языке) записаны 
во внутреннюю память изделия.
Чтобы прочитать лицензии, хранящиеся 
в папке “PMHOME” - “LICENSE”, подключите 
изделие к компьютеру в режиме 
накопителя.

При использовании Mac папка “PMHOME” - 
“LICENSE” может быть недоступна.
Для просмотра файлов используйте 
любой другой компьютер, кроме Mac, или 
перейдите по следующему URL адресу.
https://oss.sony.net/License/ILME-FX6/

ЛИЦЕНЗИОННОЕ СОГЛАШЕНИЕ 
КОНЕЧНОГО ПОЛЬЗОВАТЕЛЯ

IMPORTANT: 
BEFORE USING THE SOFTWARE CONTAINED IN THE 
SOLID STATE MEMORY CAMCORDER, PLEASE READ THIS 
END USER LICENSE AGREEMENT (“EULA”) CAREFULLY. BY 
USING THE SOFTWARE YOU ARE ACCEPTING THE TERMS 
OF THIS EULA. IF YOU DO NOT ACCEPT THE TERMS OF 
THIS EULA, YOU MAY NOT USE THE SOFTWARE.

This EULA is a legal agreement between you and Sony 
Corporation (“SONY”). This EULA governs your rights 
and obligations regarding the software of SONY and/or 
its third party licensors (including SONY’s affiliates) and 
their respective affiliates (collectively, the “THIRD-PARTY 
SUPPLIERS”) contained in the wireless adapter, together 
with any updates/ upgrades provided by SONY, any 
printed, on-line or other electronic documentation for 
such software, and any data files created by operation of 
such software (collectively, the “SOFTWARE”).

Notwithstanding the foregoing, any software in 
the SOFTWARE having a separate end user license 
agreement (including, but not limited to, GNU General 
Public license and Lesser/Library General Public License) 
shall be covered by such applicable separate end user 

license agreement in lieu of the terms of this EULA to 
the extent required by such separate end user license 
agreement (“EXCLUDED SOFTWARE”).

SOFTWARE LICENSE
The SOFTWARE is licensed, not sold. The SOFTWARE is 
protected by copyright and other intellectual property 
laws and international treaties.

COPYRIGHT
All right and title in and to the SOFTWARE (including, 
but not limited to, any images, photographs, animation, 
video, audio, music, text and “applets” incorporated into 
the SOFTWARE) is owned by SONY or one or more of the 
THIRD-PARTY SUPPLIERS.

GRANT OF LICENSE
SONY grants you a limited license to use the SOFTWARE 
solely in connection with the wireless adapter and only 
for your individual use. SONY and the THIRD-PARTY 
SUPPLIERS expressly reserve all rights, title and interest 
(including, but not limited to, all intellectual property 
rights) in and to the SOFTWARE that this EULA does not 
specifically grant to you.

REQUIREMENTS AND LIMITATIONS
You may not copy, publish, adapt, redistribute, attempt 
to derive source code, modify, reverse engineer, 
decompile, or disassemble any of the SOFTWARE, 
whether in whole or in part, or create any derivative 
works from or of the SOFTWARE unless such derivative 
works are intentionally facilitated by the SOFTWARE. 
You may not modify or tamper with any digital rights 
management functionality of the SOFTWARE. You 
may not bypass, modify, defeat or circumvent any of 
the functions or protections of the SOFTWARE or any 
mechanisms operatively linked to the SOFTWARE. You 
may not separate any individual component of the 
SOFTWARE for use on more than one wireless adapter 
unless expressly authorized to do so by SONY. You 
may not remove, alter, cover or deface any trademarks 
or notices on the SOFTWARE. You may not share, 
distribute, rent, lease, sublicense, assign, transfer or 
sell the SOFTWARE. The software, network services 
or other products other than SOFTWARE upon which 
the SOFTWARE’S performance depends might be 
interrupted or discontinued at the discretion of the 

suppliers (software suppliers, service suppliers, or 
SONY). SONY and such suppliers do not warrant that the 
SOFTWARE, network services, contents or other products 
will continue to be available, or will operate without 
interruption or modification. 

EXCLUDED SOFTWARE AND OPEN SOURCE 
COMPONENTS
Notwithstanding the foregoing limited license grant, 
you acknowledge that the SOFTWARE may include 
EXCLUDED SOFTWARE. Certain EXCLUDED SOFTWARE 
may be covered by open source software licenses 
(“Open Source Components”), which means any 
software licenses approved as open source licenses by 
the Open Source Initiative or any substantially similar 
licenses, including but not limited to any license that, 
as a condition of distribution of the software licensed 
under such license, requires that the distributor make 
the software available in source code format. If and to 
the extent disclosure is required, please visit www.sony.
com/linux or other SONY-designated web site for a list 
of applicable OPEN SOURCE COMPONENTS included in 
the SOFTWARE from time to time, and the applicable 
terms and conditions governing its use. Such terms 
and conditions may be changed by the applicable 
third party at any time without liability to you. To the 
extent required by the licenses covering EXCLUDED 
SOFTWARE, the terms of such licenses will apply in lieu 
of the terms of this EULA. To the extent the terms of the 
licenses applicable to EXCLUDED SOFTWARE prohibit 
any of the restrictions in this EULA with respect to such 
EXCLUDED SOFTWARE, such restrictions will not apply 
to such EXCLUDED SOFTWARE. To the extent the terms 
of the licenses applicable to Open Source Components 
require SONY to make an offer to provide source code 
in connection with the SOFTWARE, such offer is hereby 
made. 

USE OF SOFTWARE WITH COPYRIGHTED 
MATERIALS
The SOFTWARE may be capable of being used by you 
to view, store, process and/or use content created by 
you and/or third parties. Such content may be protected 
by copyright, other intellectual property laws, and/
or agreements. You agree to use the SOFTWARE only 
in compliance with all such laws and agreements that 
apply to such content. You acknowledge and agree 

Лицензии

https://oss.sony.net/Products/Linux/
https://oss.sony.net/License/ILME-FX6/
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that SONY may take appropriate measures to protect 
the copyright of content stored, processed or used by 
the SOFTWARE. Such measures include, but are not 
limited to, counting the frequency of your backup and 
restoration through certain SOFTWARE features, refusal 
to accept your request to enable restoration of data, and 
termination of this EULA in the event of your illegitimate 
use of the SOFTWARE. 

CONTENT SERVICE 
PLEASE ALSO NOTE THAT THE SOFTWARE MAY BE 
DESIGNED TO BE USED WITH CONTENT AVAILABLE 
THROUGH ONE OR MORE CONTENT SERVICES 
(“CONTENT SERVICE”). USE OF THE SERVICE AND THAT 
CONTENT IS SUBJECT TO THE TERMS OF SERVICE OF 
THAT CONTENT SERVICE. IF YOU DECLINE TO ACCEPT 
THOSE TERMS, YOUR USE OF THE SOFTWARE WILL 
BE LIMITED. You acknowledge and agree that certain 
content and services available through the SOFTWARE 
may be provided by third parties over which SONY has 
no control. USE OF THE CONTENT SERVICE REQUIRES AN 
INTERNET CONNECTION. THE CONTENT SERVICE MAY BE 
DISCONTINUED AT ANY TIME.

INTERNET CONNECTIVITY AND THIRD PARTY 
SERVICES
You acknowledge and agree that access to certain 
SOFTWARE features may require an Internet connection 
for which you are solely responsible. Further, you are 
solely responsible for payment of any third party fees 
associated with your Internet connection, including 
but not limited to Internet service provider or airtime 
charges. Operation of the SOFTWARE may be limited 
or restricted depending on the capabilities, bandwidth 
or technical limitations of your Internet connection 
and service. The provision, quality and security of such 
Internet connectivity are the sole responsibility of the 
third party providing such service. 

EXPORT AND OTHER REGULATIONS
You agree to comply with all applicable export and re-
export restrictions and regulations of the area or country 
in which you reside, and not to transfer, or authorize 
the transfer, of the SOFTWARE to a prohibited country 
or otherwise in violation of any such restrictions or 
regulations.

HIGH RISK ACTIVITIES
The SOFTWARE is not fault-tolerant and is not designed, 
manufactured or intended for use or resale as on-
line control equipment in hazardous environments 
requiring fail-safe performance, such as in the 
operation of nuclear facilities, aircraft navigation or 
communication systems, air traffic control, direct life 
support machines, or weapons systems, in which the 
failure of the SOFTWARE could lead to death, personal 
injury, or severe physical or environmental damage 
(“HIGH RISK ACTIVITIES”). SONY, each of the THIRD-
PARTY SUPPLIERS, and each of their respective affiliates 
specifically disclaim any express or implied warranty, 
duty or condition of fitness for HIGH RISK ACTIVITIES.

EXCLUSION OF WARRANTY ON SOFTWARE
You acknowledge and agree that use of the SOFTWARE 
is at your sole risk and that you are responsible for use 
of the SOFTWARE. The SOFTWARE is provided “AS IS,” 
without warranty, duty or condition of any kind.

SONY AND EACH OF THE THIRD-PARTY SUPPLIERS (for 
purposes of this Section, SONY and each of the THIRD-
PARTY SUPPLIERS shall be collectively referred to as 
“SONY”) EXPRESSLY DISCLAIM ALL WARRANTIES, DUTIES 
OR CONDITIONS, EXPRESS OR IMPLIED, INCLUDING, 
BUT NOT LIMITED TO, THE IMPLIED WARRANTIES 
OF MERCHANTABILITY, NONINFRINGEMENT AND 
FITNESS FOR A PARTICULAR PURPOSE. SONY 
DOES NOT WARRANT OR MAKE ANY CONDITIONS 
OR REPRESENTATIONS (A) THAT THE FUNCTIONS 
CONTAINED IN ANY OF THE SOFTWARE WILL MEET YOUR 
REQUIREMENTS OR THAT THEY WILL BE UPDATED, (B) 
THAT THE OPERATION OF ANY OF THE SOFTWARE WILL 
BE CORRECT OR ERROR-FREE OR THAT ANY DEFECTS 
WILL BE CORRECTED, (C) THAT THE SOFTWARE WILL 
NOT DAMAGE ANY OTHER SOFTWARE, HARDWARE OR 
DATA, (D) THAT ANY SOFTWARE, NETWORK SERVICES 
(INCLUDING THE INTERNET) OR PRODUCTS (OTHER 
THAN THE SOFTWARE) UPON WHICH THE SOFTWARE’S 
PERFORMANCE DEPENDS WILL CONTINUE TO BE 
AVAILABLE, UNINTERRUPTED OR UNMODIFIED, AND 
(E) REGARDING THE USE OR THE RESULTS OF THE USE 
OF THE SOFTWARE IN TERMS OF ITS CORRECTNESS, 
ACCURACY, RELIABILITY, OR OTHERWISE. 

NO ORAL OR WRITTEN INFORMATION OR ADVICE 
GIVEN BY SONY OR AN AUTHORIZED REPRESENTATIVE 
OF SONY SHALL CREATE A WARRANTY, DUTY OR 
CONDITION OR IN ANY WAY INCREASE THE SCOPE OF 
THIS WARRANTY. SHOULD THE SOFTWARE PROVE 
DEFECTIVE YOU ASSUME THE ENTIRE COST OF ALL 
NECESSARY SERVICING, REPAIR OR CORRECTION. SOME 
JURISDICTIONS DO NOT ALLOW THE EXCLUSION OF 
IMPLIED WARRANTIES, SO THESE EXCLUSIONS MAY NOT 
APPLY TO YOU.

LIMITATION OF LIABILITY
SONY AND EACH OF THE THIRD-PARTY SUPPLIERS (for 
purposes of this Section, SONY and each of the THIRD-
PARTY SUPPLIERS shall be collectively referred to as 
“SONY”) SHALL NOT BE LIABLE FOR ANY INCIDENTAL 
OR CONSEQUENTIAL DAMAGES FOR BREACH OF 
ANY EXPRESS OR IMPLIED WARRANTY, BREACH OF 
CONTRACT, NEGLIGENCE, STRICT LIABILITY OR UNDER 
ANY OTHER LEGAL THEORY RELATED TO THE SOFTWARE, 
INCLUDING, BUT NOT LIMITED TO, ANY DAMAGES 
ARISING OUT OF LOSS OF PROFITS, LOSS OF REVENUE, 
LOSS OF DATA, LOSS OF USE OF THE SOFTWARE OR 
ANY ASSOCIATED HARDWARE, DOWN TIME AND USER'S 
TIME, EVEN IF ANY OF THEM HAVE BEEN ADVISED OF 
THE POSSIBILITY OF SUCH DAMAGES. IN ANY CASE, 
EACH AND ALL OF THEIR AGGREGATE LIABILITY UNDER 
ANY PROVISION OF THIS EULA SHALL BE LIMITED TO 
THE AMOUNT ACTUALLY PAID FOR THE PRODUCT. 
SOME JURISDICTIONS DO NOT ALLOW THE EXCLUSION 
OR LIMITATION OF INCIDENTAL OR CONSEQUENTIAL 
DAMAGES, SO THE ABOVE EXCLUSION OR LIMITATION 
MAY NOT APPLY TO YOU.

CONSENT TO USE OF NON-PERSONAL 
INFORMATION, LOCATION DATA, DATA 
SECURITY
You acknowledge and agree that SONY and its 
affiliates, partners and agents may read, collect, 
transfer, process and store certain information 
collected from the SOFTWARE, including but not 
limited to information about (i) the SOFTWARE and 
(ii) the software applications, contents and peripheral 
devices that interact with your wireless adapter and the 
SOFTWARE (“Information”). Information includes, but 
is not limited to: (1) unique identifiers relating to your 
wireless adapter and its components; (2) performance 

of the wireless adapter, the SOFTWARE and their 
components; (3) configurations of your wireless adapter, 
the SOFTWARE and the software applications, contents 
and peripheral devices that interact with the wireless 
adapter and the SOFTWARE; (4) use and frequency of 
use of the functions of (x) the SOFTWARE, and (y) the 
software applications, contents and peripheral devices 
that interact with the SOFTWARE; and (5) location data, 
as indicated below. SONY and its affiliates, partners 
and agents may use and disclose Information subject 
to applicable laws in order to improve its products and 
services or to provide products or services to you. Such 
uses include, but are not limited to: (a) administering 
the functionalities of the SOFTWARE; (b) to improve, 
service, update or upgrade the SOFTWARE; (c) 
improving, developing and enhancing the current and 
future products and services of SONY and other parties; 
(d) to provide you with information about the products 
and services offered by SONY and other parties; (e) 
complying with applicable laws or regulations; and (f) 
to the extent offered, providing you with location-based 
services of SONY and other parties, as indicated below. 
In addition, SONY retains the right to use Information 
to protect itself and third parties from illegal, criminal or 
harmful conduct.

Certain services available through the SOFTWARE may 
rely upon location information, including, but not limited 
to, the geographic location of the wireless adapter. You 
acknowledge that for the purpose of providing such 
services, SONY, the THIRDPARTY SUPPLIERS or their 
partners may collect, archive, process and use such 
location data, and that such services are governed by 
the privacy policies of SONY or such third party. By 
reviewed the privacy policies applicable to such services 
and consent to such activities. 

SONY, its affiliates, partners and agents will not 
intentionally use Information to personally identify 
the owner or user of the SOFTWARE without your 
knowledge or consent. Any use of Information will be 
in accordance with the privacy policies of SONY or such 
third party. 

Please contact applicable contact address of each area or 
country for SONY’s current privacy policy. Please contact 
applicable third parties for privacy policies relating 
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to personally identifiable and other information you 
provide when you use or access third party software or 
services. 

Information may be processed, stored or transferred 
to SONY, its affiliates or agents which are located in 
countries outside of your country of residence. Data 
protection and information privacy laws in certain 
countries may not offer the same level of protection 
as your country of residence and you may have fewer 
legal rights in relation to Information processed and 
stored in, or transferred to, such countries. SONY will 
use reasonable efforts to take appropriate technical and 
organizational steps to prevent unauthorized access to 
or disclosure of Information, but does not warrant it will 
eliminate all risk of misuse of such Information.

AUTOMATIC UPDATE FEATURE
From time to time, SONY or the THIRD-PARTY SUPPLIERS 
may automatically update or otherwise modify the 
SOFTWARE, including, but not limited to, for purposes 
of enhancement of security functions, error correction 
and improvement of functions, at such time as you 
interact with SONY’s or third parties’ servers, or 
otherwise. Such updates or modifications may delete 
or change the nature of features or other aspects of the 
SOFTWARE, including, but not limited to, functions you 
may rely upon. You acknowledge and agree that such 
activities may occur at SONY’s sole discretion and that 
SONY may condition continued use of the SOFTWARE 
upon your complete installation or acceptance of such 
update or modifications. Any updates/modifications 
shall be deemed to be, and shall constitute part of, the 
SOFTWARE for purposes of this EULA. By acceptance of 
this EULA, you consent to such update/modification.

ENTIRE AGREEMENT, WAIVER, SEVERABILITY
This EULA and SONY’s privacy policy, each as amended 
and modified from time to time, together constitute the 
entire agreement between you and SONY with respect 
to the SOFTWARE. The failure of SONY to exercise or 
enforce any right or provision of this EULA shall not 
constitute a waiver of such right or provision. If any part 
of this EULA is held invalid, illegal, or unenforceable, 
that provision shall be enforced to the maximum extent 
permissible so as to maintain the intent of this EULA, 
and the other parts will remain in full force and effect.

GOVERNING LAW AND JURISDICTION
The United Nations Convention on Contracts for the 
International Sale of Goods shall not apply to this EULA. 
This EULA shall be governed by the laws of Japan, 
without regards to conflict of laws provisions. Any 
dispute arising out of this EULA shall be subject to the 
exclusive venue of the Tokyo District Court in Japan, and 
the parties hereby consent to the venue and jurisdiction 
of such courts.

EQUITABLE REMEDIES
Notwithstanding anything contained in this EULA to the 
contrary, you acknowledge and agree that any violation 
of or noncompliance with this EULA by you will cause 
irreparable harm to SONY, for which monetary damages 
would be inadequate, and you consent to SONY 
obtaining any injunctive or equitable relief that SONY 
deems necessary or appropriate in such circumstances. 
SONY may also take any legal and technical remedies 
to prevent violation of and/or to enforce this EULA, 
including, but not limited to, immediate termination of 
your use of the SOFTWARE, if SONY believes in its sole 
discretion that you are violating or intend to violate 
this EULA. These remedies are in addition to any other 
remedies SONY may have at law, in equity or under 
contract.

TERMINATION
Without prejudice to any of its other rights, SONY may 
terminate this EULA if you fail to comply with any of its 
terms. In case of such termination, you must: (i) cease 
all use, and destroy any copies, of the SOFTWARE; (ii) 
comply with the requirements in the section below 
entitled “Your Account Responsibilities”.

AMENDMENT
SONY RESERVES THE RIGHT TO AMEND ANY OF THE 
TERMS OF THIS EULA AT ITS SOLE DISCRETION BY 
POSTING NOTICE ON A SONY DESIGNATED WEB SITE, BY 
EMAIL NOTIFICATION TO AN EMAIL ADDRESS PROVIDED 
BY YOU, BY PROVIDING NOTICE AS PART OF THE 
PROCESS IN WHICH YOU OBTAIN UPGRADES/ UPDATES 
OR BY ANY OTHER LEGALLY RECOGNIZABLE FORM OF 
NOTICE. If you do not agree to the amendment, you 
should promptly contact SONY for instructions. Your 
continued use of the SOFTWARE after the effective date 

of any such notice shall be deemed your agreement to 
be bound by such amendment.

THIRD-PARTY BENEFICIARIES
Each THIRD-PARTY SUPPLIER is an express intended 
thirdparty beneficiary of, and shall have the right to 
enforce, each provision of this EULA with respect to the 
SOFTWARE of such party. 

Should you have any questions concerning this EULA, 
you may contact SONY by writing to SONY at applicable 
contact address of each area or country.

Copyright © 2012 Sony Corporation.

Лицензии на ПО с открытым 
исходным кодом

На основе лицензионных договоров, 
заключенных между корпорацией 
Sony и владельцами авторских прав на 
программное обеспечение, в этом продукте 
используется открытое программное 
обеспечение.
Для удовлетворения требований 
владельцев авторских прав на 
программное обеспечение корпорация 
Sony обязана довести до вашего сведения 
содержимое этих лицензий.
Лицензии (на английском языке) записаны 
во внутреннюю память изделия.
Чтобы прочитать лицензии, хранящиеся 
в папке “PMHOME” - “LICENSE”, подключите 
изделие к компьютеру в режиме 
накопителя.

При использовании Mac папка “PMHOME” - 
“LICENSE” может быть недоступна.
Для просмотра файлов используйте 
любой другой компьютер, кроме Mac, или 
перейдите по следующему URL адресу.
https://oss.sony.net/License/ILME-FX6/

https://oss.sony.net/License/ILME-FX6/
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Общие

Масса

 Прибл. 890 г (только основной корпус)

 Прибл. 2,59 кг (включая объектив 

SEL24105G, бленду объектива, 

аккумулятор (BP-U35), 

видоискатель, ручку и рукоятку)

Габариты

 См. стр. 145.

Требования к источнику питания

 19,5 В пост. тока (от 18,0 В до 20,5 В)

Энергопотребление

 Приблизительно 18,0 Вт (корпус, объектив, 

запись в формате XAVC-I 

QFHD 59.94P, видоискатель 

включен, внешних устройств не 

подключено)

 Приблизительно 36,0 Вт (корпус, объектив, 

запись в формате XAVC-I QFHD 

59.94P (S&Q 120 кадров/с), 

видоискатель включен, HDMI, 

SDI, внешнее устройство 

подключено)

Рабочая температура

 От 0 °C до 40 °C

Температура хранения

 От –20 °C до +60 °C

Время непрерывной работы

 Приблизительно 105 минуты (при 

использовании BP-U35)  

(корпус, объектив, запись 

в формате XAVC-I QFHD 59.94P, 

видоискатель включен, 

внешних устройств не 

подключено)
Формат записи (видео)
 XAVC Intra
  Режим XAVC-I 4K/QFHD: 

VBR, скорость потока данных 

600 Мбит/с (макс.), MPEG-4 
AVC/H.264

  Режим XAVC-I HD: 
CBG, скорость потока данных 
223 Мбит/с (макс.), MPEG-4 
AVC/H.264

 XAVC Long
  Режим XAVC-L QFHD: 

VBR, скорость потока данных 
150 Мбит/с (макс.), MPEG-4 
H.264/AVC

  Режим XAVC-L HD 50: 
VBR, скорость потока данных 
50 Мбит/с (макс.), MPEG-4 
H.264/AVC

  Режим XAVC-L HD 35: 
VBR, скорость потока данных 
35 Мбит/с (макс.), MPEG-4 
H.264/AVC

Формат записи (аудио)
 LPCM 24 бит, 48 кГц, 4-канальная
Частота кадров при записи
 XAVC Intra
  Режим XAVC-I 4K: 

4096×2160/59.94P, 50P, 29.97P, 
25P, 24P, 23.98P

  Режим XAVC-I QFHD: 
3840×2160/59.94P, 50P, 29.97P, 
25P, 23.98P

  Режим XAVC-I HD: 
1920×1080/59.94P, 50P, 29.97P, 
25P, 23.98P

 XAVC Long
  Режим XAVC-L QFHD: 

3840×2160/59.94P, 50P, 29.97P, 
25P, 23.98P

  Режим XAVC-L HD 50: 
1920×1080/59.94P, 50P, 29.97P, 
25P, 23.98P

  Режим XAVC-L HD 35: 
1920×1080/59.94P, 50P, 29.97P, 
25P, 23.98P

Время записи/воспроизведения

 XAVC Intra

  Режим XAVC-I QFHD:

   59.94P

   Прибл. 30 мин (при 

использовании CEA-G160T)

  Режим XAVC-I HD:

   59.94P

   Приблизительно 78 минут (при 

использовании CEA-G160T)

 XAVC Long

  Режим XAVC-L QFHD:

   59.94P

   Приблизительно 115 минут (при 

использовании CEA-G160T)

  Режим XAVC-L HD 50:

   59.94P

   Приблизительно 155 минут (при 

использовании CEA-G80T)

  Режим XAVC-L HD 35:

   59.94P

   Приблизительно 210 минут (при 

использовании CEA-G80T)

[Примечание]
Время записи/воспроизведения зависит от условий 
использования и характеристик памяти. Значения 
времени записи и воспроизведения приведены 
с учетом непрерывной записи одного клипа. 
Фактическое время может быть короче (это зависит 
от количества записанных клипов).

Камера

Устройство формирования изображения (тип)
 Полнокадровый датчик изображения 

CMOS, эквивалентный 35 мм, 
с одной микросхемой

Количество пикселов

 12,9 млн (всего)

 10,2 млн (эффективных)

Auto Focus
 Способ обнаружения: фазовое 

обнаружение/обнаружение по 
контрастности

Встроенные фильтры ND
 CLEAR: OFF
 1: 1/4ND
 2: 1/16ND
 3: 1/64ND
 Линейная переменная нейтральная 

плотность: 1/4ND – 1/128ND
Чувствительность ISO
 ISO 800/12800 (режим Cine EI, источник 

света D55)
Крепление объектива
 Байонет E
Широтная характеристика
 15+ остановок
Выдержка затвора
 От 64F до 1/8000 с (23.98P)
Угол раскрытия затвора
 От 5,6° до 360°, от 2 до 64 кадров
Съемка с замедлением/ускорением движения
 XAVC QFHD: от 1 кадров/с до 120 кадров/с
 XAVC HD: от 1 кадров/с до 240 кадров/с
 XAVC 4K: от 1 кадров/с до 60 кадров/с
 XAVC HD (S35): от 1 кадров/с до 120 кадров/с
Баланс белого
 От 2000 K до 15000 K
Gain
 От –3 дБ до +30 дБ (с шагом 1 дБ)
Базовый вид
 S-Cinetone, Standard, Still, ITU709, s709, 

709(800%), S-Log3, HLG Live, HLG 
Natural

Аудио

Частота дискретизации
 48 кГц
Квантование
 24 бита

Технические характеристики
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Частотная характеристика
 Режим MIC входа XLR: от 20 Гц до 20 кГц  

(±3 дБ или менее)
 Режим LINE входа XLR: от 20 Гц до 20 кГц  

(±3 дБ или менее)
Динамический диапазон
 Режим MIC входа XLR: 80 дБ (обычно)
 Режим LINE входа XLR: 90 дБ (обычно)
Искажение
 Режим MIC входа XLR: 0,08% или ниже 

(входной уровень –40 дБн)
 Режим LINE входа XLR: 0,08% или ниже 

(входной уровень +14 дБн)
Встроенный динамик
 Монофонический
Внутренний микрофон 
 Монофонический
Внутренний микрофон ручки

 Всенаправленный стереофонический 

электретный конденсаторный 

микрофон

[Примечание]
Когда установлена ручка, активным становится 
только внутренний микрофон ручки.

Вход/выход

Входы
INPUT 1/2:

 Тип XLR, 3-контактный, гнездо

 Возможность переключения LINE / MIC / 

MIC+48V

 MIC: опорный от –30 дБн до –80 дБн

TC IN:

 Тип BNC

Выходы
SDI OUT:

 Тип BNC, 12G-SDI, 6G-SDI, 3G-SDI (Level A/B), 

HD-SDI

Наушники (стерео миниразъем):

 –16 дБн (выход опорного уровня, 

максимальная громкость 

монитора, нагрузка 16 Ом)

HDMI:

 Тип A, 19-контактный

TC OUT:

 Тип BNC

Другие
DC IN:

 Совместимый с EIAJ, от 18 В до 20,5 В пост. 

тока

Многоцелевой разъем:

 Специальный (21-контактный)

REMOTE:

 3-контактный, суб-мини, диаметром 2,5 мм

Разъем пульта управления на рукоятке:

 4-контактный стерео миниразъем 3,5 мм 

(разъем для пульта управления 

на рукоятке из комплекта 

поставки)

USB-C:

 USB 3.2 Gen 1

USB/многоцелевой:

 Совместимый со стандартом USB 2.0, тип 

micro B для хранения данных (1)

VF:

 Специальный (40-контактный)

Дисплей

Видоискатель (ЖК-дисплей)
Размер экрана

 8,8 см (3,5 дюйма) по диагонали

Формат изображения

 16:9

Количество пикселов

 1280 (Г) × 720 (В)

Гнездо для носителя

Гнездо карты CFexpress Type A/SD-карты (2)

Беспроводная ЛВС

Поддерживаемые стандарты

 IEEE 802.11 a/b/g/n/ac (ILME-FX6V/VK)

 IEEE 802.11 b/g/n (ILME-FX6T/TK)

Диапазон частот

 2,4 ГГц

 5 ГГц (только ILME-FX6V/VK)

Поддерживаемые протоколы безопасности

 WEP/WPA-PSK/WPA2-PSK

Способ подключения

 Wi-Fi Protected Setup™ (WPS)/вручную

Способ доступа

 Режим инфраструктуры

Зарядное устройство (BC-CU1)

Масса

 Прибл. 60 г

Габариты

 Прибл. 57 × 26 × 101 мм  

(ширина / высота / глубина)

Вход

 19,5 В пост. тока, 26 Вт

Выход

 16,4 В пост. тока, 1,4 А

Рабочая температура

 От 0 °C до 40 °C

Температура хранения

 От –20 °C до +60 °C

Поставляемые принадлежности

Адаптер переменного тока (1)

Кабель питания (1) 

Зарядное устройство (1) 

Аккумуляторный блок (1)

Ручка (1)

ЖК-монитор (1)

Кабель USB-C (1)

Пульт управления на рукоятке (1)

Бленда ЖК-монитора (1)

Комплект разъема для крепления 

принадлежностей (1) 

(Разъем для крепления принадлежностей (1), 

пружина разъема (1), винты (4))

Крышка крепления объектива (1)

Защитная крышка разъема для рукоятки (1)

Перед использованием данного устройства (1)

Гарантийный талон (1)

Конструкция и технические 
характеристики могут быть изменены без 
предварительного уведомления.
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Примечания
ˎˎ Всегда делайте пробную запись, а 
также удостоверьтесь в надлежащем 
качестве этой записи. КОМПАНИЯ SONY 
НЕ НЕСЕТ ОТВЕТСТВЕННОСТИ ЗА КАКОЙ 
БЫ ТО НИ БЫЛО УЩЕРБ, ВКЛЮЧАЯ, 
В ЧИСЛЕ ПРОЧЕГО, КОМПЕНСАЦИЮ 
ИЛИ ВОЗМЕЩЕНИЕ УБЫТКОВ В СВЯЗИ 
С ОТКАЗОМ ДАННОГО УСТРОЙСТВА 
ИЛИ НОСИТЕЛЯ ИНФОРМАЦИИ 
ИЛИ ЛЮБЫХ ДРУГИХ НОСИТЕЛЕЙ 
ИЛИ СИСТЕМ ХРАНЕНИЯ ДАННЫХ И 
НЕОСУЩЕСТВЛЕНИЕМ ЗАПИСИ ЛЮБОГО 
СОДЕРЖАНИЯ И ТИПА.
ˎˎ Перед эксплуатацией данного 
устройства обязательно проверьте 
правильность его работы. КОМПАНИЯ 
SONY НЕ НЕСЕТ ОТВЕТСТВЕННОСТИ 
ЗА КАКОЙ БЫ ТО НИ БЫЛО УЩЕРБ, 
ВКЛЮЧАЯ, В ЧИСЛЕ ПРОЧЕГО, 
КОМПЕНСАЦИЮ ИЛИ ВОЗМЕЩЕНИЕ 
УБЫТКОВ В СВЯЗИ С УТРАТОЙ ИЛИ 
НЕДОПОЛУЧЕНИЕМ ПРИБЫЛЕЙ ИЗ-
ЗА НЕРАБОТОСПОСОБНОСТИ ЭТОГО 
УСТРОЙСТВА, КАК НА ПРОТЯЖЕНИИ 
ГАРАНТИЙНОГО ПЕРИОДА, ТАК И 
ПОСЛЕ ИСТЕЧЕНИЯ СРОКА ГАРАНТИИ, 
А ТАКЖЕ ВСЛЕДСТВИЕ ЛЮБЫХ ИНЫХ 
ВОЗМОЖНЫХ ПРИЧИН.
ˎˎ КОМПАНИЯ SONY НЕ НЕСЕТ 
ОТВЕТСТВЕННОСТИ ЗА ПРЕТЕНЗИИ 
ЛЮБОГО РОДА, ПРЕДЪЯВЛЕННЫЕ 
ПОЛЬЗОВАТЕЛЯМИ ЭТОГО УСТРОЙСТВА 
ИЛИ ТРЕТЬИМИ ЛИЦАМИ.
ˎˎ КОМПАНИЯ SONY НЕ НЕСЕТ 
ОТВЕТСТВЕННОСТИ ЗА ПОТЕРЮ, 
ИСПРАВЛЕНИЕ ИЛИ ВОСПРОИЗВЕДЕНИЕ 
ЛЮБЫХ ДАННЫХ, ЗАПИСАННЫХ В 
СИСТЕМЕ ВНУТРЕННЕЙ ПАМЯТИ, НА 
НОСИТЕЛЕ ИНФОРМАЦИИ ИЛИ НА 
ЛЮБЫХ ДРУГИХ НОСИТЕЛЯХ ИЛИ 
СИСТЕМАХ ХРАНЕНИЯ ДАННЫХ.
ˎˎ КОМПАНИЯ SONY НЕ НЕСЕТ 
ОТВЕТСТВЕННОСТИ ЗА ПРЕКРАЩЕНИЕ 
ИЛИ ПРИОСТАНОВКУ ПРЕДОСТАВЛЕНИЯ 
ЛЮБЫХ УСЛУГ, СВЯЗАННЫХ С ЭТИМ 
УСТРОЙСТВОМ, ВНЕ ЗАВИСИМОСТИ ОТ 
ОБСТОЯТЕЛЬСТВ.



8. Приложение: Технические характеристики145

Внешние габариты

Устройство: мм

UNC 1/4-20, глубина: 6

UNC 3/8-16, глубина: 5,5

2-UNC 1/8-20, глубина: 6

UNC 1/4-20, глубина: 6 UNC 1/4-20, глубина: 6

UNC 1/4-20, глубина: 5,5

98,6

11,9
8-UNC 1/4-20, глубина: 6

143
60

98,6 89,8

82,5

114

62,8

60,6

258

90,1 60,6

25
25

25

4,9

25

117
228

74
116

15326,1

6,9 28

UNC 1/4-20, глубина: 6

Указаны приблизительные габариты.
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Товарные знаки

ˎˎ  является товарным знаком Sony 
Corporation.
ˎˎ XAVC и  являются 
зарегистрированными товарными 
знаками Sony Corporation.
ˎˎ Термины HDMI и HDMI High-Definition 
Multimedia Interface и Логотип HDMI 
являются товарными знаками или 
зарегистрированными товарными 
знаками HDMI Licensing Administrator, Inc. 
в Соединенных Штатах и других странах.
ˎˎ Microsoft и Windows являются товарными 
знаками или зарегистрированными 
товарными знаками корпорации Microsoft 
Corporation в США и/или других странах.
ˎˎ Mac и macOS являются 
зарегистрированными товарными 
знаками корпорации Apple Inc. в США и/
или других странах.
ˎˎ “Catalyst Browse,” “Content Browser 
Mobile” и логотип “Content Browser 
Mobile” являются товарными знаками 
или зарегистрированными товарными 
знаками Sony Corporation.
ˎˎ iOS является товарным знаком или 
зарегистрированным товарным знаком 
корпорации Cisco Systems, Inc. и/или ее 
дочерних компаний в США и некоторых 
других странах.
ˎˎ Android и Google Play являются 
товарными знаками корпорации Google 
Inc.
ˎˎ Wi-Fi, логотип Wi-Fi и Wi-Fi PROTECTED 
SETUP являются товарными знаками 
или зарегистрированными товарными 
знаками альянса Wi-Fi Alliance.
ˎˎ N Mark является товарным знаком или 
зарегистрированным товарным знаком 
корпорации NFC Forum, Inc. в США и 
других странах.

ˎˎ Логотип SDXC является товарным знаком 
компании SD-3C, LLC.
ˎˎ CFexpress и CFexpress Type A являются 
товарными знаками ассоциации 
CompactFlash Association.
ˎˎ QR Code является товарным знаком 
Denso Wave Inc.

Все прочие названия компаний и продуктов 
являются зарегистрированными товарными 
знаками или товарными знаками 
соответствующих владельцев. В настоящем 
документе элементы, являющиеся 
товарными знаками, не обозначаются 
символами ™ или ®.
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